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Medical Device Directive
These products conform with the requirements of council directive 93/42/EEC 
concerning medical devices, when they bear the following CE Mark of Conformity:

This equipment generates, uses, and can radiate radio frequency energy. The 
equipment may cause radio frequency interference with other medical and non-
medical devices and radio communications. To provide reasonable protection 
against such interference, the:

GE Signa MR/i Systems
comply with emissions limits for (Group 2, Class A) Medical Devices as stated in 
EN 60601-1-2. However, there is no guarantee that interference will not occur in a 
particular installation.

If this equipment is found to cause interference (which may be determined by 
turning the equipment on and off), the user (or qualified service personnel) should 
attempt to correct the problem by one or more of the following measure(s):

• reorient or relocate the affected device(s);
• increase the separation between the equipment and the affected device;
• power the equipment from a source different from that of the affected device; 

and/or
• consult the point of purchase or service representative for further 

suggestions.
The manufacturer is not responsible for any interference caused by using 
interconnect cables that are not recommended or by unauthorized changes or 
modifications to this equipment. Unauthorized changes or modifications could 
void the user’s authority to operate the equipment.
Do not use devices that transmit RF Signals (cellular phones, transceivers, or 
radio controlled products) in the vicinity of this equipment as they may cause 
performance outside the published specifications. Keep the power to these types 
of devices turned off when near this equipment.
The medical staff in charge of this equipment is required to instruct technicians, 
patients, and other people who may be around this equipment to fully comply with 
the above requirement.
Immunity/Emissions Exceptions: Note the exceptions from the EMC test results. 
Check with the business EMC engineer for this information.



In accordance with the international safety standard IEC 601-1, this system is a 
Class I device, acceptable for Continous Operation, having ordignary protection 
against ingress of water with type B applied parts and is not for use in the 
presence of flammable anesthetics.

CAUTION: User to call or contact the local authorities for disposal of the MR 
System at the end of its useful life.
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Chapter 1

About This Guide

Introduction
This chapter explains the purpose and design of this Learning and Reference 
Guide. It is an introduction to the guide, providing information on the purpose, 
prerequisite skills, guide organization, chapter format, and graphic conventions 
that identify the visual symbols used throughout the guide.

Purpose of This Guide
This guide is written for health care professionals (namely, the MR technologist) 
to provide the necessary information relating to the proper operation of this 
system. The guide is intended to teach you the system components and features 
necessary to use it to its maximum potential. It is not intended to teach magnetic 
resonance imaging or to make any type of clinical diagnosis.

Prerequisite Skills
This guide is not intended to teach magnetic resonance imaging. It is necessary 
for you to have sufficient knowledge to competently perform the various 
diagnostic imaging procedures within your modality. This knowledge is gained 
through a variety of educational methods including clinical working experience, 
hospital based programs, and as part of many college and university Radiologic 
Technology programs.

Chapter Format
Each chapter contains a consistent format. This consistency provides uniformity 
for content delivery and a better learning environment for you. Listed below are 
the components for each chapter.
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Introduction
The Introduction provides a short introduction to the chapter and a list of 
tasks to be presented. There are pre-questions related to the concepts and 
tasks of the chapter. These pre-questions help you think about the concepts 
and tasks as you go through a particular chapter and help reinforce the 
learning of the material covered.

What Do I Need to Know About...
The What Do I Need to Know About... section lists and explains concepts 
necessary to perform the tasks within the chapter. 

How Do I...
The How Do I... section provides the detailed steps necessary to complete 
a given task. These detailed steps not only provide the steps to complete a 
task, but also provide additional information, as needed, related to a step.

On the first page of each task, there is a Quick Steps table in the outer 
margin. This Quick Steps table is intended to be used as a quick reference 
by the experienced technologist and provides only the steps necessary to 
complete a task.

Graphic Conventions and Legend
The format of the page is such that you have room in the outer margin to 
make notes as needed, except in the area where the Quick Steps table is 
located in the How Do I... section. Table 1-1 describes the terminology used 
for the various mouse functions. Table 1-2 describes the conventions used 
when working with menus, buttons, text boxes and keyboard keys. 
1-2  2333956-100 Rev. 0 (06/02)
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Table 1-1 Conventions for Mouse Actions

Mouse Action Description

Click
Clicking the left mouse button to select a 
button or icon. The button can be pressed 
in, not pressed in, or popped in/out.

Right-click Clicking the right mouse button.

Middle-click Clicking the middle mouse button.

Click and drag
Clicking and holding the left mouse 
button down while dragging the cursor to 
the desired location.

Right-click and drag
Clicking and holding the right mouse 
button down while dragging the cursor to 
the desired location.

Middle-click and drag
Clicking and holding the middle mouse 
button down while dragging the cursor to 
the desired location.

Double-click Clicking the left mouse button twice in 
rapid succession.

Triple-click Clicking the left mouse button three times 
in rapid succession.
2333956-100 Rev. 0 (06/02)  1-3
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Table 1-2 Conventions for Menus, Buttons, Text Boxes, and Keyboard Keys

Example Describes

Select Selecting an option in a check box or 
radial button and selecting a tab.

Press the Enter key Pressing a hard key on the keyboard.

Press and hold the Shift 
key

Pressing and holding down a hard key on 
the keyboard.

Click [Viewer] A button label or Interface button name.

Click  
(Exam prior)

Selecting an icon-based button.

In the Matrix text box,... The name of text box in which you can 
select or type text.

Type supine in the 
Patient Position text box 
(different font and bold)

Text you enter into a text box.

Select Sort > Sort by 
date

The pathway of selecting option(s) in a 
pull-down menu.
1-4  2333956-100 Rev. 0 (06/02)
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Safety Notices
The following safety notices are used to emphasize certain safety 
instructions. This guide uses the international symbol along with the danger, 
warning, or caution message. This section also describes the purpose of a 
Note.

DANGER: Danger is used to identify conditions or actions for which a 
specific hazard is known to exist which will cause severe 
personal injury, death, or substantial property damage if the 
instructions are ignored.

WARNING:Warning is used to identify conditions or actions for which 
a specific hazard is known to exist which may cause severe 
personal injury, death, or substantial property damage if the 
instructions are ignored.

CAUTION: Caution is used to identify conditions or actions for which a 
potential hazard may exist which will or can cause minor 
personal injury or property damage if the instructions are 
ignored.

NOTE: A Note provides additional information that is helpful to you. It may 
emphasize certain information regarding special tools or techniques, 
items to check before proceeding, or factors to consider about a 
concept or task.
2333956-100 Rev. 0 (06/02)  1-5
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Chapter 2

New Features

Introduction
This chapter presents an overview of the Signa® LX 9.1 new and enhanced 
features. It contains information to complement the Signa® Infinity with Signa 
Select™ (ASP2) Learning and Reference Guide.

Safety Information
Please refer to the “Working Safely” chapter in Volume 1 of your Learning and 
Reference Guide. The Safety chapter describes safety information you and the 
physician must understand thoroughly before you begin to use the system. Note 
that you will find additional safety information throughout your Learning and 
Reference Guides. If you need additional training, seek assistance from qualified 
GE Medical personnel.

The equipment is intended for use by qualified personnel only.

Make sure all of your Learning and Reference Guides are readily available at all 
times. Be sure to review the procedures and safety precautions periodically.

Product identification labels (ratings) can be found on the tops and sides of the 
cabinets, the rear of monitors, and other exterior surfaces on the equipment. In 
the event you are unable to identify these labels, contact your service personnel.

One or more of the symbols in Table 2-1 may be on your system or peripheral 
equipment. Please check for the labels that apply to your particular system.
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Table 2-1 Safety Symbols

Symbol Description (typical use)

Alternating current (rating plate, terminals)

Direct current (rating plate, terminals)

Earth (ground terminals) 

Protective earth (ground terminals)

Equipotentiality (terminals)

Class II Equipment (double insulated) (ratings)

Type B Applied Part (ratings, AP connections)

Non-ionizing electromagnetic radiation (ratings)

Main On (main disconnect/power switch)

Main Off (main disconnect/power switch)

Dangerous voltage (components, points of entry)
2-2  2333956-100 Rev. 0 (06/02)
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System Maintenance
Your system requires maintenance and service intervals. Many of the 
maintenance checks should be performed by a qualified service engineer, 
some you can perform. Be aware of the required maintenance and the 
persons responsible for completing each requirement.

GE makes available, on request, such information as circuit diagrams and 
component lists to assist your technical personnel in the repair of equipment 
classified by GE as repairable.

CAUTION – Dangerous voltage (barriers, points of 
entry)

Emergency Stop

Attention – consult accompanying documents

CAUTION 

CAUTION 

 DANGER 

CAUTION – Static Sensitive (ESD susceptible parts)

Laser Radiation (laser devices)

Symbol Description (typical use)
2333956-100 Rev. 0 (06/02)  2-3
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WARNING:Electric shock hazard. No user serviceable parts. Refer 
service to qualified service personnel.

Cleaning

Background cleaning should be done by site personnel (e.g., technologists 
or housekeeping personnel) unless otherwise indicated in the following 
maintenance schedules.

Cleaning tips:
• To clean most accessories, use nothing stronger than alcohol or a mild 

soap and water solution.
• Use hydrogen peroxide to remove bloodstains.
• Open cell sponges are coated with canvas to allow better durability and 

reliability. These sponge covers allow disinfection using only 5.25% 
sodium hypochlorite diluted between 1:10 and 1:100 with water and 
10% bleach solution. Anything else may discolor the fabric.

CAUTION: To avoid possible damage to equipment, do not use 
solutions containing amines, strong alkalis, esters, iodine, 
aromatic or chlorinated hydrocarbons, or ketones. Do not 
use autoclaves or the industrial washers and dryers found 
in most hospitals or professional laundry services.

Services

The following services in Table 2-2 should be completed at the indicated 
intervals and should be performed only by qualified service personnel.

Table 2-2 Qualified Service Personnel Services

Item Period
Operator Console (OC)
Audio Functional Check Every 6 months
Panic Switch Functional Check Daily

IPS
Body Coil Power Check Yearly
Head Coil Power Check Yearly
2-4  2333956-100 Rev. 0 (06/02)
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UPS
UPS Check Every 3 months

Table
Release Assy Check and O Ring Replacement Yearly

ID Connector Replacement Yearly
Cradle Tape Check Replacement Every 6 months
Cradle Emergency Release Check Every 6 months
Table Function Check Every 6 months
Table Appearance Check and Cleaning Every 6 months
Table Gap Check (9 mm from bridge) Every 6 months

Cradle Drive Belt Check Every 6 months

Magnet Display, Covers, and Cooling Unit
Positioning Light Check Every 3 months
Cooling Fan, Cuff, and Hose Check Every 3 months
Cover Appearance Check Daily

Magnet
Magnet Run Down Unit Battery Replacement Every 3 years
Compressor Charcoal Absorber Replacement Every 2 years

O2 Monitor 

O2 Sensor Replacement Every 3 years

Head Coil
O Ring Cable Replacement Yearly
Cable and Appearance Check Daily

Surface Coil
Surface Coil Cable Check Daily

Item (Continued) Period
2333956-100 Rev. 0 (06/02)  2-5
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You should perform the following services in Table 2-3.

Table 2-3 Operator Services

System
Scan Functional Check Every 6 months
Emergency Off Check Every 6 months
Gating Cable Check Daily

Top Level Test (TLT) Body Shim Test Yearly
Eddy Current Compensation Every 6 months
Gradient Calibration Yearly
Image Quality Check (TLT Head SNR and T2) Daily
Image Quality Check (TLT Body SNR and T2) Yearly
Ghost Check Yearly

Gapless Slice Check (Head) Every 6 months
Gapless Slice Check (Body) Every 6 months
System Gain Calibration (Head) Yearly
System Gain Calibration Yearly

Item Required Maintenance Service Interval

General
Clean 4 months
Check the table emergency 
release. 4 months

Patient Cradle 
and Pads

Check for cleanliness of pads and 
clean the inside of the cradle. Daily

Patient Table Check the table alignment and 
proper operation. 6 months

Coils, pads, and 
straps

Clean with non-abrasive cleanser. 
Clean coil anti-skid pads with water 
and mild detergent only.

Daily

Coils and coil 
cables

Check for defects or damage, worn 
cable or exposed wires. Daily

Image Quality Perform quality assurance and 
functional checks.

As 
recommended

Item (Continued) Period
2-6  2333956-100 Rev. 0 (06/02)
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Clinical Hazards

WARNING:Do not use Projection Images for localization.

CAUTION: All people, patients, and others in the scan room must wear 
a hearing protection device, such as ear plugs.

CAUTION: All patients should be monitored for increased temperature 
during the scan acquisition. If the patient reports discomfort 
due to warming, stop the scan.

CAUTION: Make sure the patient connected intravenous (IV) lines, 
oxygen tubing, urinary catheters, and any other tubing and 
cables are long enough to allow full travel of the system and 
will not become entangled, pinched, or pulled.

CAUTION: Following the exam, your patient may need assistance when 
getting off the table. After lying in a prone position for a 
length of time, your patient may experience 
light-headedness upon sitting up.

Equipment Hazards

CAUTION: Using equipment that is damaged or has been compromised 
can put the patient and/or operator at risk of injury.
2333956-100 Rev. 0 (06/02)  2-7
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CAUTION: The equipment on which the MR system application runs 
includes one or more hard disk drives, which may hold 
medical data related to patients. Such equipment may in 
some countries be subjected to regulations concerning the 
processing of personal data and the free circulation of such 
data. It is strongly recommended that access to patient files 
be protected from all persons not in medical attendance.

Indications for Use - TwinSpeed
The Signa 1.5T TwinSpeed™ Magnetic Resonance System is a whole body 
scanner designed for shorter scan times. The Signa TwinSpeed is indicated 
for use as a diagnostic imaging device to produce axial, sagittal, coronal, 
and oblique images of the internal structures of the head or body. The 
images produced by this system reflect the spatial distribution of protons 
(hydrogen nuclei) exhibiting magnetic resonance. The NMR properties that 
determine the image appearance are proton density, spin-lattice relaxation 
time (T1), spin-spin relaxation time (T2) and flow. When interpreted by a 
trained physician, these images provide information that can be useful in 
determining a diagnosis.

Gradient, Shim, and Imaging Coils
The TwinSpeed™ Resonance Module (TRM) is 60 cm in diameter and 
consists of two actively shielded gradient coils. One gradient coil can be 
used for whole body imaging and the second for smaller optimized field of 
view (FOV) advanced applications. 

The system is optimized to operate in two imaging modes.
• Zoom gradient mode

– A single coil is active in a given pulse sequence
– Intended for small FOV applications 

• Whole Body gradient mode
– A single coil is active in a given pulse sequence
– Intended for large FOV applications

You can select the active imaging mode in between sequences during scan 
prescription. The Grad Mode text box in the Imaging Parameters area 
(Figure 2-1) allows you to select the appropriate imaging mode (toggles 
between the Zoom or Whole Body modes). You can change the mode for 
each specific application with the help of this text box. 
2-8  2333956-100 Rev. 0 (06/02)
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Figure 2-1 Imaging Parameters Area

In addition to using the pull-down menu, you can type Whole or Zoom in the 
Grad Mode text box. The Whole Body mode defaults on. 

After selection of gradient mode, the system automatically calculates the 
available range of echo time (TE), repetition time (TR), slice widths, and 
pixel sizes (FOV & matrix combinations) based on gradient specifications, 
thermal model of the gradient coil, specific absorption rate (SAR) models, 
dB/dt requirements and thermal model of the Advanced Control Gradient 
Driver (ACGD). 

The images are annotated Z (for Zoom) and W (for Whole) after the FOV 
annotation.

Zoom Mode
The Zoom gradient mode is used to optimize amplitude and slew rates over 
smaller regions of interest. The Zoom mode has a FOV of 40x40 cm in the 
X and Y planes and 35 cm in the Z direction. Therefore, body parts must be 
well positioned within the FOV of the coil when operating in Zoom mode. 
The limitations of the Zoom mode are described in Table 2-4 to help ensure 
the Zoom gradient is used when it could improve image quality over Whole 
Body mode.

Table 2-4 Zoom Mode Limitations

Coils and Planes Maximum 
FOV S/I

Maximum 
FOV A/P

Maximum 
FOV R/L

All coils except CTL
All Planes 35 44 44

CTL Coil
Sagittal and Sagittal Oblique 
Frequency = S/I (Not swapped)

35 44 N/A

CTL Coil
Frequency = A/P (Swapped)

Choose 
Whole Body

Choose 
Whole Body N/A
2333956-100 Rev. 0 (06/02)  2-9
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NOTE: Cardiac pulse sequences (FastCard, FGRET, SPIRAL, and FIESTA) 
can have up to a 44 cm FOV in all directions using the Zoom mode.

Table 2-5 identifies off-center limitations for the Zoom mode.

Table 2-5 Off-center Zoom Mode Limitations

Applications of the Zoom mode include:
• High end cardiac imaging
• Brain imaging
• Functional MRI (fMRI) studies
• High resolution orthopedic imaging

Due to its higher gradient amplitude and slew rate specifications, the Zoom 
mode is primarily used for imaging small FOVs with thin slices acquired with 
SE, FSE, and GRE pulse sequences. All advanced neurovascular and 
cardiovascular applications in Zoom mode primarily use EPI, Diffusion 
Weighted Imaging (DWI) EPI, Spiral, and Fast Gradient Echo (FGRE) pulse 
sequences.

Whole Body Mode
The Whole Body gradient mode is used to obtain the highest linearity and 
largest FOV (48 cm) operation. The Whole Body mode is used primarily for 
applications demanding large coverage along the magnet axis, or large 
off-center imaging (>20 cm off-center).

Applications of the Whole Body mode include:
• Spine (sagittal and coronal)
• Shoulder
• Coronal and sagittal abdomen
• Coronal and sagittal extremities

The Whole Body mode is primarily used for conventional Magnetic 
Resonance Imaging (MRI) sequences; Spin Echo (SE), Fast Spin Echo 
(FSE), Gradient Echo (GRE), and multi-shot Echo Planar Imaging (EPI).

Plane or Sequence Off-center Limits for R/L 
or A/P

Off-center Limits for 
S/I

Axials or Coronals 12 cm N/A

Sagittal 15 cm N/A

Real Time Imaging 15 cm or use Whole Body 15 cm

Fluoro Trigger MRA 12 cm or use Whole Body 12 cm
2-10  2333956-100 Rev. 0 (06/02)
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Prescribing Images
3-Plane graphic prescription (GRx) allows you to define slices and 
saturation (SAT) bands while visualizing their exact locations on three 
different image planes simultaneously. This feature helps you achieve 
reductions in prescription time, as well as increase your prescription 
accuracy. 

Refer to the Prescribing Images chapter in this guide for additional 
information.

Imaging Parameters
For improved imaging flexibility, existing options such as ZIP 512, 
Magnetization Transfer, Variable Frequency Matrix, and the Oblique scan 
plane are now compatible with additional pulse sequences. Table 2-6 
demonstrates the compatibility between these parameters and the 
additional pulse sequences they can be used with.

Table 2-6 Imaging Parameter Compatibility Chart

The Pulse Sequence window (Figure 2-2), selected from the Imaging 
Parameters area, contains the following additional pulse sequences:
• FIESTA
• FRFSE-XL
• Spiral
• PROSE

Imaging Parameters
Pulse Sequences

Spin Echo 2D GRE 3D GRE
Oblique Scan Plane Yes Yes Yes

Variable Frequency Matrix Yes Yes Yes

ZIP 512 Yes Yes Yes

Magnetization Transfer Yes Yes Yes
2333956-100 Rev. 0 (06/02)  2-11
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Figure 2-2 Pulse Sequence Window

Fast Spin Echo Pulse Sequences
The following pulse sequences are new or contain enhancements.
• Three-dimensional Fast Spin Echo (3D FSE)
• Fluid Attenuated Inversion Recovery (FLAIR)
• T1 Fluid Attenuated Inversion Recovery (T1 FLAIR)
• Single Shot Fast Spin Echo - Excel (SSFSE-XL)
• Three-dimensional Fast Recovery Fast Spin Echo (3D FRFSE)

Refer to the Fast Spin Echo Pulse Sequences chapter in this guide for 
additional information.

3D FIESTA Pulse Sequence
The Fast Imaging Employing STeady-state Acquisition (FIESTA) is a fully 
balanced steady-state coherent imaging pulse sequence designed to 
produce high signal-to-noise (SNR) images at very short sequence times 
(TR). This guide provides you with information on the pulsing components 
and timing factors directly related to the 3D FIESTA imaging pulse 
sequence. 

Refer to the 3D FIESTA Pulse Sequences chapter in this guide for 
additional information.
2-12  2333956-100 Rev. 0 (06/02)
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Clinical Spectroscopy Pulse Sequences
Prostate Spectroscopy Imaging Exam (PROSE) is a new 3D clinical 
spectroscopy sequence designed for producing spectra of the prostate 
area. PROSE produces multiple chemical shift spectra allowing you to 
examine the compounds present in the prostate area.

Refer to the PROSE Pulse Sequence chapter in this guide for additional 
information.

Echo Planar Imaging Pulse Sequences
There are several enhancements to the Diffusion Weighted Echo Planar 
Imaging (DW EPI) sequence. There is also a new addition to the Echo 
Planar pulse sequence family, Diffusion Tensor Imaging (DTI).

Diffusion Weighted EPI
Increased gradient strength enables DW EPI sensitivities to extend beyond 
the standard B-value of 1000 s/mm2. The maximum B-value is now 7000 
s/mm2. This allows greater diffusion weighting, increasing the sensitivity of 
detection of non-mobile protons.

The Dual Spin Echo feature was moved from the User CV window to the 
Diffusion Options window. You can perform a dual-spin echo DW EPI 
acquisition by changing the User Control Variable (CV) 12, Dual Spin Echo 
Dif., from 0 (off) to 1 (on). When on, an additional refocusing pulse is 
applied in the diffusion sequence before the readout. This additional pulse 
reduces the eddy currents and minimizes image distortion; however, it 
increases the minimum TE by 10 to 14 ms. This option only produces a 
single echo.

Diffusion Tensor EPI
Diffusion Tensor Imaging (DTI) is the newest addition to the Echo Planar 
pulse sequence family. It is used to visualize the white matter fiber tracts in 
the central nervous system (CNS) and provides information on molecular 
diffusion of biological tissues. 

Refer to the Echo Planar Imaging Pulse Sequences chapter in this guide for 
additional information on DTI.
2333956-100 Rev. 0 (06/02)  2-13
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Functional Magnetic Resonance Imaging
Functional Magnetic Resonance Imaging (fMRI) is an optional brain 
mapping software application that incorporates Blood Oxygen Level 
Dependent (BOLD) imaging to map task activated regions in the brain. 

Refer to the Functional Magnetic Resonance Imaging chapter in this guide 
for additional information.

Visualize fMRI Data
BrainWave Visualizer is the visualization software included in the optional 
fMRI package. This software is located on your Advantage Windows (AW) 
4.0 workstation. BrainWave Visualizer allows you to interactively view and 
edit the fMRI data.

Refer to the Visualize fMRI Data chapter in this guide for additional 
information.

Paradigm Development
NeuroActivator is the paradigm software included in the optional fMRI 
package. This software is located on the Stimulus personal computer (PC). 
NeuroActivator allows you to create, preview, and acquire customized 
paradigms that specifically meet your needs when performing brain 
mapping MRI studies.

Refer to the Paradigm Development chapter in this guide for additional 
information.

2D FIESTA Pulse Sequence
The Fast Imaging Employing STeady-state Acquisition (FIESTA) is a fully 
balanced steady-state coherent imaging pulse sequence designed to 
produce high signal-to-noise (SNR) images at very short sequence times 
(TR). This guide provides you with information on the pulsing components 
and timing factors directly related to the 2D FIESTA imaging pulse 
sequence. 

Refer to the 2D FIESTA Pulse Sequences chapter in this guide for 
additional information.
2-14  2333956-100 Rev. 0 (06/02)
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Additional Cardiac Pulse Sequences
This guide explains additional cardiac sequences used in evaluating wall 
motion abnormalities and pathologic abnormalities within the myocardial 
tissue. 

Refer to the Additional Cardiac Pulse Sequences chapter in this guide for 
additional information.

FGRET Pulse Sequences
Fast Gradient Echo-Echo Train (FGRET) is a Fast Gradient Echo (FGRE) 
sequence with an echo-planar (EPI) readout. Features of both the FGRE 
and EPI pulse sequences are combined for use in cardiac applications. This 
guide explains the pulsing components and timing factors directly related to 
the FGRET imaging pulse sequence.

Refer to the FGRET Pulse Sequences chapter in this guide for additional 
information.

Spiral Pulse Sequences
The Spiral pulse sequence is a 2D, Gradient Echo (GRE) or SPoiled 
Gradient Echo (SPGR) sequence which uses a spiral K-space trajectory to 
obtain the required data for image creation. This guide explains the pulsing 
components and timing factors directly related to the Spiral imaging pulse 
sequences.

Refer to the Spiral Pulse Sequences chapter in this guide for additional 
information.

Imaging Options
There are several new features on the Imaging Options window (Figure 
2-3).
• T2 Prep 
• Spectral Spatial RF 
• Navigator
• Fluoro Trigger
• ASSET Calibration
• ASSET
2333956-100 Rev. 0 (06/02)  2-15
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Figure 2-3 Imaging Options Window

T2 Prep
T2 Prep is an option available with Spiral imaging. It can be used to 
suppress tissue and decrease signal from various structures. 

Refer to the Spiral Pulse Sequences chapter in this for information on T2 
Prep.

Spectral Spatial RF
Spectral Spatial RF (SSRF) is an imaging option used to suppress signal 
from fat during Spiral sequences and suppresses fat and water when used 
with PROSE pulse sequences.

Refer to the Spiral Pulse Sequences and Clinical Spectroscopy Pulse 
Sequences chapters in this guide for information on SSRF. 
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Navigator
Navigator is a cardiac option that enables you to perform navigated, 
free-breathing, coronary artery acquisitions. The Navigator Imaging Option 
is used with a 3D enhanced Fast Gradient Echo (GRE) pulse sequence to 
acquire the images.

Refer to the Cardiac Navigator chapter in this guide for information on the 
Navigator option.

Fluoro Trigger
Fluoro Trigger is an option available for Fluoro Triggered Magnetic 
Resonance Angiography (FT MRA) imaging. This option must be used in 
order to perform a FT MRA sequence.

Refer to the Bolus Triggering chapter in this guide for information on Fluoro 
Trigger. 

ASSET and ASSET Calibration
Array Spatial Sensitivity Encoding Technique (ASSET) is an option that 
enables faster scanning when using the Torso Phased Array (PA) coil. It is 
designed to achieve shorter breath-held acquisitions, thus making it easier 
for your patients experiencing difficulty holding their breath for long periods 
of time.

ASSET Calibration is an option used along with the ASSET option that 
allows you to calibrate your scan data prior to performing an ASSET 
imaging acquisition.

Refer to the Imaging with ASSET chapter in this guide for information on 
ASSET and ASSET Calibration.

Bolus Triggering
FT MRA is a technique that uses a thick slab, two-dimensional (2D) real 
time acquisition and reconstruction to monitor the region of interest for 
contrast bolus.

Refer to the Bolus Triggering chapter in this guide for additional information.
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Bolus Chasing
SmartStep has been improved to include:
• Capability of saving a site customized protocol
• Automatic prescanning of all saved series
• A quiet delay period after the bolus has been detected
• A delay count-down timer after the bolus has been detected
• Four K-space filling options
• Easier selection of mask and venous series
• Meta-series can be copied and pasted
• Left mouse clicks only are used to activate all scan functions, including 

AutoStep

Refer to the Bolus Chasing chapter in this guide for additional information.

Real Time Imaging
iDrive™ Pro Plus is an optional software package that provides you with a 
flexible environment for using real time imaging. This guide explains how to 
image real time with iDrive Pro Plus. It provides key concepts regarding the 
acquisition, tools, and image review options available. 

Refer to the Real Time Imaging chapter in this guide for additional 
information.

Displaying Images

Reference Image
Several changes have occurred within the Reference Image Viewer feature. 
The following is a list of things you can do to a referenced image:
• Window/Level (all methods)
• Image selection buttons (Image +/-)
• Zoom
• Display Normal
• Flip/Rotate
• Pan
• Scroll
2-18  2333956-100 Rev. 0 (06/02)
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When you click the [Image] button on the Film Composer icon on the Film 
Composer Options window, both the Reference image and the Primary 
image appear within a film format cell. Note the size relationship between 
the Primary and the Reference images is not indicative of what the images 
will look like when the film is printed. The Reference image is larger than it 
appears on the film.

All Reference image viewports display the same image. You can no longer 
put unique images within separate or different viewports. If you change the 
image within one Reference image viewport, all other Reference image 
viewports update to the same image, even if you have isolated the 
Reference image viewport through a double-click.

If you have the Reference images displayed in all of the viewports and use 
the F4 (Film Series) feature, references images are printed. If a Reference 
image is not on all viewports, no reference images are printed.

User Preferences
There have been additions and changes to the Partial Annotation and Tick 
Mark features located on the User Preferences window.

Partial Annotation

Two annotation fields have been added to the Partial Annotation selection 
accessed from the User Preferences window.
• Date of Birth, which is located in the upper right corner of the viewport.
• Slice Thickness and Slice Spacing, which were added to the lower left 

corner of the viewport.

Tick Marks

The Tick Mark selections from the User Preferences window have changed 
to Vertical or Horizontal, rather than Shown or Hidden.

Browser Sort Feature
The sort function in the Browser menu bar allows two sorting methods for 
Series:
• Sort by PPS status (Complete or Defer)
• Sort by Series number
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Managing Images
The MOD automatically detaches if there is no archive activity for 60 
minutes. This feature is designed to minimize the potential for MOD 
corruption if the system is shutdown without performing a detach. When the 
system detaches the MOD, the message "MOD Detached" appears in the 
archive status area.

The MOD automatically re-attaches in the following situations:
• If you have auto archive active, the system automatically re-attaches 

the MOD as soon as images appear in the archive queue.
• If Archive Pause is active, then an attach is automatically performed 

when the [Resume] button is clicked from the archive queue window.
• If you are manually archiving, an attach is automatically performed 

when an exam, series, or image is saved.

Functool
The PROSE sequence can be displayed through Functool 2, located on 
your Browser. PROSE sequences are displayed in the same manner as 3D 
Focal Brain spectroscopy sequences.

Refer to the Spectroscopy Functool 2 chapter in this guide for additional 
information.

ASSET
Array Spatial Sensitivity Encoding Technique (ASSET) is an imaging feature 
that allows faster scanning when using the Torso PA coil. It is designed to 
achieve shorter breath-held acquisitions, thus making it easier for your 
patients experiencing difficulty holding their breath for long periods of time.

Refer to the Imaging with ASSET chapter in this guide for additional 
information.

Accelerator Commands
There are several changes in the naming conventions of the Accelerator 
Commands. Table 2-7 lists the updated Accelerator Commands along with 
their type-in abbreviation and description.
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Table 2-7 Accelerator Commands

Command Type-in 
Abbreviation Description

Image Manipulation

Flip horizontal ftb Flips the image horizontally (top to 
bottom).

Flip vertical flr Flips the image vertically (left to right).

Format fo
Sets the display format to a maximum 
of five rows and five columns. For 
example, fo 3 5.

Reset rs Resets the initial display parameters.

Zoom zo Sets the magnification factor. For 
example, zo 2.

Invert inv Inverts the video.

Scroll scroll Moves the image in the viewport as 
you click and drag the mouse.

Screen Save scnsave

Captures the selected images exactly 
as it is displayed and creates a new 
image of series number 99 on the 
system disk that includes all graphics 
and display factors applied to the 
image and/or viewport at the time of 
capture.

Graphics
Report cursor rc Creates a report cursor graphic.

Report pixel rp

Displays a 4x4 mm cursor that can be
dragged to a new location. When the
cursor is deposited, the mean,
standard deviation, and area are
displayed.

Angle ang Creates an angle type measurement 
cursor.

Ellipse el Creates an ellipse type measurement 
cursor.

Rectangle rect Creates a rectangular type 
measurement cursor.
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Chapter 3

Prescribing Images

Introduction
3-Plane graphic prescription (GRx) allows you to define slices and saturation 
(SAT) bands while visualizing their exact locations on three different image 
planes simultaneously. This feature helps you achieve reductions in prescription 
time, as well as increase your prescription accuracy. 

This chapter explains the process of prescribing images. It provides the concepts 
necessary to graphically prescribe image locations, the tracker location, and SAT 
bands, as well as the basic steps to apply these techniques. It contains the 
step-by-step instructions to help you learn how to:
• Prescribe 2D graphic locations

– Single and multi-group locations
– Radial locations

• Prescribe 3D graphic locations
– Single and multi-slab locations
– Tracker location

• Prescribe SAT locations

In addition, this chapter answers the following questions:

1. What are the advantages of 3-Plane GRx?

2. What scan planes can I prescribe in 3-Plane GRx?

3. What types of prescriptions can I prescribe in 3-Plane GRx?

4. What imaging mode allows me to prescribe a tracker?

5. How many SAT bands can I prescribe at one time?
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What Do I Need to Know 
About...
This section presents the concepts necessary to successfully complete the 
process of prescribing images. Specifically, you need to understand:
• 3-Plane GRx Basics

– Acquiring Valid Localizers
– Defining the Scanning Range
– Localizer Viewports
– Selecting Images

• Two-dimensional Prescription
– Multi-group Prescription
– Radial Prescription

• Three-dimensional Prescription
– Multi-slab Prescription
– Tracker Prescription

• SAT prescription
• 3-Plane GRx functions 

– Report Cursor
– Zoom
– Display Normal
– Window Width and Level
– Pan
– Reference Lines
– Copy Rx
– Reset Center
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3-Plane GRx Basics
3-Plane GRx allows you to define slices and SAT bands while visualizing 
their exact locations on three different image planes simultaneously. This 
feature is facilitated by using one image (acquired from a 3-Plane localizer) 
from each plane in conjunction with another during graphic prescription. It 
allows you to graphically prescribe on any of the images from the localizing 
series. It also gives you the flexibility of manipulating slice location and 
placement on any one of the three images interactively, while observing the 
resultant changes in the prescription in the other two planes. 3-Plane GRx 
helps you achieve reductions in prescription time, as well as increase your 
prescription accuracy. 

During 3-Plane GRx, you can:
• Use the List Select window to load a series of images into the viewports
• Create different slice groups (parallel, oblique, radial, 2D, 3D, Tracker, 

and SAT)
• Move, size, and rotate the prescription not only on the viewport in which 

you deposited the prescription, but also the other two viewports
• Increase or decrease the number of slices or slabs
• Operate on the different slice groups (edit, delete, rotate, or resize)
• View graphic slice locations and SAT bands together in all viewports
• View and edit some application parameters based on the prescription 

and pulse sequence you select
• Save a 3-Plane GRx prescription as protocol 

3-Plane GRx is available with all scan planes, although the behavior it 
exhibits may differ depending on the scan plane prescribed. Table 3-1 lists 
the action taken by 3-Plane GRx with each scan plane.

Table 3-1 Scan Plane and 3-Plane GRx Behavior

Scan Plane Action in 3-Plane GRx 

Axial Only axial slices shall be prescribed. No rotation 
is allowed. 

Sagittal Only sagittal slices shall be prescribed. No 
rotation is allowed. 

Coronal Only coronal slices shall be prescribed. No 
rotation is allowed. 

Oblique No restrictions on prescribed slices. Rotation is 
allowed in all intersections shown.
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3-Plane GRx allows you to prescribe the following types of prescriptions:
• Two-dimensional (2D) 

– Radial
– Multi-group
– SAT

• Three-dimensional (3D) 
– Tracker
– Multi-slab 
– SAT

The 3-Plane GRx can be manipulated in either the 2D or 3D GRx mode and 
also in the SAT mode. 3-Plane GRx is viewable and editable in the SAT 
mode, and the SAT bands are viewable and editable in the GRx mode. 
However, new SAT bands cannot be created on the GRx screen and new 
GRx groups cannot be deposited on the SAT screen.

The 3-Plane GRx and the Tracker prescription display together in the 
Tracker mode and you are able to manipulate the tracker as well as the 
GRx volume. The tracker is only displayed on the image to which it is 
prescribed.

Upon completion of a 2D, 3D, or SAT prescription, the 3-Plane GRx data is 
translated into right, anterior, and superior (RAS) coordinates, these values 
are passed on to scan, and the geometry calculations are completed and 
updated.

Acquiring Valid Localizers
The Graphic Rx icon (Figure 3-1) is available in the Additional Parameters 
area when you are defining a series prescription. 

Figure 3-1 Graphic Rx Icon

3-Plane GRx can be used after an axial, sagittal, coronal, oblique, or 
3-Plane scan has been completed. A valid localizer has the same patient 
entry, patient position, and landmark as the current prescription. The valid 
localizers for 2D and 3D mode for each plane are given in Table 3-2.
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Table 3-2 Valid Localizers for 2D and 3D Modes

Valid localizers for SAT prescriptions for each plane are given in Table 3-3.

Table 3-3 Valid Localizers for SAT Prescriptions

Defining the Scanning Range
When defining the scanning range in 3-Plane GRx, there are some 
prescription limitations you need to consider. Table 3-4 provides you with 
the limitations of 3-Plane GRx prescriptions.

Table 3-4 Prescription Limitations 

3-Plane GRx allows you to change the following Scanning Range 
parameters as per the mode selected in Table 3-5. The corresponding 
changes display in all three viewports. 

Table 3-5 Editable Scanning Range Parameters

Current Prescription Plane Valid Localizer
Axial Sagittal, Coronal
Sagittal Axial, Coronal
Coronal Axial, Sagittal
Oblique Axial, Sagittal, Coronal, Oblique

Current SAT Band Valid Localizer
Axial Sagittal, Coronal, Axial
Sagittal Axial, Coronal, Sagittal
Coronal Axial, Sagittal, Coronal
Oblique Axial, Sagittal, Coronal, Oblique

Prescription Limitations
3-Plane GRx A maximum of 256 slices can be prescribed.
3-Plane SAT A maximum of 6 SAT bands can be prescribed.
3-Plane Tracker A maximum of 1Tracker prescription can be deposited.

Mode Scanning Range Parameters

2D FOV, Spacing, Slice Thickness, Frequency Direction, 
and Phase FOV

3D FOV, Slice Thickness, Overlap Locations, Number of 
Locations per Slab, and Phase FOV
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The Scanning Range area updates after you accept the prescription. You 
cannot edit the parameters once a prescription is present and you close 
3-Plane GRx. You are only able to see and modify the graphic prescription 
previously made by re-entering the Graphic Rx icon in the Additional 
Parameters area.

Localizer Viewports
When you open 3-Plane GRx, a busy cursor appears on the screen until 
initialization is complete and the appropriate three localizer images display. 
3-Plane GRx has three 410x410 localizer viewports (Figure 3-2). 

Figure 3-2 3-Plane GRx Viewports

The localizer images can be images from a 3-Plane Localizer or, if another 
series is used, three images of the same plane display. A prescription can 
be made on any of the three localizer images. The intersections of the 
slices prescribed are shown on the other viewports. For example, if a 
graphic prescription is made on the Viewport1 localizer image, the slice 
intersections are shown on Viewport2 and Viewport3 localizer images. The 
intersections signify the area on the localizer image that will be scanned.

There are various scenarios 3-Plane GRx uses for determining which 
localizer images are displayed as default images in the three viewports. The 
default load is the last valid 3-Plane Localizer.
• If you are opening 3-Plane GRx for the first time, the middle image of 

the coronal set of the most recent series of the 3-Plane Localizer loads 
in the first viewport. The middle image of the sagittal set loads in 
Viewport2 and the middle image of the axial set loads in Viewport3.
– If the localizer series is not a 3-Plane Localizer, the last compatible 

series scanned is divided into thirds and loads in the viewports, 
displaying the center slices of each third.

• If you are entering 3-Plane GRx for the second time and have acquired 
a 3-Plane Localizer, the system displays this series. 
– If this localizer series is not a 3-Plane Localizer, the valid localized 

series for the set prescription displays.
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• If you had previously prescribed SAT bands, then the default images are 
the localizers that were used in the SAT prescription.

At any instant of time one of the three viewports is always highlighted. The 
active viewport is highlighted with a green or bright border. There are 
various graphic tools that can be applied either to a selected viewport or to 
all the viewports. The following tools operate on the images loaded into the 
viewports:
• Window and Level (W/L) – using the center mouse button
• Pan – using the right mouse button
• Zoom – using the slider
• Report cursor – using the toggle button

When communication with the Graphic server is lost and the system does 
not respond to any of your actions on the 3-Plane GRx screen for an 
amount of time, an error message posts (Figure 3-3) and the 3-Plane GRx 
window closes. You are able to re-enter 3-Plane GRx by clicking the 
Graphic Rx icon again, retaining all of your deposited prescriptions.

Figure 3-3 Communication Error Message Box

Selecting Images
The List Select window allows you to select a series other than the default 
localized series for the scan. When you click the [Select Series] or [Select 
Image] buttons (Figure 3-4), the List Select Series (Figure 3-5) or the List 
Select Image window opens in the bottom corner of the 3-Plane GRx 
screen.

Figure 3-4 Select Series and Image Buttons
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Figure 3-5 List Select Series Window

The List Select window provides a filtered list of series that fit to the current 
patient, with same study and same location.

You can only select the same series for all viewports. Then you are able to 
select an individual viewport and put a specific image in that viewport from 
the selected series. Loading a specific localizer image on any of the three 
viewports can be accomplished by clicking the [Select Series] button to 
choose the desired series and the [Select Image] button to load the 
selected localizer image. 

You are able to select any series from the list. For any series other than a 
3-Plane Localizer, the middle image of the selected series loads in the 
second viewport and images on either end of the same series load in 
viewports one and three. For example, if there are 9 images in the currently 
selected series, then image 2, 5, and 8 are loaded in the viewports.

The select series button is disabled when there is a prescription on any of 
the viewports. When you click the [Erase All] button or when there are no 
prescriptions on the viewport, the [Select Series] button is enabled again.

The [Select Image] button displays all the images of the current series. The 
image shown in the currently highlighted viewport is highlighted in the list of 
images. You are able to select any image from the list and that image loads 
in the currently highlighted viewport.

You are also able to switch between images in a valid localizer image set 
using the [+] (Next) or [-] (Prior) buttons. The Next button moves to the next 
image of the currently selected series for the active viewport. The Prior 
button moves to the previous image of the currently selected series for the 
active viewport.

Two-Dimensional Prescription
Upon clicking the Graphic Rx icon in a 2D prescription, the 3-Plane GRx 
screen opens and displays with the default images in the viewports (Figure 
3-6).
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Figure 3-6 3-Plane GRx Screen for a 2D Prescription

Table 3-6 provides a description and acceptable values for each selection 
on the 3-Plane GRx screen for 2D prescriptions.

Table 3-6 3-Plane GRx Selections and Descriptions for 2D Prescriptions

Selection Description

[Erase Group] Erases a particular group of slices or slabs and its 
corresponding intersections.

[Erase All] Erases all the prescriptions and its intersections. Only 
enabled when there are prescriptions present.

[Reset Center]
Allows you to page through a data set and reselect a 
new center image for prescription. The new center is 
based on the image in the active viewport.

Instructions for 
Add Group Adds a group of slices in a different location.

Fallback to R0
Moves the slice centers from off center prescribed 
position to isocenter in the slice select direction of the 
localizer image.

Report Cursor Provides a report of the cursor location on each of the 
three viewports. 
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Keep W/L

Keeps the selected W/L for the active viewport. The 
W/L remains at the Keep W/L values as the [+] and [-] 
buttons are used to view other images within the 
selected viewport. If Keep W/L is not on, then as the [+] 
and [-] buttons are used to view other images within 
the selected viewport, the W/L reverts to the auto W/L 
values.

Loc Ref Lines

Allows you to view the reference lines on all viewports. 
The lines represent the location of the other two 
graphic planes. For example, the lines on the sagittal 
localizer image represent the locations of the axial and 
coronal localizer images.

SAT icon Opens the SAT screen. The currently prescribed slices 
are automatically accepted.

[Copy Rx]

Copies a previous Rx with the same FOV, slice 
thickness, and spacing. The slices are copied onto the 
image used to originally prescribe them. You may 
single-click on the desired series and click [Accept] or 
double-click to display the locations.

[Accept] Registers slice prescription and exits Graphic Rx.

Viewport1 
Displays the middle slice of the first third of the most 
recent series which could be used as a localizer. 
Displays the middle coronal image if a 3-Plane 
Localizer was acquired.

Viewport2
Displays the middle slice of the most recent series 
which could be used as a localizer. Displays the middle 
sagittal image if a 3-Plane Localizer was acquired.

Viewport3
Displays the middle slice of the last third of the most 
recent series which could be used as a localizer. 
Displays the middle axial image if a 3-Plane Localizer 
was acquired.

Auto Update: 
W/L Enables the W/L function to apply on all viewports.

Auto Update: 
Pan Enables the pan function to apply on all viewports.

Auto Update: 
Zoom Enables the Zoom function to apply on all viewports.

Zoom Adjusts magnification factor for displayed images using 
the slider.

[Select Series] Lists valid series from which a localizer image can be 
selected.

[Select Image] Lists the images for the selected series.

Selection Description (Continued)
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The length of the Slice lines in a 2D graphic prescription represent the FOV 
coverage. The graphic objects on the Slice lines in 3-Plane GRx enable you 
to define where and how to acquire the slices. 

The graphic objects have handles for rotating, adding, or removing slices 
based on the prescription restrictions. You can move and rotate the 
prescription in progress not only in the viewport in which you deposited the 
locations, but also in the other two viewports. 

The graphic objects provide the following functionality:
• The Add handle gives you the ability to increase or decrease the 

number of slices.
• The Rotate handles appear at the center of the slice group (one above 

and one below the center of the slice) for oblique prescriptions to give 
you the ability to turn the slice prescriptions.

• The Slice lines allow movement of the prescription by clicking and 
dragging on any area of the slice line other than the handles, to adjust 
the position of the entire graphic prescription.

[Display 
Normal]

Returns the displayed image to its default size and 
location. In other words, it removes the pan and zoom 
factors.

[-] [+] 
(Prior/Next)

Displays the previous or next image in the series from 
the currently displayed image.

Text Box Allows you to enter the image number for the image 
you wish to display.

Phase FOV
Allows you to shorten the scan time by scaling down 
the FOV size in the phase direction. The pulse 
sequence determines the range and increment values.

Freq DIR

Defines the scanning direction associated with the 
frequency encoding gradient. In general, frequency is 
the long axis of the imaging plane. The default 
frequency direction is automatically entered, but you 
can swap frequency and phase directions by changing 
the entry from the predefined list. 

FOV Defines the area of the anatomy selected for imaging. 
The size is indicated in centimeters. 

Slice Thickness Assigns thickness of each slice location in millimeters. 
Spacing Assigns space between the slices.

# Slices
Reports the number of slices prescribed. A value is 
automatically entered in this text box if slice thickness, 
slice spacing, and the start and end locations are 
specified. You cannot manually enter a value.

Selection Description (Continued)
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The selected graphic objects in the active viewport appear blue and the 
unselected graphic objects appear yellow. The graphic objects of a 2D 
prescription are shown in Figure 3-7.

Figure 3-7 2D Graphic Objects

As you add or delete slices, the slice numbers appear or disappear 
accordingly.

NOTE: If your system has a black and white monitor, the graphic objects 
appear white and the active group displays the graphic handles.

Multi-Group Prescription
It is possible to prescribe multiple groups of slice locations, each with a 
unique tilt angle within the same acquisition, on all GE Signa® MRI 
systems. This capability is referred to as Multi-slice, Multi-angle, or MSMA. 
MSMA is available for any 2D Fast Spin Echo (FSE), Spin Echo (SE), and 
multi-planar Gradient Echo (GRE) sequences. This is useful when an entire 
range of slice locations is not desired or needed for a given anatomical 
body part (e.g., axial spine and sagittal TMJ examinations).

Note that dark banding artifacts, commonly known as cross-talk, and low 
SNR tissue contrast changes are likely to occur when MSMA slices 
intersect. The data for multiple groups are generally acquired in an 
interleaved slice acquisition order. For example, two groups of five slice 
locations are prescribed and the slices intersect one another. The first 
group contains image numbers 1 to 5; the second group, 6 to 10. 
Interleaved slice acquisition order results in the image data being gathered 
as slices 1/3/5/7 and 9 gathered first, then the system goes back and 
collects data for 2/4/6/8/ and 10. Collecting the data in this manner results in 
cross-talk where the groups intersect (Figure 3-8). Care should be taken to 
avoid overlapping groups on top of the anatomy of interest. 

NOTE: Sequential GRE and sequential Fast GRE/SPGR sequences do not 
exhibit this cross-talk because the slices are acquired one at a time.
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Figure 3-8 MSMA and Cross-talk

Multi-slice Multi-group (MSMG) means only the slices within an angled 
group are acquired within a single acquisition. Three angled groups of 
slices therefore results in three separate acquisitions. Cross-talk artifacts 
are not seen with MSMG.

When using a Fast Spin Echo (FSE) pulse sequence, a user control 
variable (CV) becomes available with the prescription, allowing you to 
choose between MSMA and MSMG. Figure 3-9 illustrates the acquisition 
order options of choosing an interleaved or a sequential group for the 
current acquisition.

Figure 3-9 User CVs Screen for a Multi-Group Prescription

You must define the acquisition order by selecting an Interleaved 
Acquisition or a Sequential Group. Selecting Sequential Group (1) results in 
a MSMA acquisition and selecting Interleaved (0) results in a MSMG 
acquisition. Interleaved is the default selection.

MSMA means all prescribed slices are acquired within a single acquisition 
and MSMG means all data is collected for the slices in one group before the 
system goes on to the next group to start a new acquisition. During a 
MSMG acquisition, there is a time interval of one TR period from the end of 
one group acquisition to the start of the next group. This allows spins to 
return to a state of equilibrium, thus reducing the possibility of cross-talk. 
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With MSMA and MSMG prescriptions, the color for the selected group and 
its corresponding intersections is blue and a yellow color represents the 
unselected group and its corresponding intersections. The intersections 
display on all the three viewports for all the groups present. 

When prescribing MSMA or MSMG acquisitions, the group with the largest 
number of slices controls the frequency and phase direction. For example, if 
you are prescribing axial slices through the disc spaces on a Lumbar (L) 
spine examination, you may prescribe three slices through L3-4 and L4-5 
that have a small angle. Then you may prescribe five, very steep angled 
slices through the L5-S1 disc space. The steep angle, passing 45°, makes 
the slices an obliqued-coronal and the frequency direction changes to S/I. 

You may only perform the move, rotate, or add slices operations on one 
group at a time. Any changes within a group reflect in the corresponding 
displayed intersections. One group is always in the selected state. You are 
able to erase a single group after selecting the group and clicking the 
[Erase Group] button.

As you add or delete the slices in a multi-group prescription, the slice 
numbers appear or disappear accordingly with the slices shown. The 
numbers are contiguous across multiple groups.

NOTE: When using MSMA acquisitions, if two slices or groups of slices are 
90° to each other, one of the groups of the resulting images will be 
rotated. The R/L, A/P, and S/I annotations on the images are correct.

Radial Prescription
Radial prescriptions can be prescribed graphically with 3-Plane GRx. This 
allows multiple slices to be acquired around a central axis in the same 
series. Radial and partial radial graphic prescription is available with 
FSE-XL, FRFSE-XL, Single Shot Fast Spin Echo (SSFSE), 
SSFSE-Inversion Recovery (IR), FastCard, FastCINE, and 2D FIESTA 
pulse sequences. This type of prescription can be useful for imaging, but 
not limited to, knees, Magnetic Resonance Cholangiopancreatographies 
(MRCPs), myelograms, and hearts.

When you are prescribing a radial sequence with 3-Plane GRx the GRx 
screen appears with several additional selections, as seen in Figure 3-10 
and defined in Table 3-7.
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Figure 3-10 3-Plane GRx Screen for Radial Prescription

Table 3-7 3-Plane GRx Selections and Descriptions for Radial Prescription

For radial prescriptions, you must define the number of slices and the radial 
direction while prescribing the acquisition. You have to explicitly type the 
number of slices in the # of Slices text box. The intersections accordingly 
display the number of slices in the three viewports. You can enter a different 
number of slices to dynamically change an active prescription. 

The radial prescription has Rotate handles to turn the prescription and the 
slice numbers are displayed as in Figure 3-11. You are also able to move 
and rotate the intersections of the radial prescriptions. The intersections of 

Selection Description

# of Slices
The number of slices prescribed for a radial graphic 
prescription. The maximum allowable is 36. Keep the 
number of slices at the default of one if you do not desire 
to perform a radial prescription.

Radial Dir. Clockwise and counter clockwise directions for radial 
prescription. System defaults to clockwise.

Spacing Controls the angle between slice locations by defining the 
degree of space between each slice.
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the radial prescriptions display as blue bounding boxes (Figure 3-10). You 
are not able to graphically change the number of slices in a radial 
prescription.

Figure 3-11 Radial Graphic Objects

The radial direction can be clockwise or counterclockwise as shown in 
Figure 3-12. The system defaults to one slice and clockwise rotation. These 
settings can be changed.

Figure 3-12 Radial Directions

The maximum number of slices in a single group is determined by the 
selected pulse sequence. The largest number of slices that can be 
prescribed per group is 36 locations. If this limit is exceeded, the system 
does not accept the value. To continue, you must enter a new value with a 
lower number of slices.

The # of Slices and Spacing text boxes control the angle between the 
slices of the radial prescription. For example, if you select 5 slices in the 
Radial Parameters area and leave the Partial Radial Spacing text box 
empty, your graphic prescription looks like a wagon wheel with a 36° angle 
between each slice (Figure 3-13). 
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Figure 3-13 Wagon Wheel Radial Prescription

If you select 5 slices in the Radial Parameters area and 5° of spacing in the 
Partial Radial area, your graphic prescription looks more like cat whiskers 
(Figure 3-14) and there are 5° between each slice location.

Figure 3-14 Cat Whiskers Radial Prescription

You may also prescribe multiple radial groups. Once you have deposited 
the first graphic prescription group, pressing the Shift key and clicking on 
the image allows you to deposit the second group. The new, active radial 
graphic displays blue and the inactive, first group turns yellow. Changing 
the number of slices parameter changes the number of slices in the active 
(blue) group. 

If you are prescribing a FSE-XL radial sequence and the slice ordering is 
interleaved (acquires the maximum number of slices per acquisition,) your 
images may exhibit cross-talk and you do not have the option of choosing 
the number of locations before pause. Selecting Sequential slice ordering 
on the User CVs screen changes the number of slices to equal the number 
of acquisitions with no slice cross-talk. 

After accepting a graphic prescription, you need to enter the number of 
locations before pause in the Acquisition Timing area. The number of 
locations before pause can be of a confusing nature. If you select zero, you 
do not have to push the scan button for every slice (angle), but you may 
have cross talk problems. If you select one, you control the scan, so you 
could let the tissue relax by waiting a few seconds before clicking the 
[Scan] button.
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Since each slice is an angle and each angle is a group, the maximum 
number of locations before pause is always one unless you prescribe an 
oblique group on the same series. For example, if you prescribe a radial 
scan with 4 slices and an oblique group with 8 slices, you could enter 8 in 
the # of Locs Before Pause text box. You would start the scan, the system 
would acquire those 8 slices, then you would hit scan four more times (one 
for each slice) to acquire the radial. The oblique slices in the group (single 
angle) would let you select 4 (or whatever number of locations before 
pause). See the example in Figure 3-15.

Figure 3-15 Multi-group Oblique and Radial Prescription

In addition, there are several factors you should consider when setting the 
locations before pause in radial prescriptions:
• Set the number of locations before pause to zero if all slices are the 

same angle. This allows you to scan all slices in one breath hold. For 
multiple shorter breath holds, type in any number to break up the group.

• Set the number of locations before pause to zero or one for a radial 
prescription. If you select one, the system pauses after each slice and 
you need to click the [Scan] button for each slice. Although zero is 
compatible, it causes cross-talk where the slices intersect.

• Set the locations before pause to the number of slices of the largest 
group when using MSMA. This enables you to scan one group or one 
angle at a time.

Three-Dimensional Prescription
3-Plane GRx is also available in a 3D mode, as shown in Figure 3-16. The 
3D mode excites an entire scan volume or slab with a wide RF pulse. 
Images acquired in 3D mode are spatially encoded in the phase, frequency, 
and slice axes.

Note the Localized Reference Lines (yellow or bright) are turned on in the 
3D prescription in Figure 3-16. This is not automatic, you must click the 
[Loc Ref Lines] button to enable the feature.
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Figure 3-16 3-Plane GRx Screen for 3D Prescriptions

In addition to most of the selections on the 2D 3-Plane GRx screen, the 
following selections in Figure 3-8 are available on the 3-Plane GRx screen 
for 3D prescriptions.

Table 3-8 3-Plane GRx Selections and Descriptions for 3D Prescriptions

Selection Description

[Tracker]
Defines the tracker slice location and thickness in a 
SmartPrep™ acquisition. (Only available with 3D Gradient 
Echo (GRE), Spoiled Gradient Echo (SPGR) or Time of 
Flight (TOF) pulse sequences.

# of Scan 
Locs

Defines the number of scan locations to be acquired in a 
single slab prescription.

Overlap 
Locs

Assigns the number of overlap locations (slices) per slab in 
a multi-slab prescription. (Only available with 3D GRE, 
SPGR, and TOF.

# of Scan 
Locs

Defines the number of locations to be acquired per slab in 
multi-slab prescriptions.

# Slabs Reports the number of slabs prescribed for a multi-slab 
acquisition. 
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In 3D prescription, the box displayed (Figure 3-17) represents the size of 
the imaging volume based on FOV, slice thickness, and number of scan 
locations selected in the scanning range. A selected 3D graphic object in 
the active viewport appears blue, while the unselected graphic objects 
appear yellow.

Figure 3-17 3D Graphic Objects

Oblique 3D has the same operation on the graphic slabs as in the 2D 
oblique mode. The Rotate handle and Add handle for slice prescription are 
available along with a tic mark indicating the center of the volume. 

When the slice range extends to the center of the reference line, the FOV 
size is displayed on the localizer scan plane that is the same as the 
prescribed plane. The graphic box can be picked up by the edges and 
moved. This is a useful tool to verify the anatomy is not outside the phase 
FOV and if it is, then you can move the FOV accordingly. Figure 3-18 is an 
example of a 3D axial prescription. Note the FOV box displayed on the axial 
image. The box does not appear for 2D oblique prescriptions.

Figure 3-18 3D Axial Prescription
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The 3D slice direction is displayed by the “1” and “+” which are displayed in 
the volume. The side to which the “1” is closest is the side of the volume 
that begins with the slice one.

Figure 3-19 Slice Ordering

Prescription A displays the “1” to the left of the “+” indicating the images will 
be acquired left to right. Prescription B displays the “1” to the right of the “+” 
indicating the images will be acquired right to left.

Multi-Slab Prescription
3D Multi-slab acquires multiple, overlapping image volumes, and combines 
overlapping locations from two adjacent slabs. The active slab and its 
intersections appear blue and an unselected slab appears yellow, along 
with its corresponding intersections.

The multi-slab editable text boxes in 3D 3-Plane GRx are shown in Figure 
3-20.

Figure 3-20 3D Multi-Slab Text Boxes
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The purpose of the overlap is to have a prescription of slabs with overlaps 
that result in a continuous series of slices — with no gaps. Remember, any 
3D acquisition has aliased image data on both ends of the slab, which is 
discarded. If this aliased (and discarded) image data is in the overlap area, 
the scan prescription should result in a continuous — no gap, set of slices.

With 3D multi-slab TOF acquisitions, if no overlap is prescribed between 
adjacent slabs, a substantial inter-slab boundary artifact (venetian blind) is 
created due to the decrease in blood-background signal to noise. An 
overlap of 25% is recommended, with uniform flip angle excitations, to 
minimize the artifact.

When the overlap locations are positioned over the center reference line, 
the slices perpendicular to the prescribed plane display the graphic volume 
with a grid like appearance (Figure 3-21).

Figure 3-21 3D Multi-Slab Overlap

The shading in Figure 3-21 is to help you visualize anatomy that is 
overlapped on a multi-slab prescription. Note the grid like appearance of the 
slab on the sagittal image. This is due to the overlap area being placed over 
the sagittal reference line on the coronal localizer image. If you move the 
overlap area away from the sagittal reference line and the slab on the 
sagittal loses the grid like appearance.

Tracker Prescription 
In 3-Plane GRx, you are able to deposit a Tracker prescription for 3D Fast 
TOF or 3D Fast GRE pulse sequences. The Tracker Rx screen (Figure 
3-22) is accessed by clicking the [Tracker] button on the 3D 3-Plane GRx 
screen. You are only able to view and manipulate the tracker on the image 
which you initially deposit it. 
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Figure 3-22 3-Plane GRx Screen for a Tracker Prescription

In addition to several of the selections available on the 3D 3-Plane GRx 
screen, Table 3-9 lists the other selections and their descriptions that 
become available when prescribing your tracker volume. 

Table 3-9 3-Plane GRx Selections and Descriptions for Tracker Prescription

The Tracker prescription, as shown in Figure 3-23, has two Rotate handles. 
One handle is above the prescription and one is below the prescription. The 
middle cross hair represents the thickness of the tracker and the length is 
represented by the size of the line.

Selection Description
Tracker Length 
(mm) Defines the length of the tracker in millimeters.

Tracker Thickness 
(mm) Defines the thickness of the tracker in millimeters. 

[Accept] Accepts the Tracker prescription and brings you 
back to the 3-Plane GRx screen. 
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Figure 3-23 Tracker Graphic Objects

You can use the Rotate handles to turn the Tracker prescription to angle 
with your vessel of interest. You can move the location of the Tracker 
prescription by clicking the prescription and dragging it. 

The length of the Tracker prescription can be adjusted by entering a value 
in the Tracker Length (mm) text box in millimeters or by selecting the value 
from the drop down list provided. You can also change the thickness of the 
Tracker prescription by entering a value or selecting the value from the drop 
down list in the Tracker Thickness (mm) text box.

SAT Prescriptions
You can graphically prescribe SAT pulses on a localizer image from a valid 
series within the current exam. A valid series is any prospective orthogonal 
or oblique series with the same landmark. 

The SAT icon in the Additional Parameters area (Figure 3-24) becomes 
available after you acquire a valid series and if the series you are 
prescribing supports SAT bands.

Figure 3-24 SAT Additional Parameter

Upon clicking the SAT icon, the 3-Plane SAT screen (Figure 3-25) opens 
and displays with the default images in the viewports. Alternatively, you can 
access the SAT mode by clicking the SAT icon on the 3-Plane GRx screen. 
3-24  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Prescribing Images
Figure 3-25 3-Plane SAT Screen

In addition to the selections on the 3-Plane GRx screen, Table 3-10 
provides you with the selections that become available on the 3-Plane SAT 
screen.

Table 3-10 Selections Unique to the 3-Plane SAT Screen and Descriptions

Selection Description

S, I, A, P, L, R Defines a SAT pulse in the direction of the selected 
plane.

Location

Defines the location of the leading edge of the SAT 
pulse. Leave this text box blank for default positioning of 
SAT outside FOV or adjacent to the first or last slice. A 
positive or negative numerical value is entered here to 
explicitly prescribe the SAT location.

Thickness
Defines the thickness/width of the SAT band. The default 
thickness is defined by the PSD and in most cases is 80 
mm. Enter a value from 10 to 200 in steps of 1.

Graphic Rx 
icon

Opens the 3-Plane GRx screen. The currently prescribed 
saturation bands are automatically accepted.
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Clicking the directional buttons (S, I, A, P, R, L) allow you to prescribe SAT 
bands on any of the 3 localizer images. You are able to drop up to six SAT 
bands at one time. The intersections of the SAT bands display on the other 
2 viewports.

The SAT bands display as rectangular dotted areas representing thickness 
and location. The SAT localizer images can be changed to prescribe SAT 
bands on various planes. You are able to move, size, and rotate the SAT 
bands on all the three viewports. A selected SAT band appears red and an 
unselected SAT band is yellow.

NOTE: If your system has a black and white monitor, the SAT bands appear 
white and the active band displays the handles.

There are two Rotate handles on the leading edge of the SAT band, one on 
each side of the center of the SAT band. A Thickness handle for changing 
the width of the band is also provided. You can change the bands location 
by clicking anywhere on it, except for the handles, and dragging it. These 
objects are shown in Figure 3-26. 

[Copy Rx]

Copies SAT prescriptions for a previously prescribed 
series to current series. All SAT selections must be 
deselected to use copy Rx. Select the desired series and 
click the [Accept] button or double-click the series. The 
SAT bands copy to and appear on the currently 
displayed images. 

[Concat 
SAT]

Enables "walking SAT" for slice-select direction SAT 
pulses in concatenated acquisitions. Only valid with 
orthogonal images, parallel slices, and multi-acquisitions.

Fat Suppresses fat using spectral or chemical saturation 
pulses. Center Frequency must be set to Water. 

Water To suppress water using spectral or chemical saturation 
pulses. Center Frequency must be set to FAT. 

Tag Type
Allows selection of stripe or grid spatial SAT tags to 
obtain cardiac images sensitive to tissue motion. Only 
available with FastCINE GRE pulse sequences.

Tag Spacing Sets the distance of pixel spacing between the tag 
bands.

[Accept] Registers SAT prescription and exits 3-Plane SAT.

Selection Description (Continued)
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Figure 3-26 SAT Objects

Not all six SAT bands are visible on one viewport. Table 3-11 provides the 
SAT bands you can see on the different planes of localized images.

Table 3-11 Visible SAT Bands for Localizers

You are able to drop all six bands on different localizers based on the 
validity of the SAT bands for that localizer. For example, you may drop S 
and I bands on the sagittal localizer, A and P bands on the axial localizer, 
and R and L bands on the coronal localizer. The intersections for all of the 
bands display on the other viewports.

Once you deposit the band, you cannot drop the same type of band again in 
any of the other viewports. For example, if you drop an S band on the 
sagittal localizer, you cannot drop an S band again in any of the other 
localizers.

You can change the thickness of any band you deposit by dragging the 
Thickness handle provided on the SAT band or by explicitly typing the 
thickness value in the Thickness text box provided in the SAT screen. The 
change in the thickness of one SAT band changes the thickness in its 
corresponding intersections also.

The SAT pulse default location and thickness value change based on the 
pulse sequence selected. Generally, the thickness for Spatial SAT pulses 
default to 80 mm in all directions if a complimentary band does not currently 
exist. A complimentary band is a band opposite the selected band. For 
example, and inferior SAT band is complimentary to a superior SAT band. If 

SAT Bands Localizer Plane
A, P, R, L Axial 

S, I, A, P Sagittal

S, I, R, L Coronal

S, I, A, P, R, L Oblique
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a complimentary band exists, then the thickness of the band equals the 
thickness of the complimentary pair band. Default location for most Spatial 
SAT pulses are 30 mm away from the last slice, abutting the FOV in phase 
and frequency directions. 

SAT bands may be prescribed inside or outside the scanning volume. SAT 
locations entered state the leading edge of the SAT pulse as shown in 
Figure 3-27.

Figure 3-27 SAT Band Leading Edges

The SAT icon, located in the Additional Parameters area, updates after you 
accept the prescription. It indicates the SAT pulses applied within the 
current series. For example, Figure 3-28 indicates the series prescription 
includes fat SAT, as well as an S and I SAT band.

Figure 3-28 SAT Icon with Applied Pulses

The icon only indicates if SAT has been turned on at its default value or if 
the SAT pulse location/thickness has been altered. It does not indicate the 
actual thickness or location. To view the thickness and location of SAT 
pulses, enter the SAT screen. Several examples of the SAT icon labels are 
listed below.
• Spatial SAT pulses applied at the default location and thickness are 

shown in upper case letters beneath the SAT icon, e.g., S, I.
• Spatial SAT pulses applied with a change to their thickness or location 

are shown in lower case letters, e.g., s. i.
• If Fat or Water suppression has been selected, the selection is indicated 

as FAT or WATER.
• If no SAT selections are made, the icon label reads, "SAT". 
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Disabling the direction button (S, I, A, P, R, L) deletes the corresponding 
band and its intersections from all the viewports. For example, if you click 
the [S] direction button and then click the sagittal localizer, an S band 
copies to the sagittal and coronal localizers. If you again click the [S] 
direction button (disabling), the S band that was copied to the sagittal and 
coronal localizers erases.

3-Plane Graphic Functions
There are various graphic functions that can be performed on a selected 
viewport or all three of the viewports. You can individually selected a 
viewport by clicking in that viewport. When a viewport is individually 
selected, it has a green colored or bright border.

Report Cursor
A report of the location of the cursor can be defined by selecting the 
[Report Cursor] button. The button toggles the location report on and off. 
When on, a yellow crosshair cursor is reported on all localizer images and 
the RAS coordinates are displayed in red at the bottom-right corner of each 
viewport. You are able to modify the prescriptions even in the presence of 
the Report Cursor.

Zoom
You are able to zoom all the three localizer images with the Zoom slider 
(Figure 3-29). The range of zoom factor is from 0.5 to 8.0. The images 
default at a zoom factor of 1.0, i.e., no zoom.

Figure 3-29 Zoom Slider

Zoom applies for all the three localizer images with the Auto Update [Zoom] 
button (Figure 3-30) enabled. If the Auto Update [Zoom] button is disabled, 
the zoom applies only to the currently selected image. 

Figure 3-30 Auto Update Area
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The zoom option functions with or without prescriptions in the viewport. You 
are able to page through the image sets either by clicking the [+] and [-] 
buttons or by selecting an image and the previous Zoom value will be 
retained. Clicking the [Display Normal] button removes the zoom factor.

Display Normal
The [Display Normal] button brings the zoomed image to a default zoom 
factor of 1.0, removes the pan factor, and displays the default W/L settings. 
This action applies to all the three viewports if Auto Update [Zoom] button 
is enabled. 

Window Width and Level
Turning on the Keep W/L feature, keeps the selected W/L for the active 
viewport. The W/L remains at the Keep W/L values as you click the [+] and 
[-] buttons to view other images within the selected viewport. If Keep W/L is 
not on, then as you click the [+] and [-] buttons to view other images within 
the selected viewport, the W/L reverts to the auto W/L values.

You are also able to change the window width and window level on 
Viewports 1, 2, and 3 by middle-clicking and dragging on the image. The 
change in window width and level applies on all the 3 localizer images if the 
Auto Update [W/L] button is enabled. During window leveling, the cursor 
appears as a windowing cursor.

If the Auto Update [W/L] button is disabled, then the window leveling 
applies only on the image on which the action is being done.

Pan
You are able to move (pan the image) using the right mouse button. The 
panning action applies on all the three viewports if the Auto Update [Pan] 
button is enabled. If the Auto Update [Pan] button is disabled, then the 
movement applies only on the image on which the action is being done. You 
are able to page through the image sets either by clicking the [+] and [-] 
buttons or by selecting an image and the previous Pan value will be 
retained. Clicking the [Display Normal] button removes the pan factor. 

Reference Lines
Reference Lines are displayed on all of the viewports based on the 
intersections made by that localizer image with the other two localizer 
images by enabling the [Loc Ref Lines] button. The localized reference 
lines appear as a yellow color line, exactly at the localizers' intersection. 
You are not be able to make any operations, such as moving or rotating the 
localized reference lines.
3-30  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Prescribing Images
Copy Rx 
Copy Rx is used to copy the graphic prescription from a previous series to 
the current series, provided the current prescription has the same patient 
position, patient entry, landmark, mode, FOV, slice thickness, spacing, and 
appropriate scan plane. 

Copy Rx opens a series list and displays all of the prescriptions which 
match the localizer image on the selected viewport. Double-clicking 
automatically changes the displayed image to the image used to prescribe 
the original series and displays the slice locations. If there are no series 
meeting the copy requirements, the list of series does not appear and a 
message posts in the Advisory panel after clicking the [Copy Rx] button to 
inform you of no matching prescriptions.

Fallback to R0
Fallback to R0 moves the slice centers from their graphically prescribed 
position to isocenter, along the localizer slice-select direction. This can be in 
either the phase or the frequency direction.

Changes to the graphic prescription are not readily noticed, but the resulting 
images fall back to isocenter in the slice-select direction for sagittals and 
coronals. The fallback occurs only in the slice-select direction of the 
localizer and the imaging plane determines the phase and frequency 
direction.

Make sure the FOV is large enough to include the anatomy of interest when 
the FOV falls back. Of course, as FOV increases, resolution decreases. 
The system does not prevent you from scanning any FOV with an offset.

If you use the fallback feature on a collapsed or projection image, the 
fallback occurs in the acquisition plane. For example, if you select Fallback 
to R0 on a sagittal projection image from an axial 2DTOF, the FOV falls 
back to S/I. To adjust the L/R offset of the image, use one of the axial 
source images.

Reset Center
The Reset Center option allows you to graphically prescribe your locations 
on one slice location and redefine a new center image at another slice 
location.

Redefining the center image can be useful when prescribing axial orbits or 
shoulder images. For example, use a sagittal image where you see the 
optic nerves to prescribe the slice locations, then move to the center of the 
image and select the [Reset Center] button.
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How Do I...
This section provides the step-by-step instructions for prescribing images. 
Specifically, it describes how to:
• Prescribe 2D graphic locations

– Single and multi-group locations
– Radial locations

• Prescribe 3D graphic locations
– Single and multi-slab locations
– Tracker location

• Prescribe SAT locations
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Define the Scanning Range Prescribe 2D Graphic Locations 
Single and Multi-Group Locations
3-Plane GRx allows you to define the scan locations on a 
localizer image using the same landmark while viewing the 
exact locations on three different image planes simultaneously. 
Either orthogonal or oblique imaging can be used. 

Use this procedure to guide you through the process of 
graphically prescribing the scanning range for 2D prescriptions.

1. Enter the Scanning Range parameters.

Choose one of the system pre-defined values or enter 
your own value in the text box. Use the scroll arrows to 
increase or decrease the selected value.

a) Enter the FOV in centimeters. 

– Cover the area of anatomy selected for imaging. 
Anatomy outside the FOV in the phase direction 
results in aliasing.

b) Enter the slice thickness in millimeters.

c) Enter the slice spacing in millimeters. 

– Select a spacing that reduces cross-talk. This is 
typically 20% of the slice thickness. Cross-talk or 
overlap is caused by partial excitation of adjacent 
slices during RF excitation and refocusing by a 180° 
pulse. This causes a reduction in image contrast and 
SNR.

– To reduce the effects of cross-talk choose Interleave 
(doubles scan time), a larger interscan spacing, or 
change to a 3D technique.

2. Click the Graphic Rx icon.

Displays the 3-Plane GRx screen with the system 
selected default images loaded in the three viewports.

Quick Steps: Prescribe 2D 
Single and Multi-Group 
Locations
1. Enter the Scanning Range 

parameters. 
2. Click the Graphic Rx icon.
3. Select the image desired 

for the localizer.
4. Click [Copy] if you desire 

to copy a prescription from 
a previous series that was 
scanned in the same 
plane, mode, FOV, slice 
thickness and spacing.

5. Magnify the image using 
the Zoom slider, if 
necessary.

6. Press the Shift key and 
click in desired viewport to 
deposit the start location.

7. Click the Add handle and 
drag the cursor to the 
desired end location and 
release.

8. Rotate and center the 
slices, as needed.

9. Press the Shift key and 
click image to add another 
group to the prescription. 
Repeat steps 6 to 8 as 
necessary.

10. Enter new values in the 
corresponding text boxes 
to adjust the FOV, spacing, 
slice thickness, and phase 
FOV, if necessary.
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Click the Graphic Rx icon. 3. Select the image desired for the localizer.

a) If necessary, click [Select Series] to choose a different 
series to be used as a localizer. 

b) Select a series from the list.

c) Click [OK]. 
– Alternatively, you may click [-] and [+] to review the 

previous or next image in the series and select the 
desired image or type the desired image number in 
the text box. 

4. Click [Copy] if you desire to copy a prescription from a 
previous series that was scanned in the same plane, mode, 
FOV, slice thickness, and spacing.

a) Select the series from the 3-Plane GRx Series List.

b) Click [Accept] in the copy window.

c) Skip to step 10.

5. Magnify the image using the Zoom slider, if necessary.

Enabling Auto Update: Zoom applies the magnification 
to all three viewports.

6. Press the Shift key and click in desired viewport to deposit 
the start location.

Click the graphic line anywhere except on either the 
Rotate or Add handles and drag it to the desired start 
location.

Defines the start location.

The start graphic line appears on the image and displays 
on the corresponding intersections in the other 
viewports.

7. Click the Add handle and drag the cursor to the desired end 
location and release.

Defines the end locations.

Updates the corresponding intersections in the other 
viewports.

Quick Steps: Prescribe 2D 
Single and Multi-Group 
Locations cont.
12. Adjust the number of 

slices, rotation, and start 
and end locations in any 
of the three viewports.

13. If necessary, move to 
desired center location 
and click [Reset Center].

14. Click [Accept].
15. Note the start, end, and 

center locations and 
number of slices.
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8. Rotate and center the slices, as needed.

Click the Rotate handles, at the center of the slice group, 
to turn oblique slice prescriptions.

Click and drag on any area of the slice line, other than 
the handles, to adjust the position of the entire graphic 
prescription.

9. Press the Shift key and click image to add another group to 
the prescription. Repeat steps 6 to 8 as necessary.

10. Enter new values in the corresponding text boxes to adjust 
the FOV, spacing, slice thickness, and phase FOV, if 
necessary.

This changes the FOV, spacing, and thickness for all 
slice groups.

11. Adjust the number of slices, rotation, and start and end 
locations in any of the three viewports.

a) Click the Add handle to add or remove slices on the 
prescription.

b) Click the Rotate handle at the center of the slice group 
for oblique prescriptions to adjust the tilt angle. 

c) Click and drag on any area of the Slice lines other than 
the handles to adjust the entire prescription.

12. If necessary, move to desired center location and click 
[Reset Center].

Resets the center to the active viewport’s location.

13. Click [Accept]. 
Accepts the graphic prescription, closes the 3-Plane GRx 
screen, and allows you to continue with series 
prescription and acquisition. 

Once you have accepted the prescription, you cannot 
make additional changes to the scanning range.

When you have prescribed multiple slices with multiple 
angles and you want all of the slices within each group to 
be acquired within a breath hold, enter the number of 
slices that comprises the largest group of slices as the 
locations before pause value. Entering a number less 
than this can result in more breath hold acquisitions.
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14. Note the start, end, and center locations and number of 
slices.

Numeric values for the start/end locations, FOV center, 
and the number of slices prescribed, appear in the Scan 
Location text boxes in the Scanning Range area.

2D Scan Locations
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Radial GraphicallyPrescribe 2D Graphic Locations
Radial Locations
Radial prescriptions enable you to acquire multiple slices 
around a central axis in the same series. You can graphically 
prescribe radial locations and view their exact locations on 
three different image planes simultaneously. A radial or partial 
radial prescription can be useful for imaging, but not limited to, 
knees, MRCPs, myelograms, and hearts. 

Use this procedure to guide you through the process of 
graphically prescribing a radial sequence.

1. Click [New Series].
Located in the Rx Manager.

2. Enter the Imaging Parameters.

2D Image Mode

Oblique Image Plane

FSE-XL, FRFSE-XL, SSFSE, SSFSE-IR, FastCard, 
FastCINE, or 2D FIESTA Pulse Sequence

3. Click the Graphic Rx icon.

Displays the 3-Plane GRx screen with the system 
selected default images loaded in the three viewports.

4. Select the image desired for the localizer.

a) If necessary, click [Select Series] to choose a different 
series to be used as a localizer. 

b) Select a series from the list.

c) Click [OK]. 
d) Alternatively, you may click [-] and [+] to review the 

previous or next image in the series and select the 
desired image or type the desired image number in the 
text box.

5. Select the radial direction.

The radial direction can be clockwise or 
counterclockwise.

The system defaults to clockwise rotation. 

Quick Steps: Prescribe 
Radial Locations
1. Click [New Series].
2. Enter the Imaging 

Parameters.
3. Click the Graphic Rx icon.
4. Select the image desired 

for the localizer.
5. Select the radial direction.
6. Enter a value in the # of 

Slices and press the Enter 
key.

7. Enter a value in the Partial 
Radial Spacing text box 
and press the Enter key, if 
necessary.

8. Press the Shift key and 
click one of the images in 
3-Plane GRx.

9. Adjust the radial 
prescription.

10. Press the Shift key and 
click image to add another 
group to the prescription. 
Repeat as necessary.

11. Click [Accept].
2333956-100 Rev. 0 (06/02)  3-37
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
6. Enter a value in the # of Slices text box and press the 
Enter key.

Controls the number of slices in the radial prescription.

The maximum number of slices in a single group is 
determined by the pulse sequence. If this limit is 
exceeded, the system does not accept the value. Enter a 
new value with a lower number of slices.

7. Enter a value in the Partial Radial Spacing text box and 
press the Enter key, if necessary.

For a radial graphic prescription that looks like a wagon 
wheel, enter a value in the # of Slices text box and leave 
the Spacing text box empty.

For a partial radial prescription that looks like cat 
whiskers, enter a value in the # of Slices text box and 
the degree of the angle between the slices in the 
Spacing text box.

8. Press the Shift key and click one of the images in 3-Plane 
GRx.

Radial graphics appear on the image and display the 
corresponding intersections in other viewports.

If you "draw" the slices using the cursor, you are not able 
to get the angles.
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9. Adjust the radial prescription.

a) Place the cursor in the center of the prescription and 
drag entire prescription to the desired location on image.

b) Click the Rotate handle and turn the prescription to the 
desired starting slice number.

10. Press the Shift key and click image to add another group to 
the prescription. Repeat as necessary.

The new, active radial graphic displays blue and the first, 
inactive group appears yellow.

Changing the number of slices parameter changes the 
number of slices in the active (blue) group.

11. Click [Accept].
Accepts the radial prescription, closes the 3-Plane GRx 
screen, and allows you to continue with series 
prescription and acquisition.

When you have prescribed multiple slices with multiple 
angles and you want all of the slices within each group to 
be acquired within a breath hold, enter the number of 
slices that comprises the largest group of slices as the 
locations before pause value. Entering a number less 
than this can result in more breath hold acquisitions.

NOTE: Refer to Radial Prescription in the What Do I Need to 
Know About... section of this guide for detailed 
information on setting the number of locations before 
pause during scanning.
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Prescribe 3D Graphic Locations
Single and Multi-Slab Locations
Use 3-Plane GRx to graphically define 3D volume locations on 
a localizer image using the same landmark while viewing their 
exact locations on three different image planes simultaneously. 
Either orthogonal or oblique imaging can be used. 

Use this procedure to guide you through the process of 
graphically prescribing the scanning range for 3D prescriptions.

1. Enter the Scanning Range parameters.

Choose one of the system pre-defined values or enter 
your own value in the text box. Use the scroll arrows to 
increase or decrease the selected value.

a) Enter the FOV in centimeters. 

– Cover the area of anatomy selected for imaging. 
Anatomy outside the FOV in the phase direction 
results in aliasing.

b) Enter the slice thickness in millimeters.

c) Enter the number slices millimeters. 

– Each 3D group is able to overlap on another group for 
a multi group prescription. Enter the number of slices 
that you want to overlap between slabs within the 
same group to acquire a continuous series of slices—
with no gaps. 

– An overlap of 25% is recommended, with uniform flip 
angle excitations, to minimize the venetian blind 
artifact on multi-slab 3D TOF acquisitions.

d) Enter the number of scan locations per slab.

– This defines how many slices are in each volume.

2. Click the Graphic Rx icon. 

Displays the 3-Plane GRx screen with the system 
selected default images loaded in the three viewports.

Quick Steps: Prescribe 3D 
Single and Multi-Slab 
Locations
1. Enter the Scanning 

Range parameters. 

2. Click the Graphic Rx 
icon.

3. Select the image desired 
for the localizer.

4. Click [Copy] if you desire 
to copy a prescription 
from a previous series 
that was scanned in the 
same plane, FOV, slice 
thickness, and spacing.

5. Magnify the image using 
the Zoom slider, if 
necessary.

6. Press the Shift key and 
click image in the desired 
viewport to deposit slab.

7. Click and drag the Add 
handle to display the “1” 
and “+” orientation for the 
desired slice direction 
order.

8. Enter new values in the 
corresponding text boxes 
to adjust the number of 
slabs, FOV, slice 
thickness, overlap 
locations, number of 
locations per slab, and 
phase FOV, if necessary.

9. Create multiple groups, if 
needed, and position the 
3D volume.
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3. Select the image desired for the localizer.

a) If necessary, click [Select Series] to choose a different 
series to be used as a localizer. 

b) Select a series from the list.

c) Click [OK]. 
d) Alternatively, you may click [-] or [+] to review the 

previous or next image in the series and select the 
desired image or type the desired image number in the 
text box.

4. Click [Copy] if you desire to copy a prescription from a 
previous series that was scanned in the same plane, FOV, 
slice thickness, and spacing.

a) Select the series from the list.

b) Click [Accept] in the Copy window.

c) Skip to step 10.

5. Magnify the image using the Zoom slider, if necessary.

Enabling Auto Update: Zoom applies the magnification to 
all three viewports.

6. Press the Shift key and click image in the desired viewport 
to deposit slab.

Deposits a box representing the size of the imaging 
volume based on FOV, slice thickness, and number of 
scan locations selected.

Displays the corresponding intersections in the other 
viewports.

7. Click and drag the Add handle to display the “1” and “+” 
orientation for the desired slice direction order.

Displays the relationship of the 3D slice direction in the 
center of the volume. The side to which the “1” is closest 
is the side of the volume that begins with slice one.

For A, S, C, you need to drag the Add handle across to 
the opposite side of the volume.

8. Enter new values in the corresponding text boxes to adjust 
the number of slabs, FOV, slice thickness, overlap 
locations, number of locations per slab, and phase FOV, if 
necessary.

Quick Steps: Prescribe 3D 
Single and Multi-Slab 
Locations cont.
10. If necessary, move to 

desired center location 
and click [Reset Center].

11. Click [Accept].
12. Note the start, end, and 

center locations and the 
number of slabs.
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9. Create multiple groups, if needed, and position the 3D 
volume.

a) Click the Add handle to add or remove slabs on the 
volume prescription.

b) Click the Rotate handle on the volume for oblique 
prescriptions to adjust the tilt angle. 

c) Click and drag on any area of the box other than the 
handles to move the entire prescription.

10. If necessary, move to desired center location and click 
[Reset Center].

Redefines a new center image at another center location 
than where you graphically prescribed your locations. 

11. Click [Accept]. 
Accepts the graphic prescription, closes the 3-Plane GRx 
screen, and allows you to continue with series 
prescription and acquisition.

12. Note the start, end, and center locations and the number of 
slabs.

Numeric values for the start/end locations, FOV center, 
and the number of slabs prescribed, appear in the Scan 
Location text boxes in the Scanning Range area.

3D Scan Locations
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Prescribe 3D Graphic Locations
Tracker Location
3-Plane GRx allows you to access the Tracker Rx screen to 
deposit a tracker prescription and view its exact locations on the 
image viewport within which you initially deposit it. Either 
orthogonal or oblique imaging can be used. The 3-Plane GRx 
and the tracker prescription display together in the Tracker 
mode and both prescriptions can be manipulated.

Use this procedure to guide you through the process of 
graphically prescribing a tracker for 3D Fast GRE or Fast TOF 
GRE/SPGR pulse sequences with SmartPrep prescriptions 
after prescribing your 3D volume in the 3-Plane GRx screen.

The tracker is only enabled if the SmartPrep option key is 
present and you have selected the SmartPrep Imaging Option.

1. Click [Tracker].
Located on the 3-Plane GRx screen for 3D prescriptions.

Allows you to monitor a selected region of interest for the 
arrival of a contrast bolus.

2. Press the Shift key and click an image in any of the three 
viewports.

Deposits the tracker volume in the viewport you click.

3. Angle and move the tracker to the desired position over the 
main vessel.

Tracker placement should be no farther than ¼ above or 
below the center of the FOV to be scanned and should 
be completely contained within the vessel of interest.

a) Turn the Rotate handles to angle the tracker prescription 
with your vessel of interest. 

b) Click and drag the tracker prescription to move its 
location.

Quick Steps: Prescribe 
Tracker Location
1. Click [Tracker].
2. Press the Shift key and 

click an image in any of 
the three viewports.

3. Angle and move the 
tracker to the desired 
position over the main 
vessel.

4. Resize the tracker 
volume.

5. Reposition the 3D volume 
prescription, if necessary.

6. Click [Accept].
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4. Resize the tracker volume.

Recommended typical tracker size is a 20x20x20 mm 
volume to help minimize tracker movement.

a) Enter a value in the Tracker Length text box in 
millimeters.

– Tracker length is represented by the size of the line.

b) Enter a value in the Tracker Thickness text box in 
millimeters. 

– Tracker thickness is represented by the middle cross 
hair.

5. Reposition the 3D volume prescription, if necessary.

6. Click [Accept].
Accepts the Tracker prescription, closes the Tracker Rx 
screen, brings you back to the 3-Plane GRx screen and 
allows you to continue with series prescription and 
acquisition.
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Define Saturation BandsPrescribe SAT Locations
Use the following procedure to define SAT bands on your 
images. 3-Plane SAT allows you to graphically prescribe SAT 
bands on an image from a series within the current exam while 
viewing your GRx in three different image planes. This option is 
also used for prescribing a concatenated SAT or prescribing a 
chemical saturation technique. 

Use this procedure to guide you through the process of 
prescribing SAT locations during scanning.

1. Click the SAT icon. 

Located in the Additional Parameters area or on the 
3-Plane GRx screen.

Displays the SAT screen with any 3-Plane GRx locations 
that may have been deposited.

2. Select the image desired for the localizer.

a) If necessary, click [Select Series] to choose a different 
series to be used as a localizer. 

b) Select a series from the list.

c) Click [OK]. 
d) Alternatively, you may also click [-] and [+] to review the 

previous or next image in the series and select the 
desired image.

3. Click [Copy] if you desire to copy a SAT prescription from a 
previous series and all SATs are deselected from the current 
prescription.

a) Select the series from the list.

b) Click [Accept] in the Copy window.

c) Skip to step 9.

4. Magnify the image using the Zoom slider, if necessary.

Enabling Auto Update: Zoom applies the magnification 
to all three viewports.

Quick Steps: Prescribe 
SAT Locations
1. Click the SAT icon.

2. Select the image desired 
for the localizer.

3. Click [Copy] if you desire 
to copy a SAT 
prescription from a 
previous series and all 
SATs are deselected from 
the current prescription.

4. Magnify the image using 
the Zoom slider, if 
necessary.

5. Prescribe the desired 
spatial saturation bands.

6. Resize and move the SAT 
band to its desired 
location.

7. Prescribe the desired 
concatenated spatial 
saturation, if necessary.

8. Prescribe the desired 
chemical saturation, if 
necessary.

9. Click [Accept].
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5. Prescribe the desired spatial saturation bands.

You are able to drop up to six SAT bands at one time on 
any of the three viewports if the pulse sequence supports 
it.

The intersections of the SAT bands display on the other 
2 viewports.

The default SAT thickness is 80 mm for most sequences.

If you do not enter any value in the location text box, the 
SAT band is placed at the edge of the FOV.

a) Click [S], [I], [A], [P], [R], or [L] to prescribe directional 
spatial SAT bands. 

b) Accept the default thickness and location or enter a value 
for thickness and location.

– Alternatively, position the cursor on the image at the 
desired location for the inside edge of the saturation 
band, press the Shift key and click.

6. Resize and move the SAT band to its desired location.

a) Click and drag the Thickness handle to change the width 
of the band or type in a value in the Thickness text box.

b) Click and drag the Rotate handles on the leading edge of 
the SAT band to turn it.

c) Click and drag either edge of the SAT band to change its 
location. Do not click on the Rotate or Thickness handles 
to move it.

7. Prescribe the desired concatenated spatial saturation, if 
necessary.

Two concatenated saturation pulses can be placed 
parallel to the acquisition slice when used with a 
sequential series, or with an orthogonal series with two 
acquisitions.

a) Click saturation bands in the slice direction.

b) Click [Concat SAT].
– Do not change the thickness or location of the band.

8. Prescribe the desired chemical saturation, if necessary.

a) Select Fat.
b) Select Water.
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9. Click [Accept].
Accepts the SAT prescription, closes the 3-Plane SAT 
screen, and allows you to continue with series 
prescription and acquisition.
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Chapter 4
Fast Spin Echo Pulse

Sequences

Introduction 
There are several new additions and improvements made to the Fast Spin Echo 
(FSE) family of pulse sequences. These new modifications improve image quality 
by increasing image contrast and image signal or by decreasing overall scan 
times. 

The following pulse sequences are new or enhanced modifications of existing 
pulse sequences:
• Fast Spin Echo (FSE)
• T2 Fluid Attenuated Inversion Recovery (FLAIR)
• T1 Fluid Attenuated Inversion Recovery (FLAIR)
• Single Shot Fast Spin Echo-Excel (SSFSE-XL)
• Three-dimensional (3D) Fast Recovery Fast Spin Echo-Excel (FRFSE-XL)

This chapter explains the step-by-step instructions to help you learn how to:
• Activate Dynamic R1
• Prescribe a 3D FRFSE-XL Breath-Hold Sequence
• Prescribe a 3D FRFSE-XL Sequence with Respiratory Gating/Triggering

NOTE: This chapter includes new features or enhancements to FSE sequences. 
Refer to Volume 2 of the Signa® Infinity with Signa Select™ (ASP2) 
Learning and Reference Guide (direction #2292262-100) for additional 
FSE pulse sequences.
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In addition, this chapter answers the following questions:

1. What is Dynamic R1?

2. What is Blurring Cancellation?

3. When would I use the Classic Imaging Option?

4. How do I activate a T2 Flair pulse sequence?

5. What is SSFSE-XL?

6. What is 3D FRFSE-XL?
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What Do I Need to Know 
About...
This section presents the concepts necessary to understand FSE pulse 
sequences. Specifically, you need to understand:
• FSE Scan Parameters

– Dynamic R1
– Blurring Cancellation
– Classic Imaging Option

• T2 FLAIR
– Associated Imaging Options

• T1 FLAIR
– Associated Imaging Options

• SSFSE-XL
– Scan Parameters
– Associated Imaging Options
– Applications

• 3D FRFSE-XL
– Scan Parameters
– Associated Imaging Options
– Applications
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FSE Scan Parameters
There are several enhancements to the scanning parameters of specific 
FSE pulse sequences:
• Dynamic R1 with 3D FSE
• Blurring Cancellation and FSE-XL with FSEOPT or FRFSE-XL
• Classic Imaging Option with FRFSE-XL or FSEOPT

Dynamic R1
Dynamic R1 is an adaptation to the 3D FSE pulse sequence. It is designed 
to increase the signal-to-noise ratio (SNR) for large field of views (FOV). In 
a 3D FSE sequence, the analog receiver gain is typically set to adequately 
digitize the signal at the center of K-space, leaving the signal at the edge of 
K-space subject to digitalization noise. With Dynamic R1, the receiver 
values increase at the edge of K-space. This reduces digitalization noise 
and produces images with increased SNR. 

The optional Dynamic R1 feature can be used with a 3D FSE pulse 
sequence, if the R1 value is less than 6 after Auto Prescan is completed. 
For optimum SNR results with Dynamic R1, make sure the Receive Gain 
value, R2, is 14 or higher before proceeding to scan.

Blurring Cancellation
There is a User Control Variable (CV), Blurring Cancellation, available with 
Fast Spin Echo-Excel (FSE-XL) or Fast Recovery Fast Spin Echo-Excel 
(FRFSE-XL). It uses a multiple NEX technique to average signals and thus 
reduce ghosting artifacts. While reducing ghost-like artifacts, it may 
increase scan time.

Use FSE-XL with Fast Spin Echo Optimized (FSEOPT) or FRFSE-XL with 
Blurring Cancellation for breath-hold abdominal imaging when a dual 
acquisition is required. It uses a sequential slice ordering technique that can 
result in a fewer mis-registration problems that typically occur with 
interleaved slice ordering.

Blurring Cancellation is most effective when the echo from the center 
K-space phase encoding represents the middle of the echo train. It has 
minimum effect when the center K-space echo represents the beginning or 
end of the echo train. Therefore, select an odd ETL value and make the 
effective TE the mid-point between the shortest and the longest echo. For 
example, if you are prescribing a 3 ETL acquisition with a minimum TE of 
15 ms (the echo space), then program the effective TE to 30 ms (30 is the 
midpoint between echoes 15, 30, and 45).
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Blurring Cancellation is never compatible with 0.5 NEX. Blurring 
Cancellation and NPW are only compatible with even NEX. 

Blurring Cancellation is accessed by selecting the FSE-XL pulse sequence 
and typing in FSEOPT in the PSD Name text box or selecting FRFSE-XL 
from the Pulse Sequence window. 

Use Table 4-1 for instructions on obtaining Blurring Cancellation for FSE, 
FRFSE, and IR pulse sequences.

Table 4-1 Blurring Cancellation PSD Selections

Classic Imaging Option
The Classic Imaging Option with either the FRFSE-XL or FSE with FSE 
OPT pulse sequences can be used to potentially reduce image artifacts in 
the spine or pelvis. This imaging artifact is created when phase and 
frequency are swapped. Classic (not to be confused with Classic Fat SAT) 
derives its name from the original implementation of the basic Spin Echo 
(SE) sequence. It is the inversion of the amplitude of the slice selection 
gradient during the 90° excitation pulse relative to the amplitude of the slice 
selection gradient(s) during the 180° refocusing pulse(s). However, 
chemical shift (or shimming) differences can also cause incomplete 
refocusing of off-resonant signals and image artifacts may still be seen. 
Since Classic is sensitive to the center frequency, performing manual 
prescan insures proper center frequency.

T2 FLAIR
The T2 FLAIR selection replaces the original FLAIR selection in the Pulse 
Sequence window. All functions and FLAIR sequence performances can be 
activated through the T2 FLAIR selection. You can activate the T2 FLAIR 
sequence by selecting T2 FLAIR in the Pulse Sequence window. 

NOTE: Pausing a FLAIR acquisition during scanning may cause image 
artifacts and should be avoided.

PSD  PSD Selection Type in PSD
FSE FSE-XL FSEOPT
FRFSE FRFSE-XL -----
IR FSE-IR FRFSEOPT
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Associated Imaging Options
Imaging Options provide image processing or filters for enhancing 
anatomical features or reducing noise. In Table 4-2, the X’s indicate the 
imaging options available for use with the T2 FLAIR pulse sequence.

Table 4-2 T2 FLAIR Pulse Sequence Imaging Options.

NOTE: Refer to Volume 2 of the Signa® Infinity with Signa Select™ (ASP2) 
Learning and Reference Guide (direction #2292262-100) for 
additional information on this pulse sequence.

Imaging Options

None X Variable Bandwidth

X Flow Compensation No Phase Wrap

POMP X Extended Dynamic Range

Square Pixel Surface Coil Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer Sequential

Cardiac Gating/Triggering Respiratory Gating/Triggering

X Tailored RF IR Prepared

DE Prepared Multi-Phase

Full Echo Train CCOMP

ZIP 1024 X ZIP 512

Zip x 2 ZIP x 4

SmartPrep Blood Suppression

Multi Station Real Time

T2 Prep Spectral Spatial RF

Phase Sensitive Navigator

ASSET Calibration Fluoro Trigger

X ASSET
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T1 FLAIR
The T1 FLAIR pulse sequence is designed to reduce the T1 weighted 
imaging scan time, as compared to T1 weighted Spin Echo (SE) imaging 
scan times. It also is designed to achieve better tissue contrast-to-noise 
(CNR) and tissue SNR. 

You can activate the T1 FLAIR sequence by selecting T1 FLAIR in the 
Pulse Sequence window. This Pulse Sequence Database (PSD) now 
operates in both the Picture This and Site Protocol modes. T1 FLAIR 
images are annotated as “t1flair/90” in the lower left corner of images. 

NOTE: The Site Protocol mode allows you to adjust prescription parameters 
and save the protocol in your site library.

Pausing a FLAIR acquisition during scanning may cause image 
artifacts and should be avoided.

Associated Imaging Options
Imaging Options provide image processing or filters for enhancing 
anatomical features or reducing noise. In Table 4-3, the X’s indicate the 
imaging options available for use with the T1 FLAIR pulse sequence.

Table 4-3 T1 FLAIR Pulse Sequence Imaging Options.

Imaging Options

None X Variable Bandwidth

X Flow Compensation X No Phase Wrap

POMP Extended Dynamic Range

X Square Pixel X Surface Coil Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer X Sequential

Cardiac Gating/Triggering Respiratory Gating/Triggering

X Tailored RF IR Prepared

DE Prepared Multi-Phase

Full Echo Train CCOMP

X ZIP 1024 X ZIP 512

Zip x 2 ZIP x 4

SmartPrep Blood Suppression
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NOTE: Tailored RF, Variable Bandwidth, and Sequential are inherent to this 
sequence and can not be turned off.

Refer to Volume 2 of the Signa® Infinity with Signa Select™ (ASP2) 
Learning and Reference Guide (direction #2292262-100) for 
additional information on this pulse sequence.

SSFSE-XL
Single Shot Fast Spin Echo-Excel (SSFSE-XL) is a purchasable option 
available for your MR system. It is a modification of the original SSFSE 
pulse sequence. This feature is designed to improve the CNR and SNR 
seen in MRCP images. 

The SSFSE-XL sequence is activated by selecting SSFSE from the Pulse 
Sequence window. If you have this feature, the original SSFSE pulse 
sequence is not available to you. Differences between the two PSDs are 
outlined in Table 4-4.

Table 4-4 SSFSE versus SSFSE-XL

Multi Station Real Time

T2 Prep Spectral Spatial RF

Phase Sensitive Navigator

ASSET Calibration Fluoro Trigger

ASSET

SSFSE SSFSE-XL

TE Only the values from the TE 
pull-down list can be used.

Any value including or between 
the minimum and maximum 
values displayed on the 
advisory panel can be used.

TR
Not selectable; your system 
automatically selects the best 
value for you.

Any value between and 
including minimum to infinity 
can be used.

Imaging Options (Continued)
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Scan Parameters
SSFSE-XL scan parameter modifications include the following changes:
• Flexible TE ranges
• Selectable TR values
• Additional bandwidth ranges
• Increased number of allowable echoes
• Fractional NEX Optimization

Flexible TE Range

The flexible TE range allows for two different methods of transversing 
K-space: Linear Phase Encoding and Reverse Phase Encoding. Both 
SSFSE-XL pulse sequences select the phase encoding scheme according 
to the prescribed TE. Linear Phase Encoding is used for short to medium 
range TEs. Reverse Phase Encoding is used for long range TEs. Loss of 
SNR from a long TE scan is minimized with Reverse Linear Phase 
Encoding, since it acquires more echoes earlier in the echo train compared 
to Linear Phase Encoding. 

Refer to the following guidelines when acquiring a standard T2 SSFSE 
image.
• Fractional NEX Optimization should be turned off on the User CV 

window.
• Select a value listed for TE1. Any TE selection between the values 

listed in the Min. and Max. TE1 columns ensure Linear View Ordering 
(Figure 4-1) is applied.

ETL
The maximum ETL range is 
184 echoes. The system 
automatically chooses the 
best ETL for you.

The maximum ETL range is 
240 or 264 echoes and is 
dependent on your system’s 
hardware configuration. You 
choose the ETL you want from 
the User CV window, which 
can only be changed if 
Fractional NEX Optimization is 
turned on. The range within 
which you can choose an ETL 
value is determined by the TE 
and phase matrix values.

Bandwidth
Only 20.83, 32.25, and 62.5 
bandwidths can be used. The 
system defaults to 62.5 kHz.

The system allows 20.83, 
25.00, 31.25, 41.66, and 62.5 
bandwidth values to be used. 
System defaults to 62.5 kHz.

SSFSE SSFSE-XL
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Figure 4-1 Linear View Phase Ordering Scheme

Refer to the following guideline when acquiring a MRCP or myelogram 
image.
• Select a value listed for TE2. Select a TE value 10 to 15 ms longer than 

the minimum value listed in the Min. and Max. columns for the Eff TE 
text box (TE2). This ensures Reverse View Ordering is applied.

Figure 4-2 Reverse View Phase Order Scheme

NOTE: With certain matrix combinations, you will notice a gap between the 
TE1 and TE2 ranges in the Min. and Max. columns. Selection of a 
TE value within this range may result in download failures. Other 
matrix combinations result in an overlap between the TE1 and TE2 
values in the Min. and Max. columns. Selecting a TE value in this 
overlap range results in the use of the Reverse View Ordering 
scheme.

Selectable TR Values

TR is a programmable variable from Minimum to 16,000 ms. Selecting 
Minimum acquires the images as quickly as possible but may result in 
crosstalk and thus decrease image contrast, or change the contrast from 
slice to slice. To avoid this problem, create a pause between slices by 
selecting Minimum and entering 1 location before pause. This technique 
4-10  2333956-100 Rev. 0 (06/02)
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results in user control of the length of the pause and it increases tissue 
relaxation time between slices, thus, producing more consistent image 
contrast from slice to slice.

Alternatively, select a long TR value that allows the slice to be acquired and 
then pause during the remaining portion of the TR period before acquiring 
the next slice. For example, if a 4000 ms TR is entered, the slice acquisition 
time is less than 1 second leaving an approximate pause time of 3 seconds. 
Using this technique can be especially useful to increase T2 brain contrast.

The Minimum TR value is approximately the same TR value as the previous 
SSFSE release.

Receiver Bandwidth

Additional Receiver bandwidths (RBw) have now been incorporated into 
this PSD. This allows more flexibility for increasing SNR, therefore, 
increasing image quality.

Fractional Phase FOV Ranges

A wider range of fractional phase FOV is now available. The phase FOV 
range is from 0.5 to 1.0. Values can be increased in increments of 0.01. 
This range values allows you to choose the best phase FOV to image 
desired anatomy, without sacrificing too much signal from your image.

User Control Variables

Figure 4-3 displays the User CV screen that appears with a SSFSE-XL 
sequence.

Figure 4-3 SSFSE-XL User CVs Screen
2333956-100 Rev. 0 (06/02)  4-11
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The “normal” behavior for SSFSE-XL is a 0.5 NEX acquisition. To override 
this NEX value, you must select Fractional NEX Optimization, an option 
selected through the User CVs screen in the Additional Parameters area. 
You may turn it ON to acquire additional echoes that would normally be 
discarded. The additional echoes increase the number of overscans and 
increase SNR. Fractional NEX Optimization is only available with the 
reverse K-space filling technique. With Fractional NEX Optimization ON, 
the echoes that would normally be discarded are now acquired and used to 
increase the number of overscans, thus increasing the SNR of the image. 
Image annotation reflects the fractional NEX. This option is only 
recommended for imaging long T2 exams, and it is particularly useful when 
imaging the colon and pancreas.

Figure 4-4  Fractional NEX Optimization

When Fractional NEX Optimization is OFF, a half-NEX technique is applied 
that uses approximately half of the phase encoding data needed to fill 
K-space. This technique results in the shortest scan time possible at the 
expense of discarded echoes to achieve the prescribed TE. 

The Maximum number of Echoes option allows you to select the maximum 
number of echoes available for overscans. If the maximum value is entered, 
the system uses all available echoes resulting in the largest possible NEX. 
The number of echoes can be limited to acquire a NEX value between 0.5 
and 1. The maximum number of echoes is either 240 or 264, and is 
dependent on your system’s hardware configuration.

Associated Imaging Options
Imaging Options provide image processing or filters for enhancing 
anatomical features or reducing noise. In Table 4-5, the X’s indicate the 
imaging options available for use with the SSFSE-XL pulse sequence.
4-12  2333956-100 Rev. 0 (06/02)
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Table 4-5 SSFSE-XL Pulse Sequence Imaging Options

Applications
SSFSE-XL sequences can be used in standard imaging to reduce motion 
artifacts and imaging times. With shorter scan times, breath-hold abdominal 
imaging can be achieved. By using long TE scans, images can also be 
acquired for the colon, pancreas, gallbladder, and biliary tree. Figure 4-5 
displays a SSFSE-XL MRCP image acquired in a 4 second breath-hold.

Imaging Options

X None X Variable Bandwidth

X Flow Compensation No Phase Wrap

POMP X Extended Dynamic Range

Square Pixel X Surface Coil Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer X Sequential

X Cardiac Gating/Triggering X Respiratory Gating/Triggering

Tailored RF IR Prepared

DE Prepared Multi-Phase

Full Echo Train CCOMP

ZIP 1024 X ZIP 512

Zip x 2 ZIP x 4

SmartPrep Blood Suppression

Multi Station Real Time

T2 Prep Spectral Spatial RF

Phase Sensitive Navigator

ASSET Calibration Fluoro Trigger

X ASSET
2333956-100 Rev. 0 (06/02)  4-13
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Figure 4-5 SSFSE-XL MRCP

3D FRFSE-XL
3D Fast Recovery Fast Spin Echo-Excel (FRFSE-XL) pulse sequence is 
built on the foundation of the 3D FSE pulse sequence. It has been 
developed primarily to enable high-resolution images for MR 
cholangiopancreatography (MRCP) studies. 3D FRFSE-XL operates with 
the respiratory triggering, ASSET (Array coil Spatial Sensitivity Encoding 
Technique), fast recovery, Zerofill Interpolation (ZIP) options, sequential 
view-ordering, and half-NEX options, and it provides two alternative 
approaches to the filling of k-space. The fast recovery feature is designed to 
enhance the intensity of fluids that have long T2 relaxation times, while 
using a shortened TR time. The shortened TR time makes the high 
resolution images practical. Respiratory triggering is used to overcome 
image quality degradation due to patient breathing. 

Scan Parameters
3D FRFSE is a purchasable scan feature you can activate by selecting the 
3D imaging mode in the Imaging Parameters area and selecting FRFSE-XL 
on the Pulse Sequence window. The fast recovery sequence is necessary 
in keeping the TR short, thereby, keeping the imaging time short. The 3D 
FRFSE-XL pulse sequence allows you to acquire oblique scanning planes. 
This provides more flexibility when performing abdominal (MRCP) scans 
along a specific region of interest.

Half-NEX Selection

The 3D FRFSE-XL pulse sequence supports the half-NEX option with the 
Single Shot view-ordering mode. The half-NEX feature reduces the imaging 
time to help acquire the data in the shortest possible breath-hold. 
4-14  2333956-100 Rev. 0 (06/02)
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View Ordering Scheme

A sequential view ordering scheme can be used with the 3D FRFSE-XL 
sequence. This acquisition mode is called the Single Shot mode. It fills an 
entire ky (phase) and kx (frequency) plane of K-space in a single shot for 
each value of kz (slice) and is not interleaved with kz. The TE and ETL for 
this view ordering scheme are automatically calculated by your system.

Associated Imaging Options
Imaging Options provide image processing or filters for enhancing 
anatomical features or reducing noise. In Table 4-5, the X’s indicate the 
options available for use with the 3D FRFSE-XL pulse sequence.

Table 4-6 3D FRFSE-XL Pulse Sequence Imaging Options

Imaging Options

X None X Variable Bandwidth

X Flow Compensation X No Phase Wrap

POMP X Extended Dynamic Range

X Square Pixel X Surface Coil Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer Sequential

Cardiac Gating/Triggering X Respiratory Gating/Triggering

Tailored RF IR Prepared

DE Prepared Multi-Phase

Full Echo Train CCOMP

X ZIP 1024 X ZIP 512

X Zip x 2 X ZIP x 4

SmartPrep Blood Suppression

Multi Station Real Time

T2 Prep Spectral Spatial RF

Phase Sensitive Navigator

ASSET Calibration Fluoro Trigger

X ASSET
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Respiratory Gating/Triggering

The 3D FRFSE-XL pulse sequence can be used to acquire either 
breath-hold or respiratory gated acquisitions. Respiratory Gating/Triggering 
supports cross trigger to trigger conditions, where scanning extends over 
one respiratory cycle and the echo spacing (ESP) x ETL is greater than the 
trigger to trigger interval. This may be useful for times when you may need 
respiratory gated scans over multiple respiratory intervals at the expense of 
scan time. However, the Respiratory Interval text box does not allow 
type-in values with the Single Shot view ordering scheme, in other words, 
the only available value is 1 RR.

Zerofill Interpolation (ZIP) Options

The in-plane (ZIP 512, ZIP 1024) and through-plane (ZIP x 2, ZIP x 4) 
features provide sharper images and improve Maximum Intensity 
Projections (MIP).

Array Spatial Sensitivity Encoding Technique (ASSET)

ASSET is a technique for reducing scan time when the Torso or Torso 
Phased Array (PA) coil is used. Using the ASSET option with 3D FRFSE-XL 
decreases the imaging time to allow for shorter breath-hold acquisitions and 
allows for higher spatial resolution. Refer to the Imaging with ASSET 
chapter of this guide for ASSET details.

Variable Bandwidth Selections

Variable Bandwidth selections include values that require fractional 
decimation. Therefore, you are able to choose a bandwidth that optimizes 
ESP for your chosen parameters.

Applications
The 3D FRFSE-XL pulse sequence with the User CV of Single Shot View 
Ordering turned on, is used to acquire heavily T2-weighted images, such as 
MRCP or myelogram. The reduced imaging times allow for breath-held 
acquisitions or free breathing techniques with Respiratory 
Gating/Triggering. 3D FRFSE-XL may also be used for other T2 
applications such as spine and IAC imaging.
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How Do I...
This section provides the step-by-step instructions for imaging with the 
Dynamic R1 feature and the 3D FRFSE-XL pulse sequence. Specifically, it 
describes how to:
• Activate Dynamic R1
• Prescribe a 3D FRFSE-XL Breath-Hold Sequence
• Prescribe a 3D FRFSE-XL Sequence with Respiratory 

Gating/Triggering

Decision Matrix
A decision matrix is used in this section to provide examples of what values 
could be selected for prescribing a particular sequence. The purpose of the 
decision matrix is to help you understand the trade-offs that occur when you 
change the values for a particular parameter and to provide a framework 
with which you may build your own unique protocol.

The example protocols provide information on what could be used for these 
pulse sequences and are not to be considered recommendations by GE 
Medical Systems. For specific protocols, refer to the protocols on your 
system.

In addition to listing the information you need to select on the system, the 
“What You Select” column of the matrix uses two other conventions.
• N/A indicates the imaging parameter is not applicable to the pulse 

sequence example.
• N/S indicates the imaging parameter is not selectable in the pulse 

sequence example. The system automatically selects these imaging 
parameters.

CAUTION: Provide all patients with ear protection prior to any scan to 
help avoid possible hearing impairment. Acoustic noise 
levels can exceed 99 dbA in the magnet bore.
2333956-100 Rev. 0 (06/02)  4-17
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
Activate Dynamic R1
Dynamic R1 can be used with a 3D FSE pulse sequence to 
increase the SNR for acquiring large FOV images. If during 
manual prescan, the R1 of the imaging volume is less than 6, 
consider using Dynamic R1.

Use this procedure to activate Dynamic R1.

1. Prescribe a large single slab 3D FSE acquisition.

2. Click [Save Series].

3. Click [Prepare to Scan].

4. Click [Auto Prescan].

5. View the R2 value displayed above the [Auto Prescan] 
button.

If the value is less than 6, then Dynamic R1 can improve 
the SNR.

6. Copy and paste the current 3D FSE highlighted series in the 
Rx Manager.

7. Click [View Edit] to view and edit the series.

8. Insert cursor in the PSD Name text box and type 3dfser1.

9. Click [Save Series].

10. Click [Prepare to Scan].

11. Click [Auto Prescan].

12. View the R2 value.

If it is greater or equal to 14, proceed to [Scan].
If it is less than 14, continue with step 12.

13. Click [Manual Prescan].

14. Click and drag the Digital Gain (R2) slider in the Manual 
Prescan window to increase the value to 14.

15. Click [Done] to exit the Manual Prescan window.

16. Click [Scan].

Quick Steps: Activate 
Dynamic R1
1. Prescribe a large single 

slab 3D FSE acquisition.

2. Click [Save Series].
3. Click [Prepare to Scan].
4. Click [Auto Prescan].
5. View the R2 value 

displayed above the 
[Auto Prescan] button.

6. Copy and paste the 
current 3D FSE 
highlighted series in the 
Rx Manager.

7. Click [View Edit] to view 
and edit the series.

8. Insert cursor in the PSD 
Name text box and type 
3dfser1.

9. Click [Save Series].
10. Click [Prepare to Scan].
11. Click [Auto Prescan].
12. View the R2 value.

13. Click [Manual Prescan].
14. Click and drag the Digital 

Gain (R2) slider in the 
Manual Prescan window 
to increase the value to 
14.

15. Click [Done] to exit the 
Manual Prescan window.

16. Click [Scan].
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Prescribe a 3D FRFSE-XL Breath-Hold 
Sequence
The 3D FRFSE-XL sequence is useful in clinical applications to obtain 
high-resolution MRCP studies, as well as obtain images in the abdomen 
and pelvis. This sequence can be performed as a breath-hold or can be 
acquired with respiratory triggering.

The decision matrix (Table 4-7) is only for prescribing a 3D FRFSE-XL 
sequence. The following example protocol is for prescribing an oblique 3D 
FRFSE-XL scan to be acquired in a breath-hold. 

Table 4-7 3D FRFSE-XL Breath-Hold Protocol Example 

3D FRFSE-XL Protocol Example 
What You Select Selection Notes

Scan Rx Desktop
Scan Rx Acquire a 

localizer series
Allows Graphic Rx to become available so you can prescribe 
slices graphically on the localized image. Ensure the image 
is appropriate to prescribe the 3D volume over the anatomy 
of interest. 

Rx Manager [New Series] Adds an additional series to the patient’s exam. 

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series when the 
Patient Protocol window becomes active.

Patient Position

Patient Position Supine Indicates the orientation of the patient. Compatible with any 
patient position and entry.

Patient Entry Feet First

Coil Phased Array 
> Torso PA

Allows selection of the coil from which the signal is 
transmitted and received. Use a coil that produces the 
optimum coverage and SNR.

Series Enter a series 
description in 
the text box.

Allows you to enter a brief description of the series being 
prescribed. If you do not enter a description, the system 
enters one for you. The series description default is the 
selected scan mode, PSD, and selected imaging options.
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Imaging Parameters

Plane Oblique Defines the scan plane of the acquisition. The oblique scan 
plane selection is enabled for the 3D FRFSE-XL application. 
For MRCP imaging, select oblique for proper angling through 
the anatomy.

Mode 3D Prescribes a three-dimensional sequence. 3D must be 
selected for 3D FRFSE-XL sequences. 

Pulse Seq. FRFSE-XL Prescribes the FRFSE-XL pulse sequence. 

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has TwinSpeed™ gradients.

Imaging Options Variable 
Bandwidth, 
ZIPx2

Provides appropriate options for enhancing anatomical 
features and reducing noise. 

PSD Name N/A

Protocol N/A

3D FRFSE-XL Protocol Example 
What You Select Selection Notes
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Scan Timing

# of echoes N/S One echo is selected automatically if sequential view 
ordering is selected. 

TE N/S The TE is automatically calculated by your system when 
Single Shot View Ordering (located on the User CV window) 
is turned on.

TE2 N/A

TR 1200

Inv Time N/A

TI2 N/A

Flip Angle N/A

Echo Train Length N/S The ETL is automatically calculated by your system when 
Single Shot View Ordering (located on the User CV window) 
is turned on.

Bandwidth 31.25 The typical RBw value is 31.25 kHz. As the bandwidth 
increases, minimum TR and TE values may decrease. 

Bandwidth2 N/A

3D FRFSE-XL Protocol Example 
What You Select Selection Notes
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Scanning Range 

FOV Enter 40 in the 
text box. 

Defines the size of the area imaged. The FOV is generally 
set as small as possible to obtain the acceptable resolution 
and SNR without causing aliasing from outside the FOV into 
the anatomy of interest. Typical values are 36 to 40 cm.

Slice Thickness 4 Defines the thickness of the image slice. With the ZIPx2 
option on, interpolated slice thickness becomes one-half of 
the prescribed slice thickness. Typical values are 2 to 4 cm.

Scan Locs 22 Defines the number of scan locations per 3D slab. Typically, 
the minimum should not be less than 8.

Start, End Locations Determines the start and end locations from the Graphic Rx 
program after the slab is prescribed and posts the locations 
here. 

# Slabs 1 Determines the number of slabs as prescribed in Graphic Rx 
and posts it here. The number of slabs cannot be greater 
than one.

Acquisition Timing

Freq 256 Controls resolution. Increasing the frequency matrix 
decreases SNR and the number of slice locations allowed, 
while increasing resolution. 

Phase 192 Controls scan time and resolution. The phase matrix cannot 
exceed the frequency matrix. 

3D FRFSE-XL Protocol Example 
What You Select Selection Notes
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NEX 0.5 Half-NEX is generally used to reduce scan times and is only 
available if Single Shot View Ordering is turned on from the 
User CV window.

Phase FOV 0.8 Shortens scan time by scaling down the FOV in the phase 
direction by either 0.5, 0.6, 0.7, 0.8, or 0.9. Reduces the 
phase matrix and thus decreases scan time, decreases the 
FOV in the phase direction, and decreases SNR slightly. The 
phase FOV dimension is displayed next to the phase FOV 
factor. 

Freq DIR Unswap Displays the default frequency direction, which is typically 
the long axis of the image. Leave the frequency direction 
unswapped.

Auto Center Freq Water Sets the peak center frequency on the water peak of the 
patient during prescan.

Flow Comp DIR N/A

Autoshim On Improves image quality and is recommended for this 
sequence.

Phase Correct N/A

# of Locs Before Pause N/A

 Additional Parameters - User CVs 

Slices to discard Enter 0.00 in 
the text box.

Discard zero slices since this sample protocol uses a single 
slab.

SINGLE_SHOT View 
Ordering

Enter 1.00 in 
the text box.

Allows you to select 0.5 NEX when the SINGLE SHOT View 
Ordering is one.

Accept [Accept] Confirms the selected values and closes the User CVs 
Additional Parameter screen.

3D FRFSE-XL Protocol Example 
What You Select Selection Notes
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Additional Parameters - Graphic Rx

[+] Next and [-] Prior [+] and [-] Allows you to page through the localizer images to check the 
position of the prescription. 

Image Viewport Click the image 
to display the 
3D volume.

Allows you to prescribe 3D slab over the anatomy of interest. 
Select the adjustment handles to angle the slab. 

Copy Rx [Copy Rx]
(optional)

Copies the exact locations of the prior series if you had 
previously graphically prescribed a series with the same 
plane, FOV, and slice thickness.

Erase All [Erase All]
(If necessary)

Eliminates the graphic prescription from the screen and 
allows you to start over.

Reset Center [Reset Center]
(if necessary)

Re-establishes the FOV center on a different localized slice.

Accept [Accept] Confirms the cursor position and closes Graphic Rx.

Additional Parameters - SAT
FAT On Turns the fat SAT technique on to suppress fat on the 

images.

Series Control 
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the series.

Scan Operations
Prep Scan [Prep Scan] Performs Auto Prescan and readies the system for data 

acquisition. Select for breath-hold acquisitions. 

Scan [Scan] Initiates the acquisition. 

3D FRFSE-XL Protocol Example 
What You Select Selection Notes
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Prescribe a 3D FRFSE-XL Sequence with 
Respiratory Gating/Triggering
The 3D FRFSE-XL sequence can also be performed with Respiratory 
Gating/Triggering to acquire images in the abdomen or pelvis.

Table 4-8 provides a brief look at an example protocol for acquiring coronal 
oblique 3D FRFSE-XL images with Respiratory Gating/Triggering. The 
parameters may vary depending on your needs.

Table 4-8 3D FRFSE-XL with Respiratory Gating/Triggering Protocol 
Example

NOTE: The Grad Mode text box is only available on TwinSpeed™ 
Resonance Module (TRM) systems.

Parameter What You 
Select Parameter What You 

Select
Imaging Parameters Scanning Range

Patient Position Supine FOV 36 to 40 cm

Patient Entry Feet First Slice Thickness 2 to 4 mm
Coil Torso PA Locs per Slab 36

Plane Coronal 
Oblique

Start Use Graphic Rx 
to determine 
start and end 
locations.Mode 3D End 

Pulse Sequence FRFSE-XL # Slices Cover region of 
interest.

Grad Mode Zoom Acquisition Timing
Imaging Options Respiratory 

Gating/Trigger, 
ZIPx2

Freq 320
Phase 256

PSD Name N/A NEX 0.5

Scan Timing Phase FOV 0.8

# of Echoes 1 Freq DIR S/I or unswap

TE N/S Auto Center Freq Water 
TR N/S Flow Comp DIR N/A

Flip Angle N/A Autoshim On

Echo Train Length N/S Phase Correct Off
Bandwidth 31.25 Additional Parameters - User CV

Additional Parameters - SAT Slices to discard 0

Saturation Fat SINGLE_SHOT 
View Ordering

1
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Chapter 5

3D FIESTA Pulse
Sequence

Introduction
The Fast Imaging Employing STeady-state Acquisition (FIESTA) is a fully 
balanced steady-state coherent imaging pulse sequence designed to produce 
high signal-to-noise ratio (SNR) images at very short sequence times (TRs). 

This chapter explains the pulsing components and timing factors directly related 
to the 3D FIESTA imaging pulse sequence. It also explains the concepts and the 
step-by-step instructions to help you learn how to:
• Optimize 3D FIESTA Images
• Prescribe a 3D FIESTA Sequence

In addition, this chapter answers the following questions:

1. What is FIESTA?

2. When would I use a 3D FIESTA pulse sequence?

3. How do I get the shortest TR?

4. What are the imaging characteristics of a 3D FIESTA pulse sequence?

5. Which imaging options can be used with the 3D FIESTA pulse sequence?

6. What are some applications of the 3D FIESTA sequence?
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What Do I Need to Know 
About...
This section presents the concepts necessary to understand imaging with 
the 3D FIESTA pulse sequence. Specifically, you need to understand the 
following concepts:
• 3D FIESTA Basics
• Imaging Effects
• Imaging Characteristics
• Associated Imaging Options
• Applications

3D FIESTA Basics
The Fast Imaging Employing STeady-state Acquisition (FIESTA) sequence 
is a fully balanced steady-state coherent imaging pulse sequence designed 
to produce high SNR images at very short TRs. The pulse sequence uses 
fully balanced gradients to re-phase the transverse magnetization at the 
end of each TR interval. For very short TR sequences, the resulting signal 
intensity is independent of TR and related to (T2/T1). More importantly, the 
short TRs are essential to maintain spin phase coherence. Phase 
coherence is required to maintain coherent transverse magnetization and 
eliminate artifacts generated by magnetic susceptibility induced phase 
shifts. Thus, the advantages of FIESTA can only be realized with very short 
TR where (TR << T2) and (TR << 1/b) where b is the local frequency shift 
caused by inhomogeneity.

NOTE: << indicates “much less than”.

Tissue contrast is generated based on the ratio of the spin-spin relaxation 
time (T2) and the spin-lattice relaxation time (T1). Hence, the pulse 
sequence accentuates the contrast of spins with high T2/T1 ratios (such as 
cerebral-spinal fluid, water, and fat) while suppressing signal from tissues 
with low T2/T1 ratios (such as muscle and myocardium). 

The 3D FIESTA sequence can be used for whole body imaging and can be 
used in clinical applications that benefit from the differentiation of contrast 
between tissues of low T2/T1 ratios (low signal intensity) and high T2/T1 
ratios (high signal intensity). The 3D FIESTA technique can be useful for, 
but not limited to, imaging structures in motion such as abdominal imaging 
of the bile ducts or for rapid acquisition of static structures with high spatial 
resolution such as the cochlea or joint imaging.
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Imaging Effects
The sequence parameters have different effects that contribute to 3D 
FIESTA images. Table 5-1 summarizes the imaging effects relating to 3D 
FIESTA and is provided to help you understand the trade-offs that occur 
when you change the values for a particular parameter.

Table 5-1 Imaging Effects with 3D FIESTA

NOTE: *There is not always a direct correlation between FOV and artifact. 
In certain instances, with anatomical size and FOV, some artifact can 
occur (wrap). In most other circumstances, there is not a correlation.

Imaging Characteristics
3D FIESTA sequences produce high signal to noise images with enhanced 
contrast and temporal resolution. This sequence provides excellent contrast 
between soft tissues and fluids with reduced repetition times to minimize 
motion artifacts. 

There are several factors you should consider when using 3D FIESTA:
• 3D FIESTA supports 512 matrix.
• The TE is fixed at the minimum full value.
• When using gating turn on the Reverse Loop Order CV at the User CVs 

screen by typing 1.
– When Reverse Loop Order is OFF (0), the system scans all lines of 

K-space along the slab encoding direction per heartbeat; therefore, 
the scan time is equivalent to a number of heartbeats equal to the 

Parameters Contrast 
(T2/Ts)

Temporal 
Resolution

Spatial 
Resolution SNR Scan 

Time Artifacts

TR ⇓ ⇑ ⇑ N/A ⇑ ⇓ ⇓

TE ⇓ ⇑ N/A N/A ⇑ ⇓ ⇓

Flip Angle ⇑ ⇑ N/A N/A ⇑ N/A N/A

RBw ⇑ ⇑ ⇑ N/A ⇓ ⇓ ⇓

VPS ⇑ N/A ⇑ N/A N/A ⇓ ⇑

Matrix ⇑ N/A N/A ⇑ ⇓ ⇑ N/A

Slice 
Thickness ⇓ N/A N/A ⇑ ⇓ N/A N/A

FOV ⇓ N/A N/A ⇑ ⇓ N/A *
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number of phase encoding lines to be collected. For example, if you 
have a phase matrix of 128 selected with a Phase FOV of one, your 
scan time takes 128 heartbeats to complete.

– When Reverse Loop Order is on (1), the system collects all lines of 
K-space along the phase encoding direction per heartbeat; therefore, 
your scan time is equivalent to a number of heartbeats equal to the 
number of slab locations selected. For example, if you have selected 
a slab of 44 locations, your scan time takes 44 heartbeats to 
complete.

Associated Imaging Options
Imaging Options provide image processing or filters for enhancing 
anatomical features or reducing noise. In Table 5-2, the X’s indicate the 
imaging option available for use with the 3D FIESTA pulse sequence.

Table 5-2 3D FIESTA Pulse Sequence Imaging Options

Imaging Options

X None X Variable Bandwidth

Flow Compensation X No Phase Wrap

POMP X Extended Dynamic Range

X Square Pixel X Image Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer Sequential

X Cardiac Gating/Triggering Respiratory Gating/Triggering

Tailored RF IR Prepared

DE Prepared X Multi Phase

Full Echo Train CCOMP

X ZIP 1024 X ZIP 512

X Zip x 2 X ZIP x 4

SmartPrep Blood Suppression

Multi Station Real Time

T2 Prep Spectral Spatial RF

Phase Sensitive Navigator

ASSET Calibration Fluoro Trigger

ASSET
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Applications
3D FIESTA imaging is intended for the whole body. Imaging applications for 
3D FIESTA include screening of the spine for spinal disk hernias or disk 
intrusions into the spinal canal (spinal cord block), level of obstruction in 
hydrocephalus, biliary obstruction, cholangio-pancreatography, and in the 
visualization of the internal auditory canals (IACs).

Figure 5-1 3D FIESTA image of the IACs

• Recommendations for getting the shortest TR:
– For high-resolution imaging (≤ 0.5 mm), RBw of 42 kHz appears to 

yield a shorter TR. This is due to gradient heating limitation. 
Otherwise, 125 kHz would give the shortest TR. RBw choices are 
125, 100, 83.3, 62.5, 41.57, and 31.25 kHz. 

– Try smaller flip angles (40°) first and increase it slowly, every five 
degrees, to see if SAR limits your minimum TR. Compromise should 
be made between highest flip angle (70°) and shortest achievable 
TR (< 6 ms). The longest achievable flip angle is 90°.

WARNING:Earplugs are required for any person staying inside the scan 
room during 3D FIESTA scans due to its acoustic noise level.

3D FIESTA 
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How Do I...
This section provides the step-by-step instructions for prescribing 3D 
FIESTA imaging pulse sequences. Specifically, it describes how to:
• Prescribe a 3D FIESTA Sequence

This section also provides the following 3D FIESTA images and example 
protocols.
• Sagittal Spine
• IACs
• Body
• MRCP

Decision Matrix
A decision matrix is used in this section to provide examples of what values 
could be selected for prescribing a particular sequence. The purpose of the 
decision matrix is to help you understand the trade-offs that occur when you 
change the values for a particular parameter and to provide a framework 
with which you may build your own unique protocol.

The example protocols provide information on what could be used for these 
pulse sequences and are not to be considered recommendations by GE 
Medical Systems. For specific protocols, refer to the protocols on your 
system.

In addition to listing the information you need to select on the system, the 
“What You Select” column of the matrix uses two other conventions.
• N/A indicates the imaging parameter is not applicable to the pulse 

sequence example.
• N/S indicates the imaging parameter is not selectable in the pulse 

sequence example. The system automatically selects these imaging 
parameters.

CAUTION: Provide all patients with ear protection prior to any scan to 
help avoid possible hearing impairment. Acoustic noise 
levels can exceed 99 dbA in the magnet bore.
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Prescribe a 3D FIESTA Sequence
3D sagittal images of the spine can be acquired with the FIESTA sequence. 
The 3D FIESTA pulse sequence accentuates cerebral spinal fluid, water, 
and fat, while suppressing muscle tissue.

The decision matrix (Table 5-3) is only for prescribing a 3D FIESTA scan. 
The following example protocol in the matrix is for a 3D Sagittal Spine. 

Table 5-3 3D FIESTA Protocol Example (Sagittal Spine)

3D FIESTA Protocol Example 
What You Select Selection Notes

Scan Rx Desktop
Scan Rx Acquire a 

localizer series
Allows Graphic Rx to become available so you can prescribe 
slices graphically on the localized image. 

Rx Manager [New Series] Adds an additional series to the patient’s exam. 

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series if the Patient 
Protocol window becomes active.

Patient Position

Patient Position Supine Compatible with any patient position.

Patient Entry Head First Compatible with head or feet first entry.

Coil Phased Array 
> CS123

Use a coil that produces the optimum coverage and SNR.

Series Description Enter a series 
description in 
the text box.

If you do not enter a description, the system enters one for 
you. The series description default is the selected scan 
mode, PSD, and selected imaging options.
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Imaging Parameters

Plane Sagittal Compatible with any scan plane, except 3-plane. Select the 
plane that best meets your clinical need. 

Mode 3D Allows prescription of a three-dimensional FIESTA 
sequence.

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has Twin gradients. 

Pulse Sequence FIESTA Allows prescription of a FIESTA pulse sequence.

Imaging Options Select imaging options that optimize SNR, spatial resolution, 
number of slices and reduce motion artifacts. 

PSD Name N/A

Protocol N/A

3D FIESTA Protocol Example 
What You Select Selection Notes
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Scan Timing

# of echoes N/S One echo is automatically selected.

TE Min Full The typical TE value is minimum full.

TE2 N/A

TR N/S The minimum TR is selected automatically. 

Inv Time N/A

TI2 N/A

Flip Angle Enter 50 in the 
text box.

The typical flip angle value for the spine is 45° to 55°.

Echo Train Length N/A

Bandwidth 125 The RBw choices are 125, 100, 83.3, 62.5, 41.57, and 31.2 
kHz. 12 kHz yields the shortest TR for a slice thickness 
> 0.5 mm.

Bandwidth2 N/A

3D FIESTA Protocol Example 
What You Select Selection Notes
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Scanning Range 

FOV Enter 36 in the 
text box.

Select a FOV that covers the anatomy of interest. Anatomy 
outside the FOV in the phase direction results in aliasing. 
Small FOVs produce increased resolution, decreased SNR, 
and can increase the minimum TE value.

Slice Thickness 2.0 The typical slice thickness value for a 3D spine is 2 to 3 mm. 
Thin slices produce increased resolution and decreased 
SNR.

# of Scan Locs Enter 28 in the 
text box.

Available selections are 8 to 128 locations. There are always 
two slices on either end of the slab that are discarded. Factor 
these four slices into your selection.

Start, End Locations The start and end locations are programmed from the 
Graphic Rx program after the slabs are prescribed.

# Slabs Determined by the number of scan locations and the desired 
range of anatomy to be covered.

Acquisition Timing

Freq 384 Increasing the frequency matrix increases resolution, while 
decreasing SNR and the number of available slices.

Phase 256 Phase controls scan time and may control resolution.

NEX 1 One NEX for sufficient SNR and a reasonable scan time.

3D FIESTA Protocol Example 
What You Select Selection Notes
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Phase FOV 1.00 Select a phase FOV of one to prevent wrapping of anatomy.

Freq DIR S/I The direction displayed is the default frequency direction 
which is typically the long axis of the image. Leave the 
frequency direction unswapped.

Auto Center Freq Water The CF peak that will be set during prescan.

Flow Comp DIR N/A

Autoshim On Turn Autoshim on when using an off center FOV and on the 
first series of an exam.

Phase Correct Off Provides no additional benefits and increases prescan time.

# of Acqs Before Pause N/A

 Additional Parameters - Graphic Rx

[+] Next and [-] Prior [+] and [-] Allows you to page through the localizer images to check the 
position of the prescription. 

Image Viewport Press the Shift 
key and click 
the image to 
display the line 
cursor.

Prescribe the slices to display the slab for graphic 
prescription. Select the adjustment handles to angle, draw, 
and remove slabs. Position the volume to cover anatomy of 
interest and view the Advisory Panel to note the maximum 
number of slabs per acquisition and the number of 
acquisitions you are prescribing. 

Copy Rx [Copy Rx]
(optional)

If you had previously graphically prescribed a series with the 
same plane, FOV, and slice thickness, the prescription can 
be copied to the exact locations of the prior series.

Erase Group [Erase Group]
(If necessary)

Eliminates the graphic prescription from the screen and 
allow you to start over.

Reset Center [Reset Center]
(if necessary)

Re-establishes the FOV center on a different localized slice.

Accept [Accept] Confirms the cursor position and close Graphic Rx.

3D FIESTA Protocol Example 
What You Select Selection Notes
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Series Control
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the series.

Scan Operations
Scan [Scan] Initiates the acquisition.

3D FIESTA Protocol Example 
What You Select Selection Notes
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3D Sagittal Spine
A sagittal spine scan can be acquired with a 3D FIESTA pulse sequence. 
This sequence can be used for screening the spine for spinal disk hernias 
or intrusions into the spinal canal. The sequence accentuates cerebral 
spinal fluid, water, and fat, while suppressing muscle tissue. Figure 5-2 
shows a sagittal image of the spine acquired with a 3D FIESTA sequence. 
Table 5-4 gives you a brief look at an example protocol. The parameters 
may vary depending on your needs.

Figure 5-2 3D FIESTA 

Table 5-4 3D FIESTA Example Spine Protocol

Plane Mode Pulse 
Sequence

PSD 
Name TE TR Flip 

Angle RBw FOV Slice 
Thickness

# of Scan 
Locs

Sagittal 3D FIESTA N/A Min Full N/A 45-55 125 ~36 2 to 3 28 slices

Matrix NEX Phase 
FOV

Freq 
Direction

Center 
Frequency

Auto
Shim

Phase 
Correct

Imaging 
Options

Sat 
Pulses Comments

384x256 1 1 Unswap Water On Off None CTL coil 
recommended
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3D IACs
An axial or coronal scan of the IACs can be acquired with a 3D FIESTA 
pulse sequence. This sequence can be useful to produce a high signal to 
noise image with enhanced contrast and temporal resolution in the 
visualization of the cochlea. Figure 5-3 shows an axial image of the IACs 
acquired with a 3D FIESTA sequence. Table 5-5 gives you a brief look at an 
example protocol. The parameters may vary depending on your needs.

Figure 5-3 3D FIESTA 

Table 5-5 3D FIESTA Example IAC Protocol

NOTE: *Reduced FOVs attained by reducing matrix. 

Plane Mode Pulse 
Sequence

PSD 
Name TE TR Flip 

Angle RBw FOV Slice 
Thickness

Slice 
Spacing

Oblique 3D FIESTA N/A Min Full N/A 70 125 16 to 
28* 0.8 to 1.0 0.0

Matrix NEX Phase 
FOV

Freq 
Direction

Center 
Frequency

Auto
Shim

Phase 
Correct

Imaging 
Options

Sat 
Pulses Comments

512x512 1 1 Unswap Water On Off None
Dual or head 

coil 
recommended
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3D Body
An axial or coronal abdominal scan can be acquired with a 3D FIESTA 
pulse sequence. This sequence provides excellent contrast between soft 
tissues and fluids with reduced repetition times to minimize motion artifacts. 
Figure 5-4 shows a coronal image of the abdomen acquired with a 3D 
FIESTA sequence. Table 5-6 gives you a brief look at an example protocol. 
The parameters may vary depending on your needs.

Figure 5-4 3D FIESTA 

Table 5-6  3D FIESTA Example Body Protocol

Plane Mode Pulse 
Sequence

PSD 
Name TE TR Flip 

Angle RBw FOV Slice 
Thickness

# of Scan 
Locs

Axial or 
Coronal 3D FIESTA N/A Min Full N/S 45 to 55 125 ~40 3.0 20 to 40

Matrix NEX Phase 
FOV

Freq 
Direction

Center 
Frequency

Auto
Shim Imaging Options Comments

256x192 1 1 Unswap Water On ZIP x 2,
512 ZIP optional

Proper coil selection 
to cover anatomy
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3D MRCP
An axial or coronal MR Cholangiogram (MRCP) scan can be acquired with 
a 3D FIESTA pulse sequence. This sequence provides enhanced contrast 
and temporal resolution for imaging of the bile ducts. Figure 5-5 shows an 
image of the bile ducts acquired with a 3D FIESTA sequence. Table 5-7 
gives you a brief look at an example protocol. The parameters may vary 
depending on your needs.

Figure 5-5 3D FIESTA Contrast Enhanced Image

Table 5-7 3D FIESTA Example MRCP Protocol

Plane Mode Pulse 
Sequence

PSD 
Name TE TR Flip Angle RBw FOV Slice 

Thickness
# of Scan 

Locs

Axial or 
Coronal 3D FIESTA N/A N/S N/

S 40 125 ~40 2.8 44

Matrix NEX Phase 
FOV

Freq 
Direction

Center 
Frequency

Auto
Shim

Phase 
Correct

Imaging 
Options

Sat 
Pulses Comments

224x256 0.5 1 Unswap Water On Off None Surface coil 
recommended
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Chapter 6

PROSE Pulse Sequence

Introduction
This chapter presents an explanation and the details of the PROstate 
Spectroscopy and imaging Examination (PROSE). During a typical prostate 
examination, sagittal localizer images are acquired to guide the prescription 
of axial T1-weighted conventional Spin Echo (SE) images from the 
symphysis pubis to the aortic bifurcation. These images are used to assess 
the presence of pelvic lymph node and bone metastases and to determine if 
there is post-biopsy hemorrhage in the prostate. Subsequently, heavily 
T2-weighted high resolution Fast Spin Echo (FSE) images are acquired in 
the axial and coronal planes (or oblique axial and coronal planes) through 
the prostate and seminal vesicles to identify prostate zonal anatomy and 
pathology. The images, acquired with the combination of an endo-rectal coil 
and a pelvic or torso phased array coil, are surface coil intensity corrected 
with the Prostate Analytical Coil Correction (PACC) program. With the 
PROSE pulse sequence, the axial images are used to prescribe a 
three-dimensional (3D) volume containing as much of the prostate gland as 
possible, while excluding periprostatic lipids and the air-tissue interface of 
the rectum. PROSE acquires Chemical Shift Images, i.e., spectra, from the 
prescribed volume.
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This chapter explains the characteristics of the PROSE sequence. It also 
explains the major components of a prostate examination and the 
step-by-step instructions to help you learn how to:
• Acquire Localizer Images
• Acquire High-Resolution Images

– Acquire Axial SE Images
– Acquire Axial Oblique FSE Images
– Acquire Coronal Oblique Images

• Correct Images with PACC
• Prescribe a PROSE Acquisition
• Make Prescan Adjustments

– Examine the Spectrum
– Manually Adjust the Homogeneity

NOTE: This chapter includes new features or enhancements of clinical 
spectroscopy sequences. Refer to the Signa® Infinity with Signa 
Select™ (ASP2) Learning and Reference Guide (direction 
#2292262-100) for additional clinical spectroscopy pulse sequences.

In addition, this chapter answers the following questions:

1. What is PROSE?

2. What type of localizers do I need to acquire for a PROSE examination?

3. Which imaging options can be used with a PROSE pulse sequence?

4. How do I correct for signal intensity distortions on images acquired with 
the endo-rectal coil?

5. What is the typical size of a PROSE ROI?

6. How can I enable VSS to use with the PROSE sequence?
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What Do I Need to Know 
About...
While the imaging aspects of the prostate examination are probably familiar, 
the spectroscopy components are probably new, and therefore the PROSE 
pulse sequence is discussed in more detail in this section. Specifically, you 
need to understand:
• PROSE Description
• Coil Placement and Selection
• Prostate Imaging
• Prostate Analytical Coil Correction
• Prostate Spectrum
• Water and Lipid Signal Suppression
• PROSE Scan Parameters

– Imaging Options
– Phase Encoding Matrix Selections
– Parameters that Affect CSI Voxel Size
– Prescribing the VOI
– ROI Edge Sat Mask User Control Variable

• Spectroscopy Auto Prescan
• Spectroscopy Prescan
• CSI Storage

CAUTION: The safety precautions needed for a PROSE examination are 
identical to those required for any other Signa® 
examination. Review the Working Safely chapter in the 
Signa® Infinity with Signa Select™ (ASP2) Guide to make 
sure that the MR environment is as safe as possible for all 
patients.
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PROSE Description
A complete prostate examination combines high-resolution anatomical 
imaging of the pelvis with three-dimensional (3D) Chemical Shift Imaging 
(CSI) spectroscopy of the prostate gland. An endo-rectal coil in combination 
with the pelvic/torso phased array coil is employed to acquire the images 
and spectra. A surface coil intensity program, Prostate Analytical Coil 
Correction (PACC), is used to correct the images.

The CSI spectra are acquired with the PROSE spectroscopy pulse 
sequence. The PROSE pulse sequence provides, in a non-invasive 
manner, NMR signals (spectra) of some of the metabolites present in the 
prostate gland. Specifically, PROSE is version of the Point RESolved 
Spectroscopy (PRESS) sequence, a double spin echo sequence that uses 
a 90° excitation pulse with two slice selective refocusing radio frequency 
(RF) pulses, combined with 3D CSI phase encoding gradients to generate 
chemical shift images from a 3D voxel.

Coil Placement and Selection
The use of the body coil, for excitation, and an endo-rectal/pelvic phased 
array coil or an endo-rectal/torso phased array coil combination, for 
reception, allows for both the acquisition of high spatial resolution images 
and hydrogen spectra of the prostate, as well as coverage to the aortic 
bifurcation for the assessment of pelvic lymph nodes and bone metastases 
within the same examination. The accurate placement of the endo-rectal 
and pelvic/torso phased array coils is a critical aspect of the MRI/MRSI 
examination since it affects both the quality of the images and the spectra. 
Position the pelvic or torso phased array coil to cover the pelvis from the 
apex of the prostate to the aortic bifurcation. The endo-rectal coil is 
centered on the prostate in the sagittal plane and parallel to the prostate in 
the axial plane. Sagittal Fast Spin Echo (FSE) localizer images (reformatted 
in the axial plane) are used to check the positioning of the coils, which 
should be adjusted if necessary.

Currently, the endo-rectal coil employed is the expandable endo-rectal coil 
produced by Medrad (Medrad, Pittsburgh, PA). The General Electric 
Medical Systems (GEMS) pelvic phased array is combined with the 
endo-rectal coil via the ATDIII connector (Medrad, Pittsburgh, PA) as shown 
in Figure 6-1. The ATDIII connector is not compatible with the Low Profile 
Carriage Cover (LPCC). 
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Figure 6-1 GE Pelvic Array with the Medrad Expandable Endo-Rectal Coil

The ATD-T connector (Medrad, Pittsburgh, PA) is used when you combine 
the endo-rectal coil and a torso phased array coil (Figure 6-2). 

Figure 6-2 GE Torso Array with the Medrad Expandable Endo-Rectal Coil

The corresponding coil selections are listed in Table 6-1.

Table 6-1 Coil Selections

Coil Configuration 
Name Combiner Coil Combination

PELVICPA ATDIII Pelvic Phased Array/Endo-rectal

TORSOPA ATD Torso Phased Array/Endo-rectal

ATDTORSO ATD Torso Phased Array/Endo-rectal

ADT3ENDO ATDIII Endo-rectal

ENDOATD ATD Endo-rectal
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Ensure the coil chosen covers the entire prostate gland by checking the 
signal coverage (Figure 6-3) from superior (S) to inferior (I) using sagittal 
localizer FSE images. Also check the anterior (A) to posterior (P) coverage 
to make sure the coil is not rotated.

Figure 6-3 Checking the Coil Position

NOTE: Refer to the instructions provided with the endo-rectal coil to properly 
set up the coil for the prostate examination.

Prostate Imaging
High-resolution images are an important part of the prostate spectroscopy 
and imaging examination. In a typical prostate examination, a set of sagittal 
localizer images are used to graphically prescribe the acquisition of two 
sets of axial or axial oblique images, and to graphically prescribe a coronal 
acquisition. The localizer images are also used to check for correct coil 
placement.

After the acquisition of sagittal localizer images, axial T1-weighted 
conventional Spin Echo (SE) images are obtained from the symphysis pubis 
to the aortic bifurcation. These images are used to assess the presence of 
pelvic lymph node and bone metastases, and to determine if there is 
post-biopsy hemorrhage in the prostate. 

Figure 6-4 is an axial oblique image of the prostate gland acquired with a T1 
SE pulse sequence.
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Figure 6-4 Axial Oblique SE

If it is not possible to acquire all of the T1-weighted, axial slices through the 
pelvic anatomy without increasing the repetition time (TR), you should 
acquire the images in two sets with a smaller TR (~500-766 ms). 

During the acquisition of the T1-weighted images, you can reformat the 
sagittal images so you can check the positioning of the endo-rectal coil in 
the axial plane (to see the coil in the axial plane, the R/L prescription should 
cover the region from, roughly, R30 to L30). Adjust the endo-rectal coil, if 
necessary, before acquiring the T2-weighted images. Heavily T2-weighted, 
high-resolution, FSE images are acquired in the axial and coronal planes 
through the prostate and seminal vesicles to identify prostate zonal 
anatomy and pathology. The total time for the set up and acquisition of the 
MRI data is approximately 20 to 30 minutes. The specific imaging 
prescriptions are shown in Table 6-2.

Table 6-2 Prostate Imaging Prescriptions

1If the spectral data are acquired obliquely to match the angle of the prostate in the S/I 
dimension, the axial and coronal images must also be acquired obliquely to overlay spectra 
and reference images.
2The oblique coronal images are acquired perpendicular to the oblique axial images.

Sagittal Axial of 
Pelvis

Axial or 
Axial 

Oblique1

Coronal or 
Coronal 
Oblique2

Axial or 
Axial 

Oblique
PSD FSE T1 SE T2 FSE FSE PROSE
TE/TR 90/1000 8/766 96/6000 96/5000 130/1000
FOV 24 24 14 16 11
Thickness 5 5 3 3 25 - 40
Spacing 1.5 1.0 0.0 0.0 NA
Freq 256 256 256 256 16
Phase 192 192 192 192 8
NEX 1 1 3 3 1
Freq DIR S/I A/P A/P R/L R/L
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Prostate Analytical Coil Correction
Typically, images acquired with receive surface coils exhibit high signal 
intensity in regions close to the surface coil due to the inherent reception 
profile of the surface coil. This high signal intensity makes it difficult to 
window and level, or to interpret the images. The Prostate Analytical Coil 
Correction program, PACC, applies a surface coil intensity correction 
algorithm to the high-resolution images acquired from the prostate. The 
reception profiles of the endo-rectal and external phased array coils are 
analytically determined, and the acquired images are divided by the 
reception profiles. The analytical, endo-rectal coil correction algorithm 
requires knowledge of the position of the coil relative to the uncorrected 
images; the PACC user interface allows you to determine the location of the 
coil, thereby providing the location to the correction algorithm. The following 
text describes the PACC user interface (Figure 6-5).

Figure 6-5 PACC Window

The PACC program runs in the Browser. Before accessing the program, 
select a series that you wish to correct. It is not necessary to initially select a 
series, but it saves time if you select the exam and series with the Browser 
tools prior to starting the PACC program. Refer to the steps in the How Do 
I... section of this chapter to correct images with PACC.
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NOTE: Do not run the PACC tool and the Viewer or Mini Viewer at the same 
time. You must quit the PACC program before starting the Viewer or 
Mini Viewer (and vice versa).

Prostate Spectrum
Typical MR spectra from the human prostate are shown in Figure 6-6. The 
prominent resonance peak at ~2.6 PPM arises from the citrate molecules 
secreted by the prostate gland. Additional peaks that may be visible in the 
spectra at ~3.2, ~3.1, and ~3.0 PPM are ascribed to choline, polyamines, 
and creatine, respectively. Table 6-3 lists the chemical compounds that may 
be observed in prostate spectra.

Figure 6-6 Human Prostate NMR Spectra

Table 6-3 Prostate Spectra Chemical Compounds

Chemical Compound Chemical Shift (PPM)
Citrate 2.6

Choline 3.2

Polyamines 3.1

Creatine 3.0
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Water and Lipid Signal Suppression
The suppression or exclusion of large water and lipid/fat signals is critical to 
the successful acquisition of in vivo spectroscopic data. In the PROBE/SVQ 
sequences, those used to acquire spectra from the brain, the lipid/fat 
signals are excluded through the careful placement and selection of a 3D 
PRESS or STEAM volume or voxel, and the water signals are suppressed 
with three CHESS (Chemical Selective Suppression), RF/gradient pulse 
pairs. In the prostate, however, it is often impossible to place the voxel so as 
to exclude tissues that contain lipid/fat. Therefore, two additional 
suppression methods are available in the PROSE sequence: BASING and 
SSRF. The SSRF (Spectral Spatial Radio Frequency) technique is the 
default suppression method employed in PROSE. Dual-band SSRF pulses 
are employed to reduce the water signal and exclude the lipid frequencies. 
The metabolite region is fully excited by the SSRF pulses. The SSRF 
excitation band is broad enough to tolerate a 25 Hz shift of the SSRF pulse 
and still excite the metabolites. With SSRF, the water and lipid signals are 
not suppressed, but instead water is partially excited while the lipids are not 
excited by the SSRF pulses. In addition, the SSRF pulses have a strong 
non-linear, phase modulation that reduces peak RF power by 40%, an 
important consideration for body-coil excitation. The SSRF technique is an 
Imaging Option that is automatically selected for PROSE. If SSRF is not 
selected, the BASING (BAnd Selective INversion Gradient dephasing) 
suppression technique is used in the PROSE sequence. This method is not 
recommended since it requires more peak power and is less reliable than 
the SSRF method. The BASING technique uses two 180° inversion RF 
pulses applied along the frequency axis and two crusher gradients with 
opposite polarity. Simply, the hydrogen atoms excited by the 180° BASING 
RF pulses are dephased, destroying the resulting spin echo; hydrogen 
atoms not excited by the RF pulses are refocused by the bipolar gradient 
pair.

The SSRF technique provides more consistent water, lipid, and slice 
selective suppression than the BASING suppression technique. 
Additionally, in practical use, the SSRF pulses produce fewer spectral 
phasing artifacts, i.e., inverted or distorted (dispersive) peaks, than 
produced with the BASING technique.

PROSE Scan Parameters
Acquisition parameters for the PROSE sequence are described in the 
following sections. These parameters allow you to acquire chemical shift 
images from a volume through the prostate gland as prescribed from valid 
localizer images of the prostate.
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© 2002 General Electric Company. All rights reserved.



PROSE Pulse Sequence
Imaging Options
As indicated in Table 6-4, there are three options available with the PROSE 
sequence: Extended Dynamic Range, Cardiac Gating/Triggering, and 
Spectral Spatial RF. In the default mode of the PROSE sequence, the SSRF 
pulses and Extended Dynamic Range (EDR) options are selected 
automatically. In Table 6-4, the X’s indicate the options available for use 
with the PROSE pulse sequence.

Table 6-4 PROSE Pulse Sequence Imaging Options

Phase Encoding Matrix Selections 
3D CSI requires three matrix selections: frequency, phase, and slice (Locs 
per Slab). The allowed choices for each matrix dimension are 8, 10, 12, 14, 
and 16. Acquisition time and the prescription of isotropic CSI voxels are the 
main considerations in choosing the matrix dimensions. For example, the 

Imaging Options 
None Variable Bandwidth

Flow Compensation No Phase Wrap

POMP X Extended Dynamic Range

Square Pixel Surface Coil Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer Sequential

X Cardiac Gating/Triggering Respiratory Gating/Triggering

Tailored RF IR Prepared

DE Prepared Multi-Phase

Full Echo Train CCOMP

ZIP 1024 ZIP 512

Zip x 2 ZIP x 4

SmartPrep Blood Suppression

Multi Station Real Time

T2 Prep Navigator

Phase Sensitive X Spectral Spatial RF

ASSET Calibration Fluoro Trigger

ASSET
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8x8x8, 12x12x12, and 16x16x16 choices consist of 512, 1728, and 4096 
phase encoding steps, respectively. For a TR of 1000 ms, the respective 
acquisition times are 8:32, 28:48, and 68:16.

The 16x8x8 matrix prescription is typically used when acquiring spectra 
from the prostate gland — these are the frequency, phase, and slice 
encoding dimensions. This means that there are 8 phase encoding steps in 
the slice dimension with each slice containing 128 (16x8) CSI voxels. It is 
important to assure that the 16 phase-encode direction is the same as the 
larger dimension of the selected region, typically R/L.

Parameters that Affect CSI Voxel Size
The goal in selecting the field of view (FOV) and the spacing parameters is 
to prescribe isotropic, i.e., cubic, CSI voxels. The in-plane dimensions of a 
CSI voxel depend on the FOV selection and the in-plane phase encoding 
matrix selections. In the scan plane, square CSI pixels are obtained 
whenever the frequency and phase matrix selections are equal, e.g., 8x8, 
or when one selection is twice as large as the other, e.g., 16x8. While the 
first example should be clear, the second occurs from the manner in which 
the PROSE pulse sequence treats unequal matrix selections; the sequence 
adjusts the shape of the FOV to maintain square CSI pixels. For example, 
for a FOV of 11 cm, the 16x8x8 phase encoding matrix yields square CSI 
pixels with edges of 110/16 mm = 55/8 mm = 6.875 mm. An 11 cm FOV with 
an 8x8x8 matrix would yield pixels that are 110/8 = 13.75 mm on an edge. 
The pulse sequence always uses a square FOV or a rectangular FOV with 
a 0.5 aspect ratio, i.e., an actual 110 mm by 55 mm FOV for a 16x8 matrix 
with the 110 mm FOV selection.

The Spacing parameter selection should be chosen to match the square 
CSI pixel dimension. The PROSE sequence automatically calculates the 
spacing selection for the isotropic dimension once you have selected the 
FOV and phase encoding matrix; the first entry in the Spacing text box is 
the calculated isotropic dimension. For the example, FOV = 11 cm, 
matrix = 16x8x8, the first entry on the Spacing menu would be 6.9 mm 
(= 55/8 mm). If another Spacing value is selected the CSI voxel will not be a 
cubic volume.

The extent of the total phase encoded, CSI volume is determined by the 
FOV, the phase encoding matrix selections, and the Spacing selection. 
When the frequency and phase matrix selections are the same, e.g., 8x8x8, 
the volume is given as FOV x FOV x (Spacing x Locs per Slab). For unequal 
phase encoding matrix selections, e.g., 16x8x8, the volume is given as FOV 
x (FOV/2) x (Spacing x Loc per Slab). The phase encoding thickness in the 
“slice” dimension is the product of the Spacing and Loc per Slab entries 
(Spacing x Locs per Slab). For example, for an 11 cm FOV, a 16x8x8 matrix, 
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and a Spacing selection of 7.5 mm, the slice phase encoding would cover a 
nominal thickness of 60 mm (= 7.5 mm x 8). The total CSI phase encoding 
volume for this example would be 110 mm x 55 mm x (7.5 mm x 8).

Scan Timing Parameters
The echo time (TE) of 130 ms is the default selection for PROSE data 
acquisitions. This echo time has been selected to optimize the appearance 
of the citrate resonance peak; other choices of TE may lead to substantial 
modulations, i.e., distortions, of the citrate peak.

A TR of 1000 ms leads to reasonable acquisition times and is a good 
compromise between short acquisition times and signal saturation at 
shorter values of TR. To avoid any signal saturation, the TR should be 
around five times longer than the T1 time of the resonances of interest (TR 
> 5 x T1), which would require a TR time greater than 3000 ms. Single voxel 
spectra of the brain are typically acquired with a TR of 1500 ms, while CSI 
brain and prostate spectra are usually acquired with a TR of 1000 ms.

In CSI acquisitions, NEX works exactly as it does in standard imaging 
sequences. In clinical practice, for example, a NEX value of 1 is used with 
the 16x8x8 phase encoding selection, and a NEX value of 2 when the 
8x8x8 selection is prescribed; if the TR times are the same, the acquisition 
times are the same for both prescriptions. Acquisition times increase 
linearly with increases in NEX.

Scan Mode User Control Variable
There are four Scan Mode choices: two imaging acquisition modes (-1 and 
0) and two spectroscopy acquisition modes (1 and 2). The default value 
is 1. Table 6-5 provides a description of each scan mode.

Table 6-5 Scan Modes

Scan Mode Description

-1

An image of the slice centered within the voxel is acquired 
with thin saturation (SAT) bands placed at the edges of the 
prescribed voxel. This image clearly shows the location of 
the voxel relative to the entire slice and can be used to 
confirm the location of the voxel. With this selection, you 
should decrease the TR and TE prescribed for the 
spectroscopy acquisition to reduce the scan time. You may 
also wish to increase the FOV of the imaging acquisition to 
better visualize the location of the voxel relative to the 
anatomy around the prostate gland.
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Prescribing the VOI
The PROSE ROI is graphically prescribed on the appropriate prostate 
localizer images, typically on the axial or axial oblique T2 FSE images. The 
region of interest (ROI) should be drawn so that the prostate gland is 
entirely within the ROI, while excluding the rectum or endo-rectal coil to 
minimize susceptibility artifacts.

When prescribing the volume of interest (VOI), the ROI should be placed 
and sized on an axial or axial oblique image. With the ROI in place, you are 
able to scroll through the images to determine the extent of the prostate 
gland. Once you have determined the third dimension of the voxel, you can 
either use the [Start] and [End] buttons to graphically set the thickness of 
the voxel, or you can deposit the ROI at the center of the VOI and enter the 
voxel thickness manually. Once a VOI has been set on the Graphic Rx 
screen, you can use the [Reset Center] button to reset the center of the 
VOI to the center of the displayed localizer slice.

0

An image of the voxel is acquired, stored, and displayed. In 
this acquisition, only the signal from the prescribed volume 
is acquired, that is, the rest of the image is blank or consists 
only of noise. With this selection, you should decrease the 
TR and TE prescribed for the spectroscopy acquisition to 
reduce the scan time.

1

The spectroscopy acquisition selections control the CSI 
reconstruction — the acquisitions are identical. The 
chemical shift images are reconstructed at the centers of the 
localizer images within the prescribed CSI volume. The CSI 
voxels are centered at the centers of the localizer images. 
When using the CSI display tool, the reference images are 
the exact matches to the overlaid metabolic images. This is 
the default mode.

2

The spectroscopy acquisition selections control the CSI 
reconstruction — the acquisitions are identical. The 
chemical shift images are reconstructed as per the 
acquisition prescription. The number of reconstructed 
chemical shift images is equal to the number of Locations 
per Slab and the images are centered at the phase encoding 
locations determined from the Spacing selection. When 
using the CSI display tool, the reference images are the 
closest match to the metabolic images. If the match is not 
exact, a message appears stating "Not a perfect match."

Scan Mode Description (Continued)
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Figure 6-7 Volume 
Prescription

Prescription goals:
• Cover the gland, 

especially the peripheral 
zone.

• Minimize inclusion of 
air-interface.

• Minimize lipid inclusion. 

Typical PROSE right/left (R/L), anterior/posterior (A/P), superior/inferior 
(S/I) dimensions are 55 mm, 35 mm, and 30 mm, respectively. These 
dimensions are dependent on the size of the prostate gland.

ROI Edge Sat Mask User Control Variable
There are 36 Very Selective Suppression (VSS) RF pulses available with 
the PROSE sequence. In the current implementation, the 36 VSS pulses 
are grouped in 12 sets of 3 pulses. Basically, a suppression pulse is 
repeated three times for each prescribed location. The following discussion 
describes the placement and prescription of the 12 suppression band 
groups.

In the default operating mode, 3 pairs of VSS RF suppression bands (6 
pulses groups, a total of 18 RF pulses) are placed symmetrically around the 
prescribed PROSE VOI. The PROSE sequence uses the six default VSS 
bands to define the PROSE volume. This technique is associated with the 
three Overpress control variables. The prescribed PROSE volume is 
increased by 30% along the R/L and S/I dimensions, and 10% along the 
A/P dimension; the corresponding Overpress CV factors are 1.30, 1.30, and 
1.10, respectively. The use of the Overpress technique to define the 
PROSE volume insures the entire PROSE volume is well within the 
passband of the RF pulses used to excite the volume. This means all of the 
CSI voxels within the PROSE volume are useful and reliable, i.e., a signal 
at the edge of an Overpress VOI is as reliable as a signal at the center of 
the VOI.

The pairs of VSS pulses at the edges of the VOI can be selected or 
deselected with the ROI edge sat mask User Control Variable, which 
appears on the User CVs screen. This User CV allows independent control 
of the three VSS pulse pairs placed at the Right/Left (R/L), 
Anterior/Posterior (A/P), and Superior/Inferior (S/I) edges of the VOI. Since 
the six default VSS bands are used to define the PROSE VOI, deselecting 
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any of the six default VSS bands will cause the PROSE volume to increase 
by the “OVERPRESS” factor for that dimension which may increase lipid 
contamination of the spectra. Deselection of the six default VSS bands is 
not recommended.

The selection rules are based on assigning a numeric value to each pair; 
R/L = 1, A/P = 2, S/I = 4, and 0 to no VSS pulse. With these definitions, a 
single number from 0 to 7 can be used to select the individual pairs (1, 2, 4), 
the two pair combinations (the sums 3, 5, 6), the default three pair 
combination (7=1+2+4), or no pulses (0). Table 6-6 defines the seven 
possible selections.

Table 6-6 ROI Edge SAT Mask User CV

You can prescribe up to six additional VSS bands (each consisting of three 
VSS RF pulses). Typically, four VSS RF bands are prescribed on the T2 
axial localizer images using the SAT Rx, Additional Parameter screen. The 
two remaining bands, if used, are usually prescribed on the sagittal localizer 
images. The graphic prescription process provides visible feedback of the 
VSS band positioning and thickness. The VSS bands may be changed in 
thickness and angle, and may be placed anywhere on the localizer image. 
The thickness is given in millimeters and can be changed with the graphic 
prescription tools or by typing a numerical entry in the Thickness text box.

You can use the VSS bands to shape the rectangular PROSE voxel to 
better match the prostate, for example, by cutting off the corners of the ROI. 
VSS bands should be used to eliminate periprostatic lipid signals and the 
susceptibility shifted signals that may arise at the air-tissue interfaces that 
are included in the PRESS volume. The VSS bands are prescribed so as to 
suppress these lipid signals.

A typical example is shown in Figure 6-8.

Selection SAT Band Placement
0 Off – no VSS RF pulses.

1 S/I – the superior (S) and inferior (I) pulses only.

2 A/P – the anterior (A) and posterior (P) pulses only.

3 S/I and A/P – two pulse pairs, where 3=1+2.

4 R/L – the Right (R) and Left (L) pulses only.

5 R/L and S/I – two pulse pairs, where 5=1+4.

6 R/L and A/P – two pulse pairs, where 6=2+4.

7 R/L, A/P, and S/I – three pulse pairs, this is the default value.
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Figure 6-8 Example VSS Band Prescription

Spectroscopy Auto Prescan
In addition to the standard prescan parameters determined by the Auto 
Prescan (APS) processes, the PROSE sequence includes an Autoshim 
process to optimize the homogeneity through the PROSE voxel. 

Good homogeneity is critical for a successful PROSE acquisition. The Full 
Width Half maximum (FWHM) line width as reported on the Advisory Panel 
as "LnWdth" is a good indicator of the homogeneity through the PROSE 
volume. The line width value should not be greater than 15 Hz for a typical 
55 cmx35 cmx30 cm, PROSE voxel. Typically, the line width value 
increases as the PROSE volume increases.

If the reported value of the line width is greater than 15 Hz, use one of the 
following suggestions:
• If the line width is greater than 15 Hz, select and run APS again.
• If the line width is still greater than 15 Hz, re-prescribe the PROSE 

volume or the VSS bands. Be sure that you place the PROSE volume to 
avoid the endo-rectal coil and the air-tissue interface around the rectum. 
You can place the VSS bands to suppress signals from regions of high 
inhomogeneity. Select and run APS again.

• If the line width is still too large, you can try to reposition the PROSE 
volume and VSS bands again. Select and run APS again. If APS does 
not deliver a line width less than 16 Hz, you can try to manually adjust 
the homogeneity, or visually inspect the spectrum on the Spectroscopy 
Screen as described in the Spectroscopy Prescan section.
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We no longer fully suppress the water signal; rather, a substantial residual 
water signal is required for successful CSI data reconstruction. The water 
suppression level (Supp Lvl) percentage, reported on the Advisory Panel, 
should range from 90 to 95%. Values outside of this range are acceptable, 
but you may wish to visually inspect the spectrum before scanning.

Spectroscopy Prescan
The Spectroscopy Prescan window, Figure 6-9, consists of two display 
windows, each with a display control panel just below the window, and a 
region at the left of the screen that allows for parameter entry, adjustment, 
and control. A typical PROSE spectrum from the entire PROSE volume is 
shown in both display windows in Figure 6-9.

You can visualize and examine the spectrum acquired from the entire 
PROSE volume in the Spectroscopy Prescan window. It may be possible to 
improve the homogeneity through the PROSE volume by manually 
adjusting the X, Y, and Z gradient currents in the Gradient Shimming area 
on the Spectroscopy Prescan window.

Figure 6-9 Spectroscopy Prescan Window
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CSI Storage
After a successful PROSE data acquisition, the reconstruction process 
creates 256 phased corrected chemical shift images, which are drawn on 
one 512x512 image per prescribed slice (the number and spacing of the 
slices depends on the Scan Mode selection; a User CV). The chemical shift 
storage images are stored in a separate series in the patient database. The 
256 chemical shift images from each slice cover the frequency range from 
4.30 to 0.49 PPM. Spectra, metabolite and metabolite ratio images, 
reference images, and chemical shift images are displayed with the 
Functool 2 display tool on the Browser.
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How Do I...
This section provides the step-by-step instructions for performing a PROSE 
examination. Specifically, it describes how to:
• Acquire Localizer Images
• Acquire High-Resolution Images

– Acquire Axial SE Images
– Acquire Axial Oblique FSE Images
– Acquire Coronal Oblique Images

• Correct Images with PACC
• Prescribe a PROSE Acquisition
• Make Prescan Adjustments

– Examine the Spectrum
– Manually Adjust the Homogeneity

This section also provides a brief look at an example PROSE protocol.

Decision Matrix
A decision matrix is used in this section to provide examples of what values 
could be selected for prescribing a particular sequence. The purpose of the 
decision matrix is to help you understand the trade-offs that occur when you 
change the values for a particular parameter and to provide a framework 
with which you may build your own unique protocol.

The example protocols provide information on what could be used for these 
pulse sequences and are not to be considered recommendations by GE 
Medical Systems. For specific protocols, refer to the protocols on your 
system.

In addition to listing the information you need to select on the system, the 
“What You Select” column of the matrix uses two other conventions.
• N/A indicates that the imaging parameter is not applicable to the pulse 

sequence example.
• N/S indicates that the imaging parameter is not selectable in the pulse 

sequence example. The system automatically selects these imaging 
parameters.
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Acquire Localizer Images
In a typical prostate examination, FSE sagittal localizer images are acquired 
to guide the prescription of high-resolution axial or axial oblique images, 
and coronal oblique images through the prostate gland. 

Table 6-7 provides a brief look at an example protocol for acquiring a 
sagittal localizer of the prostate. The parameters may vary depending on 
your needs.

Table 6-7 FSE Sagittal Localizer Protocol Example

NOTE: The Grad Mode text box is only available on TwinSpeed™ 
Resonance Module (TRM) systems.

Parameter What You 
Select Parameter What You 

Select
Imaging Parameters Scanning Range

Patient Position Supine FOV 24 cm

Patient Entry Feet First Slice Thickness 5 mm

Coil Torso ATDT Spacing 1.5

Plane Sagittal Start 
Mode 2D End 
Pulse Sequence FSE # Slices
Grad Mode Zoom Acquisition Timing
Imaging Options None Freq 256

PSD Name N/A Phase 192

Scan Timing NEX 1
# of Echoes 1 Phase FOV 1

TE 90 Freq DIR default

TR 1000 Auto Center Freq Water 
Flip Angle N/A Flow Comp DIR N/A

Echo Train Length 16 Autoshim On

Bandwidth 20.83 Phase Correct Off
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Acquire High-Resolution Images
Acquire Axial SE Images
The axial or axial oblique SE images are used to survey the pelvis and 
locate the endo-rectal coil relative to the prostate gland to aid in correcting 
images with the PACC program. 

Table 6-8 provides a brief look at an example protocol for acquiring axial or 
axial oblique SE images of the prostate. The parameters may vary 
depending on your needs.

Table 6-8 SE Axial Protocol Example

NOTE: The Grad Mode text box is only available on TwinSpeed™ 
Resonance Module (TRM) systems.

If it is not possible to acquire all of the T1-weighted, axial slices 
through the pelvic anatomy without increasing the repetition time 
(TR), you should acquire the images in two sets with a smaller TR 
(~500 to 766 ms).

Parameter What You 
Select Parameter What You 

Select
Imaging Parameters Scanning Range

Patient Position Supine FOV 24 cm
Patient Entry Feet First Slice Thickness 5 mm

Coil Torso ATDT Spacing 1.0

Plane Axial or Axial 
Oblique

Start Use Graphic Rx 
to determine 
start and end 
locations.Mode 2D End 

Pulse Sequence SE # Slices Cover the 
entire pelvis.

Grad Mode Zoom Acquisition Timing
Imaging Options None Freq 256

PSD Name N/A Phase 192

Scan Timing NEX 1
# of Echoes 1 Phase FOV 1

TE 8 Freq DIR A/P

TR 766 Auto Center Freq Water 
Flip Angle N/A Flow Comp DIR N/A

Echo Train Length N/A Autoshim On

Bandwidth 20.83 Phase Correct Off
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Acquire High-resolution Images
Acquire Axial Oblique FSE Images
High-resolution images are an important part of the prostate spectroscopy 
and imaging examination. The axial or axial oblique FSE images can be 
used to prescribe the PROSE volume for the PROSE sequence.

Table 6-9 provides a brief look at an example protocol for acquiring axial or 
axial oblique FSE images of the prostate. The parameters may vary 
depending on your needs.

Table 6-9 FSE Axial Oblique Protocol Example

NOTE: The Grad Mode text box is only available on TwinSpeed™ 
Resonance Module (TRM) systems.

Parameter What You 
Select Parameter What You 

Select
Imaging Parameters Scanning Range

Patient Position Supine FOV 14 cm
Patient Entry Feet First Slice Thickness 3 mm

Coil Torso ATDT Spacing 0.0

Plane Axial or Axial 
Oblique

Start Use Graphic Rx 
to determine 
start and end 
locations.Mode 2D End 

Pulse Sequence FSE # Slices Cover entire 
prostate.

Grad Mode Zoom Acquisition Timing
Imaging Options None Freq 256

PSD Name N/A Phase 192

Scan Timing NEX 3
# of Echoes 1 Phase FOV 1

TE 96 Freq DIR A/P

TR 6000 Auto Center Freq Water 
Flip Angle N/A Flow Comp DIR N/A

Echo Train Length 16 Autoshim On

Bandwidth 20.83 Phase Correct Off
2333956-100 Rev. 0 (06/02)  6-23
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
Acquire High-resolution Images
Acquire Coronal Oblique Images
High-resolution images are an important part of the prostate spectroscopy 
and imaging examination. In addition to the axial SE and FSE images, 
coronal FSE images are also a necessary component of a PROSE 
examination. The coronal images may allow for reformatting of the CSI data 
in another plane.

Table 6-10 provides a brief look at an example protocol for acquiring coronal 
FSE images of the prostate. The parameters may vary depending on your 
needs.

Table 6-10 FSE Coronal Protocol Example

NOTE: The Grad Mode text box is only available on TwinSpeed™ 
Resonance Module (TRM) systems.

Parameter What You 
Select Parameter What You 

Select
Imaging Parameters Scanning Range

Patient Position Supine FOV 16 cm

Patient Entry Feet First Slice Thickness 3 mm

Coil Torso ATDT Spacing 0.0
Plane Coronal or 

Oblique 
Coronal

Start Use Graphic Rx 
to determine 
start and end 
locations.Mode 2D End 

Pulse Sequence FSE # Slices Cover entire 
prostate.

Grad Mode Zoom Acquisition Timing
Imaging Options None Freq 256

PSD Name N/A Phase 192

Scan Timing NEX 3
# of Echoes 1 Phase FOV 1

TE 96 Freq DIR default

TR 5000 Auto Center Freq Water 

Flip Angle N/A Flow Comp DIR N/A
Echo Train Length 16 Autoshim On

Bandwidth 20.83 Phase Correct Off
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Correct Images with PACC
Prostate images acquired with an endo-rectal coil usually 
exhibit bright signals near the coil. To correct for this brightness, 
use the PACC program to apply a surface coil intensity 
correction algorithm to the high-resolution images. This 
program allows you to determine the location of the endo-rectal 
coil relative to the uncorrected images, thereby providing the 
location to the correction algorithm. The corrected images are 
used to prescribe a 3D volume containing the prostate gland.

Use this procedure to correct images acquired with an 
endo-rectal coil.

1. Select the series of the examination you wish to correct with 
PACC from the Browser.

It is not necessary to initially select a series, but it saves 
time if you select the Exam and Series with the Browser 
tools prior to starting the PACC program.

2. Click [PACC] on the right-most Browser panel to access the 
PACC program.

The PACC graphic user interface, with four display 
windows and a simple control panel, displays on the 
desktop.

If you have selected a series on the Browser, three 
images display in the PACC window.

3. As necessary, click [Exam], [Series], and [Image] to select 
a sagittal image that you will use to locate the endo-rectal 
coil in the sagittal plane.

4. Display the SE axial/oblique coil locator image in the upper 
right display window.

a) Click anywhere in the upper right display window.

b) As necessary, click [Exam], [Series], and [Image] to 
select an axial/oblique image that you will use to locate 
the endo-rectal coil in the axial plane. 

– One of the coil locator images must be in the 
axial/oblique plane and the other in the sagittal.

Quick Steps: Correct 
Images with PACC
1. Select the series of the 

examination you wish to 
correct with PACC from 
the Browser.

2. Click [PACC] on the 
right-most Browser panel 
to access the PACC 
program.

3. As necessary, click 
[Exam], [Series], and 
[Image] to select a 
sagittal image that you 
will use to locate the 
endo-rectal coil in the 
sagittal plane.

4. Display the SE 
axial/oblique coil locator 
image in the upper right 
display window.

5. Display the FSE 
axial/oblique series to be 
corrected in the lower left 
display window..

6. Choose two coil location 
pick points on each of the 
images in the upper left 
and upper right display 
windows.

7. When you are satisfied 
with your selections, click 
[Correct Series]. 

8. Click [Quit] to exit the 
PACC user interface at 
any time when image 
correction is complete.
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5. Display the FSE axial/oblique series to be corrected in the 
lower left display window.

a) Click anywhere in the lower left display window.

b) As necessary, click [Exam], [Series], and [Image] to 
display any image in the series to be corrected.

6. Choose two coil location pick points on each of the images 
in the upper left and upper right display windows. 

Set the [Set/Show] toggle to [Set] to select the points 
near the coil. 

– Refer to the example of the RAS coordinates of the 
selected points displayed below.

PACC Window

7. When you are satisfied with your selections, click [Correct 
Series]. 

The correction may take some time, so be patient. While 
a correction is in progress, the PACC user interface will 
not respond to any actions except [Cancel].
If the correction completes successfully, the message 
"Correction Successful" appears in the status bar. 
Otherwise an error message accompanied by a pop-up 
error message window is displayed. 

The corrected axial/oblique images are displayed in the 
lower right display window.

8. Click [Quit] to exit the PACC user interface at any time.

NOTE: Do not run the PACC tool, and the Viewer or Mini Viewer 
at the same time. You must quit the PACC program 
before starting the Viewer or Mini Viewer (and vice 
versa).
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Prescribe a PROSE Acquisition
PROSE is 3D multi-voxel spectroscopy sequence used to produce spectra 
from the human prostate gland area. The PROSE sequence is one 
segment of a comprehensive prostate examination. The following entries 
for the PROSE pulse sequence decision matrix allows you to acquire 
chemical shift images from a volume through the prostate gland as selected 
from valid localizer images of the prostate. 

This decision matrix (Table 6-11) describes a PROSE sequence 
prescription that acquires spectra from isotropic CSI voxels that are 6.9 mm 
on each edge. Any changes in the suggested FOV (11 cm), phase encoding 
matrix selection (16x8x8), frequency direction (R/L), or spacing (6.9) may 
result in non-isotropic voxels, decreased SNR, or dramatic changes in scan 
time.

Table 6-11 PROSE Sequence Protocol Example

PROSE Protocol Example
 What You Select Selection Notes

Scan Rx Desktop
Rx Manager area [New Series] Adds an additional series to the patient’s exam.

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series if the Patient 
Protocol screen becomes active.

Patient Position

Patient Position Supine 3D PROSE is used in prostate scanning, so the patient 
position and entry selections reflect that.

Patient Entry Feet First

Coil ENDOATD or 
ATD3ENDO Select the name given for the compatible coil (refer to Table 

6-1 for all compatible coils). Select the coil name that only 
turns on the endo-rectal portion of the coil. Turning on the 
body portion of the coil results in too many images.

Series Type in a series 
description in 
the text box.

If you do not enter a description, the system enters one for 
you. The series description default is the selected scan 
mode, PSD, and imaging options.
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Imaging Parameters

Plane Oblique An axial oblique prescription that matches the tilt of the 
prostate gland, helps in the placement of the PROSE 
volume, such that it avoids the rectum and the endo-rectal 
coil. PROSE is compatible with any scan plane, including 
oblique and 3-Plane Localizers. Select the same plane as 
the plane of the localizer images — this differs from the 
normal image prescription process.

Mode MRS PROSE is a small volume selective sequence, which is 
enabled with the MRS selection.

Grad Mode Whole Activate the Whole gradient mode of operation for the best 
shim. This text box is only available if your system has Twin 
gradients. 

Pulse Seq PROSE Select PROSE.

Imaging Options EDR, SSRF EDR (Extended Dynamic Range) and SSRF (Spectral 
Spatial RF) are default selections.

PSD Name N/A

Protocol N/A

PROSE Protocol Example
 What You Select Selection Notes
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Scan Timing

# of echoes 1 Only 1 echo is allowed.

TE 130 A TE value of 130 ms is recommended for best visualization 
of the citrate resonance peaks.

TE2 N/A

TR 1000 If the scan mode = 1, select a typical TR of 1000 ms. A 
longer TR results in increased SNR at the expense of 
increased scan time.
If the scan mode = 0, (voxel image) select the shortest 
allowed TR.

TI N/A

Flip Angle N/A

Echo Train Length N/A

Bandwidth N/S The Receiver Bandwidth is automatically selected for 
spectroscopy scans and cannot be programmed.

Bandwidth 2 N/A

PROSE Protocol Example
 What You Select Selection Notes
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Scanning Range

FOV 11 An 11 cm FOV when used with 16 phase encoding steps 
along the frequency direction, yields a 6.9 mm CSI voxel 
edge.

Voxel Thickness 50 Choose a voxel thickness large enough to cover the 
anatomy or pathology. The lower limit is 3 mm and the upper 
limit is 100 mm. The voxel thickness varies with the size of 
the prostate gland. A typical start value is 50 mm. The actual 
value is determined by defining the Start and End locations 
in Graphic Rx.

Spacing 6.9 (should be 
the first default 
selection)

The first menu option is calculated for an isotropic voxel. The 
system automatically calculates this based on your chosen 
FOV and matrix size. This value is not available until after 
matrix values and Graphic Rx locations are determined.

Locs per Slab 8 Eight is the recommended value. Acceptable values are 
even numbers from 8 to 16. As this value increases, scan time 
dramatically increases.

Acquisition Timing

Freq 16 The 16 and 8 selections yield isotropic CSI voxels that are 
6.9 mm on an edge.

Phase 8

NEX 1 As the NEX value increases, the SNR increases and the 
scan time increases.

PROSE Protocol Example
 What You Select Selection Notes
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Freq DIR Unswap Select the default value. The frequency direction should 
correspond to the long anatomical dimension, typically the 
R/L dimension for a body scan.

Auto Center Freq Water Select water.

Flow Comp DIR N/A

Autoshim On Select Autoshim to make the volume of interest as 
homogeneous as possible.

Phase Correct N/A

Additional Parameters - User CVs

Scan Mode 1.00 One (1) allows CSI images to reconstruct at the center of the 
localizer images within the PROSE volume.

ROI edge sat mask 7.00 Enables the placement of VSS bands around the VOI. Enter 
7, this enables R/L, A/P and S/I SAT band placement.

Accept [Accept] Confirms the User CV selections and closes the window.

PROSE Protocol Example
 What You Select Selection Notes
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Additional Parameters - Graphic and SAT Rx

Select Series [Select Series] Select the surface coil intensity corrected axial or axial 
oblique T2 FSE images.

Image Viewport Click the image 
to display the 
ROI.

Position the ROI to cover the entire prostate gland, while 
excluding the rectum and endo-rectum coil to minimize 
susceptibility artifacts. Click and drag the tick marks to 
re-size the ROI. Click and drag on the center of the ROI to 
re-position. Typical PROSE LR and AP dimensions are 
55 mm and 35 mm, respectively.

[+] Next and [-] Prior [+] and [-] Page through the images to determine the extent of the 
prostate gland.

Start Location [Start] Find the most inferior slice, click [Start].

End Location [End] Find the most superior slice, click [End]. A typical PROSE SI 
dimension (voxel thickness) is 30 to 40 mm. If the value is 
larger, it is difficult to adjust the shim over the entire volume.

SAT Rx Click the SAT 
icon

Place SAT bands around the prostate to remove signal from 
fat and from the rectum.

Accept [Accept] Confirms the voxel position and closes Graphic Rx.

Series Control
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the PROSE acquisition.

PROSE Protocol Example
 What You Select Selection Notes
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Scan Operations
Auto Prescan [Auto 

Prescan]
Determines and reports the center frequency (CF), the 
receiver gains (R1 and R2), the transmit gain (TG), gradient 
shim current offsets (reported as LnWdth in Hz), and the 
water suppression level. The shim line width for a typical 
PROSE volume should not exceed 15 Hz. If the value 
exceeds this limit, check to see if the prescribed volume 
includes the endo-rectal coil or the rectum.

Spectro Prescan [Spectro 
Prescan]

The Spectro Prescan is an optional choice that can be used 
to check on the line width and water and lipid suppression. 
Experienced users can use the tools on the Spectroscopy 
window to adjust the shim and improve the line width.

Scan [Scan] Initiates the acquisition.

PROSE Protocol Example
 What You Select Selection Notes
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Make Prescan Adjustments
Examine the Spectrum
You can use the following steps as a guide to visualize the 
spectrum acquired from the entire PROSE volume, and, 
possibly, use the Gradient Shimming control panel to optimize 
the shim through the volume.

1. Click [Spectro Prescan] on the ScanRx Desktop.

2. Check that the Entry Point text box value is single1.

3. Click [Start] to acquire a spectrum from the entire PROSE 
volume.

No CSI phase encoding gradients are played out during 
this acquisition.

4. Change the top display window to Magnitude and the 
bottom display window to Pure Absorp. 

The Waveform Display menu selections are in the first 
button at the left in the display window control areas.

If you have selected an "endo-rectal coil only" coil 
configuration, e.g., ENDOATD, signals from the 
endo-rectal coil should be displayed. 

5. If you are using a full phased array coil set, e.g., TORSOPA, 
you may have to select the endo-rectal coil to see the 
correct signal.

a) To display the signal from the endo-rectal coil, Select 
Options > Display Parameters from the Spectroscopy 
window menu bar. 

b) The endo-rectal coil selection is coil 2 for the 
pelvic/endo-rectal combination and coil 3 for the 
torso/endo-rectal combination.

– Signals from the coils are noted as 1, 2, 3, and 4. 

c) Click [Apply].

6. Observe the spectra in the display windows to see if the 
water peak is near the center of the window. It may be 
possible to see the metabolite peaks to the right of the water 
peak.

Quick Steps: Examine the 
Spectrum
1. Click [Spectro Prescan] 

on the Scan Rx Desktop.

2. Check that the Entry 
Point text box value is 
single1.

3. Click [Start] to acquire a 
spectrum from the entire 
PROSE volume.

4. Change the top display 
window to Magnitude 
and the bottom display 
window to Pure Absorp.

5. If you are using a full 
phased array coil set, 
e.g., TORSOPA, you may 
have to select the 
endo-rectal coil to see the 
correct signal.

6. Observe the spectra in 
the display windows to 
see if the water peak is 
near the center of the 
window. It may be 
possible to see the 
metabolite peaks to the 
right of the water peak.

7. Use the Zero Order 
Phase slider to make the 
peak in the pure 
absorption display 
window look like the 
magnitude display.
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You may have to increase the display scale (the up/down 
arrows below the display windows) in order to observe 
the metabolite peaks.

The pure absorption display is the better spectral display, 
but usually requires a Zero Order Phase adjustment. 

The magnitude display is always positive, but the peaks 
are broader than the pure absorption peaks and may be 
distorted.

7. Use the Zero Order Phase slider to make the peak in the 
pure absorption display window look like the magnitude 
display.

It should never be necessary to change the First Order 
Phase.

The baseline should be level on both sides of the water 
peak.

8. If you see a large lipid resonance that obscures the prostate 
metabolite resonance peaks, check and correct the 
placement of the VSS bands to eliminate the unwanted lipid 
signals.

9. Broad metabolite peaks are indicative of poor homogeneity. 
If the peaks are too broad, make the recommended checks 
and adjustments.

a) Check the position of the PROSE volume relative to the 
rectum and endo-rectal coil. Reposition the volume as 
necessary.

b) Check the locations of the prescribed VSS bands. The 
VSS bands can be used to suppress signals from 
regions of high inhomogeneity, i.e., the endo-rectal coil 
and the rectum.

c) Manually adjust the X, Y, and Z gradient currents to 
improve the homogeneity. Refer to the instructions, 
“Manually Adjust the Homogeneity”.

Quick Steps: Examine the 
Spectrum, cont.
8. If you see a large lipid 

resonance that obscures 
the prostate metabolite 
resonance peaks, check 
and correct the 
placement of the VSS 
bands to eliminate the 
unwanted lipid signals.

9. Broad metabolite peaks 
are indicative of poor 
homogeneity. If the peaks 
are too broad, make the 
recommended checks 
and adjustments.
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Make Prescan Adjustments
Manually Adjust the Homogeneity
It may be possible to improve the homogeneity through the 
PROSE volume by manually adjusting the X, Y, and Z gradient 
currents in the Gradient Shimming area on the Spectroscopy 
Prescan window. The following steps present an example 
approach that you may use to manually adjust the shim.

1. Click [Spectro Prescan] on the Scan Rx Desktop.

2. Check that the Entry Point text box value is single1. 

3. Change the top display window to Magnitude and the 
bottom display window to Pure Absorp or I Chan Raw.

The Waveform Display menu selections are in the first 
button at the left in the display window control areas.

Many spectroscopists prefer to use the I Chan Raw 
display to demonstrate homogeneity changes. In this 
case, you want the I Chan Raw signal to “ring” out as far 
as possible.

4. Increase the center frequency by 100 HZ with Center Freq 
(AX).

This change allows you to see an intense water peak in 
all the display windows. Be sure that you reset the center 
frequency before leaving the Spectroscopy window.

5. Click [Start] to acquire a spectrum from the entire PROSE 
volume.

6. Watch the shape and the height of the water peak in both 
display windows. 

Look for distortions near the base of the water peak 
displayed in the Pure Absorp display window. 

7. Record the initial Gradient Shimming values for the X, Y, 
and Z gradients.

Center the gradient current shim sliders. Use the C 
button to the left of the sliders. Record the initial shim 
current values.

8. Adjust the Gradient Shimming sliders, beginning with the Z 
gradient.

The sliders have a range of ±10 steps around the center 
value.

Quick Steps: Manually 
Adjust the Homogeneity
1. Click [Spectro Prescan] 

on the Scan Rx Desktop.

2. Check that the Entry 
Point text box value is 
single1.

3. Change the top display 
window to Magnitude 
and the bottom display 
window to Pure Absorp 
or I Chan Raw.

4. Increase the center 
frequency by 100 HZ with 
Center Freq (AX).

5. Click [Start] to acquire a 
spectrum from the entire 
PROSE volume.

6. Watch the shape and the 
height of the water peak 
in both display windows. 

7. Record the initial 
Gradient Shimming 
values for the X, Y, and Z 
gradients.

8. Adjust the Gradient 
Shimming sliders, 
beginning with the Z 
gradient.

9. Adjust the Y gradient 
current in ±2 steps.

10. Adjust the X gradient 
current in ±2 steps.

11. After adjusting the three 
gradient currents, repeat 
the adjustments in the 
same order with a ±1 unit 
step.
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a) Increase the value a +2 steps by moving the slider as far 
as it will move to the right, while watching the water peak. 

– It takes at least two window display updates to see the 
effect of a gradient current change.

– You want the water peak to become narrower, while 
keeping the bottom of the water peak smooth.

b) If the peak narrows, increase the Z gradient value again 
by +2 steps.

– You can re-center the value by clicking [C].
c) Continue to increase the value until the peak starts to 

distort or fails to narrow. 

– Always return to the last good value.

d) If the peak shape degrades or broadens with a +2 step 
change, move the slider all the way to the left (a change 
from the initial value of -2 steps). 

– Remember, you need to wait at least two display 
updates to see the change.

e) Examine at the line shape. 

– If the shim improves after the -2 step change, 
decrease the shim current by another 2 steps until the 
peak stops narrowing or until the shape degrades. 

f) Stop at the best shape.

9. Adjust the Y gradient current in ±2 steps.

10. Adjust the X gradient current in ±2 steps.

11. After adjusting the three gradient currents, repeat the 
adjustments in the same order with a ±1 unit step. 

NOTE: The AutoShim results are usually good enough that you 
can start with ±1 or ±2 unit changes rather than the 
coarse ±10 unit adjustments. The best procedure is to 
use a consistent, reproducible method similar to that 
described above.

12. Once you are satisfied with the spectral line widths and 
shapes, click [Done] to leave the Spectroscopy window.

13. Click [Scan].

Quick Steps: Manually 
Adjust the Homogeneity, 
cont.
12. Once you are satisfied 

with the spectral line 
widths and shapes, click 
[Done] to leave the 
Spectroscopy window.

13. Click [Scan].
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PROSE Protocol Example
Prescribe the PROSE volume on the axial T2 FSE images. The 3D CSI 
images are reconstructed on the centers of the T2 FSE images contained 
within the prescribed PROSE volume if the User CV Scan mode selection 
equals one.

Table 6-12 provides you with a brief look at an example protocol. The 
parameters may vary depending on your needs.

Table 6-12 PROSE Protocol Example

NOTE: The voxel thickness changes when you prescribe the PROSE volume 
with the ‘Start” and End” selections on the Graphic Rx screen.

The goal is to select isotropic CSI voxels. With an 11 cm FOV and 
the 16x8x8 phase encoding matrix selection specified in the 
prescription in Table 6-12, the isotropic edge dimension is 6.9 mm 
(i.e., 110/16 = 55/8 = 6.9 mm). The isotrophic dimension is the first 
selection in the Spacing text box.

Parameter What You 
Select Parameter What You 

Select
Patient Position Scanning Range

Patient Position Supine FOV 11 cm
Patient Entry Feet First Voxel Thickness 50 mm

Coil Torso ATDT Spacing 6.9 (first 
selection)

Imaging Parameters Locs per Slab 8
Plane Oblique Acquisition Timing
Mode MRS Freq 16

Pulse Sequence PROSE Phase 8
Grad Mode Whole NEX 1

Imaging Options EDR, SSRF 
(default)

Phase FOV 1

PSD Name N/A Freq DIR R/L

Scan Timing Auto Center Freq Water 

# of Echoes 1 Autoshim On

TE 130 Phase Correct N/A
TR 1000 User CVs
Flip Angle N/A Scan mode 1

Echo Train Length N/A AWS optimization 0

Bandwidth N/S ROI edge sat mask 7
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Echo Planar Pulse
Sequences

Introduction
Diffusion Tensor Imaging (DTI) is the newest addition to the Echo Planar pulse 
sequence family. It is used to visualize the white matter fiber tracts in the central 
nervous system (CNS). DTI provides information on molecular diffusion of 
biological tissues, such as diffusion anisotropy, principle diffusion direction and 
the average diffusion coefficient. This information aids a trained physician in 
monitoring brain development in neonates, in the diagnosis of white matter 
diseases, and guides surgeons with surgical resection of brain lesions.

This chapter explains the characteristics of the Diffusion Tensor sequence. It also 
explains the step-by-step instructions to help you learn how to:
• Perform a DTI Sequence
• Launch DTI Processing in FuncTool

In addition, this chapter answers the following questions:

1. What is Diffusion Tensor?

2. Why would you use a Diffusion Tensor pulse sequence?

3. Which imaging options can be used with the Diffusion Tensor pulse 
sequence?

4. When would you use a Diffusion Tensor pulse sequence?

NOTE: This chapter includes new features or enhancements to EPI sequences. 
Refer to Volume 2 of the Signa® Infinity with Signa Select™ (ASP2) 
Learning and Reference Guide (direction #2292262-100) for additional EPI 
pulse sequences.
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What Do I Need to Know 
About...
This section presents the concepts necessary to successfully understand 
imaging with the Diffusion Tensor pulse sequence. Specifically, you need to 
understand:
• Diffusion Tensor Imaging Basics
• Scan Parameters

– General Parameters
– User Control Variables
– Diffusion Options

• Imaging Characteristics
• Associated Imaging Options
• Applications

Diffusion Tensor Imaging Basics
Diffusion Tensor Imaging (DTI) is an imaging technique that produces 
image contrast proportional to the local diffusion coefficient of water. Both 
the diffusion coefficient and its directional dependence can be measured 
using DTI. Data can then be used to image the directional dependence of 
the local diffusion coefficient in the tissue.

DTI images are acquired on your system but can be post processed 
through FuncTool to gain additional clinical information. The pulse 
sequence is an abdaptation of the Diffusion Weighted (DW) single shot 
Echo Planar Imaging (EPI) sequence (Figure 7-1) for image acquisition. As 
a refresher, a single shot EPI sequence consists of an initial 90° excitation 
pulse and 180° radio frequency (RF) pulse. This sequence also 
incorporates a long enough Repetition Time (TR) period to allow all 
prescribed echoes, thus filling K-space all at once.
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Figure 7-1 Single Shot EPI Pulse Sequence

Like DW single shot EPI, the DTI pulse sequence consists of a 90° 
excitation pulse and a 180° RF. It also includes a pair of DW gradients, one 
is placed before the 180° RF, the other immediately after. This pair of 
gradients is applied not only for the slice gradient axes, but the readout and 
the phase gradient axes as well (Figure 7-2).
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Figure 7-2 DTI Pulse Sequence

These six gradients provide the basis of the mathematical expression called 
Diffusion Tensor (Equation 7-1). In order to calculate the Diffusion Tensor, at 
least six diffusion measurements must be performed with diffusion 
gradients applied along different gradient axes. The true mathematical 
equation for Diffusion Tensor is shown in Equation 7-1.

Equation 7-1 Diffusion Tensor

DTI creates a set of DW images, as well as T2 weighted images. Both are 
used to fully characterize the diffusion tensor at each voxel. Based on 
information derived from the DTI acquisition, an image highlighting white 
matter tracts can later be produced.
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Scan Parameters
There are several scanning parameters that are important with the DTI 
pulse sequence. These parameters are responsible for image contrast, 
signal, and scan time. For easier understanding, the scan parameters are 
broken down into three main sections:
• General Parameters
• User Control Variables (User CVs)
• Diffusion Options

NOTE: This section only provides the values and information concerning the 
selection entries that are only relevant to DTI acquisitions.

General Parameters
General parameters are options that are important to acquire MR images. 
Examples of such options are scan timing parameters and acquisition 
timing parameters.

Scan Timing parameters include Echo Time (TE) and Repetition Time (TR). 
Only a minimum TE is available with DTI. And the TR selection is normally 
5000 or more. Increasing the TR increases the amount of available slices. 
You should select a TR long enough to cover your imaging area within one 
acquisition. 

Acquisition Timing parameters include the frequency matrix, NEX and 
Phase FOV. In DTI the frequency and phase matrices default to 128, 
although you can choose a minimum of 64 or a maximum of 256 for both 
matrices. Scanning with a 128x128 matrix provides adequate resolution in a 
reasonable amount of scan time. 

User Control Variables
There are potentially three variables displayed on the User CVs Screen 
(Figure 7-3) that can be used with DTI. The FLAIR Inversion option is 
displayed on this screen but this option is not compatible with DTI, and is 
always set to zero.
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Figure 7-3 Diffusion Tensor User CVs Screen

Ramp Sampling allows the system to increase the time when the echo is 
recorded. This is achieved by the system sampling along the ramp-up and 
ramp-down portions of the frequency gradient, as well as the flat top. The 
result is shorter Echo Spacing (ES), and the system moves from echo to 
echo faster. An example of Ramp Sampling is shown in Figure 7-4. The 
trade-off for using Ramp Sampling, is Receive Bandwidth (RBw) cannot be 
changed. Typically the system uses a RBw of +/- 62.5 or greater. 
Remember as RBw increases, SNR decreases. In addition to a high RBw, 
Ramp Sampling uses the fast receiver during data collection. The fast 
receiver is not compatible with phased array coils.

Figure 7-4 Effects of Ramp Sampling

The DT1+ CV appears only if your system is a Cardiac Resonance Module 
(CRM) and has an Advanced Control Gradient Driver (ACGD) 
configuration.

Time
Saved

Sampling of 8 data points
without Ramp Sampling

Sampling of 8 data points
with Ramp Sampling
7-6  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Echo Planar Pulse Sequences
DTI+ allows you to make maximum use of the gradients. If your system is a 
CRM and is equipped with ACGD, you can turn on the User CV DTI+ to 
achieve 50 mT/m gradient performance. If DTI+ is off (set to 0), or your 
system does not have ACGD, then the peak gradient strength your system 
can achieve is 40 mT/m.

Diffusion Options
There are 10 options seen on the Diffusion Options screen that are only 
available with DTI (Figure 7-5). A brief description of each option is provided 
in Table 7-1.

Figure 7-5 Diffusion Option Screen
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Table 7-1 DTI Diffusion Option Screen

Option Description

B-value

Indicates the strength and sensitivity of motion probing 
gradients. As the B-value increases, the sensitivity of 
the motion probing gradients increases. The maximum 
B-value for DTI is 3500 s/mm2, the minimum B-value is 
10 s/mm2. 

Images of Sample B-values 500 and 1000

Diffusion 
Direction

For DTI imaging you must select TENSOR, to allow the 
acquisition to be in tensor mode. Selecting any other 
direction option is not supported for DTI.

Number of 
Diffusion 
Directions

Indicates the number of diffusion directions 
programmed. The maximum number of diffusion 
directions is 55, the minimum number is 6. If the number 
of directions is greater than six, the value must be an 
odd number. The more directions prescribed, the higher 
your scan time. If the maximum number of images 
exceeds 1024, the number of diffusion directions is 
limited. To achieve a high diffusion direction number, 
decrease the prescribed number of slices. The 
recommended number of directions is 25. 

Number of T2 
Images

Indicates the number of T2 images to be collected at the 
beginning of the acquisition. The maximum number that 
can be prescribed is 10, the minimum is 1. The 
recommended number of T2 images is 1. The more T2 
images prescribed, the longer the scan time.

Recon All 
Images This radio button defaults to on and is not deselectable.

Optimize TE

Obtains the maximum gradient amplitudes with the 
minimum possible TE, based on the B-value used. 
When this option is turned off, B-values are limited and 
gradient duration is fixed, resulting in a TE of 
approximately 100 ms. This option defaults to on.

B=500 B=1000 
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Imaging Characteristics
Diffusion Tensor images are subject to similar image characteristics as 
conventional DW images. Table 7-2 outlines common parameters and the 
effects that are seen in DTI images.

Table 7-2 DTI Characteristics

Dual Spin 
Echo

This is an eddy current compensation technique, which 
reduces distortion. This option increases your TE and 
decreases SNR. It only produces a single echo.

ADC
A Diffusion Tensor processing output that automatically 
creates an ADC image data set. This set can be 
accessed through the Browser as a separate series.

Fractional 
Anisotropy

A Diffusion Tensor processing output that automatically 
creates a Fractional Anisotropy image data set. This set 
can be accessed through the Browser as a separate 
series.

Combined
A Diffusion Tensor processing output that automatically 
creates a Combined image data set. This set can be 
accessed through the Browser as a separate series.

Parameters
Image Effect

Echo 
Spacing SNR Resolution Scan 

Time
Geometric 
Distortion

Gradient Slew 
Rate ⇑ ⇓ N/A N/A N/A ⇓

Receive 
Bandwidth ⇑ ⇓ ⇓ N/A N/A ⇓

Frequency 
Matrix ⇑ ⇑ ⇓ ⇑ N/A ⇑

Phase Matrix ⇑ N/A ⇓ ⇑ N/A N/A

FOV ⇑ ⇓ ⇑ ⇓ N/A ⇓

Phase FOV ⇑ N/A ⇑ ⇓ N/A ⇑

Ramp Sampling ⇑ ⇓ N/A N/A N/A ⇓

Field Strength ⇑ N/A ⇑ N/A N/A ⇑

Diffusion 
Direction ⇑ N/A N/A N/A ⇑ N/A

B-Value ⇑ N/A ⇓ N/A N/A N/A

Option Description (Continued)
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Associated Imaging Options
Imaging Options provide image processing or filters for enhancing 
anatomical features or reducing noise. In Table 7-3, the X’s indicate the 
options available for use with the DTI pulse sequence.

Table 7-3 DTI Pulse Sequence Imaging Options

NOTE: *Fast receiver is always on, therefore this option is not needed.

**Cardiac Gating/Triggering is only allowed when the slice number is 
one.

Imaging Options

X None X Variable Bandwidth

Flow Compensation No Phase Wrap

POMP Extended Dynamic Range*

X Square Pixel Surface Coil Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer X Sequential

X Cardiac Gating/Triggering** Respiratory Gating/Triggering

Tailored RF IR Prepared

DE Prepared Multi-Phase

Full Echo Train CCOMP

ZIP 1024 ZIP 512

Zip x 2 ZIP x 4

SmartPrep Blood Suppression

Multi Station Real Time

T2 Prep Spectral Spatial RF

Phase Sensitive Navigator

ASSET Calibration Fluoro Trigger

ASSET
7-10  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Echo Planar Pulse Sequences
Applications
Currently, DTI is used for brain neuro applications. It is most commonly 
used for white matter tract visualizations. Visualizing the white matter tracts 
in the brain can be useful in monitoring patients with stroke, epilepsy, 
various brain trauma, neonatal brain development, as well as disease 
management.
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How Do I...
This section provides the step-by-step instructions for gaining images 
visualizing white matter tracts. Specifically, it describes how to:
• Perform a DTI Sequence
• Launch DTI Processing in FuncTool

CAUTION: Provide all patients with ear protection prior to any scan to 
help avoid possible hearing impairment. Acoustic noise 
levels can exceed 99 dbA in the magnet bore.
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Perform a DTI Sequence
DTI allows you to visualize the degree of diffusion anisotropy in 
brain tissue. Refer to the Applications section within this chapter 
for specific applications for DTI sequences.

Use this procedure to set-up and scan a DTI imaging pulse 
sequence. Afterwards additional images may be displayed 
using the FuncTool software located on your Advantage 
Workstation (AW) system.

1. Enter the Patient Information.

Located on the Scan Rx Desktop. 

2. Acquire a valid 3-Plane Localizer series.

Make sure the localizer covers the whole brain.

3. Click [New Series].

4. Select Coil > Head.

DTI is only compatible with head imaging.

5. Select Plane > Oblique.

DTI is compatible with any scan plane.

6. Select Mode > 2D.

DTI is only compatible with 2D imaging mode.

7. Select the DW - EPI pulse sequence.

Enables you to perform DTI acquisition.

8. Select Grad Mode > Zoom, if applicable.

This optimizes gradient amplitude and slew rates over 
small regions of interest for TwinSpeed™ Resonance 
Module (TRM) systems.

9. Click the DWI Screen icon.

Located in Additional Parameters area.

10. Enter your desired B-value.

Recommended B-value is 1000.

11. Select Tensor for the Diffusion Direction.

Located in the Diffusion Option window.

Quick Steps: Perform a DTI 
Sequence
1. Enter the Patient 

Information.

2. Acquire a valid 3-Plane 
Localizer series.

3. Click [New Series].
4. Select Coil > Head.

5. Select Plane > Oblique.

6. Select Mode > 2D.

7. Select the DW - EPI pulse 
sequence.

8. Select Grad Mode > 
Zoom, if applicable.

9. Click the DWI Screen 
icon.

10. Enter your desired 
B-value.

11. Select Tensor for the 
Diffusion Direction.

12. Enter the number of 
directions in the # of 
Diffusion Directions text 
box.

13. Enter your desired number 
of T2 images.

14. Turn on all remaining 
options in the Diffusion 
Option window.

15. Click [Accept].
16. Click the User CVs icon.

17. Select the desired options 
for this sequence.

18. Click [Accept].
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12. Enter the number of directions in the # of Diffusion 
Directions text box.

Recommended value is 25.

13. Enter your desired number of T2 images.

Recommended value is 1.

14. Turn on all remaining options in the Diffusion Option 
window.

All options can be used simultaneously or in any 
combination.

For additional information on the remaining options in 
this window refer to the DWI Screen section of this 
chapter.

15. Click [Accept].
This registers all selections into the current acquisition.

16. Click the User CVs icon.

Located in the Additional Parameters area.

17. Select the desired options for this sequence.

Ramp Sampling is required for this sequence.

FLAIR is not compatible with Tensor Imaging.

DTI+ is only available if your system is equipped with 
ACGD.

18. Click [Accept].
This registers all selections into the current acquisition.

19. Enter the Scan Timing parameters.

The only allowable number of shots is 1.

The only allowable TE is minimum.

Recommended TR is 5000 or more. This ensures all 
slices being acquired in one acquisition.

20. Enter the Scanning Range parameters.

Recommended FOV is 26.

Recommended Slice Thickness is 5.

Recommended Spacing is 1.5.

Quick Steps: Perform a 
DTI Sequence cont.
19. Enter the Scan Timing 

parameters.

20. Enter the Scanning 
Range parameters.

21. Enter the Acquisition 
Timing parameters.

22. Click the Graphic Rx 
Icon.

23. Click and drag on the 
image to deposit scan 
prescription slices.

24. Click [Accept].
25. Click [Save Series].
26. Click [Prepare to Scan].
27. Click [Scan].
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21. Enter the Acquisition Timing parameters.

Recommended matrices is 128x128.

Recommended NEX and Phase FOV is 1.

22. Click the Graphic Rx Icon.

Located in the Additional Parameters area.

23. Click and drag on the image to deposit scan prescription 
slices.

Axial plane slices are the only slices compatible with DTI 
pulse sequences.

Slices should cover the whole brain.

24. Click [Accept].
This registers slice locations into current acquisition.

Location values are displayed in the Scanning Range 
area.

25. Click [Save Series].
This closes the current prescription screen.

26. Click [Prepare to Scan].
Downloads DTI acquisition.

27. Click [Scan].
Initiates your DTI acquisition.
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Launch DTI Processing in FuncTool
In order to generate additional functional data for your DTI 
images, use the Functool software loaded on your Advantage 
Workstation (AW). 

Use this procedure to launch DTI processing in FuncTool. 

1. Select the DTI series from the (AW) Browser.

2. Click [FuncTool].
A message box indicates this is not a time course series.

3. Click [OK] to dismiss the message.

4. Select Diffusion from the list of protocols.

5. Follow the directions in the on-screen guide to generate 
your desired functional maps.

NOTE: Functool is not needed to show images as three different 
maps can be automatically reconstructed on your Signa 
system. The maps that can be generated on your system 
are an ADC, Fractional Anisotropy, and the Combined 
maps. 

Refer to the Functional Analysis manual for additional 
information on how to launch a protocol. 

Quick Steps: Launch DTI 
Processing in FuncTool
1. Select the DTI series from 

the (AW) Browser.

2. Click [FuncTool].
3. Click [OK] to dismiss the 

message.

4. Select Diffusion from the 
list of protocols.

5. Follow the directions in 
the on-screen guide to 
generate your desired 
functional maps.
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Chapter 8

Functional Magnetic
Resonance Imaging

Introduction
Functional Magnetic Resonance Imaging (fMRI) is an optional brain mapping 
software technique that incorporates Blood Oxygen Level Dependent (BOLD) 
imaging to map task activated regions in the brain. This type of imaging aids 
trained physicians in surgical planning and monitoring, as well as during the 
observation of post surgery patients.

Functional MRI Imaging operates on two software platforms: BrainWave and 
BrainWaveSO (BrainWave Software Only). The BrainWaveSO platform does not 
include the stimulus devices like the BrainWave platform. Differences that occur 
between the platforms are noted in the text.

This chapter explains the characteristics of an fMRI examination. It also provides 
the step-by-step instructions to help you learn how to:
• Set Up the Visual Equipment (BrainWave only)
• Perform an fMRI Exam
• Reprocess fMRI Data
• Import fMRI Data
• Save/Restore BrainWaveSO System Information
• Print Color Images
• Delete Logfiles
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In addition, this chapter answers the following questions:

1. What is brain mapping?

2. What is BOLD imaging?

3. When would you perform an fMRI exam?

4. What are five types of paradigms?
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What Do I Need to Know 
About...
This section presents the concepts necessary to successfully understand 
fMRI. Specifically, you need to understand:
• fMRI Description
• BOLD Technique

– User Control Variables
• Sensory Equipment BrainWaveSO
• Sensory Equipment BrainWave
• BrainWaveSO Paradigms
• BrainWave Paradigms

– Voluntary Hand Movement
– Passive Listening
– Verb Generation
– Rhyming
– Semantic Decision

• BrainWave/BrainWaveSO Software
– Acquire fMRI Scans Window
– Visualize Maps Window
– Re-Process fMRI Scans Window
– Manage System Window

fMRI Description
Functional Magnetic Resonance Imaging consists of a Single Shot-Gradient 
Echo Echo Planar Imaging (SS-GRE EPI) pulse sequence used in 
conjunction with clinical paradigms to visualize signal intensity changes 
during task activation. The BrainWave software, located on your Advantage 
Windows (AW) workstation, is also used to accomplish this type of exam. 
With these three key elements working simultaneously, images are 
produced and post processed into color maps. The color maps display the 
intensity levels where task activation has occurred. The final product is 
commonly known as Brain Mapping.
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BOLD Technique
The BOLD technique is the brain mapping process that records signal 
intensities in active regions of the brain. In BOLD fMRI, the signal increases 
during activation due to an oversupply of oxygenated blood in the 
capillaries. BOLD uses the magnetic susceptibility differences between 
these blood oxygenation states. This technique consists of acquiring a 
SS-GRE EPI acquisition, lasting approximately 6 minutes and 40 seconds. 
During this time, your patient performs a pre-determined task, called a 
paradigm. The paradigm is performed for 24 seconds, followed by a 
24 second rest period. This task and rest (sometimes called task ‘on’, task 
‘off’) procedure is repeated for eight cycles. As your patient performs the 
defined task, the blood oxygen levels in the brain increase and are seen on 
images as signal intensity changes. For fMRI, tasks are usually performed 
with the aid of various sensory equipment.

User Control Variables
Functional MRI uses a modified version of the SS-GRE EPI pulse 
sequence. The sequence is acquired in the same manner as a conventional 
SS-GRE EPI sequence, allowing only a 64x64 matrix and providing a 
number of User Control Variables (CVs). Figure 8-1 displays the User CVs 
window and Table 8-1 lists a brief description of each variable.

Figure 8-1 SS-GRE EPI User CVs
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Table 8-1 SS-GRE EPI User CVs 

Sensory Equipment BrainWaveSO
This section does not apply if your system is operating BrainWaveSO 
software rather than BrainWave software. Read the operator documentation 
provided by the manufacturer of your stimulus device.

User CVs Description

Ramp Sampling
Indicates the acquisition of echoes during the 
rise and fall times of the gradient slope. A 1 
turns it ON and 0 turns it OFF.

PSD Trigger
For research sites only. Use this feature if your 
site has a separate triggering device. The 
system default, 0, indicates internal triggering 
and 1 indicates external triggering.

# of RTC Dummy Acqs

Indicates the number of discarded images. 
The discarded images are acquired during the 
initial rest period of your fMRI acquisition. The 
acceptable number of images, which can be 
discarded, is 0 to 50. The default number of 
dummy acquisitions for BrainWave is 4.

Initial State
Indicates the starting preference phase for the 
fMRI acquisition. Use 0 for starting during the 
resting phase (baseline). Use 1 for starting 
during the active phase (stimulation).

Baseline Duration
Indicates the number of images recorded 
during the resting phase. The range of images 
is 1 to 128.

Stimulation Duration
Indicates the number of images recorded 
during the active phase. The range of images 
is 1 to 128.

Scan Duration Indicates the number of images acquired per 
location. The range of images is 1 to 1000.

Delay after each slice 
package

Indicates the time delay between each 
location phase. The time delay ranges from 1 
to 1000 milliseconds (msec).
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Sensory Equipment BrainWave
There are several pieces of sensory equipment used to perform fMRI: 
earphones, glasses, hand controls, and a microphone. This equipment 
provides the visual or audio stimulus delivery and recording mechanisms. 
The sensory equipment used in the exam usually depends on which 
paradigm is being applied. 

The visual equipment includes a pair of glasses and a holder, which is 
attached to the head coil (Figure 8-2). The glasses allow your patients to 
see the visual stimulus without having to move their head. The visual 
stimulus displays as shapes or words. 

Figure 8-2 Visual Equipment 

The audio equipment includes a pair of earphones and a microphone 
attached to the audio console (Figure 8-3). The earphones allow your 
patient to hear the audio paradigms. The audio console resides on your 
operator console and is used to select the sound medium and allows you to 
communicate with your patient. The sound volume control is located on the 
front side of the audio console. The back side of the auto console includes 
two identical switches. Both need to be set in functional or clinical modes. 
Clinical mode permits mono sound and allows the volume to be controlled 
through the audio console. Functional mode permits stereo sound and 
allows the volume to be controlled through the Stimulus PC. 
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Figure 8-3 Audio Equipment

Stimulus response equipment includes a pair of hand controls (Figure 8-3). 
They are designed to record your patient’s response to various stimuli. The 
right-hand control has blue and yellow push buttons and the left-hand 
control has green and red push buttons.

BrainWaveSO Paradigms
Since BrainWaveSO has no direct connection to, or knowledge of the 
sensory equipment being used, the paradigm information consists solely of 
an assigned paradigm name. The assigned name is permanently 
associated with the resulting data sets and used for image annotation 
purposes. Refer to the BrainWave/BrainWaveSO Software section in this 
chapter for information about entering your own paradigms.

BrainWave Paradigms
Paradigms are task activation procedures. Instruct your patient before the 
exam on which paradigm to perform during the activation and control 
periods. Six paradigms are available for fMRI, however, only one paradigm 
can be performed per acquisition. 
• Voluntary Hand Movement (left or right hand)
• Passive Listening
• Verb Generation
• Rhyming
• Semantic Decision 
• Calibration Training
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It is necessary to prepare your patient for each paradigm. Suggestions of 
what you might say to prepare your patient are given in the Patient 
Preparation section of each paradigm. 

NOTE: The following paradigms are only for systems that are running 
BrainWave software. If your system is operating BrainWaveSO, refer 
to your manufacturer’s guidelines for building a paradigm.

Voluntary Hand Movement
There are two paradigms associated with Voluntary Hand Movement: Left 
Hand Movement and Right Hand Movement. Each paradigm results in a 
task that produces signal intensity changes in various parts of the motor 
system, such as the supplementary motor area (SMA), contralateral 
primary motor cortex, cingulate motor area, and ipsilateral cerebellar cortex.

During this paradigm, your patient sees a cross-hair through the glasses, 
which periodically appears surrounded by a circle (Figure 8-4). This circle 
appears at the rate of once per second. Every time your patient sees the 
circle, either the left or right button is pressed depending on which hand 
movement paradigm is selected. If your patient presses both buttons when 
the circle appears, the response is counted as an error.

Figure 8-4 Illustration of Voluntary Hand Movement Paradigm

Patient Preparation

Here is an example of how you can prepare your patient to perform the 
Right Hand Movement paradigm.

“Hold the boxes in both your hands. Look into the
glasses. You should see a cross-hair. Keep your eyes
on the cross-hair. Whenever you see a circle appear
around the cross-hair, press only the right button
once. If no circle is seen around the cross-hair, do
not press any buttons. Try to keep your head as still
as possible throughout the scan.”

NOTE: When performing Left Hand Movement paradigm, substitute the left 
button for the right button in the above example.
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Passive Listening
The Passive Listening paradigm is the easiest of all the paradigms. It 
produces and records signal intensity changes in Wernicke’s area, which 
represents the receptive language area. This paradigm only requires the 
patient to listen.

During this paradigm, your patient wears headphones and listens to a 
narration of English text for 24 seconds. For the next 24 seconds, your 
patient hears gibberish, which is the English narration played backwards. 
While the narration is playing, your patient should lie still and carefully 
listen. You should not tell your patient what is happening, nor should they try 
to make any sense of it. 

Patient Preparation

Here is an example of how you can prepare your patient to perform the 
Passive Listening paradigm.

“For this test, all you need to do is to hold your
head still and carefully listen as the recording
plays. Do not try to understand the gibberish,
because it will not make any sense.”

Verb Generation
The Verb Generation paradigm produces and records signal intensity 
changes in Broca’s (Brodmann’s 45) area of the brain, which represents 
expressive language. 

During this paradigm, your patient sees words in the form of nouns through 
the glasses. Your patient should think of an action word, in the form of a 
verb associated with the word seen. It is important to tell your patient not to 
say the words aloud, only think the words. 

Patient Preparation

Here is an example of how you can prepare your patient to perform the Verb 
Generation paradigm.

“For this test it is very important you lie still.
Through these glasses you should see a cross-hair.
While looking at the cross-hair, try not to think of
anything. When the cross-hair disappears, it is
replaced by a word. Try to think of an action word
associated with the word. For example, if you see the
word ‘book,’ you might think of the word ‘read.’ It
is important that you only think the word silently
and NOT say the word out loud. A new word appears
2333956-100 Rev. 0 (06/02)  8-9
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every few seconds. Remember to silently think of the
action words.”

Rhyming
The Rhyming paradigm is designed to produce signal changes in the areas 
of the brain responsible for phonologic processing. These areas of brain 
activation are similar to those areas activated by the Verb Generation 
paradigm, although the Rhyming paradigm activated areas are more 
specific. 

NOTE: This is a difficult task to perform. Not all patients are able to effectively 
complete this task.

During this paradigm, your patient sees two words in the glasses. If the two 
words rhyme, your patient presses the right button. If the two words do not 
rhyme, your patient presses the left button. Your patient should only press 
one button per word pair. Pressing both buttons at the same time is counted 
by the system as an error. 

Your patient also sees two rows of five sticks and determines whether the 
two rows are identical. If the two rows are identical, your patient presses the 
right button. If the rows are not identical, the left button is pressed. The 
button needs to only be pressed once to make a selection.

Patient Preparation

Here is an example of how you can prepare your patient to perform the 
Rhyming paradigm.

“For this test, it is important to keep your head
very still. Hold the controls in both hands and look
into the glasses. At times, you will see a pair of
words, which changes every few seconds. Whenever you
see a pair of words that rhyme, press the right
button once. If the words do not rhyme, press the
left button once. Remember, the right button is for
rhyming words.

At other times during this test, you will see two
rows of five sticks. Whenever the rows of sticks look
identical, press the right button once. If the rows
are not identical, press the left button once.
Sometimes the differences are subtle, so look
carefully. Both the words and the sticks change every
few seconds.”
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Semantic Decision
The Semantic Decision paradigm is the most challenging of all previously 
mentioned paradigms. It is sometimes called the animal paradigm and is 
designed to produce signal intensity changes in the areas of the brain 
responsible for semantic processing.

NOTE: This is a fairly difficult task to perform. Not all patients are able to 
effectively complete this task.

During this paradigm, your patient hears the names of various animals. If 
the animal is both native to the United States and commonly used by 
humans, your patient presses the right button. Animal characteristics 
include animals used for hunting, as a pet, or for domestic purposes. It 
excludes zoo-kept animals. If the animal is not native to the United States or 
is not commonly used by humans, the left button is pressed. If both buttons 
are pressed, the system records the response as an error. 

At other times during this test, your patient hears a series of tones or beeps, 
each lasting approximately one second. If exactly two tones are heard 
during the series, your patient presses the right button once. If more or less 
than two tones are heard during the series, your patient presses the left 
button once.

Patient Preparation

Here is an example of how you can prepare your patient to perform the 
Semantic Decision paradigm. Make sure you allow enough time to 
thoroughly prepare your patient for this test, as the tasks are more 
challenging than any other paradigm. 

“For this test, hold the controls in both hands and
look into glasses. You should see cross-hairs in the
glasses but nothing else appears. Through your
headphones, you sometimes hear the names of animals.
Whenever you hear the name of an animal that is both
commonly used by humans and a native to the United
States, press the right button once. If this animal
is not common to the United States or not used by
humans, press the left button once. You will hear the
names of new animals every few seconds.

At other times during this test, you will hear a
series of beeps. Whenever you hear a set of beeps
that contains exactly two tones, press the right
button once. If more or less than two beeps are
heard, press the left button once. You will hear a
new series of beeps every few seconds. Keep your eyes
fixed on the cross-hairs and remember to hold your
head as still as possible throughout the scan.”
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Calibration Training
The Calibration Training paradigm is a testing paradigm. It can be used to 
help prepare your patient for an fMRI procedure, and to verify the paradigm 
delivery system is functioning properly. Alphabets are displayed through the 
glasses and an audio sound sample is transmitted through the headphones.

BrainWave/BrainWaveSO Software
BrainWave™ is the brain mapping software on the AW system used to 
record the data acquired during an fMRI exam. It integrates the sensor 
device with the software. BrainWaveSO is the same brain mapping software 
with the same applications as BrainWave except it does not include 
integrated sensor device information.

How can you tell if your system is operating BrainWave versus 
BrainwaveSO software? The button on the AW Browser is labeled either 
BrainWave or BrainWaveSO. In addition, the menu titles display either 
BrainWave or BrainWaveSO.

This software is used to start your functional brain acquisition and visualize 
brain maps. The BrainWave software is divided into four main windows, 
which can be accessed from the Main Menu (Figure 8-5).
• Acquire fMRI Scans
• Visualize Maps
• Re-Process fMRI Scans
• Manage System

Each window is equipped with several functions, as well as the BrainWave 
or BrainWaveSO Message and Warning text areas. The BrainWave 
Message area displays information regarding the system status. For 
example, the system may display messages such as, “BrainWave is in idle 
mode” or “BrainWave is now importing data to the AW Browser.” The top of 
the message area always displays the software version. The Warnings area 
displays information regarding when the system is not responding normally. 
For example, the system may display a message such as, “BrainWave is 
unable to import data to AW Browser.” After a warning has been posted, 
you should check to see if the problem can easily be resolved or contact 
your service engineer to correct the problem.
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Figure 8-5 BrainWave Main Menu

Table 8-2 provides a description of the selections in the BrainWave Main 
Menu.

Table 8-2 BrainWave Main Menu Selections 

Selection Description

[Acquire fMRI Scans]
Opens the Acquire fMRI Scans window, 
providing the functions for collecting and 
delivering paradigm fMRI data.

[Visualize Maps]
Opens the Visualize Maps window, providing 
the functions for displaying images with 
overlying color maps.

[Re-Process fMRI 
Scans]

Opens the Re-Process fMRI Scans window, 
providing the functions for re-analyzing fMRI 
data, processing fMRI data, and re-importing 
images from the AW system.

[Manage System]
Opens the Manage System window, providing 
options for setting system modes and 
establishing and modifying configuration 
system defaults.

[Quit BrainWave] Exits the BrainWave software.
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Acquire fMRI Scans Window
Figure 8-6 BrainWave Acquire Window (left) and BrainWaveSO Acquire 
Window (right)

There are three main functions in the Acquire fMRI Scans window:
• Segmentation Process
• Scanner Control
• Stimulus Delivery
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On your MR system, you must enter all of the imaging parameters before 
acquiring the fMRI data. When completed, use the Acquire fMRI Scans 
window to prepare and start the scan. Table 8-3 provides a description of 
the functions in this window.

Table 8-3 Acquire fMRI Scans Selections

Selection Description
Segmentation of Structural MRI Area

Patient Displays the patient identification (ID) number.

Exam Displays the patient exam number.

Series Displays the patient series number.

[Select]
Opens the Browser for selection of the correct patient, 
exam, and series for segmentation. It also allows you 
the choice to perform structural scans both before and 
after activation scans.

[Start 
Segmentation]
or
[Abort 
Segmentation]

Starts or stops the segmentation process, which 
automatically extracts the skin and bone data from your 
selected 3D series. The [Abort Segmentation] button 
is only seen if the segmentation process has begun.

Scanner Control Area

[Prep Scan]
Prescans the fMRI series. Also creates your EPI 
reference scan for the fMRI series you prescribed on 
your MR system.

[Start Scan] Begins the fMRI acquisition.

[Stop Scan] Aborts the fMRI acquisition. 

Acquire Provides a quick view of the completion percentage of 
the acquire phase of your scan.

Scanner 
Messages

Displays messages, regarding scanner status, posted in 
your MR scanner Message window.
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Stimulus Delivery Controls Area

Paradigm

Opens the Paradigm selection menu, which displays a 
list of all the paradigms you can perform on your patient. 
Refer to the BrainWave Paradigms section of this 
chapter for additional information.

Only with BrainWaveSO
The color and code number associated with the 
paradigm when using Composite Z-Map display mode 
is displayed above the [Abort fMRI Image Processing] 
button. The code number has a 1:1 correspondence 
with the paradigm name. Each paradigm name should 
always be unique. Never overwrite a paradigm for which 
scan data already exists.

Add Paradigm

Only with BrainWaveSO
Opens a pop-up window that allows you to add a 
paradigm name to the list of paradigms, as well as the 
associated color when Composite Z-Map mode is used 
for BrainWave Visualization.

Delete 
Paradigm

Only with BrainWaveSO
After a paradigm is selected from the Paradigm list and 
then Delete Paradigm is selected a Delete window 
opens allowing removal of the paradigm.

[Open Console 
to Stimulus 
System] 
or
[Close Console 
to Stimulus 
System]

Only with BrainWave
Opens and closes the Stimulus window on the personal 
computer (PC). Allows you to view the Stimulus 
computer and verify the stimulus is being delivered. The 
[Close Console to Stimulus System] button is only 
seen if the stimulus system has been opened.

[Test Stimulus 
Delivery]
or 
[Abort Stimulus 
Delivery]

Only with BrainWave
Allows you to perform a test of the paradigm stimulus 
you wish to give to your patient, without starting your 
fMRI acquisition. The [Abort Stimulus Delivery] button 
is only seen while the stimulus test is being delivered.

[Abort fMR 
Image 
Processing]

Stops any active image processing function. This 
includes fMRI image processing/analysis and alignment 
of fMRI data to the structural data. It does not stop 
visualization or image displays.

RTIP Disk Space Usage Area

Used Provides a quick view of the percentage of RealTime 
disk space used. 

[Return to Main 
Menu]

Closes the Acquire fMRI Scans window. Displays all the 
Main Menu functions.

Selection Description (Continued)
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Segmentation of Structural MRI Area

Segmentation is the process of automatically removing the outer layers of 
tissues for a 3D volume study. The end result is a 3D volume with the brain 
free of skin or skull tissues. The segmentation process is initiated with the 
[Start Segmentation] button. Once the 3D SPoiled Gradient Echo (SPGR) 
volume has been acquired and reconstructed on your MR system, the 
images are transferred to your AW and the segmentation process begins. A 
Processing Status window (Figure 8-7) displays the completion status of the 
segmentation process. After the segmentation process is complete, the 
results are automatically transferred and stored on the AW database.

Figure 8-7 Processing Status Window

The fMRI Processing bar represents the processing of the activation data. 
When the processing is finished, the following data is displayed in the AW 
Browser, which means that it can be saved and restored as DICOM 
information.
• The Mean EPI data, which is the size of the acquisition matrix.
• The Big Mean EPI data, which is the size of the structural data. This is 

the data that is selected when visualizing maps. It is selected by clicking 
the [Average EPI] button from the Paradigm pull-down menu on the 
Visualize Map window.

• The Z-map, which is the statistical data that is the result of the activation 
processing on the acquired matrix.

• The Big Z-map, which is the statistical data that is the result of the 
activation processing on a larger matrix.

The Alignment progress bar represents aligning the activation results to the 
segmented data (anatomy images minus the skull and skin). When the 
processing is finished, the B.I.P. (Burned in Pixel) data is displayed in the 
AW Browser, which means that it can be saved and restored as DICOM 
information.
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Scanner Control Area

The Scanner Control area is used to prepare, start, and stop the fMRI 
acquisition. On the AW, you use the [Prep Scan] button to switch your MR 
system into scan mode, perform the Auto Prescan and EPI Reference 
Scan, and create a template image. Once the acquisition is prepared, it can 
be started and stopped. The Acquire status meter allows you to visualize a 
percentage of how much of your fMRI series has been completed.

Stimulus Delivery Controls Area

In the Stimulus Delivery Controls area, you use the [Paradigm] button to 
select the paradigm you want to perform. 

NOTE: Refer to the BrainWave Paradigms section in this chapter for 
additional information. 

If your system is operating BrainWaveSO software, you can add or delete a 
paradigm from the Acquire fMRI window. Clicking the [Add Paradigm] 
button opens the window in Figure 8-8. This window only appears with 
BrainWaveSO.

Figure 8-8 Add Paradigm Window 

The first 15 characters of the text string entered in the text box is stored with 
the RTC data during acquisition. The full string of characters is stored in the 
series description in the AW Browser and appears on the image annotation. 
Enter a different name for each paradigm. The text you enter can be longer 
than 15 characters, just make sure the first 15 characters are unique.

The code is a 1:1 correspondence with the name. Once you name a 
paradigm and then acquire scans with the paradigm, never re-use the 
paradigm name. Always create a new name and code.
8-18  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Functional Magnetic Resonance Imaging
For example, in Table 8-4, the first 15 characters are the same in the left 
column of the table (incorrect), where the first 15 characters are unique in 
right column of the table (correct).

Table 8-4 Text Names

The color selection is used for the associated paradigm when using 
Composite Z-Map display mode in BrainWave Visualizer. Composite Z-Map 
mode allows simultaneous display of multiple paradigms on one image with 
variation in the colors used to identify the separate paradigms (refer to the 
Visualize fMRI Data chapter of this guide). 

After a paradigm is selected from the Paradigm Selection pull-down menu, 
and the [Delete Paradigm] button is clicked, a confirmation window opens 
(Figure 8-9). This window only appears with BrainWaveSO.

Figure 8-9 Delete Paradigm Window

Use the [Test Stimulus Delivery] button to verify the Stimulus software is 
operating properly or to allow your patient to see a sample of the stimulus 
about to be delivered. A sample of the selected paradigm stimulus is 
displayed without starting the fMRI acquisition. You can use the [Open 
Console to Stimulus System] button to see how your patient is 
responding to the stimulus being given. Once open, two separate windows 
are seen: the Patient Responses window (Figure 8-10) and the Motion 
Detection (Figure 8-11) window. 

NOTE: During the actual fMRI scan, it is not recommended to have the 
Stimulus system open. Updates to this window require the use of the 
systems working memory and may interfere with BrainWave 
functioning.

Incorrect Text Name Correct Text Name
Visual Stimulation Green Visual Stim Green

Visual Stimulation Red Visual Stim Red
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You can print a paper copy of the Patient Responses and Motion Detection 
graphs with the [Print Plot] button located in the bottom right of the window. 
Printing only includes your patient’s graph. This does not include the text in 
the lower left corner of each window.

NOTE: If a plot is desired, it must be printed before beginning another 
paradigm. Additional paradigms generate new plots and replace all 
existing plots. Previous paradigm plots can not be regenerated.

The text in the lower left corner of the Patient Responses window provides 
a summary of how well your patient performed the given stimuli. For 
example, the Patient Responses window in Figure 8-10 shows the patient 
responded to 79.17% of all stimuli in the latest block, with 94.74% accuracy. 
The text information is updated whenever the stimuli switches from a 
control block to a task block or vice versa. Figure 8-10 only appears with the 
BrainWave software and not with BrainWaveSO software.

Figure 8-10 Patient Responses Window

Figure 8-11 Motion Detection Window

After the acquisition of the fMRI scan, the BrainWave software automatically 
starts analyzing and processing the data. You can stop the analyzing and 
processing, if needed, with the [Abort fMR Image Processing] button. You 
can resume the process at a later time from the Re-Process fMRI Scans 
window.

NOTE: Refer to the Re-Process fMRI Scans Window section of this chapter 
for additional information regarding restarting the analyzing and 
processing functions.
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Visualize Maps Window
BrainWave has a visualization data tool responsible for displaying images 
with overlying color maps. You use the Visualize Maps window (Figure 
8-12) to make your selections.

Figure 8-12 Visualize Maps Window

The Visualize Maps window has two main functions: displaying functional 
data overlays and displaying the Text Report.

Table 8-5 provides a description of the selections in this window. 
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Table 8-5 Visualize Maps Window Selections

Selection Description
Exam Area

Patient Displays the patient ID number.

Exam Displays the patient exam number.

[Select] Opens the BrainWave Browser database for 
patient selection. 

[Import from AW 
Browser]

Opens to the AW archived database and allows 
you to reimport your desired patient and exam from 
the archived database.

Select Functional and Structural Components Area

Paradigm

Opens the Paradigm selection menu, displaying a 
list of the processed paradigms available for 
display. This list includes a special item, Composite 
Z-Map, that can be used to display all the 
paradigms listed simultaneously with separate 
colors assigned to the paradigm results and 
overlapping areas. Refer to the BrainWave 
Paradigms section of this chapter for a complete 
list of paradigms and their descriptions.

Overlay Type

Opens the Overlay Type selection menu, allowing 
you to select the type of image on which to impose 
the color ramps. The overlay types include 
Segmented sMRI*, Nonsegmented sMRI*, and 
Mean fMRI Image Volume.

Thresholding Area

p < 0.05
The default thresholding factor. Selecting this factor 
means you have a 95% confidence level the 
activation recorded was not noise, based on the 
calculation used by the AW BrainWave application.

Relative

Enables the thresholding slider, which you can use 
to manually set the thresholding factor. Sliding the 
bar to the left to evaluates fewer activations, thus 
increasing the confidence level. Sliding the bar to 
the right to evaluates more activations, thus 
decreasing the confidence level.

[Create/Update 
Functional - 
Structural Overlay]

Fuses the functional activation map and the 
segmented structural scan to overlie one another. 
The fused data is then displayed in the Volume 
Rendering Viewer.

[Display Text 
Report] Displays the text report for structural overlaid data.
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NOTE: *Structural Magnetic Resonance Imaging (sMRI)

Overlay Types

Once the functional data has been acquired and processed, specific 
paradigm information can be overlaid on selected image types.
• Segmented - sMRI
• Nonsegmented - sMRI
• Mean fMRI Image Volume

A segmented image is an image with the skin and skull extracted from the 
3D volume image. A nonsegmented image is an image in which the entire 
volume is displayed just as it was acquired, with all the surrounding brain 
tissues seen. Mean fMRI images are images from the EPI data set. 

Once the functional/structural overlay has been created, images are 
displayed fused with parametric data in the BrainWave Visualizer. Images 
can either be displayed using the Volume Rendering View or the Lightbox 
View. The Volume Rendering View is the default viewer for structural 
overlay.

NOTE: Refer to the Visualize fMRI Data chapter for additional viewer 
information and concepts.

Display Text Report

The Text Report is a description of the image processing performed for your 
selected patient. This report includes parameters specific to the particular 
study, e.g., the completed adjusted threshold used for image fusion. This 
type of report aids in making a formal radiologic dictation/report for the brain 
mapping study. This information can also be used for scientific writings for 
publication. A copy of this report is transferred along with the fMRI study to 
the AW. It is stored in the Image Comments Digital Imaging and 
COmmunication in Medicine (DICOM) area.

NOTE: A Text Report can not be printed, nor does it contain an interpretation 
of the results.

BrainWave Messages

During the visualize phase, the BrainWave Message area displays a color 
legend. The color legend shows how to interpret the colors in an image 
display. The interpretation of color is especially important in the overlays of 
the Mean EPI image volume with the structural MRI data. Figure 8-13 
shows an example of an Average EPI Color Legend.
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Figure 8-13 Average EPI Color Legend Example

Re-Process fMRI Scans Window
The Re-Process fMRI Scans window (Figure 8-14) is accessed with the 
[Re-Process fMRI Scans] button on the Main Menu. This window is broken 
up into two main areas: Analyze Functional MR Data, and Import Functional 
MR Data.

Figure 8-14 BrainWave Re-Process Window (left) and BrainWaveSO 
Re-Process Window (right)
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Re-processing fMRI scans may be required if your fMRI process has been 
manually aborted or if the system malfunctions. Through this window, you 
can reimport functional MR data from your AW and start the fMRI image 
processing. Table 8-6 provides a description of each selection in this 
window.

Table 8-6 Re-Process fMRI Display Selections

Manage System Window
The Manage System tool of the BrainWave software can be accessed from 
the Main Menu via the [Manage System] button. The Manage System 
window (Figure 8-15) includes the following functions:

Selection Description
Analyze Functional MR Data Area

Patient Displays the patient ID number.
Exam Displays the patient exam number.

Paradigm
Displays the list of paradigms performed on this 
patient. Refer to the BrainWave Paradigms section 
of this chapter for additional information.

[Start fMR Image 
Processing]

Begins the fMRI image processing if the image 
processing has been aborted.

Import Functional MR Data Area
Patient Displays the list of patients on the AW workstation. 

Exam Allows selection of the patient exam on which you 
wish to import the functional data.

Series Displays the patient series on which you wish to 
import the functional data.

Start Image Displays the image number you wish the system to 
start importing. 

Paradigm
Allows selection of the fMRI paradigm that 
corresponds to the selected series. This requires 
you know which series maps to which paradigm.

[Import Images 
from AW System]

Transfers the selected exam, series, and images 
you requested.

Paradigm color

Only with BrainWaveSO
Represents activation areas associated with the 
paradigm when a Composite Z-Map display is 
created. The Z-Map color and code for the selected 
paradigm is displayed above the [Import Images 
from AW System] button. Use this information to 
cross-reference with the selected paradigm.

Import Provides a quick view of the image transfer 
completion status.
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• Deletion of Stimulus PC log files (only with BrainWave)
• Management of the stimulus delivery system (only with BrainWave)
• Modification of configuration defaults

Figure 8-15 BrainWave Manage System Window (left) and BrainWaveSO 
Manage System Window (right)

Table 8-7 provides a description of the Manage System window selections.

Table 8-7 Manage System Window Selections 

Selection Description
Manage System Area

[Modify Configuration 
Defaults and Set 

Modes]

Allows you to specify the flatfile, BrainWave 
data directories, and network parameters. Any 
modifications to this area should only be 
performed by a service engineer.

Save/Restore 
BrainWaveSO System 
Information

Only with BrainWaveSO
Allows saving files you built in the acquisition 
program to a floppy disk. It is important to save 
your paradigm files so in the event you need to 
restore the files, they match your previous 
paradigm names. The paradigm name is used 
as the description in the AW Browser, in the 
paradigm pull-down menu on the Acquire fMRI 
Scans window, and as image annotation.
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Image Databases

When performing an fMRI exam, you need to be concerned with four main 
databases (Figure 8-16).
• MR System Database - contains all data files created by the system
• AW Database - contains all data files created by various software 

packages pre-loaded or transferred to the system
• Real Time Image Processing (RTIP) Database - contains image data 

files created only by the RTIP software
• Stimulus PC Database - contains the logfiles of patient responses

With an fMRI exam, the databases constantly interact with one another. 
Upon acquiring your 3D SPGR data set, images are stored in your MR 
system database. Images are then transferred from this database to the AW 
database. From here, these images can be used by the BrainWave 
software for image segmentation. 

Once you have started the functional task portion of the exam, images are 
actively stored both in the AW database and the RTIP database. The 
logfiles of patient responses are stored on the Stimulus PC. When you are 
ready to display your images, the BrainWave software requires you to 
select the patient series from the AW database.

NOTE: Periodically, all databases need to be cleared to allow space for 
additional functional studies. Refer to your RTIP and AW 
documentation for the correct deletion procedures.

Manage Stimulus Delivery System Area: Only with BrainWave
[Open Console to 
Stimulus System]

or
[Close Console to 
Stimulus System]

Opens or closes the stimulus presentation 
software on the AW. The [Close Console to 
Stimulus System] is only seen when the 
[Open Console to Stimulus System] has 
been selected.

[Check Status of 
NeuroActivator]

Performs a status inquiry of the stimulus 
delivery system and displays messages in the 
Message area.

Stimulus PC Management: Only with BrainWave
[Update Stimulus PC 
Space] Updates the Stimulus PC Space status meter.

[Delete Logfiles from 
Stimulus System] Removes patient response data from the PC.

Stimulus PC Space Displays the percentage of total space in the 
log directory being used via a status meter.

Selection Description (Continued)
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Figure 8-16 Internal Database Diagram
8-28  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Functional Magnetic Resonance Imaging
How Do I...
This section provides the step-by-step instructions for obtaining images 
visualizing white matter tracts. Specifically, it describes how to:
• Set Up the Visual Equipment (BrainWave only)
• Perform an fMRI Exam

– Set Up the Patient (BrainWave only)
– Set Up the Patient (BrainWaveSO only)
– Prescribe and Perform the Localizer and 3D SPGR Series
– Perform 3D Segmentation
– Acquire the fMRI Data
– Visualize the fMRI Data

• Reprocess fMRI Data
• Import fMRI Data
• Save/Restore BrainWaveSO System Information
• Print Color Images
• Delete Logfiles

– Remove all Logfiles (BrainWave only)
– Remove Selected Logfiles
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Set Up the Visual Equipment 
(BrainWave only)
NOTE: If your system operates BrainWaveSO, follow the 

manufacturer’s equipment setup guidelines.

Visual equipment allows your patient to view stimuli being 
presented, without head movement. The stimulus can be in the 
form of words or geometric shapes.

Use this procedure to set up the visual equipment by attaching 
the high resolution glasses to the head coil. This procedure 
should be done prior to an exam involving visual paradigms.

1. Place the glasses mount on the head coil bars.

Glasses Mount
The front screws should be facing the front of the head 
coil.

2. Hold the edge rails between your thumbs and pointer finger.

This ensures a firm grip on the glasses mount.

Attaching Glasses Mount

Quick Steps: Set Up the 
Visual Equipment 
(BrainWave only)
1. Place the glasses mount 

on the head coil bars.

2. Hold the edge rails 
between your thumbs and 
pointer finger.

3. Slightly lift the edge rails 
while pressing the glasses 
mount downward.

4. Release the edge rails.

5. Verify the mount is 
securely attached to the 
head coil.

6. Insert the top of the 
glasses into the bottom of 
the glasses mount.

7. Tighten the top screws on 
the glasses mount.

8. Screw the Track to the 
Holder Clamp.
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3. Slightly lift the edge rails while pressing the glasses mount 
downward.

This spreads the clamps, located on the bottom of 
glasses mount, apart.

4. Release the edge rails.

This closes clamps around head coil bars.

5. Verify the mount is securely attached to the head coil.

The glasses mount should not move around on head coil 
when it is touched.

If the glasses mount is not secure, repeat steps three 
through six.

NOTE: The glasses mount should always be securely fastened 
to the head coil to prevent patient injury. 

6. Insert the top of the glasses into the bottom of the glasses 
mount.

The cables of the glasses should exit out the back of the 
head coil.

The glasses can be inserted into either mount.

Glasses

7. Tighten the top screws on the glasses mount.

This secures glasses to the glasses mount.

8. Screw the Track to the Holder Clamp.

This secures the Track to the Holder Clamp.

Top View
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Perform an fMRI Exam
Set Up the Patient (BrainWave only)
Patient preparation is a very important part of an fMRI exam. To 
effectively perform the exam, your patient needs to know what 
is happening during the procedure and what actions are 
required.

Use this procedure to set up the patient with the sensory 
equipment. If you are performing an exam using a visual 
paradigm, make sure you perform the steps in the visual 
equipment setup prior to this portion of the exam.

1. Provide the patient with the Patient Alarm and explain the 
procedure to your patient.

Refer to the Patient Preparation sections of each 
paradigm for suggested instructional dialogs for each 
paradigm.

Tell the patient to activate the alarm any time during the 
test if he or she is unable to hear instructions through the 
head phones.

2. Place protective headset covers on the earphones.

The protective headset covers keep the earphones clean 
from one patient to the next.

Headset Covers

3. Place the earphones on your patient, if applicable to the 
paradigm, or provide earplugs.

The microphone should be facing up, towards the 
patient’s mouth. The earphones allow delivery of the 
stimulus and protect hearing from gradient noise.

Earphones

Quick Steps: Set Up the 
Patient (BrainWave only)
1. Provide the patient with 

the Patient Alarm and 
explain the procedure to 
your patient.

2. Place protective headset 
covers on the earphones.

3. Place the earphones on 
your patient, if applicable 
to the paradigm, or 
provide earplugs.

4. Adjust the earphones or 
earplugs to ensure patient 
comfort.

5. Position your patient’s 
head in the head coil 
cradle.

6. Slowly slide the head coil 
over the patient’s head.

7. Adjust the glasses, if 
necessary.

8. Give your patient the 
hand controls.

9. Landmark your patient for 
a brain exam.

10. Press Advance to Scan.

11. Press the microphone 
control to the ON position.

12. Adjust the microphone, if 
necessary.

13. Choose the appropriate 
audio control.

14. Adjust your patient’s 
voice control, if 
necessary.

Microphone
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4. Adjust the earphones or earplugs to ensure patient comfort.

Expand and contract the earphones, as needed, to 
ensure they are comfortable for your patient.

5. Position your patient’s head in the head coil cradle.

Make sure your patient is comfortable.

6. Slowly slide the head coil over the patient’s head.

Make sure there is enough clearance between the 
patient’s head and the glasses, if the glasses are being 
used.

fMRI Patient in Head Coil with Glasses

7. Adjust the glasses, if necessary.

a) Adjust the side controls to move the glasses from right to 
left.

b) Adjust the front controls to move the glasses up and 
down to ensure your patient can clearly see the image.

c) Have the patient adjust the focus by moving the focus 
slider controls.

Eyeglass Controls
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8. Give your patient the hand controls.

The correct hand positioning is 
important for a successful examination.

– Left hand: blue/yellow control 
buttons

– Right hand: red/green control 
buttons

9. Landmark your patient for a brain exam.

The nasion is the proper brain landmark for brain studies.

10. Press Advance to Scan.

This moves your patient to the landmarked position in the 
magnet bore.

11. Press the microphone control to the ON position.

Microphone On/Off Switch

12. Adjust the microphone, if necessary.

a) Adjust the gooseneck of the microphone, to where it is in a 
comfortable position for communicating with your patient.

Microphone Control
b) Adjust the sound volume to a level comfortable for the patient to 

hear the audio stimulus.

c) If the paradigm requires an audio stimulus, set the microphone to 
Clinical mode. This is done from the back of the microphone by 
setting the two switches to Clinical. Although the audio operates 
when the switches are set to Functional mode, it may not be 

Microphone 
Gooseneck
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clearly heard or understood by the patient. Clinical mode 
provides a larger range of volume.

Backside of Microphone

NOTE: Media controls are not operational with the fMRI option. 
Paradigms are delivered to your patient via brain 
mapping software.

13. Choose the appropriate audio control.

Select the Music position when no 
instructions are being given to your 
patient

Select the No Music position when 
listening to your patient and no 
instructions are being given to the patient.

Select the Mic position when speaking to your patient.

– Typically place your mouth 2 inches away from the 
microphone and speak directly into it. Do not speak 
off to the side of the microphone.

– The volume for the microphone is set by the factory 
and can not be adjusted using the music volume 
control.

14. Adjust your patient’s voice control, if necessary.

This ensures the level at which you hear 
your patient is adequate.

NOTE: The patient’s microphone is always active, 
even while the music or instructions are being delivered.
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Perform an fMRI Exam
Set Up the Patient (BrainWaveSO 
only)
Patient preparation is a very important part of an fMRI exam. To 
effectively perform the exam, your patient needs to know what 
is happening during the procedure and what actions are 
required.

Use this procedure to set up the patient if your system is 
operating BrainWaveSO software.

1. Follow the manufacturer’s guidelines for setting up the 
patient.

2. Landmark your patient for a brain exam. 

The nasion is the proper brain landmark for brain studies.

3. Press Advance to Scan.

This moves your patient to the landmarked position in the 
magnet bore.

Quick Steps: Set Up the 
Patient (BrainWaveSO 
only)
1. Follow the manufacturer’s 

guidelines for setting up 
the patient.

2. Landmark your patient for 
a brain exam.

3. Press Advance to Scan.
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Perform an fMRI Exam
Prescribe and Perform the Localizer 
and 3D SPGR Series
There are two series that must be performed prior to acquiring 
the fMRI acquisition: the localizer and the 3D volume sequence 
of the whole brain. The 3D sequence is later used to overlay the 
task activation color maps.

The structural exam may be acquired before or after the task 
activation series. Acquiring the task activation part of the exam 
at the beginning can often ensure the patient is more alert than 
at the end of the exam. If acquiring the structural series at the 
end of the exam, you must send the localizer scan to the AW 
before starting the task activation.

Use this procedure to set up and scan the localizer series for 
the fMRI exam. Your patient should be set up for an fMRI exam 
prior to beginning these steps.

1. Enter the patient information.

2. Prescribe a 3-Plane Localizer series of the head.

Make sure the Scanning Range parameters are large 
enough to cover the entire brain.

3. Click [Save Series].
This saves the localizer series.

4. Click [Prepare to Scan].
This downloads the localizer series.

5. Click [Scan].
This performs the Auto Prescan and initiates the localizer 
acquisition.

6. Click [New Series].
This adds an additional series to the patient’s exam. 

Quick Steps: Prescribe 
and Perform the Localizer 
and 3D SPGR Series
1. Enter the patient 

information.

2. Prescribe a 3-Plane 
Localizer series of the 
head.

3. Click [Save Series].
4. Click [Prepare to Scan].
5. Click [Scan].
6. Click [New Series].
7. Prescribe a 3D SPGR 

sequence.

8. Click [Save Series].
9. Click [Prepare to Scan].
10. Click [Scan] to initiate 

Auto Prescan and start 
the 3D SPGR acquisition.
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7. Prescribe a 3D SPGR sequence.

This is a protocol example.

The Grad Mode text box is only available on 
TwinSpeed™ Resonance Module (TRM) systems.

8. Click [Save Series].

9. Click [Prepare to Scan].
This downloads the 3D SPGR series.

10. Click [Scan] to initiate Auto Prescan and start the 3D SPGR 
acquisition.

Parameter 
Selection

What You 
Select

Parameter 
Selection

What You 
Select

Imaging Parameters Acquisition Timing
Patient Position Supine Freq 256

Patient Entry Head First Phase 192
Coil Head NEX 1

Plane Axial Phase FOV 0.75

Mode 3D Freq DIR A/P
Pulse Sequence SPGR Auto Center Freq Water 

Grad Mode Zoom Flow Comp DIR N/A

Imaging Options Variable 
Bandwidth

Autoshim On

Scan Timing Phase Correct N/A

# of Echoes N/S # of Locs Before 
Pause

N/A

TE Min Full Additional Parameters
TR 30 SAT None

Flip Angle 45 Graphic Rx Cover the 
entire brain.

Bandwidth 15.63

Scanning Range
FOV 24 cm

Slice Thickness 1.2 mm
Spacing 0

Start Location Graphic Rx

End Location Graphic Rx
# of Slices 124
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Perform an fMRI Exam
Perform 3D Segmentation
Segmentation is the process of extracting the bone and skin 
from a 3D volume image. The resulting image is a 3D model of 
the brain, which can be later used to overlay task activation 
color maps. 

Use this procedure to perform the segmentation of your 3D 
SPGR image. Your patient should be set up and the localizer 
series should be acquired prior to beginning these steps.

1. Click the Management Desktop icon.

This opens the Network Browser.

2. Select Network > Select Remote Host.

3. Select AW as the host.

This is the host to which you want to transfer your 
images.

4. Click [OK] to register the network selections.

5. Select the 3D SPGR series.

This prepares the series to be transferred.

6. Select Network > Send Series.

This displays the confirmation window.

7. Click [OK] to transfer the images to the AW.

8. Select More Software > BrainWave or BrainWaveSO.

This launches the BrainWave software.

9. Select Acquire fMRI Scans from the BrainWave Main 
Menu.

This opens the fMRI Scans window.

Quick Steps: Perform 3D 
Segmentation
1. Click the Management 

Desktop icon.

2. Select Network > Select 
Remote Host.

3. Select AW as the host.

4. Click [OK] to register the 
network selections.

5. Select the 3D SPGR 
series.

6. Select Network > Send 
Series.

7. Click [OK] to transfer the 
images to the AW.

8. Select More Software > 
BrainWave.

9. Select Acquire fMRI 
Scans from the 
BrainWave Main Menu.

10. Click [Select].
11. Select the correct patient 

and 3D SPGR series from 
the Browser.

12. Click [Import and start 
segmentation 
automatically].
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10. Click [Select].

Acquire fMRI Scans Window
A confirmation message window and the Browser open.

11. Select the correct patient and 3D SPGR series from the 
Browser.

If your patient is not listed, try re-networking your 
patient’s 3D SPGR sequence from the scanner console.

12. Click [Import and start segmentation automatically].

Confirmation Message Window
If you are acquiring the task activation before the 
structural exam, click [Select Patient and Exam 
without import]. 
This registers your patient’s information into the 
appropriate text boxes in the Segmentation of Structural 
MRI area and begins the segmentation process.

– The Processing Status window opens and indicates 
processing is occurring. Watch the status bar until it is 
filled, and watch the messages that appear to the right 
of the status bar. Processing may take a while.

– As segmentation is taking place, your fMRI data 
acquisition can be started. Refer to the next section 
for this procedure.

The [Import but don’t start segmentation] button is 
used in cases where only structural scanning is desired.

NOTE: If any segmentation imperfections should occur, these 
should not be interpreted to indicate underlying 
pathology.
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Perform an fMRI Exam
Acquire the fMRI Data
Before you can visualize any functional data, you must first 
acquire it. Acquiring fMRI data involves the actual scanning of 
the task areas of the brain.

Use this procedure to acquire your fMRI data. Your patient 
should be set up, a localizer series should be acquired, and 3D 
Segmentation should be performed prior to starting these steps. 

NOTE: The segmenting process takes a while, therefore it is 
recommended you start the process prior to beginning 
these steps.

1. Click [New Series].
This adds an additional series to the patient’s exam.

2. Prescribe the fMRI sequence.

Quick Steps: Acquire the 
fMRI Data
1. Click [New Series].
2. Prescribe the fMRI 

sequence.

3. Save and download the 
fMRI series.

4. Press Move to Scan, if 
necessary.

5. Select the desired 
paradigm from the 
Paradigm list on the AW.

6. Click [Prep Scan] on the 
AW.

7. Click [New Template].
8. Tell your patient the 

tasking sequence is about 
to begin.

9. Click [Start] on the 
BrainWave Acquisition 
panel.

10. Click [Open Console to 
Stimulus System] in the 
Acquire fMRI Scans 
window.

11. Click [Close Console to 
Stimulus System].

12. After the current Stimulus 
series is completed, print 
the plot graphs, if desired.

13. Repeat step 6, and 9 -13 
to acquire an additional 
paradigm sequence.

14. When the scan is 
complete, click [Return 
to Main Menu].

Parameter 
Selection

What You 
Select

Parameter 
Selection

What You 
Select

Imaging Parameters Acquisition Timing
Patient Position Supine Freq 64

Patient Entry Head First Phase 64
Coil Head NEX 1

Plane Axial Phase FOV 1

Mode 2D Freq DIR R/L
Pulse Sequence Gradient 

Echo EPI
Auto Center 
Freq

Water 

Grad Mode Zoom Flow Comp DIR N/A

PSD Name epi_gre_64 Autoshim On

Scan Timing Phase Correct On

# of Shots 1 Additional Parameters
TE 40 SAT None
TR 4000 Graphic Rx Cover the 

entire 
brain.

Flip Angle 90

Echo Train 
Length

N/A

Bandwidth 62.5
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NOTE: The Grad Mode text box is only available on 
TwinSpeed™ Resonance Module (TRM) systems.

3. Save and download the fMRI series.

a) Click [Save Series].
b) Click [Prepare to Scan].

– This downloads the fMRI series.

4. Press Move to Scan, if necessary.

Located on your MR system keyboard.

Advances the table to the correct starting location.

5. Select the desired paradigm from the Paradigm list on the 
AW. 

Refer to the BrainWave Paradigms section of this 
chapter for a description of each paradigm.

6. Click [Prep Scan] on the AW.

Scanner Control Area of Acquire fMRI Scans Window
This step must be performed on the AW, not your 
scanner console.

Opens the RealTime Imaging window.

Scanning Range User CVs
FOV 24 cm Ramp Sampling 0
Slice Thickness 3 mm PSD Trigger 0

Spacing 0 # of RTC 
Dummy Acqs

4

Start Location Graphic Rx Initial State 0
End Location Graphic Rx Baseline 

Duration
6

# of Slices 40 Stimulation 
Duration

6

Scan Duration 96
Delay after each 
slice package

1

Parameter 
Selection

What You 
Select

Parameter 
Selection

What You 
Select
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7. Click [New Template].
This only occurs with the first paradigm after the first 
Prep Scan.

Creates a template image used for image header 
information once the fMRI series is started.

Performs Auto Prescan and the EPI reference scan.

Creating a new template is only required on the first 
paradigm sequence. 

8. Tell your patient the tasking sequence is about to begin.

Ensures your microphone is working correctly and your 
patient is ready for the tasks.

9. Click [Start] on the BrainWave Acquisition panel. 

It is important NOT to use the [Start] button on the Real 
Time panel as this results in the BrainWave application 
getting out of synchronization with realtime scanning.

This step must be performed on your AW, not your 
scanner console.

NOTE: BrainWaveSO does not include stimulus hardware, 
therefore, skip to step 13. You are responsible for 
keeping stimulus presentation in synchronization with 
scanning when using BrainWaveSO.

10. Click [Open Console to Stimulus System] in the Acquire 
fMRI Scans window.

Opens the Stimulus PC window, displaying the Patient 
Responses and Motion Detection windows.

Make sure the screen advances past the introduction 
paradigm screen and flashes Ready. This ensures the 
patient is seeing and/or hearing the stimulus. If you don’t 
see the “Ready” message flash, then quit the scan and 
call service.

11. Click [Close Console to Stimulus System].
Closing this window reduces the network traffic and 
helps to ensure a successful scan.
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12. After the current Stimulus series is completed, print the plot 
graphs, if desired.

a) Click [Print Plot] in the Patient Responses window.

b) Click [Print Plot] in the Motion Detection window.

– Paper copies of the patient’s graphs can only be 
printed if you have a color printer.

– The graphs must be printed prior to starting another 
paradigm.

13. Repeat step 6, and 9 - 13 to acquire an additional paradigm 
sequence.

The following substeps are only necessary if you are 
performing an additional paradigm sequence.

14. When the scan is complete, click [Return to Main Menu].
Prepares you for visualizing your patient’s data.

WARNING:Do not prescribe additional fMRI sequences 
while acquiring a fMRI sequence. This may cause 
system problems.
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Perform an fMRI Exam
Visualize the fMRI Data
Visualizing the fMRI data involves the creation of structural 
overlays of the color maps. These steps can only be performed 
after the data has been acquired.

NOTE: If the Browser is open, please close it before starting this 
procedure.

1. Click [Visualize Maps].
Launches the BrainWave visualization tool.

Automatically completes patient data information. 

If the displayed patient name or exam number is not the 
patient you currently want to visualize, click [Select], 
double-click the Patient Name, click the exam number, 
and click [Select].

2. Click [Import from AW Browser], if necessary.

Only perform this step if the patient name is not the 
patient you want to visualize data on.

a) Select your patient’s name.

b) Click [OK].

3. Select the desired paradigm information you want to 
visualize from the Paradigm list.

The Paradigm list only displays the paradigms you have 
acquired on this patient.

Refer to the BrainWave Paradigms section of this 
chapter for a description of each paradigm.

4. Select the desired type of overlay from the Overlay Type 
predefined list.

The Overlay Type list displays the image sets upon 
which functional maps can be overlaid.

Refer to the Visualize Maps Window section of this 
chapter for a brief description of each overlay type.

5. Select the thresholding factor.

The recommended and defaulted factor is p<0.05. 
Selecting this means data is demonstrating 95% 

Quick Steps: Visualize the 
fMRI Data
1. Click [Visualize Maps].
2. Click [Import from AW 

Browser], if necessary.

3. Select the desired 
paradigm information you 
want to visualize from the 
Paradigm list.

4. Select the desired type of 
overlay from the Overlay 
Type predefined list.

5. Select the thresholding 
factor.

6. Click [Create/Update 
Functional - Structural 
Overlay].
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confidence that there is statistical significance between 
the control and activation states.

Select Relative if you wish to adjust the threshold 
manually.

– Move the Relative slider from left to right to adjust to 
the threshold setting.

6. Click [Create/Update Functional - Structural Overlay].
Overlays functional activation map on the segmented 
structural data.

Example of a Structural Overlay

NOTE: Refer to the Visualize fMRI Data chapter for viewing 
options and functions.
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Reprocess fMRI Data
Once the acquisition of the fMRI scan is complete, your system 
automatically starts analyzing and processing the fMRI data. 
However, there may be times when you need to restart the 
analysis and processing of this data. For example, if the 
analysis and processing had been manually aborted, you need 
to process the data prior to viewing or manipulating the fMRI 
images.

Use this procedure to start the analysis application and process 
your fMRI data. This procedure can only be performed after the 
fMRI scan is complete.

1. Click [Re-Process fMRI Scans].
Located on the BrainWave Main Menu.

Launches the BrainWave processing tool. 

2. Click [Select].
Located in the Analyze Functional MR Data area of the 
Re-Process window.

Opens the Select Exam window.

Select Exam Window

3. Double-click the name of the patient you want to analyze.

Highlights the patient name you selected.

Displays the list of exams performed on the selected 
patient.

4. Click the exam number which corresponds to the fMRI data 
set you want to analyze.

Highlights the exam you selected.

Quick Steps: Reprocess 
fMRI Data
1. Click [Re-Process fMRI 

Scans].
2. Click [Select].
3. Double-click the name of 

the patient you want to 
analyze.

4. Click the exam number 
which corresponds to the 
fMRI data set you want to 
analyze.

5. Click [Select].
6. Select the desired 

paradigm information you 
want to visualize from the 
Paradigm list.

7. Click [Start fMR Image 
Processing].

8. Click [Abort fMRI Image 
Processing], if 
necessary, to stop the 
analysis process.
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5. Click [Select].
Closes the Select Exam window and automatically fills in 
the Patient and Exam text boxes with the patient you 
selected.

6. Select the desired paradigm information you want to 
visualize from the Paradigm list.

The Paradigm list only displays the paradigms you have 
acquired on this patient.

Refer to the BrainWave Paradigms section of this 
chapter for a description of each paradigm.

7. Click [Start fMR Image Processing].
Initiates the analyze process of the fMRI data.

Opens the Processing Status window.

This button label changes to [Abort fMRI Image 
Processing] option once the process begins.

8. Click [Abort fMRI Image Processing], if necessary, to stop 
the analysis process.
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Import fMRI Data
Use this procedure to import fMRI data from the AW if the 
acquired data does not appear in the BrainWave Browser.

1. Click [Re-Process fMRI Scans].
Located on the BrainWave Main Menu.

Launches the BrainWave processing tool. 

2. Click [Select].
Located in the Import Functional MR Data area of the 
Re-Process fMRI Scans window.

Opens the Select Functional Run window.

Select Functional Run Window

3. Double-click the name of the patient you want to import.

Highlights the patient name you selected.

Displays the list of exams performed on the selected 
patient.

4. Double-click the exam number corresponding to the fMRI 
data set you want to import.

Highlights the exam you selected.

Displays the lists of series performed on the selected 
patient.

5. Click the series number corresponding to the fMRI data set 
you want to import.

Highlights the series you selected.

6. Click [Select].
Closes the Select Exam window and automatically fills in 
the Patient and Exam text boxes with the patient you 
selected.

Quick Steps: Import fMRI 
Data
1. Click [Re-Process fMRI 

Scans].
2. Click [Select].
3. Double-click the name of 

the patient you want to 
import.

4. Double-click the exam 
number corresponding to 
the fMRI data set you 
want to import.

5. Click the series number 
corresponding to the fMRI 
data set you want to 
import.

6. Click [Select].
7. Select the desired 

paradigm you wish to 
analyze from the 
Paradigm list.

8. Click [Import Images 
from the AW System].
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7. Select the desired paradigm you wish to analyze from the 
Paradigm list.

The Paradigm list only displays the paradigms you have 
acquired on this patient.

Refer to the BrainWave Paradigms section of this 
chapter for a description of each paradigm.

8. Click [Import Images from the AW System].
Transfers the selected series of the patient to the 
BrainWave database.

This continues with analysis.
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Save/Restore BrainWaveSO System 
Information
Use this procedure to save or restore your paradigm name and 
code table. Save your tables every time you change the 
paradigm table so if you have a software upgrade or you need 
to recover from a disk crash, you will be able to restore the most 
recent paradigm table.

1. Click [Manage] in the Main menu.

2. Click [Save/Restore BrainWaveSO System Information].

3. Type-in your password and click [OK].
This is the same password that is used by the 
administrator when modifying the configuration defaults 
and setting the modes.

Only the administrator who manages the paradigm table 
should be saving and restoring paradigms.

4. Put the floppy in the drive to which you are either saving or 
restoring paradigm tables.

5. Click a save or restore option.

[Save Information to Floppy Disk] saves the paradigm 
table to floppy disk, [Restore Information from Floppy 
Disk] restores the paradigm table from floppy disk to the 
system disk.

6. Click [OK] to confirm your selection.

Save Information to Floppy Disk Confirmation Prompt

Quick Steps: Save/Restor
e BrainWaveSO System 
Information
1. Click [Manage] in the 

Main menu.

2. Click [Save/Restore 
BrainWaveSO System 
Information].

3. Type-in your password 
and click [OK].

4. Put the floppy in the drive 
to which you are either 
saving or restoring 
paradigm tables.

5. Click a save or restore 
option.

6. Click [OK] to confirm your 
selection.
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Restore Data to Hard Drive Confirmation Prompt
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Print Color Images
Brain Mapping images are parametric color maps overlying EPI 
or 3D volume images. These images are helpful in visualizing 
areas of task activation and intensity levels of the activated 
areas. Printing the images provides a permanent hard copy of 
task activated areas in the brain.

In order to print color images, you must have a color printer 
connected to your system. A service engineer could assist you 
with the connection of such a printer.

1. Click the image you wish to print.

You can do this from the Lightbox View or Volume 
Rendering viewers.

Highlights the viewport of the image you wish to print.

2. Select File > Print.
Located across the top portion of the viewer.

3. Repeat steps one and two, for any additional views you 
wish to print.

NOTE: Images can also be printed from the AW. Refer to your 
AW documentation for printing instructions. Images 
printed from your AW can not be printed in color.

Quick Steps: Print Color 
Images
1. Click the image you wish 

to print.

2. Select File > Print.
3. Repeat steps one and 

two, for any additional 
views you wish to print.
2333956-100 Rev. 0 (06/02)  8-53
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
Delete Logfiles
Remove all Logfiles (BrainWave only)
When performing an fMRI exam, patient responses to the 
paradigm stimuli are recorded and stored on your Stimulus PC. 
These logfiles eventually need to be deleted to provide space 
for future acquisition logs.

Use this procedure to remove all the logfiles from the Stimulus 
PC. These steps should only be performed after the fMRI exam 
is complete and brain mapping has been performed.

1. Click [Manage System].
This is located on the Main Menu of the BrainWave 
window.

2. Click [Delete Logfiles from Stimulus System].
This removes all logfiles from the Stimulus system.

Quick Steps: Remove all 
Logfiles (BrainWave only)
1. Click [Manage System].
2. Click [Delete Logfiles 

from Stimulus System].
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Delete Logfiles
Remove Selected Logfiles
Use this procedure to only remove selected logfiles from the 
Stimulus PC. These steps should only be performed by an 
advanced Stimulus PC user, after the fMRI exam is complete.

1. Click [Manage System].
This is located on the Main Menu of the BrainWave 
window.

2. Click [Open Console to Stimulus System]. 
This opens the Stimulus PC window.

3. Position your cursor in the console window.

Temporarily stops the “four boxes” display for 
approximately five seconds.

NOTE: Your cursor must remain in the console window for the 
remainder of the steps. This ensures proper procedure 
functioning.

4. Right-click on the NeuroActivator icon.

This is located on the right bottom side of the Windows 
task bar.

This opens the NeuroActivator window.

5. Click [Exit].
This stops the NeuroActivator application so the “four 
boxes” display does not keep running.

6. Select Start > Programs > Windows NT Explorer. 
Opens the Windows Explorer panel.

7. Open the Logfile folder.

a) Click the C directory.

b) Click the NeuroActivator folder.

c) Click the Logfiles folder.

8. Select the files you want to remove.

Logfiles are listed by type, month, day and year 
(ttmmddyyyy).

Quick Steps: Remove 
Selected Logfiles
1. Click [Manage System].
2. Click [Open Console to 

Stimulus System]. 
3. Position your cursor in the 

console window.

4. Right-click on the 
NeuroActivator icon.

5. Click [Exit].
6. Select Start > Programs 

> Windows NT Explorer. 
7. Open the Logfile folder.

8. Select the files you want 
to remove.

9. Click [File].
10. Select File > Delete.

11. Click [Yes].
12. Right-click on the 

Recycle Bin icon.

13. Click [Empty Recycle 
Bin].

14. Select File > Close.

15. Select Start > Programs 
> NeuroActivator > 
Clinical.

16. Click [Close Console to 
Stimulus System].

17. Click [Return to Main 
Menu].
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a) Press Shift and click to select a consecutive range of 
files.

b) Press Ctrl and click to select additional non-consecutive 
files.

9. Click [File].
This is located at the top of the Windows Explorer panel.

10. Select File > Delete.

This opens a confirmation message window.

11. Click [Yes].
This removes all selected logfiles.

12. Right-click on the Recycle Bin icon.

This is located on the left panel of the Windows Explorer.

13. Click [Empty Recycle Bin].
This completely deletes the logfiles from the Stimulus PC 
disk.

14. Select File > Close.

This exits the Windows Explorer.

15. Select Start > Programs > NeuroActivator > 
NeuroActivator Clinical. 

This restarts the NeuroActivator application.

The “four boxes” display returns.

16. Click [Close Console to Stimulus System].
This exits the console window.

17. Click [Return to Main Menu].
This displays the BrainWave Main Menu.
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Chapter 9

Visualize fMRI Data

Introduction
BrainWave Visualizer is the visualization software included in the optional 
Functional Magnetic Resonance Imaging (fMRI) package. This software is 
located on your Advantage Windows (AW) 4.0 workstation. BrainWave Visualizer 
allows you to interactively view and edit fMRI data. It is important you read and 
understand the Functional Magnetic Resonance Imaging chapter before you use 
the visualization tool.

This chapter explains the BrainWave Visualizer fMRI visualization tool. It also 
provides the step-by-step instructions to help you learn how to:
• Adjust the Volume Rendering View
• Adjust the Lightbox View

In addition, this chapter answers the following questions:

1. What is a Volume Rendering View?

2. What is a Lightbox View?

3. How do you modify imaging views?

4. What are the quick keyboard functions?
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What Do I Need to Know 
About...
This section presents the concepts necessary to successfully understand 
the BrainWave Visualizer fMRI visualization tool. Specifically, you need to 
understand:
• BrainWave Visualizer Basics

– Transfer Functions
• BrainWave Visualizer Interface

– Main Menu Bar
– Control Panel
– Volume Rendering View
– Image Display Views
– Lightbox View
– Message Area
– Progress Area

• Volume Rendering View Interactions
– Window Properties
– View Properties
– Volume Appearance Properties
– Volume Features Properties

• Lightbox View Interactions
– Window Properties
– View Properties
– Image Features Properties

BrainWave Visualizer Basics
BrainWave Visualizer is the volume rendering tool of the BrainWave™ 
software that interactively displays fMRI data. This tool allows the 
transformation of the three-dimensional (3D) volume fMRI data into an 
image. The conversion of the volume into an image can be accomplished 
with a variety of volume rendering techniques. Most volume rendering 
techniques essentially perform the same function, but use different 
methods.
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Transfer Functions
The actual image appearance depends on a transfer function that relates 
voxel values into color and opacity and the material properties of the 
volume. For example, if you have an fMRI dataset containing bone and 
skin, you must identify transfer functions that map color and opacity to these 
features based on properties of the dataset. Scalar value can be grouped 
into color (red, green, blue) and alpha (opacity), also referred to as RGBA. 
Scalar value opacity transfer functions are useful for narrowing the range of 
scalar values that are rendered. The mapping of the gradient value 
magnitude to an opacity is also a useful transfer function for highlighting 
areas of sharp change. The final opacity is determined by multiplying the 
scalar value opacity by the gradient magnitude opacity (Figure 9-1). Your 
selection of transfer functions affects the final image produced from the 
fMRI dataset.

Figure 9-1 Transfer Functions

Blending functions consider the scalar values that are mapped to a pixel on 
the image. They result in a final pixel value that corresponds to the color 
and opacity transfer functions, the shading information, the interpolation 
type, and the gradients. Each specific blending function identifies how these 
values are combined in order to produce the final pixel value. Maximum 
intensity blending functions consider the scalar values and select the 
maximum value. 

BrainWave Visualizer Interface
The BrainWave Visualizer interface consists of different areas that allow 
you to interact with the software. 
• Main Menu Bar
• Control Panel
• Volume Rendering View
• Image Display Views
• Lightbox View
• Message Area
• Progress Area
2333956-100 Rev. 0 (06/02)  9-3
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
Figure 9-2 represents the default configuration of BrainWave Visualizer 
when a volume is loaded. In the default configuration, all areas are visual 
except the Lightbox View. This view can be displayed in place of the 3D 
Volume Rendering and Image Display views by selecting Lightbox from the 
View options on the Main Menu bar.

Figure 9-2 BrainWave Visualizer Interface

Main Menu Bar
The Main Menu bar in the BrainWave Visualizer is always visible and 
contains the following basic options:
• File – allows you to print the file as a postscript or exit the application. 
• View – allows you to control the layout of the image display views, which 

are the 3D Volume Rendering View, the Image Display Views, and the 
Lightbox View. 

• Properties – allows you to manage the control panel. The options 
available are dependent on the currently selected window.
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• Help – allows you to display basic information about the BrainWave 
Visualizer.

Control Panel
The control panel contains the selections for various data and viewing 
properties such as the transfer functions, window and level, and annotation. 
The control panel display depends on the selected property on the 
Properties menu.

Volume Rendering View
The Volume Rendering View displays a 3D view of the currently loaded 
fMRI data. Clicking the title bar of this viewer makes it active. Once active, 
the Properties menu on the Main Menu bar can be used to control which 
control panel is displayed. 

Image Display Views
The Image Display Views presents two-dimensional (2D) views of 
orthogonal slices of the 3D volume. Either one or three Image Display 
Views can be visible, depending on the settings selected in the View 
options on the Main Menu bar. The three views represent the axial, coronal, 
and sagittal slices of the 3D volume. 

Lightbox View 
The Lightbox View displays a 2D view of a grid of orthogonal slices of the 
3D volume. The control panel associated with this view can be used to 
select a 2x2, 3x2, or a 3x3 layout with the axial, coronal, or sagittal slices. 
The control panel displayed depends on your selections from the 
Properties menu on the Main Menu bar when this view is active.

NOTE: If this View is displayed, you will not see the Volume Rendering View 
and Image Display View areas.

Message Area
The Message area is always visible and displays information such as image 
cursor position, underlying scalar value, and measurement values.

Progress Area
The Progress area is always visible and displays the ongoing advancement 
status during some time consuming operations, such as loading data.
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Volume Rendering View Interactions
You are able to control the motion of the camera when you activate the 
Volume Rendering View by clicking the title bar of the viewer. An active view 
means the control panel options for that view are available in the 
Properties menu, and the print and save functions are operable for that 
view. There are five properties within the Volume Rendering View. Each 
property display contains tabs of adjustable imaging functions. Table 9-1 
provides a list of the properties for the 3D Volume Rendering View and the 
tabs presented in each area.

Table 9-1 Volume Rendering View Properties

Window Properties
When you select Window from the Properties menu, the Layout and 
Preferences tabs appear in the control panel. These tabs allow you to 
choose the layout configuration and image preferences of the views.

Layout Tab 

There are three basic configurations for the Volume Rendering View layout:
• Volume Only – one Volume Rendering View 
• One and Three – one Volume Rendering View above three Image 

Display Views
• Two by Two – one Volume Rendering View with Image Display Views in 

a 2x2 format

NOTE: The Lightbox selection in the Window layout options opens the 
Lightbox View, which does not allow volume rendering. Refer to the 
Lightbox View Interactions section for the layout options.

You may select the window configuration by choosing a selection from the 
View menu on the Main Menu bar (Figure 9-3) or from the Layout tab 
(Figure 9-4), located in the control panel when the Window property is 
selected. 

Properties Control Panel Display
Hide Closes the control panel.

Window Displays the Layout and Preferences tabs.

View Displays the General and Annotate tabs.

Volume Appearance Displays the General, Material, and Transfer 
tabs.

Volume Features Displays the Cut and Annotate tabs.
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Figure 9-3 View Layout Selections

Figure 9-4 Window Layout Tab

Preferences Tab

Image view options, such as window and leveling and slice orientation, are 
selected from the Preferences tab (Figure 9-5). The window and level 
operations may either be simultaneously linked across all image viewports 
or independent in each viewport. The orientation of the slices in the 
Lightbox View allows you to display all axial, coronal, or sagittal slices within 
the orthogonal viewports.
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Figure 9-5 Window Preferences Tab

View Properties
When you select View from the Properties menu, the control panel of the 
displays two tabs, General and Annotate. View properties are used to 
control the appearance of your viewports.

General Tab

The View General tab (Figure 9-6) allows you to change the background 
color and select standard views using the Right, Anterior, Superior (RAS) 
coordinate system.

Figure 9-6 View General Tab

You use the [Set Color] button to set the background color of the Volume 
Rendering View. You select the desired color from a color palette in the 
Choose Color window. The [OK] button accepts your color choice, displays 
it on the Set Color button, and applies the color to the background of the 
Volume Rendering View.
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There are six standard views representing the view down each of the major 
axes: Right, Left, Anterior, Posterior, Superior, and Inferior. These are 
viewing positions rather than viewing directions. For example, the [Right] 
button is a view from the right side of the volume, looking down towards the 
left.

Annotate Tab

There are two annotation types on the Annotate tab (Figure 9-7), custom 
and system specific annotation. Table 9-2 provides a description of the 
available options.

Figure 9-7 Annotate Tab

Table 9-2 View Annotate Tab Options

Option Description
Header Annotation

Display Header 
Annotation

Displays or hides a single line of text at the top center 
of the viewer. The text is entered in the Header text 
box. The annotation scales based on the length of the 
text.

[Set Color]
Opens the Choose Color window, allowing you to 
move the arrow sliders to change the header 
annotation color.

Header Allows you to enter custom Header annotation in the 
text box. 
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Volume Appearance Properties
When you select Volume Appearance from the Properties menu, the 
General, Material, and Transfer tabs appear in the control panel. These 
properties include options on the blending function, super sampling, 
material properties, and transfer functions. You can adjust these properties 
to control the appearance of the fMRI data.

General Tab

The Volume Appearance General tab (Figure 9-8) displays helpful 
information about the volume that can be used to control rendering 
properties for the volume. This tab is divided into four main areas:
• Volume Information – displays information about the size of voxels, 

units, data origin, and scalar range.
• Level-of-Detail control – allows speed adjustments verses image quality 

trade-offs.
• Blending Function – provides options on which pixels contribute to the 

imaging volume.
• Super Sampling – allows the appearance of the image resolution to be 

slightly enhanced at the expense of rendering time.

Corner Annotation

Display Corner 
Annotation

Displays four multi-line text items in the corners of the 
viewer when that viewer is active. Clicking the title bar 
activates that view. A corner can remain blank.

[Set Color]
Opens the Choose Color window, allowing you to 
move the arrow sliders to change the color of the 
corner annotation. All corner annotation is the same 
color.

Option Description
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Figure 9-8 Volume Appearance General Tab

Table 9-3 provides a description of the options located in the Volume 
Appearance General tab.

Table 9-3 Volume Appearance General Tab Options

Options Descriptions
Volume Information

Size in Voxels Indicates the image matrix used.

Size in Units Indicates the image field of view (FOV) in the X, Y, 
and Z directions.

Sample Spacing Indicates the resolution values in the X, Y, and Z 
directions.

Data Origin Indicates the position of the cursor. 

Scalar Range Indicates the minimum and maximum color scalar 
units.
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NOTE: The Volume Appearance General tab should not be confused with 
the General tab in the View properties of the control panel. These 
two tabs have different functions. 

Material Tab

The Volume Appearance Material tab (Figure 9-9) provides options for 
adjusting how the imaging volume reflects light. Table 9-4 provides a 
description of these options.

Level-of-Detail Control

Interactive 
Speed

Provides a shortcut list of three volume rendering 
viewing speeds. The faster the speed, the lower the 
image quality.

Use Low 
Resolution 
Texture Mapping

Provides a low detail level of the texture mapping 
function. Images are displayed with a low resolution 
texture while being moved.

Use Medium 
Resolution 
Texture Mapping

Provides an intermediate detail level of the texture 
mapping function. Images are displayed with a 
medium resolution texture immediately after image 
movement stops.

Use High 
Resolution 
Texture Mapping

Provides a higher detail level of the texture mapping 
function. Images are displayed with a high resolution 
texture a few seconds after image movement stops.

Use Ray Casting
Provides the highest detail level of the texture 
mapping function. Images are displayed with the 
highest resolution after image movement stops. This 
may take a while to display.

Blending Function
Maximum 
Intensity

Displays volume image using only the highest 
intensity pixels.

Composite Displays volume image fused with images taken at 
the same image location.

Super Sampling
[Z axis by 1]
[Z axis by 2]
[Z axis by 4]

Enhances the existing slice direction resolution by 
factors of 1, 2, and 4.

Options Descriptions
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Figure 9-9 Volume Appearance Material Tab

Table 9-4 Volume Appearance Material Tab Options

Option Description
Material Properties

Enable 
Shading Activates the shading option.

Ambient Indicates the lighting ambient coefficient value. 
Acceptable values range from 0 to 100. 

Diffuse Indicates the lighting diffuse coefficient value. 
Acceptable values range from 0 to 100.

Specular Indicates the lighting specular coefficient value. 
Acceptable values range from 0 to 100.

Specular 
Power

Indicates the lighting specular power. Acceptable 
values range from 0 to 50.

Preset Materials
[Unshaded] Applies a pre-defined, non-shaded light setting.

[Dull] Applies a pre-defined, dull appearance light setting.

[Smooth] Applies a pre-defined, smooth light setting.

[Shiny] Applies a pre-defined, shiny light setting.
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Transfer Tab

The Volume Appearance Transfer tab (Figure 9-10) includes color and 
opacity functions used by the functional maps to influence the appearance 
of the final image. The functions on this tab are the most difficult to set 
because the adjustments are data dependent and must be performed 
manually. There are three transfer functions that affect the rendering 
process. 
• Color transfer functions – converts the scalar data into red, green, and 

blue (RGB) colors.
• Opacity transfer function – converts the scalar data into alpha 

(transparency) values.
• Gradient transfer function – converts the magnitude of the gradient, 

(rate of change in the scalar data) into opacities.

The color and opacity transfer functions are useful for making material 
imaging changes, while the gradient transfer function is applicable for 
enhancing the edges of the imaging volume.

The Transfer tab is divided into two main areas, Preset Transfer Functions 
and Transfer Function Editor. The Preset Transfer Functions area allows 
you to choose preset color maps, an opacity ramp, and a gradient 
magnitude. There are three color map options: Rainbow, Gray, and White. 
Linear and Solid are the two opacity ramp options provided. You also have 
the option to vary the edge detection settings on the image volume.

The Transfer Function Editor allows you to create transfer functions to 
display the data. Values can be entered numerically or by making scalar 
graph adjustments. Within each graph, at least two nodes are displayed. 
Additional nodes may be added. You can activate and move the nodes to 
make transfer adjustments. An activated node is represented by an 
enlarged node surrounded by a red circle (Figure 9-10). 
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Figure 9-10 Volume Appearance Transfer Tab

Table 9-5 describes the Volume Appearance Transfer tab available options.

Table 9-5 Volume Appearance Transfer Tab Options

Options Descriptions
Preset Transfer Functions

Color Provides pre-defined color ramp settings for Rainbow, 
Gray, or White.

Scalar Opacity 
Provides pre-defined opacity linear ramp settings for a 
ramp ranging from 0.0 to 0.2, a ramp ranging from 0.0 
to 1.0, and a solid opaque function (fixed 1.0).

Gradient 
Opacity

Provides pre-defined gradient magnitude settings for 
no edge detection, medium edge detection, or strong 
edge detection.

[Apply] Displays the selected color, scalar opacity, and/or 
gradient opacity pre-defined settings.

Activated node
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[Reset] Returns the imaging volume to its original settings.
Transfer Function Editor

Scalar Establishes the scalar value of the current node. The 
value range is 0 to 1.

Opacity Establishes the opacity value of the current node. The 
value range is 0 to 1.

R,G,B,H,S,V
Indicates the respective value (red, green, blue, hue, 
saturation, value factor) of the current node. The 
acceptable range of values are from 0 to 1.

Interactive 
Apply

Applies function changes immediately to the imaging 
volume.

Value Displays the current node’s value color scale.

Hue/Saturation Displays the current node’s hue and saturation color 
palette.

Scalar 
Opacity/Color

Left text box represents the minimum scalar value, 
located on the left edge of the color spectrum. Right 
text box represents the maximum scalar value, located 
on the right edge of the color spectrum.

RGB Interpolates colors in the red, green, and blue color 
scale.

HSV Interpolates colors in the hue, saturation, and value 
color scale.

Scalar Opacity 
Function

Top text box indicates the maximum opacity value, 
represented by the top edge of the scalar opacity 
function. Bottom text box indicates the minimum 
opacity value, represented by the bottom edge of the 
scalar opacity function.

W/L Activates the window and level mode for opacity 
editing.

Lock Combines the color and opacity functions.
Scalar Color 
Function Displays the Scalar Color Function bar.

Gradient 
Opacity 
Function

Left text box indicates the minimum gradient 
magnitude value represented by the left edge of the 
gradient opacity function. The right text box indicates 
the maximum gradient magnitude value represented 
by the right edge of the gradient opacity function.

On Activates the gradient modulation function.

Options Descriptions
9-16  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Visualize fMRI Data
Volume Features Properties
The Volume Features option allows you to cut (crop) and reformat your 
imaging volume. Annotation can be displayed or removed from selected 
viewports. When you select Volume Features from the Properties menu, 
the Cut and Annotate tabs appear on the control panel. 

Cut Tab

The Volume Features Cut tab (Figure 9-11) allows you to crop and reformat 
your imaging volume. 

Figure 9-11 Volume Features Cut Tab

You can apply orthogonal cuts to the imaging volume by using the Enable 
Crop option. Cuts are made by adjusting the six imaging sliders and 
selecting a cropping type. There are five cropping types (Table 9-6) in the 
Type pull-down menu. 
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Table 9-6 Volume Features Cropping Types

When using any crop type other than Subvolume, a minimum of three 
orthogonal sliders must be moved in order to crop the volume. If you select 
Subvolume as the crop type, then only a minimum of one slider is needed to 
crop the volume. 

Cropping Type Description

Subvolume Allows only voxel cuts defined by the imaging 
sliders. This type is the system default and the 
volume is interactively updated as the cropping 
sliders are moved.

Fence
Alters a portion of the volume between any pair 
of orthogonal planes by removing the corner of 
the imaging volume. 

Inverted Fence Alters a portion of the volume outside of the 
orthogonal planes. This is the reverse action of 
the Fence operation. Instead of removing the 
imaging corners, the corners are the only 
portion of the imaging volume displayed. 

Cross
Removes the outer voxels, leaving the portion 
of the volume that is between any two pair of 
orthogonal planes. This displays a cross 
imaging effect. 

Inverted Cross Displays the portion of the volume outside of the 
two orthogonal planes, while the inner voxels 
(cross) are removed. This is the reverse 
operation of the Cross cropping type. 
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Figure 9-12 displays images with each cropping type applied. The sliders 
(Figure 9-13) are in the same position for each image to illustrate the 
difference.

Figure 9-12 Images of Cropping Types

Figure 9-13 Cropping Sliders

Thick reformat is the process of slicing the volume with a slab. The Thick 
Reformat mode is activated on the Cut tab (Figure 9-11) with the Enable 
Reformat option. The thickness of the slab can be controlled by adjusting 
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the Thickness slider. The Mouse Controls menu provides two options for 
how you use the mouse to manipulate your image. Camera is used for the 
normal reformatting mode. Reformat allows you to rotate the image using 
the mouse.

Annotation Tab

The Volume Feature Annotate tab includes several annotation and coloring 
options. Various cursor types can also be included. Figure 9-14 displays the 
Annotate tab and Table 9-7 provides a description of the options.

NOTE: The Annotate tab (Figure 9-14) should not be confused with the 
Annotate tab in the View property control panel. These two tabs have 
different functions. 

Figure 9-14 Volume Features AnnotateTab

Table 9-7 Volume Features Annotate Tab Options

Option Description

[Set Color]
Opens the Choose Color window, allowing color 
changes to be made to the respective function. All 
[Set Color] buttons on this tab have the same 
functionality.
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Bounding Box
Display 
Bounding Box Shows a 3D interactive box.

Scalar Bar

Display Scalar 
Bar

Posts a scalar bar on the right side of the volume 
viewport showing the range of colors in the activation 
map. The color corresponds to a numeric value that 
indicates the confidence of true activation. A color 
corresponding to a lower number indicates less 
confidence of true activation. 

Scalar Bar Title Allows you to display a custom title over the Scalar 
Bar.

Labeled Axes

Display 3D Tick 
Axes

Displays the 3D Tick Axes in X, Y coordinates of a 
structure as it relates to its position in the volume. For 
example, if you move the S/I slider to a desired 
structure, the number on the slider represents the 
number of millimeters from the bottom of the volume.

L/R Axis Label Allows you to enter a custom axis label for the left and 
right axes.

P/A Axis Label Allows you to enter a custom axis label for the 
posterior and anterior axes.

I/S Axis Label Allows you to enter a custom axis label for the inferior 
and superior axes.

3D Cursor
Display 3D 
Cursor

Shows one of two 3D Cursors. Cursor options are 
selected via the Type pull-down menu.

Type Allows selection of cross-hair and plane cursor types.

L/R Axis Adjusts the 3D Cursor in the left and right imaging 
directions.

P/A Axis Adjusts the 3D Cursor in the posterior and anterior 
imaging directions.

I/S Axis Adjusts the 3D Cursor in the inferior and superior 
imaging directions.

Option Description
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Lightbox View Interactions
The Lightbox View provides an alternative method for viewing your fMRI 
data. In order to see the Lightbox, you must have the lightbox layout option 
selected from the View menu or Layout tab. When Lightbox is the current 
layout option, it is automatically active since it is the only available view. You 
can select the Lightbox properties from the Properties menu on the Main 
Menu bar.

This view only displays 2D orthogonal images. Images can be axial, 
coronal, and sagittal slices of the 3D volume. There are three main 
properties within this type of view. Each property display contains tabs of 
adjustable imaging functions. Table 9-8 provides a list of the properties for 
the Lightbox View and the tabs presented in each area.

Table 9-8 Lightbox View Properties

Window Properties
When you select Window from the Properties menu, the Layout and 
Preferences tabs appear in the control panel. Similar to the 3D Volume 
Rendering View, these tabs allow you to choose the layout configuration 
and image preferences of the views. 

Layout Tab

The Lightbox View has several different layout formats (Figure 9-15) that 
can only be used by this viewer. Layouts include a four, six, and nine 
viewport setting. The images being displayed are either all axial, sagittal or 
coronal.

Properties Control Panel Display
Hide Closes the control panel.

Window Displays the Layout and Preferences tabs.

View Displays the General and Annotate tabs.

Image Features Displays image feature functions.
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Figure 9-15 Lightbox Layout Options Area

Preferences Tab

Image view options, such as window and leveling and slice orientation, are 
selected from the Lightbox View Preferences tab. 

NOTE: Refer to the Preferences Tab section in the Volume Rendering View 
Interactions section. These preferences are identical for the Lightbox 
View.

View Properties
When you select View from the Properties menu, the General tab displays 
in the control panel. 

General Tab

The Lightbox View General tab allows you to control the background color 
of the Lightbox View with the [Set Color] option. A Choose Color window 
is displayed, allowing you to choose the background color. Once you select 
a new color, that color displays on the [Set Color] button.
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Figure 9-16 General Tab

Annotate Tab

There are two annotation types on the Annotate tab, custom and system 
specific annotation.

NOTE: Refer to Annotation Tab in the Volume Rendering Interactions 
section. The annotation options for the Lightbox View are identical.

Image Features Properties
When you select Image Features from the Properties menu, the control 
panel allows you to control various image features such as slice locations, 
window and leveling settings, mouse controls, image color and probe 
(cursor) information. Figure 9-17 displays the Image Features property 
window and Table 9-9 provides a description of the options.
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Figure 9-17 Image Features Properties

Table 9-9 Image Feature Options

Option Description
Slice Location

Slice Number
Indicates the image number displayed within the 
viewer in voxels and units. You can enter a number in 
the text box or use the slider to control the slice 
number.

Window/Level
Window Indicates your image windowing factor.

Level Indicates your image leveling factor.

[Reset 
Window/Level]

Returns the window and leveling values to the original 
setting.

Mouse Operations
Left
Middle
Right

Defines the function of the left, middle, and right 
mouse buttons. The options are Pan, W/L 
(window/level), Zoom, and Measure.
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Shift-L
Shift-M
Shift-R

Provides additional mouse button functionality by 
pressing the Shift key and the desired mouse button 
at the same. For example, Shift-L defines the function 
when you press Shift and the left mouse button. The 
options are Pan, W/L (window/level), Zoom, and 
Measure.

Image Color

GrayScale Displays the functional activity in various shades of 
gray.

Color Displays the functional activity in color.

Probe Information

Value Displays the scalar value of the image pixel on which 
the cursor is placed. 

Location Displays the location (in voxels and units) of the image 
pixel on which the cursor is placed. 

Option Description
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How Do I...
This section provides the step-by-step instructions for rendering images to 
visualize white matter tracts. Specifically, it describes how to:
• Adjust the Volume Rendering View

– Control the Hide and Window Properties
– Control the Volume Features Properties
– Control the Volume Appearance Properties
– Control the Volume Features Properties
– Manipulate the Volume

• Adjust the Lightbox View
– Control the Hide and Window Properties
– Control the View Properties
– Control the Image Features Properties

NOTE: Prior to performing the tasks in this chapter, you should acquire and 
perform an fMRI exam. Use the Visualize fMRI Data instructions, 
located in the Functional Magnetic Resonance Imaging chapter to 
open the BrainWave Visualizer application of the BrainWave 
software. 
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Adjust the Volume Rendering View
Control the Hide and Window 
Properties
After your fMR images have been processed and analyzed, 
they can be displayed in the Volume Rendering View with the 
BrainWave Visualizer tool. There are several Volume Rendering 
properties that can be adjusted to your personal preference. 

1. Select the desired layout from the View menu.

Volume Only – one Volume Rendering View 

One and Three – one Volume Rendering View above 
three Image Display Views

Two by Two – one Volume Rendering View with Image 
Display Views in a 2x2 format

2. Select Properties > Hide Properties.

This hides the control panel, maximizing the visualization 
area.

3. Select Properties > Window.

The Layout and Preferences tabs display in the control 
panel.

4. Select the Preferences tab to move it forward.

5. Select the desired window and level settings.

Linked across views automatically adjusts all viewports 
to the same window and level setting.

Independent only adjusts the window and level setting 
for the viewport your mouse is located.

Quick Steps: Control the 
Hide and Window 
Properties
1. Select the desired layout 

from the View menu.

2. Select Properties > Hide 
Properties.

3. Select Properties > 
Window.

4. Select the Preferences 
tab to move it forward.

5. Select the desired window 
and level settings.
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Adjust the Volume Rendering View
Control the View Properties
The View properties of the Volume Rendering View display the 
General and Annotate tabs in the control panel. These 
properties allow you to control the appearance of your 
viewports by performing the following functions:
• Change the Background Color
• Select a Standard View
• Annotate the Volume

Change the Background Color of the Volume
Use this procedure to select the background color for the 
Volume Rendering View.

1. Select Properties > View.

The control panel displays the General and Annotate 
tabs.

2. Select the General tab to move it forward.

3. Click [Set Color].
The Choose Color window displays.

4. Select the desired color for the background from the color 
palette.

5. Click [OK].
The background color updates to your selection on the 
image view.

Select a Standard View
Use this procedure to select a standard orthogonal axis view.

1. Select Properties > View.

The control panel displays the General and Annotate 
tabs.

2. Select the General tab to move it forward.

Quick Steps: Control the 
View Properties

Change the Background 
Color of the Volume
1. Select Properties > View.

2. Select the General tab to 
move it forward.

3. Click [Set Color].
4. Select the desired color for 

the background from the 
color palette.

5. Click [OK].

Select a Standard View
1. Select Properties > View.

2. Select the General tab to 
move it forward.

3. Click the desired 
orthogonal axis view.

Annotate the Volume
1. Select Properties > View.

2. Select the Annotate tab to 
move it forward.

3. Select Display Header 
Annotation.

4. Enter your desired text in 
the Header text box.

5. Click [Set Color].
6. Select the desired color for 

text display from the color 
palette.

7. Click [OK].
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3. Click the desired orthogonal axis view.

There are six standard views representing the view down each of the 
major axes: right, left, anterior, posterior, superior, and inferior.

These are viewing positions rather than viewing directions.

Annotate the Image
Use this procedure to modify the Header and Corner Annotation function by 
adjusting the text color and annotation views.

1. Select Properties > View.

The control panel displays the General and Annotate tabs.

2. Select the Annotate tab to move it forward.

3. Select Display Header Annotation.

4. Enter your desired text in the Header text box.

The annotation displays at the top center of the view.

The annotation scales in size based on the length of the text.

5. Click [Set Color].
The Choose Color window displays.

6. Select the desired color for text display from the color palette.

Alternatively, you may click and drag the + (cursor) to select your 
desired color.

7. Click [OK].
The Choose Color window closes.

The text displays in the viewport and prints, if you have a color 
printer.
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Adjust the Volume Rendering View
Control the Volume Appearance 
Properties
You can adjust the shading and transfer functions to control the 
appearance of the fMRI data. For your ease, the Volume 
Appearance properties have been divided into the following 
sections:
• Adjust the Image Shading
• Select Preset Transfer Functions
• Create Custom Color and Opacity Transfer Functions
• Create Custom Gradient Transfer Functions

Adjust the Image Shading
The Material options allow you to adjust your image shading by 
choosing pre-defined shading materials or creating your own.

1. Select Properties > Volume Appearance.

The control panel displays the General, Material, and 
Transfer tabs.

2. Select the Material tab to move it forward.

3. Select Enable Shading. 

The shading function is activated. 

4. Click and drag the shading sliders to adjust the tinting.

Imaging sliders include Ambient, Diffuse, Specular, and 
Specular Power.

Dragging the mouse to the left decreases the shading 
factor, while dragging the mouse to the right increases 
the shading factor.

– Alternatively you can enter a shading factor into one 
of the shading text boxes.

5. Choose a pre-defined shading material.

The options are Unshaded, Dull, Smooth, and Shiny.

This automatically updates the shading sliders to the 
selected preset value.

Quick Steps: Control the 
Volume Appearance 
Properties 

Adjust the Image Shading
1. Select Properties > 

Volume Appearance.

2. Select the Material tab.

3. Select Enable Shading.

4. Click and drag the 
shading sliders to adjust 
the tinting.

5. Choose a pre-defined 
shading material.
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Control the Volume Appearance Properties 

Select Preset Transfer Functions
Use this procedure to change the volume appearance by 
selecting a predefined color transfer function.

1. Select Properties > Volume Appearance.
The control panel displays the General, Material, and 
Transfer tabs.

2. Select the Transfer tab to move it forward.

3. Double-click the desired Color in the Preset Transfer 
Functions area to apply the color settings to your image

Alternatively, you can use the following method:

– Click the desired Color transfer function.

– Click [Apply].

4. Click the down arrow to display the Scalar Opacity options.
Fixed 1.0 – linear ramp range set at constant 1.0.
Ramp to 0.2 – linear ramp range from 0.0 to 0.2.
Ramp to 1.0 – linear ramp range from 0.0 to 1.0.

5. Double-click the desired Scalar Opacity option to apply the 
settings to your image.

Alternatively, you can use the following method:

– Click the desired Scalar Opacity transfer function.

– Click [Apply].

6. Click the down arrow to display the Gradient Opacity 
options.

No Edge Detection
Medium Edge Detection
Strong Edge Detection

Quick Steps: Control the 
Volume Appearance 
Properties cont.

Select Preset Transfer 
Functions
1. Select Properties > 

Volume Appearance.

2. Select the Transfer tab to 
move it forward.

3. Double-click the desired 
Color in the Preset 
Transfer Functions area to 
apply the color settings to 
your image.

4. Click the down arrow to 
display the Scalar Opacity 
options.

5. Double-click the desired 
Scalar Opacity option to 
apply the settings to your 
image.

6. Click the down arrow to 
display the Gradient 
Opacity options.

7. Double-click the desired 
Gradient Opacity option to 
apply the settings to your 
image.

8. Click [Reset], if necessary.
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There are three Gradient Opacity options.7. Double-click the desired Gradient Opacity option to apply 
the settings to your image.

Alternatively, you can use the following method:

– Click the desired Gradient Opacity transfer function.

– Click [Apply].

8. Click [Reset], if necessary.

The color settings return to the original setting.

Repeat steps 3 through 7 to make new color settings.

Create Custom Color and Opacity Transfer 
Functions
Use this procedure to manually adjust your color and opacity 
transfer functions to change the volume appearance.

Scalar Opacity Transfer Function Area

1. Select RGB to activate the color spectrum.
Alternatively, you can select HSV to activate the hue, 
saturation, and value color spectrum.

2. Enter a minimum value in the left Scalar Opacity/Color text 
box.

This sets the starting range of your color spectrum.
The default minimum value is 0.

3. Enter a maximum value in the right Scalar Opacity/Color 
text box.

This sets the ending range of your color spectrum.

The default maximum value is 4095.

Quick Steps: Control the 
Volume Appearance 
Properties cont.

Create Custom Color and 
Opacity Transfer Functions
1. Select RGB to activate the 

color spectrum.

2. Enter a minimum value in 
the left Scalar 
Opacity/Color text box.

3. Enter a maximum value in 
the right Scalar 
Opacity/Color text box.

4. Enter a maximum value in 
the top Scalar Opacity 
Function text box.

5. Enter a minimum value in 
the bottom Scalar Opacity 
Function text box.

6. Click the Scalar Opacity 
Function graph line to 
create additional nodes, if 
necessary.

7. Click and drag the node to 
reposition it.

Create Custom Gradient 
Transfer Functions
1. Enter a minimum value in 

the left Gradient Opacity 
Function text box.

2. Enter a maximum value in 
the right Gradient Opacity 
Function text box.

3. Click and drag the node to 
reposition it.
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4. Enter a maximum value in the top Scalar Opacity Function text box.
This sets the ending range for your opacity function.
The default maximum value is 1.
The values can be changed in 0.1 increments.

5. Enter a minimum value in the bottom Scalar Opacity Function text 
box.

This sets the starting range for your opacity function.
The default minimum value is 0.
The values can be changed in 0.1 increments.

6. Click the Scalar Opacity Function graph line to create additional 
nodes, if necessary.

The node colors are based on the location of where you click the line. 
This location matches the corresponding area on the color spectrum.

7. Click and drag the node to reposition it.
The node increases in size and is surrounded by a red circle.
Nodes cannot be moved past another node.

Create Custom Gradient Transfer Functions
Use this procedure to manually adjust the gradient opacity transfer function 
to change the volume appearance.

Gradient Opacity Transfer Function Area

1. Enter a minimum value in the left Gradient Opacity Function text box.
Sets the starting range for your gradient opacity function.
The defaulted and minimum value is 0.

2. Enter a maximum value in the right Gradient Opacity Function text 
box.

Sets the ending range for your opacity function.
The defaulted and maximum value is 819.

3. Click and drag the node to reposition it.
Nodes cannot be moved past another node.
9-34  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Visualize fMRI Data
Adjust the Volume Rendering View
Control the Volume Features 
Properties
View properties allow you to make cuts and annotation changes 
to your image volume. For your ease, the volume control 
features have been separated into two sections:
• Cut and Reformat the Image Volume
• Annotate the Volume Tools

Cut and Reformat the Image Volume
Use this procedure to remove portions of the brain by applying 
orthogonal cuts to the imaging volume and reformat the image 
by adjusting the thickness.

1. Select Properties > Volume Features.
The control panel displays the Cut and Annotate tabs.

2. Select the Cut tab to move it forward.

3. Select Enable Crop.
This permits image cropping to be performed.

4. Click and drag three Cut sliders toward the middle of the 
slider bar.

a) Click and drag either the Left or Right slider.

b) Click and drag either the Posterior or Anterior slider.

c) Click and drag either the Inferior to Superior slider.

5. Select the desired cropping type from the Type menu.
Refer to the Cut Tab section of this chapter for a 
description of the cropping types.

6. Adjust the Cut sliders to visualize the desired area.

7. Select Enable Reformat.
This activates the thick reformat feature, allowing you to 
make oblique slab cuts.

Quick Steps: Control the 
Volume Features 
Properties

Cut and Reformat the Image
1. Select Properties > 

Volume Features.
2. Select the Cut tab to move 

it forward.
3. Select Enable Crop.
4. Click and drag three Cut 

sliders toward the middle 
of the slider bar.

5. Select the desired 
cropping type from the 
Type menu.

6. Adjust the Cut sliders to 
visualize the desired area.

7. Select Enable Reformat.
8. Click and drag the 

Thickness slider to adjust 
the slice thickness.

9. Select an option from the 
Mouse Controls menu.
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Cl 8. Click and drag the Thickness slider to adjust the slice 
thickness.

Move the slider to the left to decrease slice thickness.

Move the slider to the right to increase slice thickness.

9. Select an option from the Mouse Controls menu.

Camera is the normal reformatting mode.

Reformat allows you to rotate with a left-click and move 
in and out with a right-click.

Annotate the Volume Tools
Use this procedure to select the type and color of cursors for 
the Volume Rendering View.

1. Select Properties > Volume Features.

The control panel displays the Cut and Annotate tabs.

2. Select the Annotate tab to move it forward.

3. Select the 3D Cursor type from the Type menu.

Cross Hairs displays a cross line cursor.

Plane displays a square cursor.

4. Select Display 3D Cursor.
The selected cursor type displays.

5. Click and drag the 3D Cursor sliders to adjust the cursor.

The cursor planes move across the volume image and 
corresponding images at the bottom of the window.

Alternatively, you may enter a 3D Cursor position in the 
appropriate axis text box.

6. Click [Set Color].
The Choose Color window displays.

7. Select the desired color from the color palette.

Alternatively, you may click and drag the + (cursor) to 
select your desired color.

8. Click [OK].
The Choose Color window closes.

The cursor color updates. 

Quick Steps: Control the 
Volume Features 
Properties cont.

Annotate the Volume Tools
1. Select Properties > 

Volume Features.

2. Select the Annotate tab to 
move it forward.

3. Select the 3D Cursor type 
from the Type menu.

4. Select Display 3D Cursor.
5. Click and drag the 3D 

Cursor sliders to adjust the 
cursor.

6. Click [Set Color].
7. Select the desired color 

from the color palette.

8. Click [OK].
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Adjust the Volume Rendering ViewAdjust the Volume Rendering View 
Manipulate the Volume
There are several viewing options that allow you to adjust the 
location and size of your 3D volume and perform distance 
measurements. Use the following procedures to:
• Rotate the 3D Volume
• Pan the 3D Volume
• Zoom the 3D Volume
• Measure a Distance 
• Use Keyboard Quick Functions

Rotate the 3D Volume
Use this procedure to manually adjust the volume viewing 
angles.

1. Place your cursor anywhere on the image.

2. Click and drag the image to rotate it to your desired position.

Dragging the mouse from side to side rotates the image 
from left to right.

Dragging the mouse from top to bottom rotates the 
image inferiorly to superiorly.

Dragging the mouse diagonally rotates the image in all 
directions simultaneously.

Pan the 3D Volume
Use this procedure to reposition your imaging volume in the 
viewport.

1. Place your cursor anywhere on the image.

2. Middle-click and drag the image to reposition it in the 
viewport.

Zoom the 3D Volume
Use this procedure to adjust the viewing magnification factors.

1. Place your cursor anywhere on the image.

Quick Steps: Manipulate 
the Volume

Rotate the 3D Volume
1. Place your cursor 

anywhere on the image.

2. Click and drag the image 
to rotate it to your desired 
position.

Pan the 3D Volume
1. Place your cursor 

anywhere on the image.

2. Middle-click and drag the 
image to reposition it in 
the viewport.

Zoom the 3D Volume
1. Place your cursor 

anywhere on the image.

2. Right-click and drag to 
adjust image 
magnification.

Measure a Distance
1. Click the image at the 

desired measurement 
starting point.

2. Drag the measurement 
line to the desired end 
point.

Use the Quick Keyboard 
Functions
1. Press R to reset the 

image to its original 
settings.

2. Press P to update the 
cursor’s position between 
views.
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2. Right-click and drag to adjust image magnification.

Dragging the mouse upward increases magnification

Dragging the mouse downward decreases magnification.

Measure a Distance
1. Click the image at the desired measurement starting point.

The beginning point of measurement is defined.

2. Drag the measurement line to the desired end point.

The end point of measurement is defined.

The measurement report is given in the Message area.

Use the Quick Keyboard Functions
1. Press R to reset the image to its original settings.

2. Press P to update the cursor’s position between views.
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Adjust the Lightbox View
Control the Hide and Window 
Properties
After your fMR images have been processed and analyzed, 
they can also be displayed in the Lightbox View with the 
BrainWave Visualizer tool. There are several Lightbox View 
properties that can be adjusted to your personal preference.

1. Select View > Lightbox.

This displays the Lightbox View.

2. Select Properties > Hide Properties.

The control panel hides, maximizing the visualization 
area.

3. Select Properties > Window.

The Layout and Preferences tabs display in the control 
panel.

4. Select the Layout tab to move it forward.

5. Select the desired viewport layout.

2x2 layout with the axial, coronal, or sagittal slices.

3x2 layout with the axial, coronal, or sagittal slices.

3x3 layout with the axial, coronal, or sagittal slices.

6. Select the Preferences tab to move it forward.

7. Select the desired window and level setting.

Linked across views automatically adjusts all viewports 
to the same window and level setting.

Independent only adjusts the window and level setting 
for the viewport your mouse is located.

8. Select the desired slice orientation.

Axial Slices – displays all axial slices.

Coronal Slices – displays all coronal slices.

Sagittal Slices – displays all coronal slices.

Quick Steps: Control the 
Hide and Window 
Properties
1. Select View > Lightbox.

2. Select Properties > Hide 
Properties.

3. Select Properties > 
Window.

4. Select the Layout tab to 
move it forward.

5. Select the desired 
viewport layout.

6. Select the Preferences 
tab to move it forward.

7. Select the desired 
window and level setting.

8. Select the desired slice 
orientation.
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Adjust the Lightbox View
Control the View Properties
View properties allow you to select the background color for the 
Lightbox View and make additional annotation changes. For 
your ease, the View properties have been separated into two 
sections:
• Change the Background Color of the Image
• Annotate the Image

Change the Background Color of the Image
Use this procedure to select the background color for the 
Lightbox View.

1. Select Properties > View.

The control panel displays the General and Annotate 
tabs.

2. Select the General tab to move it forward.

3. Click [Set Color].
The Choose Color window displays.

4. Select the desired color for the background from the color 
palette.

5. Click [OK].
The Choose Color window closes.

The background color updates to your selection on the 
image view.

Quick Steps: Control the 
View Properties

Change the Background 
Color of the Image
1. Select Properties > 

View.

2. Select the General tab to 
move it forward.

3. Click [Set Color].
4. Select the desired color 

for the background from 
the color palette.

5. Click [OK].

Annotate the Image
1. Select Properties > 

View.

2. Select the Annotate tab 
to move it forward.

3. Select Display Header 
Annotation.

4. Enter your desired text in 
the Header text box.

5. Click [Set Color].
6. Select the desired color 

for text display from the 
color palette.

7. Click [OK].
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Annotate the Image
Use this procedure to modify the Header and Corner Annotation function by 
adjusting the text color and annotation views.

1. Select Properties > View.

The control panel displays the General and Annotate tabs.

2. Select the Annotate tab to move it forward.

3. Select Display Header Annotation.

The Header Annotation feature is activated.

4. Enter your desired text in the Header text box.

The annotation displays at the top center of the view.

The annotation scales in size based on the length of the text.

5. Click [Set Color].
The Choose Color window displays.

6. Select the desired color for text display from the color palette.

7. Click [OK].
The Choose Color window closes.

The text displays in the Lightbox View and prints, if you have a color 
printer.
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Adjust the Lightbox View
Control the Image Features 
Properties
The Image Features properties allow you to manually select the 
slice number of an image to be displayed, window and level 
setting, mouse, and image color settings. For your ease, the 
Image Features properties have been separated into these 
sections:
• Select a Slice Number
• Change the Window and Level Setting
• Select the Mouse Operations
• Adjust the Image Color Settings

Select a Slice Number
Use this procedure to manually select your desired image 
number in the Lightbox Views. 

1. Select Properties > Image Features.

The Image Feature operations display.

2. Enter the desired image number in the Slice Number text 
box.

The image of the slice number you chose displays.

Alternatively, you may choose to:

– Click and drag the Slice Number slider to scroll 
through the images to make a selection.

– Press the Page Up or Page Down keys to scroll 
through the images.

– Press and hold the left or right arrow keys on the 
keyboard to page through the images.

Change the Window and Level Setting
Use this procedure to manually change or reset the image 
contrast and brightness factors.

1. Select Properties > Image Features.

The Image Feature operations display.

Quick Steps: Control the 
Image Features Properties

Select a Slice Number
1. Select Properties > 

Image Features.

2. Enter the desired image 
number in the Slice 
Number text box.

Change the Window and 
Level Setting
1. Select Properties > 

Image Features.

2. Enter a window setting in 
the Window text box.

3. Enter a level setting in the 
Level text box.

4. Click [Reset Window/ 
Level], if necessary.

5. Select the desired color 
scale.
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Cli2. Enter a window setting in the Window text box.

Window settings control the image contrast.

3. Enter a level setting in the Level text box.

Level settings controls the image brightness.

4. Click [Reset Window/Level], if necessary.

The window and level values restore to the original 
settings.

Select the Mouse Operations
Use this procedure to select your mouse operation settings for 
the Lightbox Views.

1. Select Properties > Image Features.

The Image Feature operations display.

2. Select the mouse action from the Left pull-down menu.

Pan moves the image in the viewport.

W/L alters the window and level settings.

Zoom adjusts the image magnification factors.

Measure allows distance measurements to be acquired 
and a measurement report is given in the Message area.

3. Repeat the above step for selecting the mouse operations 
for the Middle, Right, Shift+L (left), Shift+M (middle), and 
Shift+R (right) pull-down menus.

Adjust the Image Color
Use this procedure to make adjustments to the image display 
color settings in the Lightbox Views.

1. Select Properties > Image Features.

The Image Feature operations display.

2. Select the desired color scale.

Grayscale displays images with varying shades of gray.

– Scalar values are linearly mapped from black to white.

Color displays images with varying shades of color.

– Scalar values are mapped to a color with values 
varying linearly.

Quick Steps: Control the 
Image Features Properties 
cont.

Select the Mouse 
Operations
1. Select Properties > 

Image Features.

2. Select the mouse action 
from the Left pull-down 
menu.

3. Repeat the above step for 
selecting the mouse 
actions for the Middle, 
Right, Shift+L (left), 
Shift+M (middle), and 
Shift+R (right) pull-down 
menus.

Adjust the Image Color
1. Select Properties > 

Image Features.

2. Select the desired color 
scale.
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Chapter 10

Paradigm Development

Introduction
NeuroActivator is the paradigm software included in the optional Functional 
Magnetic Resonance Imaging (fMRI) package. This software is located on your 
Stimulus personal computer (PC). NeuroActivator allows you to create, preview, 
and acquire customized paradigms that specifically meet your needs. Paradigms 
are used when performing brain mapping MRI studies to acquire different types of 
functional data. 

This chapter explains the paradigm customization process. It contains the 
step-by-step instructions to help you learn how to:
• Start Up the Stimulus PC
• Configure Input and Output Devices
• Configure Feedback and Background Events
• Set Up the Display Properties
• Design a Paradigm
• Save a Paradigm Sequence
• Delete a Paradigm Sequence

In addition, this chapter answers the following questions:

1. What is NeuroActivator?

2. What is a stimulus sequence?

3. What are the available input devices?

4. What are feedback events?

5. What are background events?

6. How do I save a customized paradigm sequence?
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What Do I Need to Know 
About...
This section presents the concepts necessary to successfully create your 
customized paradigm. Specifically, you need to understand:
• NeuroActivator Description

– Paradigms
• NeuroActivator Prerequisites
• NeuroActivator Window

– Sequence Area
– Group Area
– Event Area

• Event Behaviors
– Input/Output Setup Window
– Feedback Setup Tab
– Background Setup Tab
– Display Properties Window
– Other Properties Window
– Debug Window

• Saving Your Paradigm

NeuroActivator Description
NeuroActivator is a software tool used for stimulus sequencing and 
presentation. Currently, it is only used with the BrainWave software, located 
on your Advantage Windows (AW) workstation. NeuroActivator allows you 
to present visual and/or auditory stimuli and record responses with timing 
accuracy. You can configure the software to provide feedback to your 
patient and record patient responses.

NeuroActivator operates in two modes, clinical (default mode) and 
research. The clinical mode acquires your paradigm sequences. The 
research mode allows you to create your own paradigms. The clinical mode 
must be closed when you want to create a new paradigm. 

NOTE: If your system requires a license key, ask your service engineer for 
the information.
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Paradigms
There are six standard paradigms on the Stimulus PC. Paradigms include 
task and control time periods. A task is the time period when the responsive 
stimuli is being presented. The control time period is the time between each 
task, also known as the rest period. NeuroActivator provides a way to 
combine the two time periods with graphics, sound, and/or movie clips to 
create a customized paradigm.

NeuroActivator Prerequisites
Prior to reading this chapter, you should read and understand the 
Functional Magnetic Resonance Imaging and the Visualize fMRI Data 
chapters. Both chapters contain necessary information in understanding the 
importance of paradigms in functional imaging. Paradigms are key 
instruments for activating specific areas of the brain. Consult a trained 
physician prior to creating any paradigm. Physicians can help you choose 
the best stimuli to activate the areas of the brain they are monitoring. 

Make sure all sensory equipment is properly connected before beginning an 
fMRI examination. Sensory equipment is used to deliver the stimulus 
paradigm and record your patient’s responses.

Gather all of the sensory files needed for your paradigm. These are data 
files used to create paradigms and can be divided into several types:
• Image
• Reverse CLR (Color)
• Movie
• Animation
• Sound

Each sensory file supports various file extensions, indicating the file type. A 
file extension is the notation at the end of the file name, preceded by a 
period. Table 10-1 lists supported file extensions for each sensory file type.

Table 10-1 Sensory File Types

Sensory Type Definition Supported File Extension
Image Static pictures • Bit Map (BMP)

• Graphics Interchange Format (GIF)
• Joint Photographic Experts Group 

(JPEG)
• Portable Network Graphics (PNG)

Reverse CLR
Bitmap pictures 
with reversing 
color capability
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NeuroActivator Window
The NeuroActivator window (Figure 10-2) is the main window used when 
creating or modifying paradigms. It is divided into three areas:
• Sequence
• Group
• Event

Figure 10-1 NeuroActivator Window

Sequence Area
The Sequence area allows you to create and modify the structure of a 
stimulus sequence. Sequences are displayed as a list of events and 
groups. An event is characterized as a stimulus or delay that lasts for a set 
time period. A group is characterized as multiple events or multiple groups. 
However, a group cannot be a combination of both an event and a group.

Movie Video clip • Audio Video Interleaved (AVI)
• Moving Pictures Group (MPG)
• Moving Pictures - Broadcast quality 

CD-ROM video and audio (MP12)
• QuickTime Movie (QT)

Animation
Built-in 
animation 
displaying 
moving dots

Sound Audible wave • Digital Audio Waveforms (WAV)

Sensory Type Definition Supported File Extension
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The events are displayed in numerical order, beginning with one. Adjacent 
events or groups are separated by a circle icon, called an empty node.

NOTE: The events mentioned above are referred to as standard events. This 
is to avoid confusion with other events mentioned in this chapter.

Table 10-2 provides a list of the editing options and functions.

Table 10-2 Sequence Area Options

Group Area
The Group area displays the events or groups contained in a sequence. 
The events are listed with the event name and its associated properties. 
The groups are displayed with three outlining factors:
• Group name
• Total duration time 
• Randomization parameter

Event Area
The Event area (Figure 10-2) allows you to customize a standard event. 
Customizing is only permitted when the standard event is highlighted, either 
in the Sequence or Group area. Many options presented in this area can 
also be accessed on various setup windows. Table 10-3 provides a 
description of the Event options.

Option Description
Create Adds a new standard event or group.

Paste Adds a previously copied or cut standard event or group.

Copy Creates a copy of the highlighted standard event or group.

Cut Removes the highlighted standard event or group.

Delete Permanently removes the highlighted standard event or 
group.

Rename Allows the highlighted standard event or group name to be 
changed.

Group 
Properties Provides the total stimuli acquisition time and order.
2333956-100 Rev. 0 (06/02)  10-5
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
Figure 10-2 NeuroActivator Window: Event Area

Table 10-3 Event Area Options

Option Description

Name Defines the standard event name. The name should 
not exceed 15 characters.

Type Provides a list of stimulus types, including image, 
movie, sound, and visual motion.

Media Displays the media file name, which is selected with 
the [Select Media] button.

[Select Media]
Opens a selection window that allows you to make 
your media file selection. The Visual Motion type 
opens the Animation Setup window.

[Reverse Color 
Settings] Switches between the two visual stimuli color settings.

Duration Displays the time the media performs the event.

Delay Displays the time interval between each medium, in 
seconds.

Use 
Background

Activates a background event and the Background list 
area.

NOTE: Refer to the Event Behaviors section of this 
chapter for additional information.

Background Displays a list of background events.
Function Defines the selected event as a task or control action. 

Use Feedback

Activates a feedback event and the Feedback list 
area.

NOTE: Refer to the Event Behaviors section of this 
chapter for additional information.

Feedback Displays the list of response events.

Response Type Defines what kinds of the response is expected. 
Response can be positive, negative or neutral. 

[Save Event] Saves the event information.
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Event Behaviors
Event behaviors are often referred to as setup parameters. They provide 
functions for selecting additional Background and Feedback parameters, 
changing the visual stimuli display settings, and prescribing your animation 
settings. Event behaviors are defined using the Setup menu options (Figure 
10-3) on the Main Menu bar.

Figure 10-3 Setup Menu Options

Selecting an option opens a window containing the parameters available for 
modification. Each setup window contains the standard functions described 
in Table 10-4.

Table 10-4 Standard Setup Functions

Input/Output Setup Window
Your first setup procedure involves prescribing your desired input devices 
and output options using the Input/Output Setup window (Figure 10-4). The 
input device options are a mouse, keyboard, or a four button response 
control. The four button response control provides four options for recording 
information. Each button can be customized to record the same or different 
response types. 

The information is output to the NeuroActivator software. You can specify 
an alternative imaging device for triggering the paradigm. If another device 
is used, it is recommended to test for a signal prior to performing the 
paradigm, using the [Pulse Calibration] button. 

Function Description

[OK] Registers your parameter selections in the NeuroActivator 
system and closes the current setup window.

[Cancel] Closes the current setup window without saving any of 
your parameter selections.

[Help] Opens the Help window.
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Figure 10-4 Input/Output Setup Window

Table 10-5 provides a list of the Input/Output Setup options.

Table 10-5 Input/Output Setup Options

Option Description

Device Provides a list of response recording devices, 
including mouse, keyboard, and button boxes.

Button Box Configuration
Button Box 
Name

Displays the hand control name. This area is only 
activated when a device selection has been made.

[Calibration]
Opens the Signal Calibration window, allowing you to 
test for response signals generated through the hand 
controls.

Serial Port Connection

Serial Port
Provides four Stimulus PC port options. Connection 
of your response device can be accessed via 
communication (COM) ports one through four.

Baudrate Specifies your serial port transfer speed.
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Signal Calibration

Signals received from the hand controls are transferred to the Stimulus PC 
via a serial port, at a pre-selected speed. A calibration test, enabled with the 
[Calibration] button, is required to ensure the hand controls are working 
properly (Figure 10-5).

Figure 10-5 Signal Calibration Window

Response

ID 
(Identification)

Displays the name of the device response key. Once 
an input device is selected the response area 
displays the response key types. Selecting a key type 
automatically updates the ID text box.

Allowed Indicates if the response received is valid. Device 
calibration is needed prior to making a selection.

Type
Indicates how NeuroActivator interprets a response. 
Responses can be positive, negative, or neutral. This 
selection is needed for analyzing response data.

[Change] Removes all selections made in the Response area.

Output
Record Allowed 
Responses 
Only

Indicates permitted responses only recorded in the 
event log. If this option is not selected, all responses 
are recorded.

Record Scanner 
Pulses

Indicates imaging device pulse signals are being 
recorded. 

[Pulse 
Calibration]

Opens the Signal Calibration window, which is used 
to test for incoming signals from an imaging device.

Option Description
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Feedback Setup Tab
A feedback event occurs when a response to a standard event is received. 
You may program a feedback event to occur with either an allowed or 
unallowed response. Feedback events can be programed to start if the 
response is received during a specified time period. When invoked, the 
feedback event overlaps or temporarily replaces the standard event. For 
example, if you have prescribed visual stimuli for both the standard and 
feedback events, the feedback visual replaces the standard visual. After the 
specified feedback time period has lapsed, the feedback visual is stopped 
and replaced by the original standard visual. 

Another way to use this type of event is during a reaction time window. A 
reaction time window is defined by two time points, t1 and t2. Each point is 
measured, in seconds, from the start of a standard event. The t1 time point 
is entered in the Shorter Than text box, displayed in the Reaction Time 
Window area. The t2 time point is entered in the Longer Than text box. If t1 
is less than t2, the reaction time window includes reaction times shorter 
than t1 and longer then t2. If t1 is greater than t2, the reaction time window 
includes reaction times longer than t2 and shorter than t1. For example, 
entering 4 seconds in the Shorter Than text box and 6 seconds in the 
Longer Than text box, results in the feedback event starting if a detected 
response is less than 4 seconds or more than 6 seconds. Any time points 
beyond the total standard event time are excluded from the reaction time 
windows.

Feedback event parameters are entered in the Background and Feedback 
Setup window on the Feedback tab (Figure 10-6). All feedback event 
parameters do not have to be prescribed from this tab. Several options can 
be entered in the Event area. Table 10-6 provides a description of the 
options not described in the Event area section of this chapter.

NOTE: Refer to Table 10-3 for options not mentioned in the Feedback 
Options table.
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Figure 10-6 Background Feedback Setup Window: Feedback Tab

Table 10-6 Feedback Tab Options

Option Description
Feedback Editor

Edit New Feedback Creates a new feedback event.
Edit Current 
Selection Modifies an existing feedback event.

[Save] Saves the edited or new feedback event.

[Delete] Removes a selected feedback event from the 
feedback list.

Feedback To
Unallowed 
Responses

Initiates a feedback event, if an unallowed 
response is received.

Reaction Time 
Window

Initiates a feedback event, if responses are 
received during the specified reaction time window.
Reaction Time Window

Shorter Than 
Sets a response time limit, measured in seconds. 
Initiates a feedback event, if a response is received 
in a time less than the set limit.

Longer Than
Sets a response time limit, measured in seconds. 
Initiates a feedback event, if a response is received 
in a time greater than the set limit.
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Background Setup Tab
A background event is presented during the rest period of a paradigm. The 
default event during this time period is a blank screen. Background events 
can be used to contrast your standard event. For example, if your standard 
event consisted of several words, the background event could be several 
arrows or line bars. You can assign more than one background in a group 
by allocating different background stimuli to the events in the Event area.

The Background tab (Figure 10-7) of the Background and Feedback Setup 
window includes parameter options to create and edit backgrounds. All 
background parameters do not have to be prescribed from this tab. Several 
options can be entered in the Event area on the NeuroActivator window. 
Table 10-7 only explains the options not described in the Event area section 
of this chapter. 

Figure 10-7 Background and Feedback Setup Window: Background Tab 

Table 10-7 Background Tab Options

Option Description
Edit New 
Background Allows you to create a new background event.

Edit Current 
Selection Allows you to modify an existing background event.

[Save] Saves the edited or new background selection.

[Delete] Removes a selected background event from the 
background list.
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NOTE: Refer to Table 10-3 for options not mentioned in the Background tab 
Options table.

Animation Setup

The Animation Setup window is the only setup window that cannot be 
accessed through the Setup menu options on the Main Menu bar. You can 
select it in the Background tab in the Background and Feedback Setup 
window or in the Event area of the NeuroActivator window after the Visual 
Motion media type has been selected. The Animation Setup window (Figure 
10-8) allows you to prescribe various animated dot functions. Table 10-8 
describes the available options.

Figure 10-8 Animation Setup Window

Name Defines the background name. The name should not 
exceed 15 characters.

Background and 
Event Start at 
the Same Time

Initiates an auditory background event to start 
simultaneously with the standard event.

NOTE: This option has no affect on visual background 
events.

Option Description
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Table 10-8 Animation Setup Window Options

Display Properties Window
Display properties modify the appearance of all visual stimuli in a sequence. 
Adjustments can be made to the viewing size, mouse cursor effects, and 
animation display colors. Display properties can be prescribed from the 
Display Properties window (Figure 10-9) accessed from the Setup menu 
options on the Main Menu bar. Table 10-9 describes the available options.

Option Description
Animation 
Type

Provides two options for animation dot movement, 
Radial and Random+Directional.

Dot Number Indicates the total number of dots displayed. The 
minimum dot number is 1, the maximum is 400.

Dot 
Brightness

Provides brightness levels for the dots. Acceptable 
values range from 0 (white) to 255 (black).

Contrast
Indicates the brightness differences between the 
foreground and background colors. If the contrast value 
is positive, the foreground is brighter than the 
background.

Radial Motion 
Speed

Indicates the dot speed in pixels per second for radial 
animations. Acceptable values range from 1 to 400.

Random 
Motion Speed

Indicates the dot speed in pixels per second for 
random+directional animations. Acceptable values 
range from 1 to 400.

Directional 
Motion Speed

Indicates the number of directions dots can move in 
pixels per second for random+directional animations. 
Acceptable values range from 1 to 400.

Directional 
Motion

Indicates the number of directions the dots can move in 
for randow+directional animations. Acceptable values 
range from 1 to 50.
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Figure 10-9 Display Properties Window

Table 10-9 Display Properties Window Options

Option Description
General Properties

Display 
Scaling 
Factor

Provides image size display options in percentages of 
the original image size. Selecting 100% or Original Size 
for animated dots, displays images on a full screen.

Show Mouse 
Cursor Displays the mouse cursor during stimulus presentation.

Screen 
Background 
Color

Specifies the background color not filled by the visual 
event. The background color is a combination of the red, 
green, and blue spectrum colors. Acceptable values 
range from 0 to 255.

Animation Properties
Background Displays the selected background color.
Foreground Displays the selected foreground color.

Contrast
Indicates brightness differences between the foreground 
and background colors. If the contrast value is positive, 
the foreground is brighter than the background.
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Other Properties Window
The Other Properties window (Figure 10-10) displays miscellaneous 
paradigm options. All options are presented as features that can be toggled 
on or off. Checking the desired options activate the features and apply them 
to the entire sequence. Table 10-10 describes the available options.

Figure 10-10 Other Properties Window

Table 10-10 Other Properties Window Options

Brightness Allows changes in brightness level for animated events. 
Acceptable values range from 0 to 255.

Dot Size
Specifies the size of the dots. Each dot displayed in the 
foreground has a square shape. The size notated is the 
length of each side of the square, in pixels.

Option Description

Use Sound Card Activates the sound card feature. Use this 
option your paradigm includes sound files.

Save Relative File Path If 
Possible

Records media file names with an .stm 
extension. Use this feature to save from 
manually entering the .stm file extension.

Trigger Stimuli With 
Scanner Pulse

Allows the paradigm to be triggered by a 
pulse signal, such as a MR system.

Repeatedly Present 
Stimuli Without Stop

Repeats the entire paradigm sequence until 
the escape (ESC) key is pressed.

Pause Presentation Until 
an Allowed Response is 
Received

Operates in a training mode. The program 
pauses the presentation at a new event, if 
no allowed responses are received.

Option Description
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Debug Window
The Debug window (Figure 10-11) offers two main functions, it records 
received responses in a debug format and analyzes your patient logfile with 
the Response Analyzer. Table 10-11 describes the available options.

Figure 10-11 Debug Window

Table 10-11 Debug Window Options

Saving Your Paradigm
After setting up your paradigm sequence and previewing it, you are ready to 
save the paradigm. Clicking the [Save] button opens the Paradigm 
Information window (Figure 10-12). This window stores information in the 
paradigm file required by the BrainWave software. BrainWave uses this 
information to analyze your fMRI data. Paradigm file names must begin with 
the letters nn, and end with the file extension .stm. Table 10-12 describes 
the information required in the Paradigm Information window.

Option Description
Record Result in 
Debug Format

Activates the debug recording format. Allows 
Stimulus PC drive selection of the logfile location.

[Select File] Opens the Event Logfile Selection window to 
access and analyze previously saved logfiles.
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Figure 10-12 Paradigm Information Window

Table 10-12 Paradigm Information Window Options

Option Description

Paradigm 
Name

A name for the paradigm should be a single word (no 
spaces or special characters) preceded by the 2000 
series number to ensure easy detection of the name by 
the BrainWave software. For example, 2000leftmotor. 
The number and name combination should be different 
from other saved paradigm names. 

Paradigm A paradigm description used to assign labels to buttons 
in the BrainWave software.

Number of 
Events per 
Half Cycle

The duration of each time period, in seconds, which is 
termed an Epoch.

Time between 
1st and 2nd 
Pulses

The time, in seconds, between the first pulse and the 
second pulse. The time can be determined by using the 
standard trigger pulse time of 8 seconds for the first pulse 
and the duration of the next time period for the second. 
For example, if you started your paradigm with a rest 
period of 8 seconds and the task period is 24 seconds, 
the time between the pulses would be 32 seconds.

Epoch
An alphanumeric single word (no spaces) description of 
the events. One event should be labeled rest and the 
other event, the paradigm name.

Duration
The time, in milliseconds, for each epoch. The total 
duration time should match the time calculated by the MR 
system. 
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How Do I...
This section provides the step-by-step instructions for creating, modifying 
and running your custom paradigm. Specifically, it describes how to:
• Start Up the Stimulus PC
• Configure Input and Output Devices

– Set Up the Input Device
– Set Up the Output Device

• Configure Feedback and Background Events
– Set Up a Feedback Event
– Set Up a Background Event
– Edit or Delete an Event

• Set Up the Display Properties
• Design a Paradigm

– Set Up the Paradigm
– Duplicate an Event or Group
– Preview a Paradigm

• Save a Paradigm Sequence
• Delete a Paradigm Sequence
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Start Up the Stimulus PC
The NeuroActivator software can be accessed after starting the 
Stimulus PC. The clinical version of the NeuroActivator 
software automatically begins, but you may switch to the 
research mode if your site has a research agreement.

Use this procedure to start up your Stimulus PC. It also 
provides the steps to switch your system to research mode.

1. Press the Stimulus PC power button on the Silent Vision 
box.

The Stimulus PC powers on and begins initialization.

2. Press CTRL + ALT + DELETE.

The Login window opens.

3. Enter Administrator in the login text box.

The login name may be automatically entered.

A password is not needed.

4. Click [OK] to close the Login window.

The NeuroActivator message window opens.

The system boots up in clinical mode.

5. Press the space bar or move the mouse to display the 
Stimulus PC desktop.

6. If desired, switch to the research mode.

a) Right-click the NeuroActivator icon.

b) Select Exit to close the clinical version of the software.

c) Select Start > Programs > NeuroActivator > 
NeuroActivator - Research to enable the research 
mode.

Quick Steps: Start Up the 
Stimulus PC
1. Press the Stimulus PC 

power button on the Silent 
Vision box.

2. Press CTRL + ALT + 
DELETE.

3. Enter Administrator in 
the login text box.

4. Click [OK] to close the 
Login window.

5. Press the space bar or 
move the mouse to display 
the Stimulus PC desktop.

6. If desired, switch to the 
research mode.
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Configure Input and Output Devices
Set Up the Input Device
Input devices provide a way to identify a response from your 
patient. Available input devices include a computer mouse, 
keyboard, or a control box. Use this procedure to set up your 
input device to allow stimulus recording and triggering.

1. Select Setup > Input/Output to open the Input/Output 
Setup window.

2. Select a Device in the Input area.

The standard choices are mouse, keyboard, or the 
button boxes one through four.

If you select a button box, the system automatically 
enters your selection in the Button Box Name text box.

3. Select the desired Serial Port Connection, if your input 
device is a button box.

a) Select a Serial Port. 
b) Select the Baudrate.

4. Select the desired ID in the Response area.

The options are displayed in the lower portion of the 
Response area.

– If your input device is a mouse, select L, M, or R.

– If your input device is a keyboard, select a number 0 
to 9 or a letter a through z.

– If your input device is one of the button boxes, select 
one of the box numbers once they are calibrated.

Your selection is displayed in the ID text box. 

5. Select the validity of the response in the Allowed text box.

Yes indicates responses received from the selected ID 
are valid.

No indicates responses received from the selected ID 
are invalid.

6. Select a response type in the Type text box.

Neutral indicates all responses.

Positive indicates valid responses.

Negative indicates invalid responses.

Quick Steps: Set Up the 
Input Device
1. Select Setup > 

Input/Output to open the 
Input/Output Setup 
window.

2. Select a Device in the 
Input area

3. Select the desired Serial 
Port Connection, if your 
input device is a button 
box.

4. Select the desired ID in the 
Response area.

5. Select the validity of the 
response in the Allowed 
text box.

6. Select a response type in 
the Type text box.
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Configure Input and Output Devices
Set Up the Output Device
The default output device is the NeuroActivator software. 
However, you can specify an alternative imaging device for 
triggering the paradigm. 

Use this procedure to configure an alternative output device 
and ensure you are receiving an incoming signal.

1. Select Setup > Input/Output to open the Input/Output 
Setup window.

2. Select the desired output triggering options in the Output 
area.

Record Allowed Responses Only

Record Scanner Pulses

3. Click [Pulse Calibration] if you have elected to record the 
scanner pulse.

This is recommended to test for an incoming imaging 
device signal.

4. Click [OK] to save the input and output information.

Quick Steps: Set Up the 
Output Device
1. Select Setup > 

Input/Output to open the 
Input/Output Setup 
window.

2. Select the desired output 
triggering options in the 
Output area.

3. Click [Pulse Calibration] 
if you have elected to 
record the scanner pulse.

4. Click [OK] to save the 
input and output 
information.
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Configure Feedback and Background Events
Set Up a Feedback Event
A feedback event is triggered by the patient’s response. It can 
be configured to view a response from the selected input device 
as valid or invalid. 

Use this procedure to adjust the parameters in the Background 
and Feedback Setup window to set up the options for a 
feedback event.

1. Select Setup > Feedback/Background to open the 
Background and Feedback Setup window.

2. Select the Feedback tab to move it forward.

3. Select Use Feedback.

The Feedback area is activated and lists the previously 
added feedback events.

If no feedback events have been created, the Feedback 
area appears blank.

4. Select Edit New Feedback to activate the create mode.

5. Enter a feedback event name in the Name text box.

The name must not include symbols, spaces, or more 
than 15 characters.

6. Select the desired sensory file in the Type text box.

Refer to Table 10-1 for a description of the types of 
supported sensory files.

7. Click [Select Media].

8. Select the desired stimuli data file.

Refer to Table 10-1 for the supported data file 
extensions.

9. Click [Open].
Your selection is displayed in the Media text box.

10. Enter the feedback viewing time in the Duration text box.

This displays the time the media performs the event, in 
seconds.

Quick Steps: Set Up a 
Feedback Event
1. Select Setup > 

Feedback/Background to 
open the Background and 
Feedback Setup window.

2. Select the Feedback tab 
to move it forward.

3. Select Use Feedback.

4. Select Edit New 
Feedback to activate the 
create mode.

5. Enter a feedback event 
name in the Name text 
box.

6. Select the desired sensory 
file in the Type text box.

7. Click [Select Media].
8. Select the desired stimuli 

data file.

9. Click [Open].
10. Enter the feedback viewing 

time in the Duration text 
box.

11. Select Unallowed 
Responses (optional).

12. Use the Reaction Time 
Window option if you want 
the feedback event to start 
during a specified time 
period.

13. Click [Save].
14. Click [OK] to close the 

window.
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11. Select Unallowed Responses (optional).

Only use this option if you want the feedback event to start when an 
invalid response is given.

12. Use the Reaction Time Window option if you want the feedback event to 
start during a specified time period.

a) Select Reaction Time Window.

b) Enter a reaction time, in seconds, in the Shorter Than text box.

c) Enter a reaction time, in seconds, in the Longer Than text box.

NOTE: Total time period for steps b and c, should not exceed time allowed 
for the standard event. Standard even times are the total time it takes 
to deliver the paradigm sequence.

13. Click [Save].
Your feedback event parameters are saved.

The background events are listed in the Feedback area.

14. Click [OK] to close the window.
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Configure Feedback and Background Events
Set Up a Background Event
Background events are stimuli that are present during the rest 
delay period of a paradigm sequence. These types of events 
are useful if a contrast to the standard event is needed. You can 
assign more than one background stimuli to an event.

Use this procedure to set up a background event to present 
during the rest period of your paradigm.

1. Select Setup > Feedback/Background to open the 
Background and Feedback Setup window.

2. Select the Background tab to move it forward.

3. Select Use Background.

The Background List area is activated and displays the 
previously created background events.

If no background events have been created, the 
Background List area appears blank.

4. Select Edit New Background to activate the create mode.

5. Enter a background event name in the Name text box.

Your chosen name must not include symbols, spaces, or 
more than 15 characters.

6. Select the type of sensory file in the Type text box.

Refer to Table 10-1 for a description of the supported 
sensory file types.

7. Click [Select Media].

8. Select the desired stimuli data file.

Refer to Table 10-1 for the supported data file 
extensions.

9. Click [Open].
Your selection is displayed in the Media text box.

10. Select Background and event start at the same time 
(optional).

Only use this option if you want to start the standard and 
background events simultaneously.

Quick Steps: Set Up a 
Background Event
1. Select Setup > 

Feedback/Background to 
open the Background and 
Feedback Setup window.

2. Select the Background 
tab to move it forward.

3. Select Use Background.

4. Select Edit New 
Background to activate 
the create mode.

5. Enter a background event 
name in the Name text 
box.

6. Select the type of sensory 
file in the Type text box.

7. Click [Select Media].
8. Select the desired stimuli 

data file.

9. Click [Open].
10. Select Background and 

event start at the same 
time (optional).

11. Click [Save].
12. Click [OK] to close the 

window.
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11. Click [Save].
Your background event parameters are saved.

The background event is displayed in the Background List area.

12. Click [OK] to close the window.
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Configure Feedback and Background Events
Edit or Delete an Event
There may be times when you need to modify or remove an 
existing feedback or background event from the respective 
display list. Parameter changes to the events are permitted, as 
well as deletion of an existing event. 

Use this procedure to edit or delete an event listed in the 
Feedback or Background List areas.

1. Select Setup > Feedback/Background to open the 
Background and Feedback Setup window.

2. Select the appropriate event tab.

Selecting Feedback moves this tab forward.

Selecting Background moves this tab forward.

3. Select Use Feedback or Use Background.

The Feedback or Background List area is activated.

4. Select the event you want to edit.

5. Select Edit Current Selection.

The edit mode and the delete option become available.

6. Modify the desired parameters or click [Delete] if you want 
to remove the selected event from the list area.

Refer to the Event Behaviors section of this chapter for 
additional parameter information.

7. Click [Save] to update the current event.

8. Click [OK] to exit.

Quick Steps: Edit or Delete 
an Event
1. Select Setup > 

Feedback/Background 
to open the Background 
and Feedback Setup 
window.

2. Select the appropriate 
event tab.

3. Select Use Feedback or 
Use Background.

4. Select the event you want 
to edit.

5. Select Edit Current 
Selection.

6. Modify the desired 
parameters or click 
[Delete] if you want to 
remove the selected 
event from the list area.

7. Click [Save] to update the 
current event.

8. Click [OK] to exit.
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Set Up the Display Properties
Display properties allow you to make modifications to the 
appearance of the visual stimuli used in your paradigms. These 
properties are used to adjust the size of the view, the display of 
the mouse cursor, background colors, and enter Animation 
parameters. 

Use this procedure to adjust the appearance of the visual 
stimuli in your paradigm sequence.

1. Select Setup > Display to open the Display Properties 
window.

2. Select a viewing size in the Display Scaling Factor text 
box.

The visual stimuli adjust to the selected viewing size.

3. Select Show mouse cursor (optional).

The mouse cursor is displayed during stimulus 
presentation.

4. Adjust the Screen Background Color to alter the image 
background color.

a) Enter a value in the red text box.

b) Enter a value in the green text box. 

c) Enter a value in the blue text box. 

Valid color values are 0 to 255.

5. Adjust the brightness values in the Animation Properties 
area.

a) Enter a value in the Brightness text box for the 
background.

b) Enter a value in the Brightness text box for the 
foreground.

Valid brightness values are 0 to 255.

6. Select a pixel size in the Dot Size text box.

Valid sizes range from 0 to 10.

7. Click [OK] to close the window.

Quick Steps: Set Up the 
Display Properties
1. Select Setup > Display to 

open the Display 
Properties window.

2. Select a viewing size in the 
Display Scaling Factor 
text box.

3. Select Show mouse 
cursor (optional).

4. Adjust the Screen 
Background Color to 
alter the image 
background color.

5. Adjust the brightness 
values in the Animation 
Properties area.

6. Select a pixel size in the 
Dot Size text box.

7. Click [OK] to close the 
window.
10-28  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Paradigm Development
Design a Paradigm
Set Up the Paradigm
A paradigm is a sequence involving at least two repeated 
events. Events are used as task and rest functions. Paradigm 
sequences set up with the NeuroActivator software can be used 
with your MRI system.

Use this procedure to set up a custom paradigm.

1. Click the NeuroActivator icon.

The NeuroActivator software initializes.

2. Select File > New > Group.

This creates a group titled NewGroup.

3. Enter a new group name.

The name should not exceed 15 characters.

Alternatively, you can rename the group using the 
following steps:

– Right-click on NewGroup.

– Select Rename.

– Enter your desired name.

4. Right-click on the empty node.

This is positioned under the group name.

Sequence Area

Quick Steps: Set Up the 
Paradigm
1. Click the NeuroActivator 

icon.

2. Select File > New > 
Group.

3. Enter a new group name.

4. Right-click on the empty 
node.

5. Select New > Event.
6. Enter a new event name.

7. Select the type of sensory 
file in the Type text box.

8. Click [Select Media].
9. Select the desired stimuli 

data file.

10. Click [Open].
11. Enter a display time in the 

Duration text box.

12. Enter a rest time in the 
Delay text box.

13. Click [Save Event] to save 
the current state of the 
sequence.

Empty 
Nodes
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5. Select New > Event.
This creates a new event. 

6. Enter a new event name.

The name should not exceed 15 characters.

Alternatively, you can rename the event using the following steps:

– Right-click on NewEvent.

– Select Rename.

– Enter your desired name.

7. Select the type of sensory file in the Type text box.

Refer to Table 10-1 for a description of the supported sensory file 
types.

8. Click [Select Media].

9. Select the desired stimuli data file.

Refer to Table 10-1 for the supported data file extensions.

10. Click [Open].
Your selection displays in the Media text box.

11. Enter a display time in the Duration text box.

The time is measured in seconds.

12. Enter a rest time in the Delay text box.

The time is measured in seconds.

13. Click [Save Event] to save the current state of the sequence.
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Design a Paradigm
Duplicate an Event or Group
Events and groups can be easily duplicated. This is helpful 
when multiple events occur in the same paradigm. 

Use this procedure to quickly copy and paste an event or group 
to a new location in the paradigm sequence.

1. Right-click on the desired event or group in the Sequence 
area.

This selects the event or group.

This also displays a shortcut menu.

2. Select Copy to create a copy of the highlighted standard 
event or group.

3. Right-click on an empty node.

4. Select Paste to insert the event or group in this location.

5. Repeat steps 3 and 4 as needed to add additional events or 
groups.

Quick Steps: Duplicate an 
Event or Group
1. Right-click on the desired 

event or group in the 
Sequence area.

2. Select Copy to create a 
copy of the highlighted 
standard event or group.

3. Right-click on an empty 
node.

4. Select Paste to insert the 
event or group in this 
location.

5. Repeat steps 3 and 4 as 
needed to add additional 
events or groups.
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Design a Paradigm
Preview a Paradigm
Preview mode allows you to view your paradigm, prior to saving 
it. Your paradigm sequence can be viewed at any time during 
the creation process. After exiting the preview mode, your 
screen returns you to the place you left in the creation process.

Use this procedure to preview a paradigm while you are in the 
process of creating it.

1. Right-click on the desired group to preview in the Sequence 
area.

2. Select Preview to display your paradigm sequence.

3. Press the ESC key to exit the preview mode.

Quick Steps: Preview a 
Paradigm
1. Right-click on the desired 

group to preview in the 
Sequence area.

2. Select Preview to display 
your paradigm sequence.

3. Press the ESC key to exit 
the preview mode.
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Save a Paradigm Sequence
After your paradigm has been created, you can save it in the 
NeuroActivator Research folder.

Use this procedure to save your paradigm sequence.

1. Select File > Save to open the Save File window.

2. Enter a paradigm file name.

The name must include the letters nn as a prefix and 
.stm as the file extension.

3. Make sure the Research folder is displayed in the Save In 
text box.

If not, follow the path to obtain the folder. C:\Sensor 
Systems Inc\NeuroActivator 1.0\research.

4. Click [Save] to save your paradigm file.

The Paradigm Information window opens.

5. Enter a unique name in the Paradigm Name text box.

A 2000 series number should precede the name you 
choose. For example, 2000lftmotor. 

NOTE: The paradigm 2000 series number and specified name 
should not be used for any other paradigm name.

6. Enter the remaining paradigm information.

Refer to the Saving Your Paradigm section of this 
chapter for additional information.

This information is necessary to analyze your fMRI data.

7. Click [OK] to close the window.

8. Select File > Run.
A message window opens.

9. Click [OK] to save the paradigm logfile.

10. Press the Enter key to display the paradigm.

Quick Steps: Save a 
Paradigm Sequence
1. Select File > Save to 

open the Save File 
window.

2. Enter a paradigm file 
name.

3. Make sure the Research 
folder is displayed in the 
Save In text box.

4. Click [Save] to save your 
paradigm file.

5. Enter a unique name in 
the Paradigm Name text 
box.

6. Enter the remaining 
paradigm information.

7. Click [OK] to close the 
window.

8. Select File > Run.

9. Click [OK] to save the 
paradigm logfile.

10. Press the Enter key to 
display the paradigm.
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Delete a Paradigm Sequence
You can remove paradigms from the NeuroActivator Research 
folder. This option is only available when you are in research 
mode. Refer to the Start Up the Stimulus PC procedure in this 
chapter for starting the system in research mode. 

Use this procedure to remove paradigms that are no longer 
needed or are invalid.

NOTE: Invalid paradigms are paradigms with duplicating names 
and/or series numbers.

1. Select File > Open.

2. Make sure the Research folder is displayed in the Look In 
text box.

If not, follow the path to obtain the folder. C:\Sensor 
Systems Inc\NeuroActivator 1.0\research.

3. Select the desired paradigm file to delete.

4. Click [Open].
Your selected paradigm displays in the Sequence area of 
the NeuroActivator window.

5. Right-click on the paradigm name.

This displays the confirmation window.

6. Select Delete to remove the paradigm.

Alternatively you could use the following procedure:

– Click on the paradigm name.

– Select Edit > Delete.

7. Click [Yes] to confirm the removal the selected files from the 
system.

Quick Steps: Delete a 
Paradigm Sequence
1. Select File > Open.

2. Make sure the Research 
folder is displayed in the 
Look In text box.

3. Select the desired 
paradigm file to delete.

4. Click [Open].
5. Right-click on the 

paradigm name.

6. Select Delete to remove 
the paradigm.

7. Click [Yes] to confirm the 
removal the selected files 
from the system.
10-34  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



2333956-100 Re
© 2002 General
Chapter 11

2D FIESTA Pulse
Sequence

Introduction
The Fast Imaging Employing STeady-state Acquisition (FIESTA) is a fully 
balanced steady-state coherent imaging pulse sequence designed to produce 
high signal-to-noise ratio (SNR) images at very short sequence times (TRs). 

This chapter explains the pulsing components and timing factors directly related 
to the 2D FIESTA imaging pulse sequence. It also explains the concepts and the 
step-by-step instructions to help you learn how to:
• Optimize 2D FIESTA Images
• Prescribe a 2D FIESTA Sequence 

In addition, this chapter answers the following questions:

1. What is FIESTA?

2. When would I use a 2D FIESTA pulse sequence?

3. What are the imaging characteristics of a 2D FIESTA pulse sequence?

4. Which imaging options can be used with a 2D FIESTA pulse sequence?

5. What are some applications for the 2D FIESTA sequence?
v. 0 (06/02)  11-1
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What Do I Need to Know 
About...
This section presents the concepts necessary to understand imaging with 
the 2D FIESTA pulse sequence. Specifically, you need to understand the 
following concepts:
• 2D FIESTA Basics
• Imaging Effects
• Image Characteristics
• Associated Imaging Options
• Applications

2D FIESTA Basics
The Fast Imaging Employing STeady-state Acquisition (FIESTA) sequence 
is a fully balanced steady-state coherent imaging pulse sequence designed 
to produce high SNR images at very short TRs. The pulse sequence uses 
fully balanced gradients to re-phase the transverse magnetization at the 
end of each TR interval. For very short TR sequences, the resulting signal 
intensity is independent of TR and related to (T2/T1). More importantly, the 
short TRs are essential to maintain spin phase coherence. Phase 
coherence is required to maintain coherent transverse magnetization and 
eliminate artifacts generated by magnetic susceptibility induced phase 
shifts. Thus, the advantages of FIESTA can only be realized with very short 
TR where (TR << T2) and (TR << 1/b) where b is the local frequency shift 
caused by inhomogeneity.

NOTE: << indicates “much less than”.

Tissue contrast is generated based on the ratio of the spin-spin relaxation 
time (T2) and the spin-lattice relaxation time (T1). Hence, the pulse 
sequence accentuates the contrast of spins with high T2/T1 ratios (such as 
cerebral-spinal fluid, water, and fat) while suppressing signal from tissues 
with low T2/T1 ratios (such as muscle and myocardium). 

2D FIESTA is a fast-ECG-gated, segmented K-space acquisition. The 
sequence combines both high temporal resolution with excellent image 
contrast and can be used for whole body imaging. 2D FIESTA can be used 
in clinical applications that benefit from the differentiation of contrast 
between tissues of low T2/T1 ratios (low signal intensity) and high T2/T1 
ratios (high signal intensity). This type of acquisition sequence can be 
useful for imaging structures in motion such as the heart.
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The 2D FIESTA technique uses balanced gradients, which are designed to 
maintain phase coherence of the transverse magnetization at each radio 
frequency (RF) excitation. Most other fast scan techniques use phase 
spoiling to eliminate phase coherence.

Imaging Effects
The sequence parameters have different effects that contribute to the 2D 
FIESTA images. Table 11-1 summarizes the imaging effects relating to 2D 
FIESTA and is provided to help you understand the trade-offs that occur 
when you change the values for a particular parameter.

Table 11-1 Imaging Effects with 2D FIESTA

NOTE: *There is not always a direct correlation between FOV and artifact. 
In certain instances, with anatomical size and FOV, some artifact can 
occur (wrap). In most other circumstances, there will not be a 
correlation.

Imaging Characteristics
2D FIESTA sequences are capable of producing high signal to noise 
images with enhanced contrast and temporal resolution. Water and fat 
contrast is accentuated, while muscle and myocardial tissues are 
suppressed.

There are several benefits of 2D FIESTA:
• High signal-to-noise images

Parameters Contrast 
(T2/Ts)

Temporal 
Resolution

Spatial 
Resolution SNR Scan 

Time Artifacts

TR ⇓ ⇑ ⇑ N/A ⇑ ⇓ ⇓

TE ⇓ ⇑ N/A N/A ⇑ ⇓ ⇓

Flip Angle ⇑ ⇑ N/A N/A ⇑ N/A N/A

RBw ⇑ ⇑ ⇑ N/A ⇓ ⇓ ⇓

VPS ⇑ N/A ⇑ N/A N/A ⇓ ⇑

Matrix ⇑ N/A N/A ⇑ ⇓ ⇑ N/A

Slice 
Thickness ⇓ N/A N/A ⇑ ⇓ N/A N/A

FOV ⇓ N/A N/A ⇑ ⇓ N/A *
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• Excellent contrast between soft tissues and fluids
• Reduced repetition times, which minimizes motion artifacts
• Inherent flow compensation, which minimizes artifacts due to blood flow

Figure 11-1 Image of 2D FIESTA FastCINE. Note the increased SNR over 
the standard FastCINE acquisition shown on the left.

Table 11-2 Timing differences between the standard FastCINE sequence 
and the 2D FIESTA FastCINE sequence

There are several factors you should consider when using 2D FIESTA:
• The Receive Bandwidth (RBw) is fixed at 125 kHz
• The TE is fixed at the minimum full value
• The smallest FOV with all matrices is 22 cm
• A 512 frequency matrix is not supported by 2D FIESTA

Oblique Short Axis
FOV = 36
Slice Thickness = 7 mm
Matrix = 256x192

FastCINE 2D FIESTA 
FastCINE

TR 7.3 ms 4.0 ms

TE 2.7 ms 1.8 ms 

FastCINE 2D FIESTA FastCINE
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Associated Imaging Options
Imaging Options provide image processing or filters for enhancing 
anatomical features or reducing noise. In Table 11-3, the X’s indicate the 
imaging options available for use with the 2D FIESTA pulse sequence.

Table 11-3 2D FIESTA Pulse Sequence Imaging Options

Applications
2D FIESTA imaging can be used in clinical applications that benefit from the 
differentiation of contrast between tissues of low T2/T1 ratios (low signal 
intensity like the myocardium) and high T2/T1 ratios (high signal intensity 
like blood). This type of acquisition sequence can be useful for imaging, but 
not limited to, structures in motion such as the heart, which needs clear 

Imaging Options

None X Variable Bandwidth

Flow Compensation X No Phase Wrap

POMP X Extended Dynamic Range

X Square Pixel X Image Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer X Sequential

X Cardiac Gating/Triggering Respiratory Gating/Triggering

Tailored RF IR Prepared

DE Prepared Multi Phase

Full Echo Train CCOMP

ZIP 1024 ZIP 512

Zip x 2 ZIP x 4

SmartPrep Blood Suppression

Multi Station Real Time

T2 Prep Spectral Spatial RF

Phase Sensitive Navigator

ASSET Calibration Fluoro Trigger

ASSET
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delineation between the blood and the myocardium. The improved blood 
pool myocardium contrast allows for better delineation of the myocardial 
boundaries and hence expedites the determination of the ventricular 
volumes at end-systole and end-diastole. 

WARNING:Ear plugs are required for any person staying inside the scan 
room during 2D FIESTA scans due to its acoustic noise.
11-6  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



2D FIESTA Pulse Sequence
How Do I...
This section provides the step-by-step instructions for prescribing a 2D 
FIESTA imaging pulse sequence. Specifically, it describes how to:
• Prescribe a 2D FIESTA Sequence

This section also provides the following 2D FIESTA images and an example 
protocol.
• Cardiac Short or Long Axis

Decision Matrix
A decision matrix is used in this section to provide examples of what values 
could be selected for prescribing a particular sequence. The purpose of the 
decision matrix is to help you understand the trade-offs that occur when you 
change the values for a particular parameter and to provide a framework 
with which you may build your own unique protocol.

The example protocols provide information on what could be used for these 
pulse sequences and are not to be considered recommendations by GE 
Medical Systems. For specific protocols, refer to the protocols on your 
system.

In addition to listing the information you need to select on the system, the 
“What You Select” column of the matrix uses two other conventions.
• N/A indicates the imaging parameter is not applicable to the pulse 

sequence example.
• N/S indicates the imaging parameter is not selectable in the pulse 

sequence example. The system automatically selects these imaging 
parameters.

CAUTION: Provide all patients with ear protection prior to any scan to 
help avoid possible hearing impairment. Acoustic noise 
levels can exceed 99 dbA in the magnet bore.
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Prescribe a 2D FIESTA Sequence
The 2D FIESTA sequence is useful for imaging structures in motion such as 
the heart, which needs clear delineation between the blood and the 
myocardium. The improved blood pool myocardium contrast allows for 
better delineation of the myocardial boundaries and hence expedites the 
determination of the ventricular volumes at end-systole and end-diastole. 

The decision matrix (Table 11-4) is only for prescribing a 2D FIESTA scan. 
The following example protocol is for prescribing a short axis cardiac scan 
for a TwinSpeed™ or an EchoSpeed™ system.

Table 11-4 2D FIESTA Protocol Example (Short Axis Cardiac)

2D FIESTA Protocol Example 
What You Select Selection Notes

Scan Rx Desktop
Scan Rx Acquire a 

localizer series
Allows Graphic Rx to become available so you can prescribe 
slices graphically on the localized image.

Rx Manager [New Series] Adds an additional series to the patient’s exam. 

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series if the Patient 
Protocol window becomes active.

Patient Position

Patient Position Supine Although compatible with any patient position and entry, 
supine and feet first are recommended. This ensures 
accurate cardiac gating/triggering and patient safety by 
ensuring proper routing of gating cables out of the bore, and 
proper routing of the coil cable to its attachment point on the 
dog-house.

Patient Entry Feet First

Coil Phased Array 
> Cardiac

Use a coil that produces the optimum coverage and SNR.

Series Description Enter a series 
description in 
the text box.

If you do not enter a description, the system enters one for 
you. The series description default is the selected scan 
mode, PSD, and selected imaging options.
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Imaging Parameters

Plane Oblique Compatible with any scan plane. Select the plane that best 
meets your clinical need. For cardiac short or long axis 
imaging, select oblique for proper angle through the heart.

Mode 2D Prescribes a two-dimensional sequence.

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has Twin gradients. 

Pulse Sequence FIESTA Prescribes a FIESTA pulse sequence.

Imaging Options Cardiac 
Gating 
Triggering and 
Sequential

Cardiac Gating/Triggering and Sequential are automatically 
selected and cannot be turned off. Sequential acquires one 
slice at a time and multiple cardiac phases. 

PSD Name N/A

Protocol N/A

2D FIESTA Protocol Example 
What You Select Selection Notes
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Scan Timing

# of echoes N/S One echo is selected automatically.

TE N/S The TE default is minimum full.

TE2 N/A

TR N/S The minimum TR is selected automatically. The calculated 
TR is the minimum TR attainable and is based on SAR 
restrictions. The TR may be adjusted through changes to 
any the following parameters; frequency matrix, FOV, slice 
thickness and flip angle. You achieve the best image quality 
at TR of 4 ms or lower.

Inv Time N/A

TI2 N/A

Flip Angle 40 The typical flip angle value is 40° to 45°.

Echo Train Length N/A

Bandwidth N/S The RBw default is 125 kHz.

Bandwidth2 N/A

2D FIESTA Protocol Example 
What You Select Selection Notes
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Scanning Range 

FOV 40 Select a FOV that covers the anatomy of interest, about 
40 cm for the chest. Anatomy outside the FOV in the phase 
direction results in aliasing. Small FOVs produce increased 
resolution, decreased SNR, and can increase the minimum 
TE value.

Slice Thickness 7.0 The typical slice thickness value for the heart is 7 to 8 mm. 
Thin slices produce increased resolution and decreased 
SNR.

Spacing Enter 0.0 in 
the text box.

Zero spacing is allowed. Slices are acquired sequentially 
and cross-talk is not a problem.

Start, End Locations The start and end locations are programmed from the 
Graphic Rx program after the slices are prescribed.

# Slices Sequential scan ones slice per acquisition. The number of 
slices indicates the number of acquisitions prescribed.

Acquisition Timing

Freq Enter 224 in 
text box.

Increasing the frequency matrix produces increased 
resolution, decreased SNR, and decreased number of 
slices.

Phase Enter 224 in 
text box.

Phase controls scan time and may control resolution.

2D FIESTA Protocol Example 
What You Select Selection Notes
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NEX 1 One NEX for sufficient SNR and a reasonable scan time.

Phase FOV 0.75 Select a phase FOV to prevent wrapping of anatomy. 
Choices are 1.0, 0.75, and 0.5. Reducing the phase matrix 
decreases scan time, FOV in the phase direction, and SNR 
(slightly).

Freq DIR S/I The direction displayed is the default frequency direction 
which is typically the long axis of the image. Leave the 
frequency direction unswapped.

Auto Center Freq Water The CF peak that will be set during prescan.

Flow Comp DIR N/A

Autoshim On Autoshim can improve image quality and is recommended 
for this sequence.

Phase Correct Off Provides no additional benefits and increases prescan time.

# of Locs Before Pause 1 After you prescribe the slices, return to this screen and 
prescribe an automatic pause in the scan at predetermined 
points for breath-hold studies.

 Additional Parameters - Gating/Triggering

Trigger Type Select the best 
lead.

When ECG gating, use the lead that provides the best 
signal.

# of R-R Interval N/A

Arrhythmia Rejec. 
Window

20 Values around 20% are most commonly used to allow a 
reasonable latitude. If the patient’s heart rate is irregular, 
increase this value and the TW, then the time available to 
collect data decreases.

2D FIESTA Protocol Example 
What You Select Selection Notes
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Trigger Delay Minimum The most minimum TD is desired to cover the full R-R 
Interval.

Inter-Seq. Delay N/A

Cardiac Phases N/A

# of Cardiac Phases to 
Reconstruct

Enter 20 in the 
text box.

Sets the number of cardiac phases to be reconstructed.

Views per Segment 12 The typical range of values is 12 to 20 VPS. Heart Rate = 50, 
select 20 VPS. Heart Rate = 70, select 12 VPS.

Heart Rate [update Rate] Lets the system obtain an automatic reading of the current 
heart rate. Updates the rate prior to beginning the scan.

Accept [Accept] Confirms the selected values and closes Gating/Triggering 
Additional Parameter screen.

 Additional Parameters - User CVs  

Manual Arrhythmia 
Monitoring

1.0 Manually monitors arrhythmias. When Auto Arrhythmia 
Monitoring is on (0), too many triggers are detected outside 
the TW resulting in an aborted scan.

Accept [Accept] Confirms selection of User CV and closes the screen.

 Additional Parameters - Graphic Rx

[+] Next and [-] Prior [+] and [-] Allows you to page through the localizer images to check the 
position of the prescription. 

2D FIESTA Protocol Example 
What You Select Selection Notes
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Image Viewport Click the image 
to display the 
line cursor.

Prescribe slices from the cardiac base to the apex for 
graphic prescription. Select the adjustment handles to angle, 
draw, and remove slices. Position the slices to cover 
anatomy of interest and view the Advisory Panel to note the 
maximum number of slices per acquisition and the number 
of acquisitions you are prescribing. The scan time increases 
as the number of acquisitions increase.

Copy Rx [Copy Rx]
(optional)

If you had previously graphically prescribed a series with the 
same plane, FOV, and slice thickness, the prescription can 
be copied to the exact locations of the prior series.

Erase All [Erase All]
(If necessary)

Eliminates the graphic prescription from the screen and 
allows you to start over.

Reset Center [Reset Center]
(if necessary)

Re-establishes the FOV center on a different localized slice.

Accept [Accept] Confirms the cursor position and closes Graphic Rx.

Series Control
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the series.

Scan Operations
Prep Scan [Prep Scan] Performs Auto Prescan and readies the system for data 

acquisition. Select for breath-hold acquisitions. 

Scan [Scan] Initiates the acquisition. Instruct the patient to hold his/her 
breath as long as possible, until the scan stops, if able.

2D FIESTA Protocol Example 
What You Select Selection Notes
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2D Cardiac Short or Long Axis
A Cardiac short or long axis scan can be acquired with a 2D FIESTA pulse 
sequence to image the heart. This sequence provides improved blood-pool 
myocardium contrast for better delineation of the myocardial boundaries. 
Figure 11-2 shows long and short axis images of the heart acquired with 2D 
FIESTA sequences. Table 11-5 gives you a brief look at an example 
protocol. The parameters may vary depending on your needs.

Figure 11-2  2D FIESTA Acquisitions

Table 11-5 2D FIESTA Cardiac Protocol Example 

Short Axis Long Axis 

Plane Mode Pulse 
Sequence

PSD 
Name TE TR Flip 

Angle RBw FOV Slice 
Thickness

Slice 
Spacing

Oblique 2D FIESTA N/A Min Full N/A 40 to 45 125 ~40 7 to 8 0.0

Matrix NEX Phase 
FOV

Frequency 
Direction

Center 
Frequency

Auto
Shim

Phase 
Correct Imaging Options Sat 

Pulses

224x224 1 0.75 Unswapped Water On Off Cardiac Gating/Trig, 
Sequential None

Trigger 
Type ARW TD VPS Phases User CVs Time Comments

Best 
Lead 20 Min

12 to 20
HR 50=20
HR 70=12

20
Manual 

Arrhythmia 
Monitoring = 1 

A function of patients 
heart rate. Approx 5 

to 20 seconds.
Cardiac coil 

recommended
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© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
This page intentionally left blank.
11-16  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Additional Cardiac Pulse Sequences
Chapter 12

Additional Cardiac Pulse
Sequences

Introduction 
This chapter explains additional cardiac sequences used in evaluating wall 
motion abnormalities and pathologic abnormalities within the myocardial 
tissue. This chapter also explains the concepts of each sequence and 
provides the step-by-step instructions to help you learn how to:
• Prescribe the Wall Motion Sequence
• Prescribe the Multi Phase FGR-ET Sequence
• Prescribe the IR Prep Gated FGRE Sequence
2333956-100 Rev. 0 (06/02)  12-1
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
How Do I...
This section provides the step-by-step instructions for following protocols 
and prescribing cardiac imaging pulse sequences. Specifically, this section 
describes how to:
• Prescribe the Wall Motion Sequence
• Prescribe the Multi Phase FGR-ET Sequence
• Prescribe the IR Prep Gated FGRE Sequence

Decision Matrix
A decision matrix is used in this section to provide examples of what values 
could be selected for prescribing a particular sequence. The purpose of the 
decision matrix is to help you understand the trade-offs that occur when you 
change the values for a particular parameter and to provide a framework 
with which you may build your own unique protocol.

The example protocols provide information on what could be used for these 
pulse sequences and are not to be considered recommendations by GE 
Medical Systems. For specific protocols, refer to the protocols on your 
system.

In addition to listing the information you need to select on the system, the 
“What You Select” column of the matrix uses two other conventions.
• N/A indicates that the imaging parameter is not applicable to the pulse 

sequence example.
• N/S indicates that the imaging parameter is not selectable in the pulse 

sequence example. The system automatically selects these imaging 
parameters.

CAUTION: Provide all patients with ear protection prior to any scan to 
help avoid possible hearing impairment. Acoustic noise 
levels can exceed 99 dbA in the magnet bore.
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Prescribe the Wall Motion Sequence
The Wall Motion Sequence is the first series of the three sequence cardiac 
protocol. It demonstrates functional and anatomical information of the heart. 
Tagging can be used with this sequence to better visualize contractile 
function.

The decision matrix (Table 12-1) is only for prescribing a Wall Motion 
Sequence. The following example protocol is for prescribing a short axis 
cardiac scan for a TwinSpeed™ or an EchoSpeed™ system.

Table 12-1 Wall Motion Sequence Protocol Example

Wall Motion Sequence Protocol Example 
What You Select Selection Notes

Scan Rx Desktop
Scan Rx Acquire a 

localizer series
Allows Graphic Rx to become available so you can prescribe 
slices graphically on the localized image.

Rx Manager [New Series] Adds an additional series to the patient’s exam. 

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series if the Patient 
Protocol window becomes active.

Patient Position

Patient Position Supine Supine and feet first are recommended to ensure accurate 
cardiac gating/triggering and patient safety by ensuring 
proper routing of gating cables out of the bore, and proper 
routing of the coil cable to its attachment point on the 
dog-house.

Patient Entry Feet First

Coil Phased Array 
> Cardiac

Use a coil that produces the optimum coverage and SNR.

Series Description Enter a series 
description in 
the text box.

If you do not enter a description, the system enters one for 
you. The series description default is the selected scan 
mode, PSD, and selected imaging options.
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Imaging Parameters

Plane Oblique Oblique is used for proper angle through the heart.

Mode 2D Allows prescription of a two-dimensional sequence.

Pulse Sequence Fast Card 
GRE

Use a FastCard GRE pulse sequence if tagged or a 
FastCard SPGR if no tags are used.

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has Twin gradients. 

Imaging Options FC, Cardiac 
Gating/
Triggering, 
and 
Sequential

Flow Comp increases signal from blood. Cardiac 
Gating/Triggering and Sequential are automatically selected. 
Sequential acquires one slice at a time and multiple cardiac 
phases. It is required for tagging. 

PSD Name N/A

Protocol N/A

Wall Motion Sequence Protocol Example 
What You Select Selection Notes
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Scan Timing

# of echoes N/S One echo is automatically selected.

TE Min Full Increase TE to produce increased T2* contrast, decreased 
SNR, and increased magnetic susceptibility artifacts.

TE2 N/A

TR N/S The minimum TR is selected automatically. 

Inv. Time N/A

TI2 N/A

Flip Angle 20 The typical flip angle value is 20°.

Echo Train Length N/A

Bandwidth 31.25 The typical Receive Bandwidth value is 31.25 kHz.

Bandwidth2 N/A

Wall Motion Sequence Protocol Example 
What You Select Selection Notes
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Scanning Range 

FOV Enter 36 in the 
text box.

Select a FOV that covers the anatomy of interest, about 
36 cm for the heart. Anatomy outside the FOV in the phase 
direction results in aliasing. Small FOVs produce increased 
resolution, decreased SNR, and can increase the minimum 
TE value.

Slice Thickness Enter 8 in the 
text box.

The typical slice thickness value for the heart is 7 to 8 cm. 
Thin slices produce increased resolution and decreased 
SNR.

Spacing Enter 0 in the 
text box.

Zero spacing is allowed. Slices are acquired sequentially 
and cross-talk is not a problem.

Start, End Locations The start and end locations are programmed from the 
Graphic Rx program after the slices are prescribed.

# Slices Sequential scans one slice per acquisition. The number of 
slices indicates the number of acquisitions prescribed.

Acquisition Timing

Freq 256 Increasing the frequency matrix produces increased 
resolution and decreased SNR.

Phase Enter 128 in 
the text box.

Phase controls scan time and may control resolution.

Wall Motion Sequence Protocol Example 
What You Select Selection Notes
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NEX 1 One NEX for sufficient SNR and a reasonable scan time.

Phase FOV 0.75 Select a phase FOV to prevent wrapping of anatomy. 
Choices are 1.0, 0.75, and 0.5. Reducing the phase matrix 
decreases scan time, FOV in the phase direction, and SNR 
(slightly).

Freq DIR Unswapped The direction displayed is the default frequency direction 
which is typically the long axis of the image. Leave the 
frequency direction unswapped.

Auto Center Freq Water The CF peak that will be set during prescan.

Flow Comp DIR N/A

Autoshim On Autoshim can improve image quality and is recommended 
for this sequence.

Phase Correct Off Provides no additional benefits for this sequence and 
increases prescan time.

# of Locs Before Pause 1 After you prescribe the slices, return to this screen and 
prescribe an automatic pause in the scan at predetermined 
points for breath-hold studies.

Additional Parameters - SAT 

Tag Type [Stripe] or 
[Grid]

Sets spatial SAT pulses over anatomy of interest to obtain 
cardiac images sensitive to tissue motion.

Tag Pixel Spacing Specify a Pixel 
separation.

Sets the distance between the tag bands. It is defaulted to a 
value of 7 pixels and the minimum allowed is 2 pixels. The 
frequency matrix divided by two (XRES ÷ 2) determines the 
maximum setting.

Accept [Accept] Confirms SAT prescription and closes the SAT Rx Additional 
Parameter screen.

Wall Motion Sequence Protocol Example 
What You Select Selection Notes
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Additional Parameters - Gating/Triggering 

Trigger Type Select the best 
lead.

When ECG gating, select the lead that provides the best 
signal.

# of R-R Interval N/A

Arrhythmia Rejection 
Window

50 Values around 50% are most commonly used to allow a 
reasonable latitude.

Trigger Delay Minimum The most minimum TD is desired to cover the full R-R 
Interval.

Inter-Seq Delay N/A

Cardiac Phases N/A

# of Card. Phases to 
Reconstruct 

20 Sets the number of cardiac phases to be reconstructed.

Views per Segment 6 The typical value is 1 to 8 VPS. See the VPS Guide for your 
patient’s heart rate.

Heart Rate [update Rate] Lets the system obtain an automatic reading of the current 
heart rate. Updates the rate prior to beginning the scan.

Accept [Accept] Confirms the selected values and closes Gating/Triggering 
Additional Parameter screen.

Wall Motion Sequence Protocol Example 
What You Select Selection Notes
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Additional Parameters - User CVs 

Manual Arrhythmia 
Monitoring

1.0 Manually monitors arrhythmias. When Auto Arrhythmia 
Monitoring is on (0), too many triggers are detected outside 
the TW resulting in an aborted scan.

Accept [Accept] Confirms selection of User CV and closes the Additional 
Parameter screen.

Additional Parameters - Graphic Rx   

[+] Next and [-] Prior [+] and [-] Allows you to page through the localizer images to check the 
position of the prescription. 

Image Viewport Click the image 
to display the 
line cursor.

Prescribe the slices from the cardiac base to the apex to 
display the graphic prescription. Select the adjustment 
handles to angle, draw, and remove slices. Position the 
slices to cover anatomy of interest and view the Advisory 
Panel to note the maximum number of slices per acquisition 
and the number of acquisitions you are prescribing. The 
scan time increases as the number of acquisitions increase.

Copy Rx [Copy Rx]
(optional)

If you had previously graphically prescribed an oblique 
series with the same FOV and slice thickness, the 
prescription can be copied to the exact locations of the prior 
series.

Reset Center [Reset Center]
(if necessary)

Re-establishes the FOV center on a different localized slice.

Erase All [Erase All]
(If necessary)

Eliminates the entire graphic prescription from the screen 
and allows you to start over.

Wall Motion Sequence Protocol Example 
What You Select Selection Notes
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Accept [Accept] Confirms the cursor position and closes the Graphic Rx 
Additional Parameter screen.

Series Control 
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the series.

Scan Operations
Prep Scan [Prep Scan] Performs Auto Prescan and readies the system for data 

acquisition. 

Scan [Scan] Initiates the acquisition. Instruct the patient to hold his/her 
breath as long as possible, until the scan stops, if able.

Wall Motion Sequence Protocol Example 
What You Select Selection Notes
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Prescribe the Multi Phase FGR-ET Sequence
The Multi Phase FGR-ET Sequence is the second step in the cardiac 
protocol. Multiple images are acquired at each slice location over a defined 
number of cardiac cycles. Each slice location is obtained at the same phase 
of the cardiac cycle. This sequence also uses IR Prep to suppress the 
myocardium and enhance T1 contrast so that the tissue is better visualized. 

The decision matrix (Table 12-2) is only for prescribing a Multi Phase 
FGR-ET Sequence. The following example protocol is for prescribing a 
short axis cardiac scan for a TwinSpeed or an EchoSpeed system.

Table 12-2  Multi Phase FGR-ET Sequence Protocol Example

Multi Phase FGR-ET Sequence Protocol Example 
What You Select Selection Notes

Scan Rx Desktop
Rx Manager [New Series] Adds an additional series to the patient’s exam. 

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series if the Patient 
Protocol window becomes active.

Patient Position

Patient Position Supine Supine and feet first are recommended to ensure accurate 
cardiac gating/triggering and patient safety by ensuring 
proper routing of gating cables out of the bore, and proper 
routing of the cable to its attachment point on the dog-house.

Patient Entry Feet First

Coil Phased Array 
> Cardiac

Use a coil that produces the optimum coverage and SNR.

Series Description Enter a series 
description in 
the text box.

If you do not enter a description, the system enters one for 
you. The series description default is the selected scan 
mode, PSD, and selected imaging options.
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Imaging Parameters

Plane Oblique Oblique plane is used to obtain the proper angle through the 
heart.

Mode 2D Allows prescription of a two-dimensional sequence.

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has Twin gradients. 

Pulse Sequence Fast GRE ET Use a Fast Gradient Echo sequence with echo train readout. 

Imaging Options Cardiac 
Gating 
Triggering, 
Variable 
Bandwidth, 
Multi Phase, 
and IR 
Prepared

Cardiac Gating/Triggering should be selected. Multi Phase is 
used to acquire multiple images at each slice location. IR 
Prepared is used to improve T1 contrast. 

PSD Name N/A

Protocol N/A

Multi Phase FGR-ET Sequence Protocol Example 
What You Select Selection Notes
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Scan Timing

# of echoes N/S One echo is automatically selected.

TE N/S Only Minimum Full TE is allowed.

TE2 N/A

TR N/S The minimum TR is selected automatically. The minimum TR 
decreases as RBw increases, and as ETL, frequency matrix, 
and obliquity decrease.

Inv. Time N/S The Inversion Time is automatically calculated based on the 
other sequence parameters. The TI is generally in the range 
of 150 to 175 ms when 0.75 PFOV is selected. Otherwise, 
the TI is >230 ms, causing poor fat suppression.

TI2 N/A

Flip Angle Enter 25 in the 
text box.

The typical flip angle value is 25°.

Echo Train Length 4 As the ETL is increased, TR increases, and image blurring 
increases. Note the (phase matrix x PFOV) must be an even 
multiple of the ETL. The system posts a message if this is 
not followed.

Bandwidth 125 The typical RBw value is 125 kHz. Generally, wider 
bandwidths are used to minimize TR and TE values. 

Bandwidth2 N/A

Multi Phase FGR-ET Sequence Protocol Example 
What You Select Selection Notes
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Scanning Range 

FOV Enter 36 in the 
text box.

Select a FOV that covers the anatomy of interest, about 32 
to 40 cm. Anatomy outside the FOV in the phase direction 
results in aliasing. Small FOVs produce increased resolution, 
decreased SNR, and can increase the minimum TE value.

Slice Thickness 10 10 mm is generally used to obtain coverage through the 
entire heart on this sequence.

Spacing Enter 0 in the 
text box.

Zero spacing for complete coverage.

Start, End Locations The start and end locations are programmed from the 
Graphic Rx program after the slices are prescribed.

# Slices The maximum number of slices per acquisition depends on 
the heart rate, the number of R-R Intervals, the ETL, TR, and 
frequency matrix.

Acquisition Timing

Freq 128 Increasing the frequency matrix decreases echo space, 
SNR, the number of slice locations allowed, while increasing 
resolution. Available selections are 64 to 256, in steps of 32.

Phase 128 Phase controls scan time and resolution. The phase matrix 
cannot exceed the frequency matrix. Available selections are 
64 to 256, in steps of 32. Note the (phase matrix x PFOV) 
must be an even multiple of the ETL.

Multi Phase FGR-ET Sequence Protocol Example 
What You Select Selection Notes
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NEX N/S One NEX is used automatically.

Phase FOV 0.75 Select a PFOV of 1.0 to prevent wrapping of anatomy. 
Choices are 1.0, 0.75, and 0.5. Reduce the phase matrix to 
decrease scan time, FOV in the phase direction, and SNR 
(slightly). The (phase matrix x PFOV) must be an even 
multiple of the ETL. Due to effects on TI, 0.75 PFOV is 
recommended.

Freq DIR Unswapped The direction displayed is the default frequency direction 
which is typically the long axis of the image. Leave the 
frequency direction unswapped.

Auto Center Freq Water The CF peak that will be set during prescan.

Flow Comp DIR N/A

Autoshim On Autoshim can improve image quality and is recommended.

Phase Correct Off Provides no additional benefits and increases prescan time.

# of Locs Before Pause 0 This sequence should not be segmented in relation to time 
and therefore should not have a pause. The scan time is 
approximately 40 seconds or more and is performed as a 
breath hold for as long as possible. Locations before pause 
should be zero.

Additional Parameters - Gating/Triggering 

Trigger Type Select the best 
lead.

When ECG gating, select the lead that provides the best 
signal.

# of R-R Interval 2 1, 2, 3, or 4 x R-R Interval is available. As the heart rate 
increases, a larger R-R Interval is needed for complete 
coverage of the heart.

Multi Phase FGR-ET Sequence Protocol Example 
What You Select Selection Notes
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Trigger Window 5 Values of 5 to 10 are most commonly used. As the TW 
increases, the number of slice locations allowed decreases. 
Use larger values on patients with irregular heart rates. 
Actual scan times are longer than expected if triggers are 
detected outside the TW.

Trigger Delay Minimum The most minimum TD is desired to cover the full R-R 
Interval.

Inter-Seq Delay N/A

Cardiac Phases N/A

# of Card. Phases to 
Reconstruct

N/A

Views per Segment N/A

Heart Rate [update Rate] Lets the system obtain an automatic reading of the current 
heart rate. Updates the rate prior to beginning the scan.

Accept [Accept] Confirms the selected values and closes Gating/Triggering 
Additional Parameter screen.

Additional Parameters - Multi Phase 

Phases per Location Enter 30 in the 
text box.

Defines the number of times the sequence repeats, and 
therefore, the number of images acquired for each slice 
location. Typically 30 to 45 phases.

Phase Acq. Order N/A

Delay after Acquisition N/A

Accept [Accept] Confirms the selected value and closes Multi Phase 
Additional Parameter screen.

Multi Phase FGR-ET Sequence Protocol Example 
What You Select Selection Notes
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Additional Parameters - User CVs 

Echo tuning mode 0.00 All User CVs for this sequence are turned off (0=off). Refer to 
the What Do I Need to Know About... section for the 
discussion on Manual Echo Alignment.

Echo delay 0.00

Manual echo alignment 0.00

Ramp Sampling 0.00

turbo_acq 0.00

Accept [Accept] Confirms the selected values and closes User CVs 
Additional Parameter screen.

Additional Parameters - Graphic Rx 

[+] Next and [-] Prior [+] and [-] Allows you to page through the localizer images to check the 
position of the prescription. 

Multi Phase FGR-ET Sequence Protocol Example 
What You Select Selection Notes
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Image Viewport Click the image 
to display the 
line cursor.

Prescribe the slices from the cardiac apex to the base to 
display the graphic prescription. Select the adjustment 
handles to angle, draw, and remove slices. Position the 
slices to cover anatomy of interest and view the Advisory 
Panel to note the maximum number of slices per acquisition 
and the number of acquisitions you are prescribing.

Copy Rx [Copy Rx]
(optional)

If you had previously graphically prescribed an oblique 
series with the same FOV and slice thickness, the 
prescription can be copied to the exact locations of the prior 
series.

Reset Center [Reset Center]
(if necessary)

Re-establishes the FOV center on a different localized slice.

Erase All [Erase All] 
(If necessary)

Eliminates the graphic prescription from the screen and 
allows you to start over.

Accept [Accept] Confirms the cursor position and closes the Graphic Rx 
Additional Parameter screen.

Series Control
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the series.

Scan Operations
Prep Scan [Prep Scan] Performs Auto Prescan and readies the system for data 

acquisition.

Scan [Scan] Initiates the acquisition. Instruct the patient to hold his/her 
breath as long as possible, until the scan stops, if able.

Multi Phase FGR-ET Sequence Protocol Example 
What You Select Selection Notes
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Prescribe the IR Prep Gated FGRE Sequence
The IR Prep Gated FGRE Sequence is the last of three pulse sequences in 
the cardiac protocol to evaluate the LV myocardium. 

The decision matrix (Table 12-3) is only for prescribing an IR Prep Gated 
FGRE Sequence. The following example protocol is for prescribing a short 
axis cardiac scan for a TwinSpeed or an EchoSpeed system.

Table 12-3  IR Prep Gated FGRE Sequence Protocol Example

IR Prep Gated FGRE Sequence Protocol Example 
What You Select Selection Notes

Scan Rx Desktop
Rx Manager [New Series] Adds an additional series to the patient’s exam. 

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series if the Patient 
Protocol window becomes active.

Patient Position

Patient Position Supine Supine and feet first are recommended to ensure accurate 
cardiac gating/triggering and patient safety by ensuring 
proper routing of gating cables out of the bore, and proper 
routing of the coil cable to its attachment point on the 
dog-house.

Patient Entry Feet First

Coil Phased Array 
> Cardiac

Use a coil that produces the optimum coverage and SNR.

Series Description Enter a series 
description in 
the text box.

If you do not enter a description, the system enters one for 
you. The series description default is the selected scan 
mode, PSD, and selected imaging options.
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Imaging Parameters

Plane Oblique Oblique is used for proper angle through the heart.

Mode 2D Allows prescription of a two-dimensional sequence.

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has Twin gradients. 

Pulse Sequence Fast GRE Use a Fast GRE pulse sequence.

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has Twin gradients. 

Imaging Options Cardiac 
Gating 
Triggering and 
IR Prepared

Cardiac Gating/Triggering should be selected. IR Prepared 
is used to improve T1 contrast.

PSD Name N/A

Protocol N/A

IR Prep Gated FGRE Sequence Protocol Example 
What You Select Selection Notes
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Scan Timing

# of echoes N/S One echo is automatically selected.

TE Min Full Increase TE to produce increased T2* contrast, decreased 
SNR, and increased magnetic susceptibility artifacts.

TR N/S The minimum TR is selected automatically. 

Prep Time 200 The typical TI value with IR Prepared and 1 R-R selected is 
200. The typical TI value with 2 R-R is 325. This can change 
from patient to patient.

TI2 N/A

Flip Angle 20 The typical flip angle value is 20°.

Echo Train Length N/A

Bandwidth 31.25 The typical RBw value is 31.25 kHz.

Bandwidth2 N/A

IR Prep Gated FGRE Sequence Protocol Example 
What You Select Selection Notes
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Scanning Range 

FOV Enter 36 in the 
text box.

Select a FOV that covers the anatomy of interest, about 
36 cm for the heart. Anatomy outside the FOV in the phase 
direction results in aliasing. Small FOVs produce increased 
resolution, decreased SNR, and can increase the minimum 
TE value.

Slice Thickness Enter 8.0 in 
the text box.

The typical slice thickness value for the heart is 7 to 8 cm. 
Thin slices produce increased resolution and decreased 
SNR.

Spacing Enter 0.0 in 
the text box.

Zero spacing for complete coverage.

Start, End Locations The start and end locations are programmed from the 
Graphic Rx program after the slices are prescribed.

# Slices Use the minimum number of locations needed to cover the 
entire heart. The R-R Interval and TW affect the number of 
slices per acquisition. As the heart rate increases, the slices 
per acquisition decreases. Increase the TW and the slices 
per acquisition decreases. The number of acquisitions is 
shown on the Advisory panel.

Acquisition Timing

Freq 256 Increasing the frequency matrix produces increased 
resolution and decreased SNR.

IR Prep Gated FGRE Sequence Protocol Example 
What You Select Selection Notes
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Phase 192 Phase controls scan time and may control resolution.

NEX 2 Two NEX for sufficient SNR and a reasonable scan time.

Phase FOV 0.75 Choices are 1.0, 0.75, and 0.5. Reduce the phase matrix and 
thus decrease scan time, FOV in the phase direction, and 
SNR (slightly).

Freq DIR Unswapped The direction displayed is the default frequency direction 
which is typically the long axis of the image. Leave the 
frequency direction unswapped.

Auto Center Freq Water The CF peak that will be set during prescan.

Flow Comp DIR N/A

Autoshim On Autoshim can improve image quality and is recommended.

Phase Correct Off Provides no additional benefit for this sequence and 
increases prescan time.

# of Locs Before Pause 1 Prescribes an automatic pause in the scan at predetermined 
points for breath-hold studies. You can only acquire one slice 
per breath hold for this sequence.

Additional Parameters - User CVs 

Perform Arrhythmia 
Rejection

0.00 Using Arrhythmia Rejection (1) results in an increase in scan 
time if triggers occur prior to the TW, but image quality will 
improve. Too many triggers detected outside the TW results 
in an aborted scan.

Accept [Accept] Confirms selection of User CV and closes the Additional 
Parameter screen.

IR Prep Gated FGRE Sequence Protocol Example 
What You Select Selection Notes
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Additional Parameters - Gating/Triggering 

Trigger Type Select the best 
lead.

When ECG gating, select the lead that provides the best 
signal.

# of R-R Interval 1 1 or 2 x R-R Intervals are available to change your image 
contrast. 

Trigger Window 20 The typical value for TW for this sequence is 20.

Trigger Delay Enter value of 
60% of the R-R 
Interval value.

Note the patient’s R-R Interval, calculate 60% of the value, 
and input the new value for the TD. For example, if your 
patient’s R-R Interval is 780, then 60% x 780 = 468. You 
would then type in 468 in the TD text box.

Inter-Seq. Delay N/A

Cardiac Phases N/A

# of Card. Phases to 
Reconstruct

N/A

Views per Segment  24 To collect the images faster, since the sequence acquires 
one slice per breath hold, typical values are 24 to 32 VPS.

Heart Rate [update Rate] Lets the system obtain an automatic reading of the current 
heart rate. Update the rate prior to beginning the scan.

Accept [Accept] Confirms the selected values and closes the 
Gating/Triggering Additional Parameter screen.

IR Prep Gated FGRE Sequence Protocol Example 
What You Select Selection Notes
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Additional Parameters - Graphic Rx 

[+] Next and [-] Prior [+] and [-] Allows you to page through the localizer images to check the 
position of the prescription. 

Image Viewport Click the image 
to display the 
line cursor.

Prescribe the slices from cardiac apex to base to display the 
graphic prescription. Select the adjustment handles to angle, 
draw, and remove slices. Position the slices to cover the 
anatomy of interest and view the Advisory Panel to note the 
maximum number of slices per acquisition and the number 
of acquisitions you are prescribing. The scan time increases 
as the number of acquisitions increase.

Copy Rx [Copy Rx]
(optional)

If you had previously graphically prescribed an oblique 
series with the same FOV and slice thickness, the 
prescription can be copied to the exact locations of the prior 
series.

Reset Center [Reset Center]
(if necessary)

Re-establishes the FOV center on a different localized slice.

Erase All [Erase All]
(If necessary)

Eliminates the graphic prescription from the screen and 
allows you to start over.

Accept [Accept] Confirms the cursor position and closes Graphic Rx 
Additional Parameter screen.

Series Control 
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the series.

Scan Operations
Prep Scan [Prep Scan] Performs Auto Prescan and readies the system for data 

acquisition.

Scan [Scan] Initiates the acquisition. Instruct the patient to hold his/her 
breath as long as possible, until the scan stops, if able.

IR Prep Gated FGRE Sequence Protocol Example 
What You Select Selection Notes
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Cardiac Images and Example Protocols 
Wall Motion Sequence
The Wall Motion Sequence is the first series in the cardiac protocol and can 
be acquired with a FastCINE SPGR without tags or a FastCINE GRE with 
tags as shown in Figure 12-1. This sequence allows the assessment of the 
contractile function of the ventricular wall.

Figure 12-1 Short Axis FastCINE GRE with Tagging

Table 12-4 Wall Motion Sequence Example 

GRE Tagged View

Plane Mode Pulse 
Sequence TE TR Flip 

Angle RBw FOV Slice 
Thickness

Slice 
Spacing Matrix

Oblique 2D FastCard SPGR 
(GRE if tagged)

Min 
Full N/S 20 31.2 40 8.0 0.0 256x128

NEX Phase 
FOV

Freq 
Direction

Center 
Frequency AutoShim Phase 

Correct Imaging Options Sat Pulses

1 0.75 Unswap Water On Off
Cardiac Gating/ 
Triggering, FC, 

Sequential

Tags optional. 
Stripe or Grid. 
Choose pixel 
separation.

User CVs Trigger 
Type

Arr Rej, 
Window

Trigger 
Delay VPS Phases Multi Phase 

Options Comments

Manual 
Arrhythmia 

Monitoring = 1 
Select the 
Best Lead 50 Min See VPS 

chart 20 N/A Cardiac coil 
recommended
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Cardiac Images and Example Protocols
Multi Phase FGR-ET Sequence
The Multi Phase FGR-ET Sequence is the second series in the cardiac 
protocol. This multi-slice sequence is typically repeated to acquire multiple 
phases of the cardiac cycle.

Table 12-5  Multi Phase FGR-ET Sequence Example 

Plane Mode Pulse 
Sequence TE/TI TR Flip 

Angle ETL RBw FOV Slice 
Thickness

Slice 
Spacing

Oblique 2D FGRE-ET Min/Auto N/S 25 4 125 ~32 to 40 10.0 0.0

Matrix NEX Phase 
FOV

Frequency 
Direction

Center 
Frequency

Auto 
Shim

Imaging 
Options User CVs

128x128 1 0.75 Unswapped Water On Cardiac Gating/ 
Triggering, VBw, 
MPh, IR Prep

Echo Tuning Mode:0 
Echo Delay:0 
Man Echo Align:0

Trigger Type Trigger 
Window

Trigger 
Delay R-Rs Phases Cine 

Options
Multi Phase 

Options Comments

Select the 
Best Lead 5 to 10 Min 1 to 4 20 N/A 30 to 45 Cardiac coil 

recommended
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Cardiac Images and Example Protocols
IR Prep Gated FGRE Sequence
The last series in the cardiac protocol is acquired with a Fast GRE, IR Prep 
pulse sequence. 

Table 12-6 IR Prep Gated FGRE Sequence Example 

Plane Mode Pulse 
Sequence TE/TI TR ETL

#Shots
Flip 

Angle RBw FOV Slice 
Thickness

Slice 
Spacing

Oblique 2D Fast GRE Min Full/ 
200 N/S N/A 20 31.25 ~36 8.0 0.0

Matrix NEX Phase 
FOV

Frequency 
Direction

Center 
Frequency

Auto
Shim

Phase 
Correct Imaging Options Vascular 

Options

256x192 2 0.75 Unswapped Water On Off Cardiac Gating/ 
Triggering, IR Prep N/A

User CVs Trigger 
Type

Trigger 
Window

Trigger 
Delay R-Rs VPS Multi Phase 

Options Comments

Perform 
Arrhythmia 

Rejection = 0
Select the 
Best Lead 20 60% of R-R 

Interval 1 24 N/A Cardiac coil 
recommended
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Chapter 13

FGRET Pulse Sequences

Introduction
Fast Gradient Echo-Echo Train (FGRET) is a Fast Gradient Echo (FGRE) 
sequence with an echo-planar (EPI) readout. FGRET uses a short repetition time 
(TR) gradient echo pulse sequence with the ability to acquire multiple views per 
TR using an EPI echo train (ET). Features of both the FGRE and EPI pulse 
sequences are combined for use in cardiac applications. 

This chapter explains the pulsing components and timing factors directly related 
to the FGRET imaging pulse sequence. It contains the step-by-step instructions 
to help you learn how to:
• Prescribe the FGRET-MP Sequence 
• Perform Manual Echo Alignment for the FGRET-MP Sequence
• Adjust Echo Alignment for the FGRET-MP Sequence
• Prescribe the FGRET-RT Sequence
• Perform Manual Echo Alignment for the FGRET-RT Sequence
• Adjust Echo Alignment for the FGRET-RT Sequence 

In addition, this chapter answers the following questions:

1. What is FGRET?

2. When would I use the FGRET pulse sequence?

3. What methods can I use to acquire the FGRET pulse sequence?

4. What are the imaging characteristics of the FGRET pulse sequence?

5. Which imaging options can be used with the FGRET pulse sequence?

6. What are some applications for FGRET sequences?
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What Do I Need to Know 
About...
This section presents the concepts necessary to understand imaging with 
FGRET pulse sequences. Specifically, you need to understand the following 
concepts:
• FGRET Basics
• Optimizing the User Control Variables

– Echo Tuning And Alignment
– Ramp Sampling
– Turbo Acquisition Mode

• FGRET with Multi Phase
– Parameter Selection Effects
– Image Characteristics
– Associated Imaging Options
– Applications

• FGRET for Real Time
– Parameter Selection Effects
– Associated Imaging Options
– Applications
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FGRET Basics
FGRET uses a short TR, FGRE pulse sequence with the ability to acquire 
multiple views (phase encoding steps) per TR using an EPI ET. Features of 
both the FGRE and EPI pulse sequences are combined for use in cardiac 
applications. Refer to Table 13-1 for the features of FGRE and EPI that 
come together to compose the FGRET pulse sequence.

Table 13-1 FGRET Features

There are two methods for using FGRET.
• FGRET with Multi Phase (FGRET-MP)

– This is a sequence that supports acquisition of a dynamic myocardial 
image series.

– This is a multi-slice sequence used in conjunction with the Multi 
Phase Imaging Option. The sequence is generally repeated 30 to 60 
times for observation of tissue changes over time. 

– Images are annotated “FGR/ET.” MP and EG (for Multi Phase and 
ECG Gating/Triggering, respectively) are annotated in the Imaging 
Options line. 

• FGRET for Real Time (FGRET-RT) 
– This is a single-slice sequence that is initiated and controlled with the 

Signa® iDrive™ Pro Plus feature for Real Time Cardiac Acquisitions 
(RTCAs). When you enable it on your scanner, the data acquisition 
runs continuously.

– Images are annotated “FGR/ET.” RT is annotated in the Imaging 
Options line of the image.

Fast Gradient Echo Features EPI Features
Uniform RF excitation at minimum 
TRs

Interleaved gradient echo 
acquisition

Centric phase encoding
Acquisition of multiple views in one 
TR, the number of TRs being equal 
to the number of shots

Segmented k-space filling

FASTCINE, retrospective gating in 
FastCard-ET
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Optimizing User Control Variables
The FGRET-MP and FGRET-RT pulse sequences include several control 
variables accessed via the User Control Variables (User CVs) screen 
located in the Additional Parameters area. Selecting the User CVs Screen 
icon, opens the User CVs screen (Figure 13-1).

Figure 13-1 User CVs Screen for FGRET-MP and FRGET-RT 

Echo Tuning and Alignment
FGRET-MP is susceptible to ghosting artifacts caused by phase errors that 
accumulate within the ET. Auto echo alignment is used by the system to 
compensate for these phase errors. Echo alignment is performed for each 
slice location at the start of each acquisition. 

It is recommended that a trial acquisition be performed before the FGRET 
series. This acquisition can be used to evaluate the success of the auto 
echo alignment process. If it appears that there is an unacceptable amount 
of image blurring as in Figure 13-2, the manual echo alignment procedure 
can be performed. Alternatively, perform a manual echo alignment series 
rather than allowing the system to perform the alignment automatically.
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Figure 13-2 Misaligned Echoes

Figure 13-2 exhibits echoes that are misaligned by a few microseconds. By 
adjusting the echo delay, on the User CVs screen, the echoes can be 
brought more closely into alignment as shown in Figure 13-3.

Figure 13-3 Aligned Echoes

A trial FGRET-RT acquisition can be performed to evaluate the success of 
the auto echo alignment process. If it appears that there is an unacceptable 
amount of image blurring, the manual echo alignment procedure can also 
be performed. 

Manual echo alignment is enabled on the User CVs screen. The CVs Echo 
tuning mode, Echo delay and Manual Echo Alignment are used to perform 
manual alignment. The default for these control variables is zero, meaning 
off. The procedure for manual echo alignment can be found in the How Do 
I... section; refer to Perform Manual Echo Alignment for the FGRET-MP or 
FRGET-RT Sequence.

NOTE: A properly calibrated MR imaging system is essential to obtain 
adequate image quality in ET pulse sequences. A service engineer 
performs system calibration. 

Ramp Sampling
Ramp sampling can be used with FGRET sequences. Ramp sampling is 
performed in the same fashion as an EPI sequence. Ramp sampling 
expands the usable time during which an echo is acquired (or sampled). 
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Echo sampling takes place during the rise/fall portion of the readout 
gradient, as well as during the flat-top portion. The result is decreased echo 
spacing which, in turn, decreases image blurring. Note that when ramp 
sampling is enabled on the User CVs screen, the receive bandwidth (RBw) 
is set to 125 kHz and cannot be changed.

Turbo Acquisition Mode
Turbo acquisition mode allows a portion of the processing, generally 
completed during acquisition, to be completed during image reconstruction. 
The result is a decrease in data acquisition time, which provides an 
improvement in the frame rate. The frame rate is the number of images 
acquired per second. Turbo acquisition can increase the frame rate by as 
much as ten percent. The increased frame rate can be important when 
observing tissue enhancement. The trade-off to using the turbo acquisition 
mode is a slight increase in image ghosting or blurring. Turning on Ramp 
Sampling can mitigate these effects. 

FGRET with Multi Phase
FGRET with Multi Phase (FGRET-MP) is a cardiac gated, multi-slice 
acquisition that supports acquisition of a dynamic myocardial image series. 
Multiple images are acquired at each slice location over a defined number 
of cardiac cycles. Each image at the same slice location is acquired at the 
same phase of the cardiac cycle. Therefore, the sequence is not intended 
to image a slice location at multiple phases of the cardiac cycle.

FGRET-MP acquires all data for one slice in a single cardiac cycle, and 
multiple slice locations can be acquired within that cardiac cycle if time 
allows. Selecting Fast GRE ET on the Pulse Sequence window, as well as, 
Cardiac Gating/Triggering and Multi Phase on the Imaging Options window 
sets up the sequence. The sequence is typically repeated 30 to 60 times, 
obtaining a large number of images at each location over a period of time. 
Each slice location is obtained at the same phase of the cardiac cycle. 

After selecting Multi Phase on the Imaging Options window, the Multi Phase 
screen is used to define the number of times the sequence repeats. This is 
set as Phases per Location on the Multi Phase screen. If 6 slice locations 
are prescribed and Phases per Location is set to 30, a total of 180 images 
will be obtained. Thirty images will be acquired at each location. 

The maximum number of slices per acquisition depends on the patient’s 
heart rate, the number of R-R intervals, the ETL, TR, and frequency matrix. 
Also, a maximum of 64 locations and 512 total images can be prescribed. 
This means the total number of images in FGRET-MP sequences is based 
on Equation 13-1.
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Equation 13-1 FGRET-MP Total Number of Images

(Number of Phases X Number of Locations) = 512

FGRET-MP allows the selection of one, two, three or four R-R intervals on 
the Cardiac Gating/Triggering screen, resulting in cross R-R imaging.
• When 1 x R-R is used, a complete image of all slice locations is 

acquired every cardiac cycle. 
– When 1 x R-R is used, the images are acquired in a sequential 

fashion within one cardiac cycle (e.g., the data for six slices would be 
obtained in this order; 1, 2, 3, 4, 5, 6).

An exception to this is when 1 x R-R is used and Inversion 
Recovery (IR) Prepared is turned on. In this case, the slices are 
acquired in an interleaved fashion (e.g., six slices are collected in 
this order, 1, 3, 5, 2, 4, 6).

• If 2 x R-R is selected, the prescribed slices are acquired across two 
cardiac cycles. 
– For example, if 6 slice locations are prescribed, images 1, 3, and 5 

are acquired across the first cardiac cycle. Images 2, 4, and 6 are 
then acquired within the second cardiac cycle. 

• 2 x R-R (or greater) can be used for obtaining full coverage through the 
heart when the patient's heart rate is above 80 BPM and all slices 
cannot be acquired in one cardiac cycle.

The number of slice locations prescribed can be either an odd or even 
number. Prescribe your slices from the cardiac apex to the base for 
improved image quality at the cardiac apex. Also, prescribe the maximum 
number of slice locations allowed per R-R interval to prevent degradation of 
the first slice images acquired in the sequence. 

Parameter Selection Effects
The sequence parameters have different effects that contribute to the 
FGRET-MP images. The following parameter selections are compatible 
with FGRET-MP:
• Phased array
• Phase field of view (FOV) less than one (0.5 and 0.75)
• RBw from 32 to 125 kHz
• ETL of 2, 4, 8, or 12
• Number of excitations (NEX) is not selectable, 1 NEX is automatically 

used. Therefore, adjust other scan parameters to increase SNR. 
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The following factors can be affected by altering the values for a particular 
parameter:
• Contrast
• Resolution
• Temporal resolution

Factors that affect Contrast

FGRET-MP can also use a saturation prep-pulse by selecting IR Prepared 
on the Imaging Options window. IR Prepared can be used to suppress the 
myocardium and enhance T1 contrast so the tissue is better visualized. An 
added benefit is the inversion times (TI) used also provide some fat 
suppression. 

The prep-pulse used is a notched pulse; it is applied at a width covering half 
the number of prescribed slice locations on either side of the current slice. 
The prep-pulse prepares the next slice prior to acquisition of the current 
slice. The TI times are longer than the time it takes to acquire a slice. The 
prep time (TI time) is calculated automatically based on sequence 
parameters and cannot be edited. The actual TI time is annotated on the 
images; e.g., TI:173.

The flip angle for this sequence is typically set between 15° to 25°. The 
optimal flip angle is 25°, causing the myocardium to be darker. 

Note that the prep pulse is not applied to the first slice location; therefore, 
the image contrast for that slice differs from the remaining slices. Also, 
when FGRET-MP is used in conjunction with IR Prepared, the slices are 
acquired in an interleaved fashion even when 1 x R-R interval is selected.

Factors that Affect Resolution

The FOV you select should be the size of the patient to obtain optimal 
image resolution for the anatomy being examined. Anatomy outside the 
FOV in the phase directions wraps into the image since NPW is not 
compatible with FGRET. Keep in mind that you can use 0.75 Phase FOV as 
well.

The slice thickness you choose should be between 8 to 10 mm to cover the 
heart. An 8 mm slice thickness produces better resolution, but the 10 mm 
slice thickness may produce a better signal-to-noise ratio (SNR).

Your frequency and phase matrix choices should be 128x128 for optimal 
resolution, echo spacing, and SNR. The phase matrix also controls scan 
time and cannot exceed the value of the frequency matrix. 
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Factors that Affect Temporal Resolution

Temporal resolution is related to the number of phases acquired in the least 
amount of time. Table 13-2 describes what effect specific parameters have 
on temporal resolution in the FGRET sequence.

Table 13-2 Effects on Temporal Resolution

Image Characteristics
FGRET-MP demonstrates an assessment of myocardial tissue. This 
sequence allows high temporal resolution, while applying sufficiently long 
inversion time to allow T1 weighting. FGRET-MP images can also be 
acquired under cardiac stress and rest conditions as shown in Figure 13-4.

Figure 13-4 Images acquired with the FGRET sequence. Note the filling 
defect is only noticeable on the image that was acquired under stress 
conditions.

Associated Imaging Options
Imaging Options provide image processing or filters for enhancing 
anatomical features or reducing noise. In Table 13-3, the X’s indicate the 
imaging options available for use with the FGRET-MP pulse sequence.

Parameter Temporal Resolution
⇑ TR ⇓

⇑ ETL ⇑

⇑ Bandwidth ⇑

⇑ Phase FOV ⇓

FGRET 
Representing a defect under 
stress conditions. 

FGRET 
No defect under rest conditions.
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Table 13-3 FGRET-MP Pulse Sequence Imaging Options

NOTE: *Surface Coil Intensity Correction (SCIC) is available with the Torso 
coil. There are no SCIC parameters for the Cardiac coil.

Applications
FGRET-MP imaging can be used in clinical applications to obtain 
myocardial images with high temporal resolution.

Imaging Options

None X Variable Bandwidth

X Flow Compensation No Phase Wrap

POMP Extended Dynamic Range

X Square Pixel X* Surface Coil Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer Sequential

X Cardiac Gating/Triggering Respiratory Gating/Triggering

Tailored RF X IR Prepared

DE Prepared X Multi-Phase

Full Echo Train CCOMP

ZIP 1024 ZIP 512

Zip x 2 ZIP x 4

SmartPrep Blood Suppression

Multi Station Real Time

T2 Prep Spectral Spatial RF

Phase Sensitive Navigator

ASSET Calibration Fluoro Trigger

ASSET
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WARNING:The system cardiac gating waveforms are not to be used for 
physiologic monitoring. The patient's condition may not be 
reflected, resulting in improper emergency medical 
treatment.

FGRET for Real Time
FGRET for Real Time (FGRET-RT) is a fast gradient echo-echo train 
sequence performed using RTCA with Signa iDrive Pro Plus to obtain real 
time image data with interactive scan plane manipulation.

FGRET-RT, sometimes called "fluoro" mode, has been developed to 
provide real time localization of cardiac anatomy. FGRET-RT is prescribed 
in the same manner as any iDrive RTCA series. Once data acquisition is 
initiated on the Acquire tab, the data acquisition runs continuously. Your 
input is required on the Acquire tab to manipulate the scan plane, but 
Acquire tab Image Contrast tools are not available for FGRET-RT. You can 
review and save the images in the same fashion as any other iDrive image.

NOTE: Refer to Real Time Imaging chapter in this guide for additional 
information on iDrive Pro Plus.

Due to the large ETs used in FGRET-RT, the sequence is susceptible to 
ghosting artifacts caused by phase errors. The use of fat saturation (SAT) 
and low flip angles may help decrease the blurring that occurs with 
FGRET-RT imaging. FGRET-RT also provides auto echo alignment, which 
is performed to compensate for these phase errors. 

Auto echo alignment is performed each time the scan plane is changed 
during the FGRET real time session. As a result, there are some images 
acquired as echo alignment is taking place, and these images may exhibit 
blurring. 

Manual echo alignment, a feature also accessed on the User CVs screen, 
can be used to check and adjust the echo alignment prior to starting the real 
time data acquisition. Manual echo alignment is not commonly used with 
FGRET-RT. Refer to this section (What Do I Need to Know About...) for 
details on the User CVs screen, and the Manual Echo Alignment procedure 
in the How Do I... section for details on how to perform manual alignment. 

There are several factors you should consider when using FGRET-RT:
• As in any iDrive RTCA prescription, only one location is prescribed. 
• Spatial SAT pulses are not allowed.
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Parameter Selection Effects
The sequence parameters have different effects that contribute to the 
FGRET-RT images. The following factors can be affected by altering the 
values for a particular parameter:
• Contrast
• Resolution
• Frame rate

Factors that Affect Contrast

Images acquired with RTCA can display different types of contrast. Image 
contrast can be controlled by Fat SAT and Flow Compensation (FC). These 
selections can be prescribed during series prescription. FC and Fat SAT are 
not available on the Pro Plus Acquire tab to turn on or off. The use of Fat 
SAT and low flip angles may help compensate for the image blurring that 
occurs with FGRET-RT. Water SAT is not allowed. The Contrast tools on the 
Pro Plus Acquire tab: IR, SAT, Fat SAT, SPGR, and FC, are not available for 
FGRET-RT. 

Factors that Affect Resolution

Prescribe a FOV that covers the anatomy of interest. Small FOVs produce 
increased resolution, decreased SNR, and may increase the minimum TE. 
Keep in mind that anatomy outside of the phase FOV could result in 
aliasing. Refer to Table 13-4 for additional parameter selections that affect 
image resolution with FGRET-RT.

Table 13-4 Effects on Resolution

Factors that Affect Frame Rate

Several series parameters affect the frame rate (FPS) during real time data 
acquisition. Frame rate can be affected by the parameters shown in Table 
13-5. RBw affects the readout time. As bandwidth increases, the system 
samples faster during the echo which decreases the minimum TR. The 
frequency matrix also affects the readout time. As the frequency matrix 
increases, the system must read more samples during the echo which 
increases the minimum TR. 

Parameter Resolution
⇑ Slice Thickness ⇓

⇑ Frequency Matrix ⇑

⇑ Phase Matrix ⇑

Square Pixels ⇑
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Table 13-5 Affects on Frame Rate

Associated Imaging Options
Imaging Options provide image processing or filters for enhancing 
anatomical features or reducing noise. In Table 13-6, the Xs indicate the 
imaging options available for use with the FGRET-RT pulse sequence.

Table 13-6 FGRET-RT Pulse Sequence Imaging Options

Parameter Frame Rate
⇑ RBw ⇑

Fat Sat ⇓

⇑ ETL ⇑

⇑ Frequency Matrix ⇓

Imaging Options
None X Variable Bandwidth

X Flow Compensation No Phase Wrap

POMP Extended Dynamic Range

X Square Pixel Surface Coil Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer Sequential

Cardiac Gating/Triggering Respiratory Gating/Triggering

Tailored RF IR Prepared

DE Prepared Multi-Phase

Full Echo Train CCOMP

ZIP 1024 ZIP 512

Zip x 2 ZIP x 4

SmartPrep Blood Suppression

Multi Station X* Real Time

T2 Prep Spectral Spatial RF

Phase Sensitive Navigator

ASSET Calibration Fluoro Trigger

ASSET
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NOTE: *Real Time must be selected to acquire FGRET-RT images.

Applications
FGRET-RT can be used to quickly obtain localizer images and locations for 
imaging cardiac anatomy, as well as other areas of the body.
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How Do I...
This section provides the step-by-step instructions for prescribing FGRET 
imaging pulse sequences and for performing manual echo alignment. 
Specifically, it describes how to:
• Prescribe the FGRET-MP Sequence
• Perform Manual Echo Alignment for the FGRET-MP Sequence
• Adjust Echo Alignment for the FGRET-MP Sequence
• Prescribe the FGRET-RT Sequence
• Perform Manual Echo Alignment for the FGRET-RT Sequence
• Adjust Echo Alignment for the FGRET-RT Sequence

Decision Matrix
A decision matrix is used in this section to provide examples of what values 
could be selected for prescribing a particular sequence. The purpose of the 
decision matrix is to help you understand the trade-offs that occur when you 
change the values for a particular parameter and to provide a framework 
with which you may build your own unique protocol.

The example protocols provide information on what could be used for these 
pulse sequences and are not to be considered recommendations by GE 
Medical Systems. For specific protocols, refer to the protocols on your 
system.

In addition to listing the information you need to select on the system, the 
“What You Select” column of the matrix uses two other conventions.
• N/A indicates that the imaging parameter is not applicable to the pulse 

sequence example.
• N/S indicates that the imaging parameter is not selectable in the pulse 

sequence example. The system automatically selects these imaging 
parameters.

CAUTION: Provide all patients with ear protection prior to any scan to 
help avoid possible hearing impairment. Acoustic noise 
levels can exceed 99 dbA in the magnet bore.
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Prescribe the FGRET-MP Sequence
The FGRET-MP sequence is useful in clinical applications to obtain 
myocardial images. It is a cardiac gated sequence with the Multi Phase 
Imaging Option. Multiple images are acquired at each slice location over a 
defined number of cardiac cycles. Each slice location is obtained at the 
same phase of the cardiac cycle. This sequence also uses IR Prepared to 
suppress the myocardium and enhance T1 contrast so that the tissue is 
better visualized. 

The decision matrix (Table 13-7) is only for prescribing the FGRET-MP 
sequence. The following example protocol is for prescribing an oblique 
short axis cardiac scan for a TwinSpeed™ or an EchoSpeed™ system. 

Table 13-7 FGRET-MP Protocol Example (Short Axis Cardiac)

FGRET-MP Protocol Example 
What You Select Selection Notes

Scan Rx Desktop
Scan Rx Acquire a 

localizer series
Allows Graphic Rx to become available so you can prescribe 
slices graphically on the localized image. 

Rx Manager [New Series] Adds an additional series to the patient’s exam. 

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series if the Patient 
Protocol window becomes active.

Patient Position

Patient Position Supine Indicates the orientation of the patient. Although compatible 
with any patient position and entry, supine and feet first are 
recommended. This Ensures accurate cardiac 
gating/triggering and patient safety by ensuring proper 
routing of gating cables out of the bore, and proper routing of 
the coil cable to its attachment point on the dog-house.

Patient Entry Feet First
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Coil Phased Array 
> Cardiac

Allows selection of the coil from which the signal is 
transmitted and received. Use a coil that produces the 
optimum coverage and SNR.

Series Enter a series 
description in 
the text box.

Allows you to enter a brief description of the series being 
prescribed. If you do not enter a description, the system 
enters one for you. The series description default is the 
selected scan mode, PSD, and selected imaging options.

Imaging Parameters

Plane Oblique Defines the scan plane of the acquisition. Compatible with 
any scan plane. Select the plane that best meets your 
clinical need. For cardiac short or long axis imaging, select 
oblique for proper angle through the heart.

Mode 2D Prescribes a two-dimensional sequence.

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has Twin gradients. 

Pulse Seq. Fast GRE ET Prescribes the FGRET pulse sequence.

Imaging Options Cardiac 
Gating 
Triggering, 
Variable 
Bandwidth, 
Multi-Phase, 
and IR 
Prepared

Provides appropriate options for enhancing anatomical 
features and reducing noise. Cardiac Gating/Triggering 
should be selected. Multi Phase acquires multiple images at 
each slice location. IR Prepared improves T1 contrast.

PSD Name N/A

Protocol N/A

FGRET-MP Protocol Example 
What You Select Selection Notes
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Scan Timing

# of echoes N/S One echo is selected automatically.

TE Min Full The only selection available is minimum full.

TE2 N/A

TR N/S The minimum TR is selected automatically. The minimum TR 
decreases as RBw increases, and as ETL, frequency matrix, 
and obliquity decrease.

TI N/S The TI is automatically calculated based on the other 
sequence parameters. The TI is generally in the range of 
150 to 175 ms when 0.75 PFOV is selected. Otherwise, the 
TI is >230 ms, causing poor fat suppression.

TI2 N/A

Flip Angle Enter 25 in the 
text box.

The typical flip angle value is 25°.

Echo Train Length 4 As the ETL is increased, TR increases, and image blurring 
increases. Note the (phase matrix x PFOV) must be an even 
multiple of the ETL. The system posts a message if this is 
not followed.

Bandwidth 125 The typical RBw value is 125 kHz. Generally, wider 
bandwidths are used to minimize TR and TE values. 

Bandwidth2 N/A

FGRET-MP Protocol Example 
What You Select Selection Notes
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Scanning Range 

FOV 36 Defines the size of the area imaged. Select an FOV that 
covers the anatomy of interest, about 32 to 40 cm. Anatomy 
outside the FOV in the phase direction results in aliasing. 
Small FOVs produce increased resolution, decreased SNR, 
and can increase the minimum TE value.

Slice Thickness 10.0 Defines the thickness of the image slice. 10 mm is generally 
used to obtain coverage through the entire heart on the first 
pass sequence.

Spacing Enter 0.0 in 
the text box.

Places a zero spacing between the prescribed slice 
locations. Zero spacing is used for complete coverage.

Start, End Locations Determines the start and end locations from the Graphic Rx 
program after the slices are prescribed and posts the 
locations here. 

# Slices Determines the number of slices as prescribed in Graphic Rx 
and posts it here. Adjust the number of slice locations as 
necessary. The maximum number of slices per acquisition 
depends on the heart rate, the number of R-R intervals, the 
ETL, TR, and frequency matrix.

FGRET-MP Protocol Example 
What You Select Selection Notes
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Acquisition Timing

Freq 128 Controls resolution. Increasing the frequency matrix 
decreases echo space, SNR, the number of slice locations 
allowed, while increasing resolution. Available selections are 
128 to 256, in steps of 32.

Phase 128 Controls scan time and resolution. The phase matrix cannot 
exceed the frequency matrix. Available selections are 64 to 
256, in steps of 32. Note the (phase matrix x PFOV) must be 
an even multiple of the ETL.

NEX N/S One NEX is used automatically.

Phase FOV 0.75 Shortens scan time by scaling down the FOV in the phase 
direction by either 0.5 or 0.75. A full PFOV of one is also 
available to prevent wrapping of anatomy. Reduce the phase 
matrix to decrease scan time, FOV in the phase direction, 
and SNR (slightly). Note the (phase matrix x PFOV) must be 
an even multiple of the ETL. Due to effects on TI, 0.75 PFOV 
is recommended for optimum fat suppression. 

Freq DIR Unswap Displays the default frequency direction which is typically the 
long axis of the image. Leave the frequency direction 
unswapped.

Auto Center Freq Water Sets this CF peak during prescan.

Flow Comp DIR N/A

Autoshim On Improves image quality and is recommended for this 
sequence.

Phase Correct N/A

# of Locs Before Pause N/A

FGRET-MP Protocol Example 
What You Select Selection Notes
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 Additional Parameters - Gating/Triggering 

Trigger Type Select the best 
lead.

Defines which signal is sent by the cardiac monitor to 
activate the data acquisition. When ECG gating, select the 
lead that provides the best signal.

# of R-R Interval 2 Defines the time between the peak of one R-wave and the 
peak of the next one. Usually 2 R-R intervals allow complete 
coverage of the heart. 1, 2, 3, or 4 x R-R Interval is available. 
As the heart rate increases, a larger R-R Interval is needed 
for complete coverage of the heart.

Trigger Window 10 Defines the period of time where no data is acquired and 
when the system is waiting for the next R-wave trigger. 
Values of 10 to 15 are most commonly used. As the TW 
increases, the number of slice locations allowed decreases. 
Use larger values on patients with irregular heart rates. 
Actual scan times are longer than expected if triggers are 
detected outside the TW.

Trigger Delay Minimum Defines the delay time between the occurrence of the 
triggering pulse and the actual onset of imaging. The most 
minimum TD is desired to cover the full R-R interval.

Inter-Seq Delay N/A

Cardiac Phases N/A

# of Card. Phases to 
Reconstruct

N/A

Views per Segment N/A

FGRET-MP Protocol Example 
What You Select Selection Notes
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Heart Rate [update Rate] Lets the system obtain an automatic reading of the current 
heart rate. Updates the rate prior to beginning the scan.

Accept [Accept] Confirms the selected values and closes Gating/Triggering 
Additional Parameter screen.

 Additional Parameters - Multi Phase 

Phases per Location Enter 30 in the 
text box.

Defines the number of times the sequence repeats, and 
therefore, the number of images acquired for each slice 
location. Typically select 30 to 60 phases.

Phase Acq. Order N/A

Delay after Acquisition N/A

Accept [Accept] Confirms the selected value and closes Multi Phase 
Additional Parameter screen.

 Additional Parameters - User CVs 

Echo tuning mode 0.00 All User CVs for this sequence are turned off (0=off). Refer to 
the What Do I Need to Know About... section for the 
discussion on Manual Echo Alignment.Echo delay 0.00

FGRET-MP Protocol Example 
What You Select Selection Notes
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Manual echo alignment 0.00

Ramp Sampling 0.00

turbo_acq 0.00

Accept [Accept] Confirms the selected values and closes the User CVs 
Additional Parameter screen.

Additional Parameters - Graphic Rx

[+] Next and [-] Prior [+] and [-] Allows you to page through the localizer images to check the 
position of the prescription. 

Image Viewport Click the image 
to display the 
line cursor.

Allows you to prescribe slices from the cardiac apex to the 
base for graphic prescription. Select the adjustment handles 
to angle, draw, and remove slices. Position the slices to 
cover anatomy of interest and view the Advisory Panel to 
note the maximum number of slices per acquisition and the 
number of acquisitions you are prescribing. The scan time 
increases as the number of acquisitions increase.

Copy Rx [Copy Rx]
(optional)

Copies the exact locations of the prior series if you had 
previously graphically prescribed a series with the same 
plane, FOV, and slice thickness.

Erase All [Erase All]
(If necessary)

Eliminates the graphic prescription from the screen and 
allows you to start over.

Reset Center [Reset Center]
(if necessary)

Re-establishes the FOV center on a different localized slice.

Accept [Accept] Confirms the cursor position and closes Graphic Rx.

Series Control 
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the series.

FGRET-MP Protocol Example 
What You Select Selection Notes
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Scan Operations
Prep Scan [Prep Scan] Performs Auto Prescan and readies the system for data 

acquisition. Select for breath-hold acquisitions. 

Scan [Scan] Initiates the acquisition. Instruct the patient to hold his/her 
breath as long as possible, until the scan stops, if able.

FGRET-MP Protocol Example 
What You Select Selection Notes
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Perform Manual Echo Alignment for an 
FGRET-MP Pulse SequencePerform Manual Echo Alignment for 

the FGRET-MP Sequence
Manual Echo Alignment can be performed after performing a 
trial series if image quality is in question, or this procedure can 
be performed instead of a trial series. This process allows a 
manual check of the echo alignment to ensure optimum image 
quality. Even when this procedure is performed, image quality 
can be affected by phase offsets which are inherent to ET 
sequences. This procedure guides you through the process of 
manually aligning the echoes for the FGRET-MP sequence.

1. Prescribe the series to be used for the FGRET-MP 
acquisition.

Refer to the FGRET-MP decision matrix.

2. Turn IR Prepared off.

Located on the Imaging Options window.

3. Click the User CVs Screen icon.

Located in the Additional Parameters area.

4. Enter 1 in the Echo tuning mode text box.

Prompts the system to display a representation of the 
echoes from which proper alignment can be assessed.

5. Click [Accept].
Accepts the entry and closes the User CVs screen.

6. Click the Multi Phase Screen icon.

Located in the Additional Parameters area.

7. Enter 1 in the Phases per location text box.

Prescribes one phase per slice location.

8. Click [Accept].
Accepts the entry and closes the Multi Phase screen.

9. Click the Graphic Rx icon.

Located in the Additional Parameters area.

10. Prescribe one slice location through the center of the 
anatomy.

The slice angle, FOV, RBw, and matrix values must be 
exactly the same as the FGRET series.

Quick Steps: Perform 
Manual Echo Alignment 
for the FGRET-MP 
Sequence
1. Prescribe the series to be 

used for the FGRET-MP 
acquisition.

2. Turn IR Prepared off.

3. Click the User CVs 
Screen icon.

4. Enter 1 in the Echo 
tuning mode text box.

5. Click [Accept].
6. Click the Multi Phase 

Screen icon.

7. Enter 1 in the Phases per 
location text box.

8. Click [Accept].
9. Click the Graphic Rx 

icon.

10. Prescribe one slice 
location through the 
center of the anatomy.

11. Click [Accept].
12. Click [Save Series].
13. Click [Prepare to Scan].
14. Click [Scan].
15. Evaluate the images.

16. Prescribe the FGRET-MP 
pulse sequence.
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11. Click [Accept].
Accepts the prescription and closes the Graphic Rx 
screen.

12. Click [Save Series].
Closes the scan prescription screen, accepts the 
prescription, and saves it in the Rx Manager as RXD.

13. Click [Prepare to Scan].
Downloads the series.

14. Click [Scan].
Auto Prescan is performed and the system initiates the 
data acquisition with Echo tuning mode on.

15. Evaluate the images.

If the echoes are aligned, continue with step16.

Aligned Echoes
If the echoes are misaligned, adjust the echo alignment 
using the Adjust the Echo Alignment for the FGRET-MP 
Sequence procedure.

Misaligned Echoes

16. Prescribe the FGRET-MP pulse sequence.

Refer to the FGRET-MP decision matrix.

Set the Manual echo alignment to zero.
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Adjust Echo Alignment for an FGRET-MP 

Pulse Sequence

Adjust Echo Alignment for the 
FGRET-MP Sequence
Use this procedure if you have performed a manual echo 
alignment of the FGRET-MP pulse sequence and the echoes 
are misaligned. Another series must be acquired to adjust the 
echo alignment. This procedure guides you through the process 
of adjusting the echo delay to bring the echoes more closely 
into alignment. 

1. Copy and paste the FGRET-MP series used in the Manual 
Echo Alignment process.

2. Click [View Edit].
Opens the series and allows for changes.

3. Click the User CVs Screen icon.

Located in the Additional Parameters area.

The User CVs return to their default state when a new 
series is selected.

4. Enter 1 in the Echo tuning mode text box. 

Prompts the system to display a representation of the 
echoes from which proper alignment can be assessed.

5. Enter 6 in the Echo delay text box.

Values from ±1 to ±12.

– The delay unit is microseconds.

6. Enter 1 in Manual echo alignment text box.

Enables manual alignment.

7. Click [Accept].
Accepts the entries and closes the User CVs screen.

8. Click [Save Series].
Closes the scan prescription screen, accepts the 
prescription, and saves it in the Rx Manager as RXD.

9. Click [Prepare to Scan].
Downloads the series.

10. Click [Scan].
Auto Prescan is performed and the system initiates the 
data acquisition with Echo tuning mode on.

Quick Steps: Adjust Echo 
Alignment for the 
FGRET-MP Sequence
1. Copy and paste the 

FGRET-MP series used 
in the Manual Echo 
Alignment process.

2. Click [View Edit].
3. Click the User CVs 

Screen icon.

4. Enter 1 in the Echo 
tuning mode text box.

5. Enter 6 in the Echo delay 
text box.

6. Enter 1 in Manual echo 
alignment text box.

7. Click [Accept].
8. Click [Save Series].
9. Click [Prepare to Scan].
10. Click [Scan].
11. Evaluate the images.

12.  Repeat the acquisition, 
changing the echo delay 
each time, until the 
echoes are aligned as 
well as possible.

13. Record the value of the 
optimal echo delay.

14. Prescribe the FGRET-MP 
pulse sequence.

15. Enter the echo values on 
the User CVs screen.

16. Scan the FGRET-MP 
pulse sequence.
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11. Evaluate the images.

If the echoes are aligned, continue with step 13.

If the echoes are misaligned continue with step 12.

12. Repeat the acquisition, changing the echo delay each time, until the 
echoes are aligned as well as possible.

Continue to repeat steps 1 to 11 to adjust the echo delay value. 

Adjust the echo delay in increments of one.

– This may be a negative value. 

13. Record the value of the optimal echo delay.

NOTE: If you are unable to align the echoes, contact your service engineer. 

14. Prescribe the FGRET-MP pulse sequence.

Refer to the FGRET-MP decision matrix.

The slice locations must be the same obliquity as the location used 
for the manual echo alignment series.

15. Enter the echo values on the User CVs screen.

Echo tuning mode = 0 

– Zero is off.

Echo delay = the value determined in step 13.

Manual echo alignment = 1

– One is on.

16. Scan the FGRET-MP pulse sequence.

Refer to the FGRET-MP decision matrix.
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Prescribe the FGRET-RT Sequence
The FGRET-RT sequence is performed using iDrive Pro Plus for RTCAs to 
obtain real time image data with interactive scan plane manipulation. This is 
useful to quickly obtain localizer images and locations for imaging cardiac 
anatomy, as well as other areas of the body.

The decision matrix (Table 13-8) is only for prescribing the FGRET-RT 
scan. The following example protocol is for prescribing a real time scan for 
obtaining localizer images for imaging cardiac anatomy on a TwinSpeed or 
an EchoSpeed system. 

Table 13-8 FGRET-RT Protocol Example (Cardiac Localizers)

FGRET-RT Protocol Example 
What You Select Selection Notes

Rx Manager
Rx Manager [New Series] Adds an additional series to the patient’s exam. 

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series if the Patient 
Protocol screen becomes active.

Patient Position

Patient Position Supine Indicates the orientation of the patient. Although compatible 
with any patient position and entry, supine and feet first are 
recommended. This ensures accurate cardiac 
gating/triggering and patient safety by ensuring proper 
routing of gating cables out of the bore, and proper routing of 
the coil cable to its attachment point on the dog-house.

Patient Entry Feet First

Coil Phased Array 
> Cardiac

Allows selection of the coil from which the signal is 
transmitted and received. Use a coil that produces the 
optimum coverage and SNR.

Series Description Enter a series 
description in 
the text box.

Allows you to enter a brief description of the series being 
prescribed. If you do not enter a description, the system 
enters one for you. The series description default is the 
selected scan mode, PSD, and selected imaging options.
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Imaging Parameters

Plane Axial Defines the scan plane of the acquisition. Any orthogonal 
scan plane is allowed to set up the first slice in this real time 
sequence. 

Mode 2D Prescribes a two-dimensional sequence. 2D is the only 
mode allowable for real time sequences. 

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has Twin gradients. 

Pulse Sequence Fast GRE ET Prescribes the FGRET pulse sequence.

Imaging Options Real Time, 
Variable 
Bandwidth

Provides appropriate options for enhancing anatomical 
features and reducing noise. Real Time enables FGRET-RT. 
VBw is available, but not necessary to alter the RBw. Square 
Pixels and FC are the only other available options.

PSD Name N/A

Protocol N/A

FGRET-RT Protocol Example 
What You Select Selection Notes
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Scan Timing

# of echoes N/S One echo is selected automatically.

TE Min Full The only available selection is minimum full.

TE2 N/A

TR Minimum The minimum TR is the only available selection. The 
minimum TR decreases as RBw increases, and as ETL, 
frequency matrix, and obliquity decrease.

TI N/A

TI2 N/A

Flip Angle Enter 15 in the 
text box. 

The typical flip angle value is between 12° and 15° to help 
minimize image blurring.

Echo Train Length 8 As the ETL is increased, image blurring increases, the frame 
rate increases, and scan time decreases. 2, 4, 8, and 12 
ETLs are allowed. You may want to decrease this value if 
you are operating a HiSpeed™ or SmartSpeed™ system.

Bandwidth 125 As the RBw increases, SNR decreases, minimum TE and 
TR values result, and image blurring decreases as a result of 
shorter echo spaces. 32, 62.5, and 125 kHz are allowed.

Bandwidth2 N/A

FGRET-RT Protocol Example 
What You Select Selection Notes
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Scanning Range 

FOV 36 Defines the size of the area imaged. Select an FOV that 
covers the anatomy of interest, about 32 to 40 cm. Anatomy 
outside the FOV in the phase direction results in aliasing. 
Small FOVs produce increased resolution, decreased SNR, 
and can increase the minimum TE value.

Slice Thickness 10.0 Defines the thickness of the image slice. 8 mm to 10 mm is 
generally used to obtain the home images. This value can be 
interactively changed during data acquisition.

Spacing N/A FGRET-RT is a single slice acquisition; spacing is not 
required.

Start, End Locations 0.0 Determines the start and end locations. Either Explicit or 
Graphic Rx can be used to prescribe the single slice 
location.

# Slices 1 Determines the number of slices as prescribed in Explicit or 
Graphic Rx and posts it here. Only one slice location is 
allowed for real time sequences.

Acquisition Timing

Freq 128 Increasing the frequency matrix decreases echo space, 
SNR, the number of slice locations allowed, while increasing 
resolution. Available selections are 64 to 256, in steps of 32.

FGRET-RT Protocol Example 
What You Select Selection Notes
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Phase 128 The typical value is 96 or 128. The phase matrix cannot 
exceed the frequency matrix. 

NEX N/S One NEX is used automatically.

Phase FOV 0.75 Select a phase FOV of one to prevent wrapping of anatomy. 
Choices are 1.0, 0.75, and 0.5. Reduce the phase matrix to 
decrease scan time, FOV in the phase direction, and SNR 
(slightly). The phase FOV dimension is displayed next to the 
phase FOV factor.

Freq DIR R/L Displays the default frequency direction which is typically the 
long axis of the image. To swap phase and frequency, select 
the other direction.

Auto Center Freq Water Sets this CF peak during prescan.

Flow Comp DIR N/A

Autoshim On Improves image quality and is recommended for this 
sequence.

Phase Correct N/A

# of Locs Before Pause N/A

 Additional Parameters - User CVs 

Echo tuning mode 0.00 Manual echo alignment is not commonly performed on 
FGRET-RT. Refer to the What Do I Need to Know About... 
section for the discussion on manual echo alignment.Echo delay 0.00

Manual echo alignment 0.00

Ramp Sampling 1.00 Decreases the echo space and image blurring. The RBw is 
fixed at 125 kHz when ramp sampling is enabled. Enter 1 in 
the text box to use ramp sampling. Leave the text box at the 
default value of zero if ramp sampling is not desired. 

FGRET-RT Protocol Example 
What You Select Selection Notes
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turbo_acq 1.00 Decreases data acquisition times and increases the frame 
rate. Enter 1 in the text box to use turbo acquisition mode. 
Recommended with Ramp Sampling to decrease image 
blurring. This option is not supported with the Body coil. 

Accept [Accept] Confirms the selected values and closes the User CVs 
Additional Parameter screen.

Series Control 
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the series.

Scan Operations
Scan [Scan] Initiates Auto Prescan and the iDrive Acquire tab opens. 

Home images are acquired and at this point, the Acquire tab 
can be used to navigate through the anatomy and alter 
image contrast as needed. Scan planes and slice locations 
can be copied from the iDrive windows to a series in the Rx 
Manager.

FGRET-RT Protocol Example 
What You Select Selection Notes
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Perform Manual Echo Alignment for 
the FGRET-RT Sequence
Manual echo alignment can be performed if after performing the 
FGRET-RT series, image quality is in question. Manual echo 
alignment can also be performed prior to starting the real time 
sequence. This process allows a manual check of the echo 
alignment to ensure optimum image quality. Even when this 
procedure is performed, image quality can be affected by phase 
offsets which are inherent to ET sequences. This procedure 
guides you through the process of manually aligning the echoes 
for the FGRET-RT pulse sequence.

1. Prescribe the series to be used for the FGRET-RT 
acquisition.

Refer to the FGRET-RT decision matrix.

2. Turn Real Time off.

Located on the Imaging Options window.

3. Click the User CVs Screen icon.

Located in the Additional Parameters area.

4. Enter 1 in the Echo tuning mode text box.

Prompts the system to display a representation of the 
echoes from which proper alignment can be assessed.

5. Click [Accept].
Accepts the entry and closes the User CVs screen.

6. Click the Graphic Rx icon.

Located in the Additional Parameters area.

7. Prescribe one slice location through the center of the 
anatomy.

The slice angle, FOV, RBw, and matrix values must be 
exactly the same as the FGRET series.

8. Click [Accept].
Accepts the prescription and closes the Graphic Rx 
screen.

9. Click [Save Series].
Closes the scan prescription screen, accepts the 
prescription, and saves it in the Rx Manager as RXD.

Quick Steps:  Perform 
Manual Echo Alignment 
for the FGRET-RT 
Sequence
1. Prescribe the series to be 

used for the FGRET-RT 
acquisition.

2. Turn Real Time off.

3. Click the User CVs 
Screen icon.

4. Enter 1 in the Echo 
tuning mode text box.

5. Click [Accept].
6. Click the Graphic Rx 

icon.

7. Prescribe one slice 
location through the 
center of the anatomy.

8. Click [Accept].
9. Click [Save Series].
10. Click [Prepare to Scan].
11. Click [Scan].
12. Evaluate the images.

13. Prescribe the FGRET-RT 
pulse sequence.
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10. Click [Prepare to Scan].
Downloads the series.

11. Click [Scan].
Auto Prescan is performed and the system initiates the 
data acquisition with echo tuning mode on.

12. Evaluate the images.

If the echoes are aligned, continue with step13.

Aligned Echoes
If the echoes are misaligned, adjust the echo alignment 
using the Adjust Echo Alignment for the FGRET-RT 
Sequence procedure.

Misaligned Echoes

13. Prescribe the FGRET-RT pulse sequence.

Refer to the FGRET-RT decision matrix.

Set the Manual echo alignment to zero.
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Adjust Echo Alignment for the 
FGRET-RT Sequence
Use this procedure if you have performed a manual echo 
alignment of the FGRET-RT pulse sequence and the echoes 
are misaligned. Another series must be acquired to adjust the 
echo alignment. This procedure guides you through the process 
of adjusting the echo delay to bring the echoes more closely 
into alignment. 

1. Copy and paste the FGRET-RT series used in the Manual 
Echo Alignment process.

2. Click [View Edit].
Opens the series and allows for changes.

3. Click the User CVs Screen icon.

Located in the Additional Parameters area.

The User CVs return to their default state when a new 
series is selected.

4. Enter 1 in the Echo tuning mode text box. 

Prompts the system to display a representation of the 
echoes from which proper alignment can be assessed.

5. Enter 6 in the Echo delay text box.

Values from ±1 to ±12.

– The delay unit is microseconds.

6. Enter 1 in Manual echo alignment text box.

Enables manual alignment.

7. Click [Accept].
Accepts the entries and closes the User CVs screen.

8. Click [Save Series].
Closes the scan prescription screen, accepts the 
prescription, and saves it in the Rx Manager as RXD.

9. Click [Prepare to Scan].
Downloads the series.

10. Click [Scan].
Auto Prescan is performed and the system initiates the 
data acquisition with Echo tuning mode on.

Quick Steps: Adjust Echo 
Alignment for the 
FGRET-RT Sequence
1. Copy and paste the 

FGRET-RT series used in 
the Manual Echo 
Alignment process.

2. Click [View Edit].
3. Click the User CVs 

Screen icon.

4. Enter 1 in the Echo 
tuning mode text box.

5. Enter 6 in the Echo delay 
text box.

6. Enter 1 in Manual echo 
alignment text box.

7. Click [Accept].
8. Click [Save Series].
9. Click [Prepare to Scan].
10. Click [Scan].
11. Evaluate the images.

12. Repeat the acquisition, 
changing the echo delay 
each time, until the 
echoes are aligned as 
well as possible.

13. Record the value of the 
optimal echo delay.

14. Prescribe the FGRET-RT 
pulse sequence.

15. Enter the echo values on 
the User CVs screen.

16. Scan the FGRET-RT 
pulse sequence.
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11. Evaluate the images.

If the echoes are aligned, continue with step 13.

If the echoes are misaligned continue with step 12.

12. Repeat the acquisition, changing the echo delay each time, 
until the echoes are aligned as well as possible.

Continue to repeat steps 1 to 11 to adjust the echo delay 
value.

Adjust the echo delay in increments of one.

– This may be a negative value. 

13. Record the value of the optimal echo delay.

This value will be manually entered in a later step.

NOTE: If you are unable to align the echoes, contact your service 
engineer. 

14. Prescribe the FGRET-RT pulse sequence.

Refer to the FGRET-RT decision matrix.

The slice locations must be the same obliquity as the 
location used for the manual echo alignment series.

15. Enter the echo values on the User CVs screen.

Echo tuning mode = 0 

– Zero is off.

Echo delay = the value determined in step 13.

Manual echo alignment = 1

– One is on.

16. Scan the FGRET-RT pulse sequence.

Refer to the FGRET-RT decision matrix.
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Chapter 14

Spiral Pulse Sequences

Introduction
The Spiral pulse sequence is a 2D, Gradient Echo (GRE) or Spoiled Gradient 
Echo (SPGR) sequence which uses a spiral trajectory to obtain the required data 
for image creation. There are two types of Spiral imaging available: 
High-Resolution (Hi-Res) Spiral and Real Time Spiral.

This chapter explains the pulsing components and timing factors directly related 
to the Spiral imaging pulse sequences. It contains the step-by-step instructions to 
help you learn how to:
• Prescribe a Hi-Res Spiral Sequence 
• Prescribe a Real Time Spiral Sequence

In addition, this chapter answers the following questions:

1. What is Spiral?

2. When would I use a Spiral pulse sequence?

3. What methods can I use to acquire a Spiral pulse sequence?

4. What are the imaging characteristics of a Spiral pulse sequence?

5. Which imaging options can be used with a Spiral pulse sequence?

6. What are some applications for Spiral sequences?
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What Do I Need to Know 
About...
This section presents the concepts necessary to understand imaging with 
Spiral pulse sequences. Specifically, you need to understand the following 
concepts:
• Spiral Basics

– Parameter Selection Effects
– Peripheral Nerve Stimulation

• High Resolution Spiral
– Gated Non-Sequential Hi-Res Spiral
– Gated Sequential Hi-Res Spiral
– Imaging Characteristics
– Associated Imaging Options
– Applications

• Real Time Spiral
– Parameter Selection Effects
– Imaging Characteristics
– Associated Imaging Options
– Applications
14-2  2333956-100 Rev. 0 (06/02)
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Spiral Basics
Spiral imaging is a data acquisition method in which k-space is filled in a 
spiral fashion, as opposed to k-space being filled in a uniform rectilinear 
grid. Following spiral data collection, the data is interpolated onto a 
rectilinear grid, which is necessary for applying the Fast Fourier Transform 
(FFT) for image formation. 

The Spiral pulse sequence is a 2D, GRE or SPGR sequence which uses a 
spiral trajectory to obtain the required data for image creation. A spiral 
trajectory is obtained by simultaneously applying the gradients in the X and 
Y directions. By knowing the strength and direction of the gradients at any 
given time, points within the anatomy can be localized and a gradient echo 
can be collected. 

Spiral imaging provides the following benefits:
• Efficient k-space data collection

– Filling k-space in a spiral trajectory allows the necessary data to be 
collected quicker as compared to line-by-line data collection using a 
rectilinear grid. The outermost corners of k-space are not filled in a 
spiral trajectory. Figure 14-1 illustrates of a single spiral trajectory.

• Center of k-space is over-sampled
– This is due to data collection beginning at the center of k-space. This 

provides an effect similar to multiple averaging of data.
• Relatively short echo times

– This results from data collection that can begin immediately after 
radio frequency (RF) excitation.

• Intrinsic flow and motion compensation properties 
– These properties result in images with reduced motion artifacts 

without the use of flow compensation (FC) or other motion 
compensation techniques.
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Figure 14-1 Single Spiral Trajectory or Arm. This arm contains 50 points of 
data.

Either a single trajectory or multiple trajectories can be performed in Spiral 
imaging. The number of trajectories for a sequence is defined as the 
"number of arms." Each arm contains a defined number of points and each 
point is a piece of data, which contributes to the filling of k-space. A point is 
the number of data points that are collected for each spiral arm. The 
number of arms and points, along with the selected field of view (FOV) and 
receive bandwidth (RBw) contribute to image resolution. The maximum 
number of points and arms allowed is based upon Equation 14-1.

Equation 14-1 Maximum Number of Point and Arms

        # of Points x # of Arms x The Decimation Factor ≤ 131,072

The decimation factor is based on the prescribed RBw. At 125 kHz, the 
decimation factor is 1, at 62.5 it is 2, and at 31.25 it is 3. The system 
displays an error if the selected combination of points, arms, and RBw is 
unacceptable. 

Although these parameters affect resolution, there is not a direct method of 
calculating resolution based only on these factors. The effective resolution 
is displayed in the Acquisition Timing area. Effective resolution is based on 
the acquired resolution and the reconstruction resolution. It is automatically 
calculated and displayed. Due to the interpolation of the spiral data into a 
rectilinear grid needed for the FFT, reconstruction times are longer, as 
compared to many other types of pulse sequences. 

The Acquisition Timing area is modified to reflect a spiral acquisition. The 
Points text box replaces Frequency, and Arms text box replaces Phase. 
The Effective Resolution text box is displayed in place of the Frequency 
Direction (there is no frequency direction in a spiral data acquisition) and 
displays the effective resolution of the prescribed sequence. The B0 Maps 
14-4  2333956-100 Rev. 0 (06/02)
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text box is seen in place of Phase Correct. Figure 14-2 displays the 
modified Acquisition Timing area and Table 14-1 describes the new text 
boxes. 

Figure 14-2 Spiral Acquisition Timing Area

Table 14-1 Spiral Acquisition Timing Selections

Selection Description

Points

Defines the number of data points that are collected for 
each spiral arm. The minimum is 512 and the maximum is 
8192 (4096 for a multi-array coil), in increments of 2. 
Points and Arms are annotated in place of the Matrix, 
e.g., 4096x32/1.00NEX.

Arms

Defines the number of spiral trajectories that are 
performed. Multiple arms can be interleaved within the 
same TR, or they can be collected in consecutive TRs; 
the method used depends on the type of spiral sequence 
being performed. Increasing the number of arms 
increases spatial resolution because sampling is taking 
place further toward the edges of k-space. The minimum 
is 1 and the maximum is 32, in increments of 1. 

Effective 
Resolution

Shows the effective resolution of the prescribed series in 
millimeters. This text box is not editable. The Effective 
Resolution annotation replaces the Frequency direction in 
the lower right corner of the image, e.g., EffR: 0.51.

B0 Maps

Compensates for phase differences that result from 
inhomogeneities by performing a type of phase 
correction. Turning B0 Maps on can improve image 
quality. Two spiral arms (TRs) are added to an acquisition 
when B0 Maps is on, adding a minimal amount to scan 
time, thus extending breath-hold acquisition times. When 
B0 Maps is used, it is indicated in the same fashion as 
Phase Correct. PC is annotated as a prescan option on 
the Series Text page. 
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Parameter Selection Effects
The effects of changing sequence parameters in spiral imaging may differ 
from other pulse sequences, or the effects may be more pronounced. Table 
14-2 can be used for reference when setting up a spiral sequence. The 
parameters in the table are mentioned because of the importance of 
choosing these factors carefully for spiral imaging.

Table 14-2 Imaging Effects with Spiral Sequences

There are several additional factors that affect image contrast:
• Applying a 60° flip angle allows you to maintain a T1 weighted contrast 

on static tissue, allowing bright flow signal.
• The T2 Prep Imaging Option is a magnetization prep pulse that allows 

suppression of muscles and venous structures.

There are several factors you should consider when using Spiral 
sequences:
• Wrap-around (aliasing) can occur in all directions in spiral acquisitions, 

except in the slice-select direction. Use FOVs large enough to cover the 
anatomy of interest to avoid this wrap. 

• Incorrect coil positioning can result in stimulation of tissue outside the 
FOV, which results in increased aliasing; therefore, it is important to 
ensure correct coil positioning over the anatomy of interest.
– It may be beneficial to use a decreased number of coil elements, 

when possible, to help decrease the possibility of aliasing from 
unwanted tissue. For example, the Cardiac Phased Array coil allows 
selection of either the anterior or posterior coil elements by selecting 
CARDIAC_ANT or CARDIAC _POST respectively. Turning off 
un-needed coil elements decreases the possibility of aliasing from 
unwanted anatomy. 

Parameters SNR Spatial 
Resolution Scan Time Image 

Blurring

Spiral 
Aliasing 
(wrap)

⇑ RBw ⇓ No change 
or slight ⇓ No change ⇓ No change

⇑ # of Arms ⇓ ⇑ ⇑ No change No change

⇑ # of Points ⇓ ⇑ No change 
or slight ⇑ ⇑ No change

⇑ FOV ⇑ ⇓ No change ⇑ ⇓

Center Freq 
off-center ⇓ No change No change ⇑ No change
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Peripheral Nerve Stimulation
Spiral imaging increases the possibility of Peripheral Nerve Stimulation 
(PNS). dB/dt refers to the rate of change in magnetic field to time, which is 
expressed in Tesla/seconds. dB/dt and specific absorption rate (SAR) levels 
for the patients are based on current scientific literature related to safety, 
and that the level of exposure shall be a medical judgment as to the 
patient's potential risk versus benefit.

PNS is described as a light touching sensation felt on various areas of the 
skin surface. These areas vary, depending upon which gradient axis is in 
use. Some common areas for the sensation are the bridge of the nose, 
arms, chest and upper abdomen. Hands clasped together considerably 
lowers nerve stimulation thresholds and should be avoided. The potential 
for PNS is low, but it exists for all sequences and gradient configurations.

CAUTION: Patients who complain of PNS during a Spiral sequence 
should have the series stopped and replaced with another 
pulse sequence. If the PNS occurs with a non-Spiral 
sequence, the patient should be removed from the magnet 
and the incident reported to GE Medical Systems. 

PNS is not harmful. The potential for inducing PNS is kept within limitations. 
In the United States, the system is limited from operating above 66% of the 
PNS threshold by the software (unless the system is operating in research 
mode). The point at which 50% of a population will experience PNS is the 
PNS threshold. 

Your MR system is capable of operating under two modes: Clinical mode 
(normal) and Research mode (proprietary license agreement with GE). 

High Resolution Spiral
High Resolution Spiral (Hi-Res Spiral) has been developed to obtain high 
resolution images in ultra-fast scan times, in seconds and even 
milliseconds. This sequence is well suited for obtaining images of the 
coronary arteries.

Hi-Res Spiral acquisitions can be performed in cardiac-gated or non-gated 
method. To perform a spiral sequence, either Spiral Gradient Echo (GRE) or 
Spiral Spoiled Gradient Echo (SPGR) is selected on the Pulse Sequence 
window. Selections on the Imaging Options window further define the type 
of data to be acquired. 
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Hi-Res Spiral sequences can be acquired cardiac-gated or non-gated.
• Non-gated Hi-Res Spiral is a 2D, GRE or SPGR sequence. 

– Spiral GRE or Spiral SPGR is selected on the Pulse Sequence 
window. 

– One or more slice locations can be acquired. 
– Non-gated Hi-Res Spiral is not commonly used due to the nature of 

the anatomy.
• Gated Hi-Res Spiral is a 2D, GRE or SPGR sequence that is 

cardiac-gated in the same manner as a FastCard sequence. 
– Two types of gated spiral can be performed: non-sequential and 

sequential.

Gated Non-Sequential Hi-Res Spiral
In a Gated Non-Sequential Hi-Res Spiral sequence, single-slice or 
multi-slice imaging is allowed. In multi-slice, the maximum number of slices 
allowed is based on the heart rate. Only a single cardiac phase can be 
acquired.

There are three types of Gated Non-Sequential Hi-Res Spiral sequences:
• Single-arm, single-slice acquisition

– Obtains all the data for the slice in one TR, also called a single-shot. 
This sequence is rarely performed due to poor image resolution.

• Single-arm, multi-slice acquisition 
– Obtains all the data for all locations in a single R-R interval. Each 

slice location is acquired in a single shot. This sequence is rarely 
performed due to poor image resolution.

• Multi-arm acquisition 
– Repeats the data acquisition, which took place in the single-arm 

acquisition, whether it is single or multi-slice. All slice locations are 
acquired at the same phase of the cardiac cycle.

Gated Sequential Hi-Res Spiral
Gated Sequential Hi-Res Spiral sequences can acquire single-slice or 
multi-slice images. Sequential must be selected on the Imaging Options 
window to perform this sequence. The sequence then allows you to acquire 
multiple cardiac phases. The number of cardiac phases obtained can be 
entered manually in the # of Cardiac Phases to Reconstruct text box on 
the Cardiac Gating/Triggering screen. Alternatively, the number of phases 
acquired can be automatically determined by the system when Auto is 
selected for the number of cardiac phases to reconstruct.
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There are four types of Gated Sequential Hi-Res Spiral sequences.
• Single-arm, single-slice acquisition 

– Obtains all the data for one phase in one TR period, then repeats the 
data acquisition at subsequent phases within one cardiac cycle.

• Multi-arm, single-slice acquisition
– Repeats the single-arm sequence to complete the number of arms 

defined; if six arms are prescribed, the sequence is repeated six 
times.

• Single-arm, multi-slice acquisition 
– Obtains all the phase data for a single location in one R-R interval. 

All phases for the next location are obtained in the next R-R interval, 
and so on, until all slices are complete.

• Multi-arm, multi-slice acquisition 
– Completes all the arms for slice one, collecting all phases for that 

slice in one R-R interval. All phases and arms are then collected for 
the next slice, and so on, until all slices are complete.

For multi-slice acquisitions, if a negative spacing (overlap) is prescribed, the 
slice locations are acquired in an interleaved fashion to avoid cross-talk. 
Otherwise, acquisition slice ordering is done sequentially. Reducing the flip 
angle from 60° to 45° for gated sequential acquisitions reduces saturation 
effects and improves SNR. 

In gated sequences, extend the trigger delay (TD) to a point at which 
mid-diastole is taking place (commonly 350 to 450 ms) to obtain images 
during the most quiescent part of the cardiac cycle. Another benefit of 
obtaining image data at mid-diastole is flow is maximized at this time.

Imaging Characteristics
Spiral imaging produces images with high spatial and temporal resolution. 
The pulse sequences are annotated “GR/SPIRAL/20” or 
“SPGR/SPIRAL/20” with 20 indicating the flip angle.

Figure 14-3 Hi-Res Spiral Image of the Coronary Artery 
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Associated Imaging Options
Imaging Options provide image processing or filters for enhancing 
anatomical features or reducing noise. In Table 14-3, the X’s indicate the 
imaging options available for use with the Hi-Res Spiral pulse sequence.

Table 14-3 Hi-Res Spiral Pulse Sequence Imaging Options

Two primary imaging options are available for Spiral imaging. 
• Spectral Spatial RF (SSRF) uses slice-selective pulses to suppress 

signal from fat. 
– This can be especially useful for suppressing the fat that may 

interfere with visualization of the coronary arteries.
• T2 Prep applies a sequence of non-selective 90° and 180° RF pulses to 

suppress tissue. 
– This can be used to decrease signal from surrounding venous 

structures and lessen signal from tissue such as cardiac muscle. 

Imaging Options
None X Variable Bandwidth

X Flow Compensation No Phase Wrap

POMP X Extended Dynamic Range

Square Pixel Surface Coil Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer X Sequential

X Cardiac Gating/Triggering Respiratory Gating/Triggering

Tailored RF IR Prepared

DE Prepared Multi-Phase

Full Echo Train CCOMP

ZIP 1024 ZIP 512

Zip x 2 ZIP x 4

SmartPrep Blood Suppression

Multi Station Real Time

X T2 Prep X Spectral Spatial RF

Phase Sensitive Navigator

ASSET Calibration Fluoro Trigger 

ASSET
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There are several factors you should consider when using the imaging 
options with Hi-Res Spiral sequences:
• When FC is used, it is applied in the slice-select direction only.
• Sequential can only be used in the gated mode and is required for 

multiple cardiac phases. 
• The RBw is limited to 31.25, 41.67, 62.5, and 125 kHz.

– When the number of points is prescribed to 2048 or greater, the RBw 
must be set to 125 kHz.

In addition, Hi-Res Spiral is also compatible with the following options:
• Phased array
• Fat and water suppression

– Not allowed with SSRF
• Spatial SAT

– Not allowed with T2 Prep

Applications
Spiral imaging is intended for whole body imaging and is capable of 
producing images with high spatial and temporal resolution, such as fine 
structures where motion can be a problem. Examples include:
• Cardiac Gated Hi-Res Spiral can be used to image the coronary 

arteries. 
• Single-slice, Multi-phase Cardiac Gated Hi-Res Spiral can be used to 

capture in plane, multiple cardiac phases of a single coronary artery.
• Visualization of the coronaries may be improved with the use of SSRF.
• T2 Prep can be used to decrease signal from venous structures.

WARNING:The system cardiac gating waveforms are not to be used for 
physiologic monitoring. The patient's condition may not be 
reflected, resulting in improper emergency medical 
treatment.
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Real Time Spiral Imaging
Real Time Spiral Imaging is used with the iDrive Pro Plus Real Time 
Cardiac Acquisition (RTCA) imaging feature. Real Time Spiral acquisitions 
are defined by selecting either Spiral GRE or Spiral SPGR on the Pulse 
Sequence window and Real Time on the Imaging Options window. As in 
any iDrive RTCA prescription, only one location is prescribed for this 
sequence.

The following are key components of Real Time Spiral:
• All coil types are allowed.
• Cardiac Gating/Triggering is not allowed. 

– The Real Time Spiral frame-rate is typically described in frames per 
second (FPS) providing high-temporal resolution images exhibiting 
little or no motion in areas such as the heart.

• Real Time Spiral images are of low spatial resolution, so this sequence 
is typically used for localization of anatomy.

• The prescribed number of points affects the maximum number of arms 
allowed. Likewise, the number of arms affects the maximum number of 
points allowed. 

• The Imaging Option SSRF is available with Real Time Spiral. 
– SSRF can be used to suppress signal from fat. This can be 

especially useful for suppressing the fat that may interfere with 
visualization of the coronary arteries.

NOTE: Refer to the Imaging with Real Time chapter in this guide for additional 
information on iDrive Pro Plus.

Parameter Selection Effects
Real Time Spiral is compatible with the following selections.
• Phased array
• RBw limited to 62.5 and 125 kHz
• Fat suppression
• B0 Maps
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In addition, there are several factors you should consider when using Real 
Time Spiral:
• If B0 Maps is desired, it must be turned on in the Acquisition Timing area 

during series prescription and cannot be turned on/off at the iDrive Pro 
Plus Acquire tab.
– B0 Maps is annotated on the Series Text page as PC.

• When B0 Maps is turned on during series prescription, the displayed 
FPS value is indicative of the frame rate during the point in data 
acquisition when the B0 Map function is performed. 
– The actual frame rate (when B0 Maps is not being performed) is likely 

to be higher.
• If the effective resolution (which is based on the points, arms and RBw) 

is below the value resulting from the FOV (in mm) divided by 128, the 
system requires a change in either points, arms, or RBw.

• If the FOV (in mm) divided by 128 is greater than the calculated 
effective resolution, the resulting image resolution is based on the 
equation, not the effective resolution. 
– FOV (in mm) divided by 128 = Pixel size

• Fat suppression must be turned on during series prescription and 
cannot be turned on/off at the iDrive Pro Plus Acquire tab.

• Spatial SAT pulses are not allowed.

Imaging Characteristics
Real Time Spiral is a low spatial resolution sequence. The pulse sequence 
is annotated “GR/SPIRAL/20” or “SPGR/SPIRAL/20” with 20 indicating the 
flip angle. The images are not annotated to show that Real Time was 
selected on the Imaging Options window. 

Figure 14-4 Real Time Spiral Image
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Associated Imaging Options
Imaging Options provide image processing or filters for enhancing 
anatomical features or reducing noise. In Table 14-4, the X’s indicate the 
imaging options available for use with the Real Time Spiral pulse sequence.

Table 14-4 Real Time Spiral Pulse Sequence Imaging Options

NOTE: *Real Time must be selected to acquire Real Time Spiral images.

NOTE: **SSRF must be turned on during series prescription on the Imaging 
Options window and cannot be turned on/off at the iDrive Pro Plus 
Acquire tab.

Applications
Real Time Spiral can be used for the quick localization of anatomy lying in 
double-oblique planes and in areas where motion can be a problem, such 
as the coronary arteries. 

Imaging Options
None X Variable Bandwidth

Flow Compensation No Phase Wrap

POMP X Extended Dynamic Range

Square Pixel Surface Coil Intensity Correction

Respiratory Compensation Classic

Magnetization Transfer Sequential

Cardiac Gating/Triggering Respiratory Gating/Triggering

Tailored RF IR Prepared

DE Prepared Multi-Phase

Full Echo Train CCOMP

ZIP 1024 ZIP 512

Zip x 2 ZIP x 4

SmartPrep Blood Suppression

Multi Station X* Real Time

T2 Prep X** Spectral Spatial RF

Phase Sensitive  Navigator

ASSET Calibration Fluoro Trigger

ASSET
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How Do I...
This section provides the step-by-step instructions for prescribing Spiral 
imaging pulse sequences. Specifically, it describes how to:
• Prescribe a Hi-Res Spiral Sequence
• Prescribe a Real Time Spiral Sequence

Decision Matrix
A decision matrix is used in this section to provide examples of what values 
could be selected for prescribing a particular sequence. The purpose of the 
decision matrix is to help you understand the trade-offs that occur when you 
change the values for a particular parameter and to provide a framework 
with which you may build your own unique protocol.

The example protocols provide information on what could be used for these 
pulse sequences and are not to be considered recommendations by GE 
Medical Systems. For specific protocols, refer to the protocols on your 
system.

In addition to listing the information you need to select on the system, the 
“What You Select” column of the matrix uses two other conventions.
• N/A indicates that the imaging parameter is not applicable to the pulse 

sequence example.
• N/S indicates that the imaging parameter is not selectable in the pulse 

sequence example. The system automatically selects these imaging 
parameters.

CAUTION: Provide all patients with ear protection prior to any scan to 
help avoid possible hearing impairment. Acoustic noise 
levels can exceed 99 dbA in the magnet bore.
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Prescribe a Hi-Res Spiral Sequence
The Hi-Res Spiral sequence is useful in clinical applications to obtain 
high-resolution images in ultra-fast scan times. This sequence is well suited 
for acquiring images of the coronary arteries. Visualization of the coronaries 
may be improved with the use of T2 Prep and SSRF.

The decision matrix (Table 14-5) is only for prescribing a Hi-Res Spiral scan 
with cardiac gating. The following example protocol is for prescribing an 
oblique right coronary artery cardiac scan for a TwinSpeed or an 
EchoSpeed system. 

Table 14-5 Hi-Res Spiral Protocol Example (Right Coronary Artery)

 Hi-Res Spiral Protocol Example 
What You Select Selection Notes

Scan Rx Desktop
Scan Rx Acquire a 

localizer series
Allows Graphic Rx to become available so you can prescribe 
slices graphically on the localized image. 

Rx Manager [New Series] Adds an additional series to the patient’s exam. 

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series if the Patient 
Protocol screen becomes active.

Patient Position

Patient Position Supine Indicates the orientation of the patient. Although compatible 
with any patient position and entry, supine and feet first are 
recommended. This ensures accurate cardiac 
gating/triggering and patient safety by ensuring proper 
routing of gating cables out of the bore, and proper routing of 
the coil cable to its attachment point on the dog-house.

Patient Entry Feet First
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Coil Phased Array 
> Cardiac

Allows selection of the coil from which the signal is 
transmitted and received. Use a coil that produces the 
optimum coverage and SNR. Up to a four-coil phased array 
coil is allowed. Note that two additional configurations are 
available for the Cardiac PA coil. CARDIAC_ANT and 
CARDIAC_POST turn on the two coil elements in the 
anterior and posterior portion of the cardiac coil, respectively. 
CARDIAC_ANT can be used to reduce signal from posterior 
anatomy, thus reducing the potential for aliasing from the 
spine and back in spiral acquisitions. These selections are 
available from the Phased Array coil list.

Series Description Enter a series 
description in 
the text box.

Allows you to enter a brief description of the series being 
prescribed. If you do not enter a description, the system 
enters one for you. The series description default is the 
selected scan mode, PSD, and selected imaging options.

Imaging Parameters

Plane Oblique Defines the scan plane of the acquisition. Compatible with 
any scan plane. Select the plane that best meets your 
clinical need. Oblique is generally used to obtain the proper 
angle through the heart.

Mode 2D Prescribes a two-dimensional sequence.

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has Twin gradients. 

Pulse Sequence Spiral SPGR Prescribes a Spiral SPGR pulse sequence. Spiral GRE is 
also an allowable selection.

Imaging Options Cardiac 
Gating 
Triggering, 
Sequential, 
and Spectral 
Spatial RF

Provides appropriate options for enhancing anatomical 
features and reducing noise. Cardiac Gating/Triggering and 
Sequential allow a gated sequence with multiple cardiac 
phases. Select Sequential for a single cardiac phase 
acquisition and do not select for a multiple phase cardiac 
acquisition. This sequence can also be acquired without 
cardiac gating. SSRF can be used to suppress signal from 
fat that may interfere with visualization of the coronary 
arteries. Select T2 Prep to diminish signal from tissue such 
as muscle and venous structures. Use of T2 Prep 
dramatically reduces SNR.

 Hi-Res Spiral Protocol Example 
What You Select Selection Notes
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PSD Name N/A

Protocol N/A

Scan Timing

# of echoes N/S One echo is selected automatically.

TE Minimum The only TE available selection is minimum.

TE2 N/A

TR N/S The minimum TR is used to maintain ultra-fast scan times.

Inv Time N/A

TI2 N/A

Flip Angle 60 The typical flip angle value is 60°. Decrease the flip angle to 
45° for sequential acquisitions to reduce saturation effects. 

Echo Train Length N/A

Bandwidth 125.00 The RBw values allowed are 31.25, 41.67, 62.5, and 125 
kHz. Typical values are 62.5 and 125 kHz. The systems 
selects one of the four values closest to the typed-in value. 
Increasing the RBw results in decreased SNR, decreased 
image blurring, and a slight decrease in spatial resolution. 
The bandwidth must be set to 125 kHz when the number of 
points is 2048 or greater.

Bandwidth2 N/A

 Hi-Res Spiral Protocol Example 
What You Select Selection Notes
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Scanning Range 

FOV 24 Defines the size of the area imaged. Select an FOV that 
covers the anatomy of interest, about 20 to 40 cm. Anatomy 
outside the FOV results in spiral aliasing. As the FOV 
decreases, SNR decreases, spatial resolution increases, 
and image blurring decreases.

Slice Thickness 5 Defines the thickness of the image slice. A slice thickness of 
3 to 5 mm is generally used. As the slice thickness 
decreases, SNR decreases. 

Spacing Enter 0.0 in 
the text box.

Places a zero spacing between the prescribed slice 
locations. Zero spacing or even a negative spacing is 
commonly used. A negative spacing, e.g., -2.5, is allowable, 
up to 50% of the slice thickness. When a negative spacing is 
prescribed, slice-ordering is performed in an interleaved 
fashion to minimize cross-talk. Note that cardiac vessels 
may be more successfully captured with sequential slice 
ordering. 

Start, End Locations Determines the start and end locations from the Graphic Rx 
program after the slices are prescribed and posts the 
locations here. 

# Slices Determines the number of slices as prescribed in Graphic Rx 
and posts it here. Adjust the number of slice locations as 
necessary. 

 Hi-Res Spiral Protocol Example 
What You Select Selection Notes
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Acquisition Timing

Points 4096 Defines the number of data points to be collected for each 
spiral arm. The typical values are 2048 to 4096 points. As 
the number of points increases, spatial resolution increases 
as indicated by the smaller effective resolution. As pixel size 
gets smaller, SNR decreases as indicated by the SNR meter. 
The prescribed number of arms and RBw affect the 
maximum number of points allowed.

Arms 16 Defines the number of spiral trajectories to be performed. 
The typical values are 16 to 24 arms. Increasing the arms 
and the RBw affect the maximum number of arms allowed.

NEX 1 Low NEX values are generally used to maintain ultra-fast 
scan times. As NEX increases, SNR and scan time increase.

Phase FOV N/A

Effective Resolution N/S Calculates the effective resolution by the system and posts it 
here in millimeters. This text box is non-editable. Effective 
resolution is displayed when the FOV, arms, points, and 
RBw are defined.

Auto Center Freq Water Sets this CF peak during prescan.

Flow Comp DIR N/A

Autoshim On Improves image quality and is recommended for this 
sequence.

B0 Maps On Improves image quality and corrects for phase differences 
that result from field inhomogeneities. The use of B0 Maps 
adds to the total scan time, but is recommended.

# of Locs Before Pause 1 Allows for breath-hold acquisitions. If acquiring the slices 
sequentially, use one location per breath-hold.

 Hi-Res Spiral Protocol Example 
What You Select Selection Notes
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 Additional Parameters - Gating/Triggering

Trigger Type Select the best 
lead.

Defines which signal is sent by the cardiac monitor to 
activate the data acquisition. When ECG gating, select the 
lead that provides the best signal. Peripheral gating is not 
recommended.

# of R-R Interval N/A

Arrhythmia Rejec. 
Window

20 Defines the window size, as a percentage of the R-R 
interval, outside of which the system rejects data if a trigger 
is detected. Values around 20% are most commonly used to 
allow reasonable latitude. If the patient’s heart rate is 
irregular, increase this value and the TW, then the time 
available to collect the data will decrease.

Trigger Delay Enter 450 in 
the text box. 

Defines the delay time between the occurrence of the 
triggering pulse and the actual onset of imaging. Values 
between 350 and 450 are most common. In addition to 
manually entering a value, the minimum and recommended 
choices can also be selected. Increasing the TD decreases 
the maximum number of slices allowed.

Inter-Seq Delay Minimum Defines the time between each image in the cardiac cycle. 
Minimum or Even spacing are the choices.

Cardiac Phases N/A

# of Card. Phases to 
Reconstruct

Auto Collects the maximum number of phases available 
automatically. The number of cardiac phases can also be 
entered manually in the text box.

Views per Segment N/A

 Hi-Res Spiral Protocol Example 
What You Select Selection Notes
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Heart Rate [update Rate] Lets the system obtain an automatic reading of the current 
heart rate. Updates the rate prior to beginning the scan.

Accept [Accept] Confirms the selected values and closes the 
Gating/Triggering Additional Parameter screen.

 Additional Parameters - Graphic Rx

[+] Next and [-] Prior [+] and [-] Allows you to page through the localizer images to check the 
position of the prescription. 

Image Viewport Click the image 
to display the 
line cursor.

Prescribes slices for graphic prescription. Select the 
adjustment handles to angle, draw, and remove slices. 
Position the slices to cover anatomy of interest and view the 
Advisory Panel to note the maximum number of slices per 
acquisition and the number of acquisitions you are 
prescribing. The scan time increases as the number of 
acquisitions increase.

Copy Rx [Copy Rx]
(optional)

Copies the exact locations of the prior series if you had 
previously graphically prescribed a series with the same 
plane, FOV, and slice thickness.

Erase All [Erase All]
(If necessary)

Eliminates the graphic prescription from the screen and 
allows you to start over.

Reset Center [Reset Center] 
(If necessary)

Re-establishes the FOV center on a different localized slice.

Accept [Accept] Confirms the cursor position and closes Graphic Rx.

Series Control 
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the series.

Scan Operations
Prep Scan [Prep Scan] Performs Auto Prescan and readies the system for data 

acquisition. Select for breath-hold acquisitions.

Scan [Scan] Initiates the acquisition. Instruct the patient to hold his/her 
breath as long as possible, until the scan stops, if able.

 Hi-Res Spiral Protocol Example 
What You Select Selection Notes
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Prescribe a Real Time Spiral Sequence
The Real Time Spiral sequence is performed using iDrive Pro Plus to obtain 
real time image data with interactive scan plane manipulation. This is useful 
to quickly obtain localizer images and locations for imaging cardiac 
anatomy, as well as, other areas of the body.

The decision matrix (Table 14-6) is only for prescribing a Real Time Spiral 
scan. The following example protocol is for prescribing an oblique short axis 
cardiac scan for a TwinSpeed or an EchoSpeed system. 

Table 14-6 Real Time Spiral Protocol Example (Short Axis Cardiac)

Real Time Spiral Protocol Example 
What You Select Selection Notes

Rx Manager
Rx Manager [New Series] Adds an additional series to the patient’s exam. 

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series if the Patient 
Protocol screen becomes active.

Patient Position

Patient Position Supine Although compatible with any patient position and entry, 
supine and feet first are recommended. This ensures 
accurate cardiac gating/triggering and patient safety by 
ensuring proper routing of gating cables out of the bore, and 
proper routing of the coil cable to its attachment point on the 
dog-house.

Patient Entry Feet First

Coil Phased Array 
> Cardiac

Use a coil that produces the optimum coverage and SNR. 
Up to a four-coil phased array coil is allowed. As the number 
of coils increases, the frame rate decreases.

Series Description Enter a series 
description in 
the text box.

If you do not enter a description, the system enters one for 
you. The series description default is the selected scan 
mode, PSD, and selected imaging options.
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Imaging Parameters

Plane Axial Only orthogonal planes are allowed during series 
prescription. Any plane can be obtained from the Pro Plus 
Acquire tab.

Mode 2D Prescribes a two-dimensional sequence. 2D is the only 
mode allowed. 

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has Twin gradients. 

Pulse Sequence Spiral SPGR Prescribes a Spiral SPGR pulse sequence. Spiral GRE is 
also an allowable selection for Real Time Spiral.

Imaging Options Real Time, 
Spectral 
Spatial RF

Real Time enables Real Time Spiral. SSRF eliminates signal 
from fat. SSRF decreases the frame rate.

PSD Name N/A

Protocol N/A

Real Time Spiral Protocol Example 
What You Select Selection Notes
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Scan Timing

# of echoes N/S One echo is selected automatically.

TE Minimum The only TE selection available is minimum.

TE2 N/A

TR Minimum The minimum TR is recommended to maintain ultra-fast 
scan times. Selections available include minimum, 70, 80, 
90, and 100.

TI N/A

TI2 N/A

Flip Angle 30 The typical flip angle value is between 25° and 30°. Large flip 
angles are likely to result in tissue saturation. 

Echo Train Length N/A

Bandwidth 62.50 As the RBw increases, SNR decreases, spatial resolution 
decreases slightly, and image blurring decreases as a result 
of shorter echo spaces. 62.5 and 125 kHz are allowed.

Bandwidth2 N/A

Real Time Spiral Protocol Example 
What You Select Selection Notes
2333956-100 Rev. 0 (06/02)  14-25
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.0
Scanning Range 

FOV 24 Defines the size of the area imaged. Select an FOV that 
covers the anatomy of interest, about 24 to 32 cm. Anatomy 
outside the FOV may result in spiral aliasing. Small FOVs 
produce increased resolution, decreased SNR, and may 
decrease image blurring. Large FOVs may decrease the 
minimum TR and thus increase frame rate.

Slice Thickness Enter 8.0 in 
the text box. 

Defines the thickness of the image slice. A value of 5 to 
8 mm is typically used. 

Spacing Enter 0.0 in 
the text box. 

A single slice is prescribed for the real time series. Spacing 
can be zero.

Start, End Locations Enter 0.0 in 
the text boxes. 

Prescribes a single slice location prescription explicitly. 
Graphic Rx can also be used to prescribe the slice location.

# Slices 1 Only one slice location is allowed for real time sequences.

Acquisition Timing

Points 1024 Defines the number of data points to be collected for each 
spiral arm. As the number of points increases, spatial 
resolution increases as indicated by the smaller effective 
resolution. As the pixel size gets smaller, the SNR decreases 
as indicated by the SNR meter. FPS decreases. 

Real Time Spiral Protocol Example 
What You Select Selection Notes
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Arms 6 Defines the number of spatial trajectories to be performed. 
Increasing the arms results in increased SNR, increased 
scan time, and increased spatial resolution, but the FPS 
decreases. 

NEX 1 One NEX is generally used to maintain ultra-fast scan times. 
As NEX increases, SNR, and scan time increase.

Phase FOV N/A

Effective Resolution N/S Calculates the resolution and posts it here in millimeters. The 
Effective Resolution is a non-editable text box. Effective 
resolution is displayed when the FOV, arms, points, and 
RBw are defined.

Auto Center Freq Water Sets this CF peak during prescan.

Flow Comp DIR N/A

Autoshim On Improves image quality and is recommended for this 
sequence.

B0 Maps On Improves image quality. With B0 Maps on, the displayed FPS 
is the frame rate when B0 Maps is being performed. The 
actual frame rate is likely to be greater than the displayed 
value.

# of Locs Before Pause N/A

Series Control 
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the series.

Scan Operations
Scan [Scan] Initiates Auto Prescan and the iDrive Acquire tab opens. 

Home images are acquired and at this point, the Acquire tab 
can be used to navigate through the anatomy and alter 
image contrast as needed. Scan planes and slice locations 
can be copied from the iDrive window to a series in the Rx 
Manager.

Real Time Spiral Protocol Example 
What You Select Selection Notes
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Chapter 15

Cardiac Navigator

Introduction
Cardiac Navigator is an optional software package that enables you to perform a 
navigated, free-breathing, coronary artery imaging acquisition. This technique is 
useful in clinical applications with patients who are unable to hold their breath. 
The Cardiac Navigator sequence uses a 3D Enhanced Fast Gradient Echo 
(GRE) pulse sequence with the Navigator imaging option to acquire images.

This chapter explains the Cardiac Navigator imaging option and the method of 
acquiring a coronary artery data set using this acquisition technique. It contains 
the step-by-step instructions to help you learn how to:
• Prescribe a Cardiac Navigator Sequence
• Prescribe Localizer Images with iDrive Pro Plus
• Prescribe the Navigator Tracker
• Monitor the Navigator Pulse

In addition, this chapter answers the following questions:

1. What is Cardiac Navigator?

2. Which pulse sequence can I use with the Cardiac Navigator option?

3. Which options are compatible with Cardiac Navigator?

4. When would I use the Cardiac Navigator option?

5. What are the imaging characteristics of a Cardiac Navigator sequence?

6. What are the applications for Cardiac Navigator sequences?
v. 0 (06/02)  15-1
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What Do I Need to Know 
About...
This section presents the concepts necessary to understand imaging with 
the Cardiac Navigator imaging option. Specifically, you need to understand 
the following concepts:
• Background
• Cardiac Navigator Basics

– Supported Features
• Acquiring Cardiac Navigator Sequences

– Navigator Tracker
– Navigator Monitor Window

• Image Characteristics
• Applications

Background
Magnetic Resonance (MR) Cardiac imaging is challenged by cardiac and 
respiratory motion. The heart executes a complex torquing motion as it 
contracts and expands during the cardiac cycle. Additionally, it moves in all 
three dimensions as the diaphragmatic cage moves up and down during the 
respiratory cycle. The motion results in ghosting and blurring artifacts, 
which pose a substantial challenge in coronary artery visualization and 
subsequent diagnosis. 

With the advent of faster hardware, electrocardiogram (ECG) gating, and 
K-space segmenting, Fast GRE sequences have enabled the division of 
K-space into segments and its acquisition in successive cardiac cycles, 
thereby effectively "freezing" cardiac motion. Typically, these are 
two-dimensional (2D) sequences and are within the realm of 
breath-holding, in order to reduce respiratory motion artifacts.

Coronary artery imaging involves imaging of tortuous vessels with 
diameters ranging from 2 to 4 mm. This imposes an even higher spatial 
resolution limit on the imaging sequences. Three-dimensional (3D) imaging 
sequences are advantageous, as they allow high-resolution data sets that 
permit reformatting of the slices post acquisition. This can help visualize the 
length of tortuous vessels, which may be missed with a conventional 2D 
technique. 3D imaging times, however, are in the order of minutes, which 
rule out breath-holding as a viable option. Early sequences used respiratory 
bellows to track and gate to the motion of the diaphragm. This technique is 
sub-optimal as the abdominal motion is not necessarily representative of 
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the diaphragmatic motion, especially in the instance where someone is a 
"chest breather." The technique of choice is to use navigator echoes to 
directly estimate the position of the right hemi-diaphragm and gate the 
acquisition based on this. A Fast GRE sequence with perpendicularly 
intersecting slab planes is used to excite a column of spins. Fourier 
transform of the resultant echo yields the position of the liver-lung edge, 
enabling prospective gating from the diaphragm position. 

In prospective gating, the current position of the right hemi-diaphragm (as 
collected from the phase of the current navigator echo in relation to a 
tracker reference) is compared against the threshold as deduced from a 
histogram of the diaphragm displacement data over a period of time. If the 
position is within a narrow acceptance window about the threshold, the 
acquired data from the main sequence (3D Fast GRE) following the 
navigator sequence is accepted. The acceptance window size is fixed to an 
optimal value to provide a trade-off between the total scan time and the 
suppression of motion artifacts. Reducing the window size generally results 
in better image quality. However, if the window size is reduced too far, 
image degradation may result, directly as a product of increased scan times 
and changes in the respiratory cycle. Based on the total scan time, it is 
likely the respiratory waveform may undergo a shift in its baseline. If this 
occurs, the scan may not complete in an acceptable time, unless the 
acceptance window is widened and/or the threshold is shifted accordingly. 
The Navigator option allows you to manually adjust the acceptance window 
and/or the threshold value during the scan acquisition.

Cardiac Navigator Basics
The Cardiac Navigator feature is a purchasable imaging option that is 
compatible with the 3D Fast GRE pulse sequence. 

This acquisition method involves acquiring a cardiac gated, 3D Fast GRE 
volume that covers the coronary vessels. Additionally, this volume is 
scanned in conjunction with a navigator pulse that tracks the motion of the 
diaphragm. By placing the navigator tracker pulse over the right 
hemi-diaphragm, the acquisition is synchronized to the end-expiration 
respiratory phase of the patient, thus minimizing respiratory ghosting 
artifacts. 

The navigator acquisition interrogates the position of the right 
hemi-diaphragm at each R-R interval immediately prior to the data 
acquisition segment. If the position of the right hemi-diaphragm is within the 
acceptance window of the end-expiration position, then data acquisition is 
enabled for that R-R interval. Otherwise, the segment repeats until an 
acceptable diaphragm position is found. The respiratory waveform may be 
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viewed during the acquisition to track the patient respiration and monitor 
whether it falls within the acquisition acceptance window and threshold 
level.

This application allows for improved visualization of the coronary arteries, 
through the following capabilities:
• A high SNR yield
• Contiguous slices 
• Reformation of a single slab 
• Can provide higher in-plane spatial resolution of coronary vessels, than 

existing, conventional, 2D breath-hold techniques
• Greater flexibility in capturing the path of the coronary vessel with the 

3D volume of data, allowing an increased tolerance for slice positioning 
inaccuracies

Supported Features
The Navigator option is available only in the cardiac gated mode and is 
compatible with all the features supported by the non-navigator version of 
Fast GRE, except for spatial saturation and the Smart Prep options. In 
addition, it supports the T2 Prep imaging option to suppress the myocardial 
signal, while improving the contrast in the coronary arteries. 

Table 15-1 lists the compatible features supported in the 3D Fast GRE 
pulse sequence with Cardiac Navigator option.

Table 15-1 Fast GRE with Cardiac Navigator Compatibility 

Compatible Not Compatible
Flow Compensation Spatial Saturation

Square Pixels POMP
Cardiac Gating/Triggering Respiratory Compensation

DE Prepared Magnetization Transfer
ZIP x2 and ZIP x4 Tailored RF
ZIP 512 and 1024 Full Echo Train

Variable Bandwidth SmartPrep
No Phase Wrap Multi Station

Extended Dynamic Range Classic
Sequential Respiratory Gating/Triggering
Multi Phase IR Prepared

Cardiac Compensation Blood Suppression
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Acquiring Cardiac Navigator Sequences
You can acquire a Cardiac Navigator sequence by prescribing a 3D Fast 
GRE pulse sequence and selecting the gating and navigator options from 
the Imaging Options window. During graphic prescription of your 3D 
volume, you are required to prescribe your Navigator Tracker over the right 
hemi-diaphragm to synchronize the acquisition to the end-expiration 
respiratory phase of your patient. 

Navigator Tracker
You are able to prescribe the Navigator tracker on a localizer image during 
graphic prescription. The default length of the Navigator tracker is 100 mm 
with a default thickness of 20 mm. The width essentially determines the 
slice thickness (or diameter of the cylindrical pulse) of the excitation. These 
parameters are selectable and you are able to adjust them using the 
graphical objects of the tracker on the localizer image.

The tracker prescription, as shown in Figure 15-1, has two Rotate handles. 
One handle is above the prescription and one is below the prescription. The 
middle cross hair represents the thickness of the tracker and the length is 
represented by the size of the line.

T2 Prep Real Time
Fractional echo Spectral Spatial RF
Fractional NEX Fat/Water Suppression

PFOV (0.5, 0.6, 0.7, 0.8, 0.9)
SPECIAL

Double Oblique Scan Planes
Reverse Loop Order

Compatible Not Compatible
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Figure 15-1 Tracker Graphic Objects

Use the Rotate handles to turn the tracker prescription to angle over the 
right hemi-diaphragm. You can move the location of the tracker prescription 
by clicking the prescription and dragging it. Figure 15-2 displays an 
example of the Navigator tracker prescribed on a sagittal localizer. 

Figure 15-2 Navigator Tracker Prescription

The length of the tracker prescription can be adjusted by entering a value in 
the Tracker Length (mm) text box in millimeters or by selecting the value 
from the drop down list provided. You can also change the thickness of the 
tracker prescription by entering a value or selecting the value from the drop 
down list in the Tracker Thickness (mm) text box. 

Navigator Monitor Window
The Navigator Monitor window (Figure 15-3) opens when the navigator 
sequence starts scanning. This window remains open for the entire scan. 
You can close it by clicking the [Done] button and then re-open it by clicking 
the [Navigator] button at the bottom of the Scan Operations area. A 
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baseline is acquired first so the system has an idea of how the patient’s 
diaphragm is moving with respiration, represented as a graphed sinusoidal 
wave.

Figure 15-3 Navigator Monitor Window with Established Baseline

Table 15-2 provides the Navigator Monitor window selections and their 
descriptions.

Table 15-2 Navigator Monitor Window Functions

Selection Description

Status Displays information about the current status of the 
monitor function in progress.

Current 
Displacement

Displays the respiratory phase in millimeters. This is 
calculated after the initial prescan and is updated if you 
change it.

Threshold
Allows you to change the threshold in steps of 1 mm. 
The step size is absolute, so if the Navigator autoscales, 
the perceived displacement of the threshold bar is 
smaller.
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The Status area of the Navigator Monitor window provides four specific 
pieces of information at various times throughout the scan.
• The first status message indicates a baseline acquisition is in progress.
• The second status message (which appears only momentarily) 

indicates the threshold is being calculated as the histogram analysis is 
being carried out.

• The third indicates the displacement of the acquired Navigator pulse 
from the reference.

• The final message indicates the total scan time in xx:xx mins format.

The system determines the total scan acquisition time by using the 
calculation shown in Equation 15-1. This initially projected time posts in the 
scan time countdown area.

Equation 15-1 Navigator Scan Time

Scan Time = (# Phase Encodes + # Overscans) x  

Acceptance 
Window 

Allows you to change the acceptance window in real 
time. It defaults to ±2 mm. The minimum step size is 
±0.5 mm and the maximum is ±10 mm. This allows for 
any drifts in the baseline of the respiratory cycle during 
the scan acquisition and/or the flexibility to increase or 
decrease the total scan time.

Efficiency % 

Indicates how often the detected triggers are used for 
data acquisition. Higher efficiency means you are 
making good use of all the detected triggers and scan 
time is improved, but it is not necessarily an indicator of 
image quality. This depends on your acceptance window 
and where the data is being acquired (in respect to the 
respiratory cycle).

Tracker 
Position

Re-scales the display to accommodate for major 
changes in a patient's breathing, i.e., the patient’s 
breathing began labored and shallow, but now the 
patient has relaxed and breathing has slowed. 
Sometimes setting the threshold does not compensate 
for this and re-scaling the display helps you set the 
proper threshold and acceptance window. 

Total No. of 
Views

Indicates the number of views needed to complete the 
data acquisition.

[Done] Closes the Navigator Monitor window.

Selection Description (Continued)
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The waveform you observe is an indicator of the movement of the 
diaphragm, which is affected by respiration. The numbers on the sinusoidal 
wave graph show the displacement as detected by the tracker in millimeters 
(Figure 15-4). This graphical representation of the Current Displacement 
value also provides you with a history of displacement, not only the current 
value. 

This area also illustrates the threshold level, acceptance window, and 
triggers. The threshold (red line) allows you to set the center point of the 
acceptance window. The threshold is most commonly set at the level of 
expiration when the diaphragm is at the most quiescent point. This, along 
with the acceptance window, defines when cardiac triggers are accepted 
and data acquisition takes place. The size of the acceptance window 
(yellow lines) affects how far on either side of the threshold image data is 
accepted when triggers are detected. The blue points on the waveform 
indicate where triggers were "seen" and the triggers are only displayed if 
they fall in the acceptance window. 

Figure 15-4 Navigator Monitor Window with Displacement

The line indicating the threshold and the acceptance window updates with 
each new phase point. The adjustments you make to the threshold value or 
gating acceptance window are changed dynamically. Widening the 
acceptance window accepts more triggers, but at the expense of a 
decrease in image quality (data contains more variance in patient motion). 
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Efficiency is increased as the window is widened. Increasing the threshold 
should not affect image quality; it only affects where the data is acquired in 
the respiratory cycle. 

There is a real time counter provided on the Navigator Monitor window to 
indicate the efficiency of the scan. This counter provides information on the 
number of views that have been accepted or rejected for the current view. It 
also provides the efficiency as a percentage using Equation 15-2.

Equation 15-2 Efficiency Equation

% Efficiency = (Accepted views)/(Accepted + Rejected views)

Once the acquisition is completed, the total scan time and the total number 
of views acquired display in the Status area. The total time for the navigator 
phase calculation (including sequence play out, data processing, phase 
computation, and communication time) is 50 ms. This ensures the 
respiratory position has not changed significantly at the end of the actual 
scan data collection (in the order of approximately 100 ms for Fast GRE 
sequence) which follows the navigator echo sequence.

When a new series is prescribed while the current series (with navigator 
option) is in progress, the navigator window remains in its current state. You 
are able to close the window by clicking the [Done] button, allowing the new 
prescription to be entered. If you close the Navigator Monitor window, the 
[Navigator] button is ready for re-opening on the Scan Operations area as 
long the active scan is in progress.

Image Characteristics
A 3D Fast GRE Navigator image (Figure 15-5) demonstrates suppression 
of the myocardium and improved contrast for the coronary arteries during 
free-breathing of your patient. The T2 Prep imaging option and SPECIAL fat 
suppression option have been used when acquiring this Navigator image to 
visualize the coronary arteries.
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Figure 15-5 3D Fast GRE Navigator Image

The images obtained with the navigator feature are labeled with the "/NAV" 
tag appended to the Imaging Options line on the image, as well as on the 
text page Imaging Options line. 

Applications
Navigator provides better imaging methods for evaluating the coronary 
arteries. It is useful to acquire free-breathing, coronary artery images in 
those patients who are unable to hold their breath. 

WARNING:The system cardiac gating waveforms are not to be used for 
physiologic monitoring. The patient's condition may not be 
reflected, resulting in improper emergency medical 
treatment.
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How Do I...
This section provides the step-by-step instructions for imaging with the 
Navigator imaging technique. Specifically, it describes how to:
• Prescribe a Cardiac Navigator Sequence
• Prescribe Localizer Images with iDrive Pro Plus
• Prescribe the Navigator Tracker
• Monitor the Navigator Pulse

Decision Matrix
A decision matrix is used in this section to provide examples of what values 
could be selected for prescribing a particular sequence. The purpose of the 
decision matrix is to help you understand the trade-offs that occur when you 
change the values for a particular parameter and to provide a framework 
with which you may build your own unique protocol.

The example protocols provide information on what could be used for these 
pulse sequences and are not to be considered recommendations by GE 
Medical Systems. For specific protocols, refer to the protocols on your 
system.

In addition to listing the information you need to select on the system, the 
“What You Select” column of the matrix uses two other conventions.
• N/A indicates the imaging parameter is not applicable to the pulse 

sequence example.
• N/S indicates the imaging parameter is not selectable in the pulse 

sequence example. The system automatically selects these imaging 
parameters.

CAUTION: Provide all patients with ear protection prior to any scan to 
help avoid possible hearing impairment. Acoustic noise 
levels can exceed 99 dbA in the magnet bore.
15-12  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Cardiac Navigator
Prescribe a Cardiac Navigator Sequence
The Cardiac Navigator sequence is useful in clinical applications to obtain 
free-breathing coronary artery images, particularly in those patients who are 
unable to hold their breath. This technique uses a 3D Fast GRE pulse 
sequence with the Cardiac Navigator imaging option to acquire the images. 
T2 Prep is recommended to allow suppression of the muscle and venous 
structures, while improving visualization of the coronary arteries.

The decision matrix (Table 15-3) is only for prescribing a Cardiac Navigator 
sequence. The following example protocol is for prescribing an oblique 3D 
Fast GRE Navigator scan. 

Table 15-3 Cardiac Navigator Protocol Example 

Cardiac Navigator Protocol Example 
What You Select Selection Notes

Scan Rx Desktop
Scan Rx Acquire a 

localizer series
Allows Graphic Rx to become available so you can prescribe 
slices graphically on the localized image. A coronal image 
from which the lung-liver edge can be visualized is generally 
the localizer used to prescribe the Navigator tracker. Ensure 
the image is also appropriate to prescribe the 3D volume 
over the anatomy of interest. 

Rx Manager [New Series] Adds an additional series to the patient’s exam. 

Patient Protocol [Patient 
Position]

Allows you to begin prescribing your new series when the 
Patient Protocol window becomes active.

Patient Position

Patient Position Supine Indicates the orientation of the patient. Although compatible 
with any patient position and entry, supine and feet first are 
recommended. This ensures accurate cardiac 
gating/triggering and patient safety by proper routing of 
gating cables out of the bore, and proper routing of the coil 
cable to its attachment point on the trolley.

Patient Entry Feet First
2333956-100 Rev. 0 (06/02)  15-13
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Coil Phased Array 
> Cardiac

Allows selection of the coil from which the signal is 
transmitted and received. Use a coil that produces the 
optimum coverage and SNR.

Series Enter a series 
description in 
the text box.

Allows you to enter a brief description of the series being 
prescribed. If you do not enter a description, the system 
enters one for you. The series description default is the 
selected scan mode, PSD, and selected imaging options.

Imaging Parameters

Plane Oblique Defines the scan plane of the acquisition. Compatible with 
any scan plane. Select the plane that best meets your 
clinical need. For cardiac Navigator imaging, select oblique 
for proper angle through the anatomy.

Mode 3D Prescribes a three-dimensional sequence. 3D must be 
selected for 3D Cardiac Navigator sequences. The 3D option 
may only be selected if a valid localizer scan exists for the 
current patient.

Pulse Seq. Fast GRE Prescribes the Fast GRE pulse sequence. Only the Fast 
GRE pulse sequence can be used with the Cardiac 
Navigator option.

Grad Mode Zoom Activates the gradient mode of operation. This text box is 
only available if your system has TwinSpeed™ gradients.

Imaging Options Cardiac/ 
Gating 
Triggering, 
Variable 
Bandwidth, 
ZIPx2, ZIP512, 
T2 Prep, and 
Navigator.
RealTime

Provides appropriate options for enhancing anatomical 
features and reducing noise. Cardiac Gating/Triggering 
should be selected to enable ECG gating and allows the 
Navigator selection to become available. VBw is used to 
obtain high bandwidths which results in decreased TE and 
TR values. The ZIP x2 option gives you higher interpolated 
slice resolution and ZIP 512 enhances your apparent 
resolution. Use T2 Prep to suppress the myocardium and 
increase contrast in the coronary arteries.
Select RealTime if your system operates with iDrive Pro Plus 
so you can acquire the localizers in iDrive.

PSD Name N/A

Protocol N/A

Cardiac Navigator Protocol Example  (Continued)
What You Select Selection Notes
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Additional Parameters - SAT

3-Plane SAT Fat Enables the SPECIAL fat suppression technique. SPECIAL 
cannot be used if IR Prepared is selected at the Imaging 
Options window.

Scan Timing

# of echoes N/S One echo is selected automatically.

TE Minimum Typically, a Minimum TE is used to obtain low TR values for 
maintaining short scan times. Minimum Full is recommended 
with 0.5 NEX.

TE2 N/A

TR N/S The minimum TR is selected automatically. The minimum TR 
is posted in the Min. column to the right of the TR text box. 
The minimum TR may decrease as RBw is increased and as 
the Frequency matrix decreases.

Prep Time Auto The system allows automatic selection of the Prep Time 
when SPECIAL is turned on.

TI2 N/A

Cardiac Navigator Protocol Example  (Continued)
What You Select Selection Notes
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Flip Angle Enter 20 in the 
text box.

The typical flip angle values are 15° or 20°. The use of 
higher flip angles in cardiac imaging increases the saturation 
of the myocardium.

Echo Train Length N/A

Bandwidth 31.25 The typical RBw value is 31.25 kHz. As the bandwidth 
increases, minimum TR and TE values may decrease. 

Bandwidth2 N/A

Scanning Range 

FOV Enter 28 in the 
text box. 

Defines the size of the area imaged. The FOV is generally 
set as small as possible to obtain the acceptable resolution 
and SNR without causing aliasing from outside the FOV into 
the anatomy of interest. Typical values are 20 to 32 cm.

Slice Thickness 3.0 Defines the thickness of the image slice. With the ZIPx2 
option on, interpolated slice thickness becomes 1.5 mm.

Scan Locs 12 Defines the number of scan locations per 3D slab. Typically, 
the maximum should not exceed 20 and the minimum should 
not exceed 8.

Start, End Locations Determines the start and end locations from the Graphic Rx 
program after the slab is prescribed and posts the locations 
here. 

# Slabs 1 Determines the number of slabs as prescribed in Graphic Rx 
and posts it here. The number of slabs cannot be greater 
than one.

Cardiac Navigator Protocol Example  (Continued)
What You Select Selection Notes
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Acquisition Timing

Freq 384 Controls resolution. Increasing the frequency matrix 
decreases SNR and the number of slice locations allowed, 
while increasing resolution. 

Phase 160 Controls scan time and resolution. The phase matrix cannot 
exceed the frequency matrix. 

NEX 1 One NEX is generally used to maintain acceptable scan 
times. 

Phase FOV 0.8 Shortens scan time by scaling down the FOV in the phase 
direction by either 0.5, 0.6, 0.7, 0.8, or 0.9. Reduces the 
phase matrix and thus decreases scan time, decreases the 
FOV in the phase direction, and decreases SNR slightly. The 
phase FOV dimension is displayed next to the phase FOV 
factor. 

Freq DIR Unswap Displays the default frequency direction, which is typically 
the long axis of the image. Leave the frequency direction 
unswapped.

Auto Center Freq Water Sets the peak center frequency on the water peak of the 
patient during prescan.

Flow Comp DIR N/A

Autoshim On Improves image quality and is recommended for this 
sequence.

Phase Correct N/A

Contrast On Enter a value of 0 for the contrast amount. This value turns 
on the required reconstruction algorithm for navigator. Leave 
the Agent text box blank.

# of Locs Before Pause N/A

Cardiac Navigator Protocol Example  (Continued)
What You Select Selection Notes
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Gating Control

ECG Noise Filter On Designed to improve gating detection at the expense of a 
time delay from when the QRS complex is generated to 
when Signa detects it. The default position is on, leave ECG 
Noise Filter in the on state.

Advanced ECG Gating On Designed to improve trigger detection in ECG Gated scans 
by detecting which component of the QRS complex is the 
correct trigger. The default position is on, leave Advance 
ECG Gating in the on state. 

Lead Display ECG-II Test all leads and select the lead that produces the highest 
R-peak Amplitude, which should be at least 1.0 mV. If the 
mV is less than 1.0, repeat the preparation procedure and 
reposition the electrodes.

Cardiac Trigger Level Auto Auto trigger is the default and sets the ECG trigger level to 
65% (the range is 30-90%). Reduce the trigger level to 50% 
if the trace is good but triggers are missing.

Gating Reset [Gating Reset] Click to re-initialize the gating subsystem if:
- The waveform is noisy.
- Triggers are being missed.
- The waveform is inverted.
- The system is unable to find valid triggers due to patient 
activity such as sudden motion.

Accept [Accept] Confirms the selected values and closes the Gating Control 
window.

Cardiac Navigator Protocol Example  (Continued)
What You Select Selection Notes
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 Additional Parameters - Gating/Triggering 

Trigger Type Select the best 
lead.

Defines which signal is sent by the cardiac monitor to 
activate the data acquisition. When ECG gating, select the 
lead that provides the best signal.

# of R-R Interval N/A

Trigger Window 20 Defines the period of time where no data is acquired and the 
system is waiting for the next R-wave trigger. Values of 10 to 
20 are commonly used. Use larger values for patients with 
irregular heart rates.

Trigger Delay 350 Defines the delay time between the occurrence of the 
triggering pulse and the actual onset of imaging. 
Recommend imaging is at diastole, as this is when the heart 
is the quietest and when coronary flow is maximized. The 
diastolic value is heart rate dependent. Heart rate ranges 
from 60 to 85 BPM usually have delay times around 350. 
The lower the heart rate, the higher the trigger delay time.

Inter-Seq Delay N/A

Cardiac Phases N/A

# of Card. Phases to 
Reconstruct

N/A

Views per Segment N/A

Heart Rate [update Rate] Lets the system obtain an automatic reading of the current 
heart rate. Updates the rate prior to beginning the scan.

Accept [Accept] Confirms the selected values and closes Gating/Triggering 
Additional Parameter screen.

Cardiac Navigator Protocol Example  (Continued)
What You Select Selection Notes
2333956-100 Rev. 0 (06/02)  15-19
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
 Additional Parameters - User CVs 

Turbo Mode Enter 0.00 in 
the text box.

Disables Turbo mode.

Reverse Loop Order Enter 0.00 in 
the text box.

Disables Reverse Loop Order. Turning Reverse Loop Order 
off, acquires one phase encoding line for each slice, every 
heartbeat. This is the desired method of acquisition.

Accept [Accept] Confirms the selected values and closes the User CVs 
Additional Parameter screen.

Additional Parameters - Graphic Rx

iDrive Pro Plus Refer to the procedure “Prescribe localizer images with 
iDrive Pro Plus,” if your system operates with iDrive Pro 
Plus.

[+] Next and [-] Prior [+] and [-] Allows you to page through the localizer images to check the 
position of the prescription. 

Cardiac Navigator Protocol Example  (Continued)
What You Select Selection Notes
15-20  2333956-100 Rev. 0 (06/02)
© 2002 General Electric Company. All rights reserved.



Cardiac Navigator
Image Viewport Press the Shift 
key and click 
the image to 
display the 3D 
volume.

Allows you to prescribe 3D slab over the anatomy of interest. 
Select the adjustment handles to angle the slab. 

Copy Rx [Copy Rx]
(optional)

Copies the exact locations of the prior series if you had 
previously graphically prescribed a series with the same 
plane, FOV, and slice thickness.

Erase All [Erase All]
(If necessary)

Eliminates the graphic prescription from the screen and 
allows you to start over.

Reset Center [Reset Center]
(if necessary)

Re-establishes the FOV center on a different localized slice.

Tracker Rx [Tracker] Allows you to place the Navigator Tracker on the image. 
Refer to the procedure “Prescribe the Navigator Tracker.”

Accept [Accept] Confirms the cursor position and closes Graphic Rx.

Series Control 
Save Series [Save Series] Closes the scan prescription screen, accepts the 

prescription, and saves it in the Rx Manager as RXD.

Rx Manager
Prepare to Scan [Prepare to 

Scan]
Downloads the series.

Scan Operations
Prep Scan [Prep Scan] Performs Auto Prescan and readies the system for data 

acquisition. Select for breath-hold acquisitions. 

Scan [Scan] Initiates the acquisition. 

Cardiac Navigator Protocol Example  (Continued)
What You Select Selection Notes
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Prescribe Localizer Images with 
iDrive Pro Plus
These instructions only apply if your system operates with 
iDrive Pro Plus. Use iDrive Pro Plus to acquire two sets of 
localizer images: one set of localizer images from which to 
position the tracker pulse and another set from which to 
prescribe the 3D volume.

1. Click [Scan] to initiate iDrive Pro Plus.

2. Change the slice thickness from 16 to 8.

This improves image resolution.

3. Select the coronal reference image.

4. Click [Define Scout].

5. Click [Draw Line].
Position the vertical line cursor over the right diaphragm.

6. Click [Save Image] when the diaphragm is in the most 
superior location (expiration).

Acquire several sagittal images for tracker pulse 
positioning.

7. Click [Draw Line] to turn the line tool off.

8. Select the coronal reference image.

9. Click [Step] and position the cursor so that the arrow is 
pointing either towards or away from you.

The arrow direction indicates the direction you are going 
to step the Realtime image. You want to step the image 
towards the heart.

10. Click the left mouse button until you see a good heart 
image.

11. Click [Save Image].
Acquire several coronal images for positioning the 3D 
volume.

Quick Steps: Prescribe 
Localizer Images with 
iDrive Pro Plus
1. Click [Scan] to initiate 

iDrive Pro Plus.

2. Change the slice 
thickness from 16 to 8.

3. Select the coronal 
reference image.

4. Click [Define Scout].
5. Click [Draw Line].
6. Click [Save Image] when 

the diaphragm is in the 
most superior location 
(expiration).

7. Click [Draw Line] to turn 
the line tool off.

8. Select the coronal 
reference image.

9. Click [Step] and position 
the cursor so that the 
arrow is pointing either 
towards or away from 
you.

10. Click the left mouse 
button until you see a 
good heart image.

11. Click [Save Image].
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Prescribe the Navigator Tracker
The Navigator Tracker synchronizes the acquisition to the 
end-expiration respiratory phase of your patient, thus 
minimizing respiratory ghosting artifacts. During scan 
prescription, you enable the navigator pulse by selecting the 
Navigator option on the Imaging Options window. The Graphic 
Rx Additional Parameter gives you access to the Tracker Rx 
screen, allowing you to prescribe the Navigator Tracker. 

Use the following procedure to prescribe the Navigator Tracker 
from the 3-Plane GRx window.

1. Display an image on which the liver-lung edge can be 
visualized.

Use the [+] Next and [-] Prior buttons to page through 
the localizer images.

2. Deposit the Navigator Tracker on the image.

a) Click [Tracker] to open the tracker graphic controls.

b) Position the cursor over the desired anatomy.

c) Press the Shift key and click to deposit the Navigator 
Tracker on the image.

3. Place the center tic-mark of the tracker line at the liver-lung 
edge of the right lobe.

The tracker line should be as lateral as possible. 

– If placed too close to midline, the tracker pulses may 
interfere with the anatomy of interest (if performing 
cardiac imaging), causing artifacts.

Tracker Positioning on Right Hemi-diaphragm

4. Enter 70 in the Tracker Length text box.

The tracker length should not overlay the 3D volume.

Quick Steps: Prescribe the 
Navigator Tracker
1. Display an image on 

which the liver-lung edge 
can be visualized.

2. Deposit the Navigator 
Tracker on the image.

3. Place the center tic-mark 
of the tracker line at the 
liver-lung edge of the right 
lobe.

4. Enter 70 in the Tracker 
Length text box.

5. Enter 12 in the Tracker 
Thickness text box.

6. Adjust the position of the 
Navigator Tracker.

7. Click [Accept] to close 
the Tracker Rx window.
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5. Enter 12 in the Tracker Thickness text box.

The tracker width should not overlay the 3D volume. 

Be cautious with the tracker size. Only one tracker pulse 
is seen on your image. Two tracker gradient pulses are 
applied with the Navigator sequence. You can think of 
the second pulse being applied at a 45° angle to the 
tracker line you have deposited. 

6. Adjust the position of the Navigator Tracker.

Move or angle the tracker using the handles.

7. Click [Accept] to close the Tracker Rx window.

8. Click [Accept] to close the 3-Plane GRx window and accept 
the prescription.
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Monitor the Navigator Pulse
When you begin the Navigator acquisition, the Navigator 
Monitor window opens on the Scan Rx Desktop. Your MR 
system determines and displays a baseline respiratory cycle. 
The status area of the Navigator Monitor window indicates the 
baseline is being acquired. As the status of the scan changes, 
the status area updates to reflect the current status of the scan.

Use the following procedure to monitor and adjust the Navigator 
pulse during data acquisition to accommodate for drifts in your 
patient’s respiratory cycle.

1. View the baseline respiratory waveform and phase 
displacement of the Navigator Tracker.

The threshold and acceptance window are graphically 
marked on the monitor window.

Navigator Monitor with Baseline Display

Navigator Monitor with Displacement Display

Quick Steps: Monitor the 
Navigator Pulse
1. View the baseline 

respiratory waveform and 
phase displacement of 
the Navigator Tracker.

2. Adjust the displacement 
of the Navigator Tracker, 
if necessary.

3. Click [Done] to close the 
Navigator Monitor 
window.
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2. Adjust the displacement of the Navigator Tracker, if 
necessary.

a) Enter a value in the Threshold text box.

– This shifts the threshold displacement according to 
the value.

– Alternatively, click the arrows to change the threshold 
value in ±1 mm increments.

b) Enter a value in the Acceptance Window text box. 

– This widens or narrows the acceptance window 
according to the value. 

– Increasing the acceptance at this point improves data 
acquisition time. 

– Alternatively, click the arrows to change the threshold 
value in ±2 mm increments.

3. Click [Done] to close the Navigator Monitor window.

The window can be re-opened at any time by clicking 
[Navigator] in the Scan Operations area of the Scan Rx 
Desktop.
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Chapter 16

Bolus Chasing

Introduction
Bolus Chasing is a technique used in imaging a bolus of contrast as it travels 
through the vessels. It is usually performed in conjunction with a bolus triggering 
technique.

This chapter explains the automated multi station technique for contrast 
enhanced peripheral vascular angiography. It contains the step-by-step 
instructions to help you learn how to:
• Prepare the Patient
• Scan the Localizer Series
• Set up the Scan Parameters
• Set up the Graphic Parameters
• Scan the SmartStep Series
• Copy and Paste a SmartStep Series
• Scan using the GE Saved SmartStep Protocol

In addition, this chapter answers the following questions:

1. What is SmartStep used for?

2. What is a meta-series?

3. How does elliptic-centric k-space filling affect image contrast?

4. What is Turbo mode?

5. Why would I want to use a mask series?

6. How do I prescribe a mask series?
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What Do I Need to Know 
About...
This section presents the concepts necessary to successfully complete the 
SmartStep process. Specifically, you need to understand:
• SmartStep Basics
• Contrast Mechanism
• SmartStep User Control Variables

– Meta-Series
– Image Acquisition Delay
– Turbo Mode
– SPECtral Inversion At Lipids (SPECIAL)
– K-space
– Acquisition Type

SmartStep Basics
SmartStep (Multi Station) is an optional feature that provides automatic 
table movement and switching of prescribed coils between stations, 
including body to phased array, and/or between phased array elements. 
SmartStep is used with 3D Fast Time Of Flight Gradient Echo (TOF 
GRE)/SPoiled Gradient Echo (TOF SPGR), and 3D Fast GRE/SPGR pulse 
sequences.

Contrast Mechanism
SmartStep is used to chase a bolus of contrast down the lower extremities. 
In contrast-enhanced Magnetic Resonance Angiography (CEMRA), the 
mechanism used is the T1 shortening effect of gadolinium and not flow 
enhancement. Gadolinium shortens the T1 of blood from 1200 ms to 
approximately 100 ms. Consequently, slice locations can be prescribed so 
the vessels run in plane and not through plane. In Figure 16-1, images are 
displayed of both flow and contrast enhancements.
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Figure 16-1 Flow vs. Contrast Enhanced Images

SmartStep User Control Variables
There are several User Control Variables (User CVs) located on the User 
CVs Screen. The number of options is dependent on several factors 
including gradient configuration, selected Imaging Options, and whether the 
prescription is for the first or subsequent stations. Figure 16-2 and Figure 
16-3 display the User CV options available with the SmartPrep feature prior 
to selection of number of stations. Figure 16-4 displays the User CV options 
for the second and subsequent stations.

Contrast EnhancementFlow Enhancement
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Figure 16-2 SmartStep User CVs Screen (Page 1)

Figure 16-3 SmartPrep User CVs Screen (Page 2)
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Figure 16-4 User CV Window (second and subsequent stations)

Meta-Series
A meta-series consists of multiple series linked together. You can link up to 
four series together at one time. By doing so, the scanner automatically 
moves the table after each series to the next pre-determined point, as well 
as switches on and off the appropriate coils, you selected at the time of set 
up. 

The Multi Station Imaging Option must be selected for the system to 
automatically create a Meta-series, once the first series is saved. You can 
then edit the changes you want made to the parameters.

If your site uses a protocol with a different number of stations, save one 
protocol for each scenario. For example, save one protocol for a three 
station SmartStep and save another protocol for a four station SmartStep. 
Once a protocol is saved with the Multi Station Imaging Option and a set 
number of stations selected, the number of stations value cannot be 
changed.

NOTE: The Multi Station Imaging Option cannot be turned off after it has 
been saved in a series. Therefore, if you try to turn it off after 
performing a copy/paste or after loading a protocol that has it on, an 
error message appears.
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You have the ability to select scan parameters unique for each station, with 
the exception of Plane, Scan Mode, and Pulse Sequence. Figure 16-5 
displays an example of a three station meta-series. Table 16-1 provides the 
descriptions of areas pointed out in Figure 16-5.

Figure 16-5 Rx Manager of Three Station Meta-series

Table 16-1 Descriptions of Figure 16-5 Components

Numbers Description

1

This area displays the state of the meta-series.
• NEW represents the series has just been created; nothing 

has been done to it yet.
• INRX represents the series is currently in the view/edit 

mode.
• RXD represents the series has been prescribed.
• ACT represents the series is in an active state and has 

been downloaded.
• PSCD represents the series has been prescanned.
• SCND represents the series has been scanned.

2

This area displays the series number. Figure 16-5 displays a 
1 in this column, which signifies the first series for this exam.

NOTE: The series number is displayed for each station of the 
meta-series.

1

4
3
2
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Image Acquisition Delay
Image Acquisition Delay is an option that allows you to enter a scan pause 
time before the start of your acquisition. The maximum delay time is 100 
seconds; it is entered on the User CVs Screen. The delay period begins 
after the [AutoStep] button is clicked. This delay applies only to the first 
station of the mask, arterial, and venous phases. The monitor and the 
magnet enclosure displays and counts down the delay time you entered. 
After the delay time reaches zero, your system displays the acquisition time 
and the system begins to scan.

Turbo Mode
Turbo mode is available on HiSpeed™ Plus, EchoSpeed™, and 
TwinSpeed™ systems as a User CV for Fast TOF and Fast GRE/SPGR 
pulse sequences. It reduces the width of the RF pulse and allows shorter 
TR periods, thus shorter total scan times. This option performs in two 
modes: faster and fastest. Table 16-2 lists the required text entries for the 
available modes and the changes in the RF time with each selection.

Table 16-2 Turbo Mode User CV

3

This area represents the acquisition type and the station 
number.

• “M” represents Mask Phase
• “A” represents Arterial Phase
• “V” represents Venous Phase
The number after the phase distinction represents the station 
(meta-series) number.

4

This area represents the series description. It displays a 
shortened version of the series description you entered in 
the Patient Position area. If nothing has been entered for the 
series description, the system automatically enters one for 
you. It includes the coil type and the scanning plane. An 
example of this is shown in Figure 16-5.

NOTE: You can change the series description for each station 
once you are in view/edit mode for that station.

Turbo Mode 
Text Box Entry  Mode RF Duration

0 Turbo Mode off 1.6 ms
1 Turbo Mode on Faster 0.8 ms
2 Turbo Mode on Fastest 0.6 ms

Numbers Description (Continued)
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SPECIAL
SPECIAL is Spectral Inversion at Lipids is a fat suppression technique that 
uses a 180° inversion pulse to nullify the signal from fat. This option is not 
compatible with Elliptic-centric or Reverse Elliptic-centric k-space filling. 
SPECIAL is turned on when Fat SAT is selected from the Saturation 
window. Selection of SPECIAL results in a Prep Time display on the Scan 
Timing screen.

NOTE: Refer to the Imaging Options chapter for additional information on 
the SPECIAL feature.

K-Space Filling
When using SmartStep, there are several ways to fill k-space. The options 
in Table 16-2 can be found on the User CVs screen.

Table 16-3 K-Space Filling Options

In addition, these methods of k-space filling are no longer linked to 
SmartStep or SmartPrep. Centric and Elliptic-centric can be used with any 
Fast GRE or Fast SPGR scan prescription.

Acquisition Type
There are three acquisition types that can be used with SmartStep.
• Mask Acquisition
• Arterial Acquisition
• Venous Acquisition

Mask Acquisition scans the prescribed stations prior to administration of 
contrast. Arterial Acquisition scans all prescribed stations for contrast in the 
arterial phase. Venous Acquisition scans all prescribed stations for contrast 
in the venous phase. You can use all three acquisition types within the 
same examination series. The Acquisition type is displayed in the Rx 
Manager, located on the Scan Desktop. Figure 16-5 displays an example of 
an Arterial Acquisition. Enter a 1 in the Mask and/or Venous text boxes to 
turn this feature on. Enter a 0 in the Mask and/or Venous text boxes to turn 
this feature off.

K-Space Filling Options Fills K-Space How...
Reverse Elliptical-centric Fills outer lines and outer slices first.

Elliptical-centric Fills the center lines and center slices first.

Centric Fills the center lines first.

Reverse Centric Fills the outer lines first.
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NOTE: The mask and venous series will not appear in the Rx Manager until 
after the prescan has been completed for the meta-series. The Rx 
Manager automatically updates and posts all acquisition types you 
selected from the User CVs Screen.

The acquisition order of the meta-series has changed from previous 
software versions. Refer to Table 16-4 for the order of acquiring each type 
of meta-series using SmartStep.

Table 16-4 Meta-Series Acquisition Order

Real-Time SAT
The Real-time SAT User CV appears only if Fluoro Trigger is selected from 
the Imaging Options window. It is not available on systems that have iDrive 
Pro.

Real-time SAT applies saturation pulses when Real-time is open. When 
selected, it improves the contrast between the bolus and the surrounding 
tissue. 
• Select 0 when the plane you are viewing in Real-time is either a sagittal 

or coronal. 
• Select 1 when the plane you are viewing in Real-time is an axial plane. 

The saturation pulses are placed outside the slice and move with the 
slices as you traverse through the anatomy.

Meta-Series Order of Scan
Prescan Bottom, middle, top

Mask Top, middle, bottom

Arterial Top, middle, bottom

Venous Bottom, middle, top
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How Do I...
This section provides the step-by-step instructions for bolus chasing using 
SmartStep. Specifically, it describes how to:
• Prepare the Patient
• Scan the Localizer Series
• Set up the Scan Parameters 
• Set up the Graphic Parameters
• Scan the SmartStep Series
• Copy and Paste a SmartStep Series
• Scan using the GE Saved SmartStep Protocol

NOTE: The first five sets of steps must be followed in the order provided 
above to successfully perform a SmartStep examination.
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IPrepare the Patient
Use this procedure to perform a scan with SmartStep. With 
SmartStep, the system automatically advances the table and 
starts the next prescribed series. 

You should already know how to setup a protocol for your 
system; only a brief review is provided. The rest of the 
procedure guides you through the SmartStep scanning process.

NOTE: It is suggested you use SmartPrep or FT MRA, if you 
have it on your system. This takes the guesswork out of 
bolus timing.

Refer to Working Safely chapter in Volume 1 for important 
information regarding patient safety.

1. Select the appropriate coil.

Refer to the Gradient, Shim, and Imaging Coils chapter 
in Volume 1 for suggested coil positioning.

It is recommended you use the Peripheral Vascular (PV) 
coil for a bolus chasing examination, although the body 
coil can also be used.

2. Position the patient feet first.

This ensures the patient’s head is close to the magnet 
entrance, making it easier to give breathing instructions.

3. Elevate the patient’s legs with sponges.

This step is not needed, if using the peripheral vascular 
coil.

This places your patient’s legs parallel to the table.

4. Place Respiratory Bellows on the patient (optional).

This is helpful in detecting when and how long your 
patient is suspending respirations during breath holding 
techniques.

Refer to the Gating and Triggering chapter in Volume 3 
for correct placement techniques.

5. As directed by your physician, set up the patient IV catheter.

Follow your physician’s or facility’s guidelines.

Quick Steps: Prepare the 
Patient
1. Select the appropriate coil.

2. Position the patient feet 
first.

3. Elevate the patient’s legs 
with sponges.

4. Place Respiratory Bellows 
on the patient (optional).

5. As directed by your 
physician, set up the 
patient IV catheter.

6. Prepare the power injector 
(optional).

7. Bring your patient’s arms 
above their head.

8. Press Landmark to 
landmark your patient.

9. Record off-sets of 
remaining stations you 
wish to scan.

10. Press Move to Scan.
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6. Prepare the power injector (optional).

Follow your power injector specifications.

If a power injector is not used, follow your facility’s 
procedure for administering rapid bolus injections.

7. Bring your patient’s arms above his or her head.

This minimizes the chance for a wrap around artifact.

If the patient’s arms cannot be placed above the head, 
elevate the arms on cushions, to help minimize wrap 
around artifact.

Display of Patient Arm Position

8. Press Landmark  to landmark your patient.

Landmark for your first station only. 

9. Record off-sets of remaining stations you wish to scan.

It is recommended you use the suggested off-sets.

If the suggested off-sets are not used with the PV coil, 
images may result in coil cut-off.

Use the align light to record the location of any additional 
off-sets.

10. Press Move to Scan .
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ffScan the Localizer Series
Use this procedure following the patient preparation portion of 
the exam. The steps provided give you instructions on how to 
set up and scan a multi station meta-series localizer.

1. Click the Patient Position icon.

Located on the Scan Desktop.

2. Select Coil > PVUPPER.

It is recommended you use the Peripheral Vascular (PV) 
coil for a bolus chasing examination, although the body 
coil can also be used.

3. Enter a description in the Series Description text box.

Suggested name is “Top Loc”.

4. Select Plane > 3 Plane.

Located in the Imaging Parameters area.

5. Select Mode > 2D.

Located in the Imaging Parameters area.

6. Select Localizer in the Pulse Sequence window.

7. Click [Accept].
This registers the pulse sequence for your acquisition.

8. Select Grad Mode > Whole, if applicable.

The Grad Mode text box is only available on 
TwinSpeed™ Resonance Module (TRM) systems.

9. Select No Phase Wrap from the Imaging Options window.

No Phase Wrap (NPW) prevents aliasing of anatomy 
inside a prescribed field of view (FOV).

10. Click [Accept]. 
This registers the imaging options into your current 
acquisition.

11. Enter values into the Center FOV text boxes.

Suggested parameters: 0 S/I, 0 A/P and 0 R/L.

Quick Steps: Scan the 
Localizer Series
1. Click the Patient 

Position icon.

2. Select Coil > PVUPPER.

3. Enter a description in the 
Series Description text 
box.

4. Select Plane > 3 Plane.

5. Select Mode > 2D.

6. Select Localizer in the 
Pulse Sequence window.

7. Click [Accept]. 
8. Select Grad Mode > 

Whole, if applicable.

9. Select No Phase Wrap 
from the Imaging Options 
window

10. Click [Accept]. 
11. Enter values into the 

Center FOV text boxes

12. Enter the Number of 
Slices into the text box.

13. Enter the remaining 
imaging parameters. 

14. Click [Save Series].
15. Select the localizer in the 

Rx Manager, right-click, 
and select Copy from the 
pull-down menu.

16. With the cursor still in the 
Rx Manager, select 
Paste, then Paste again.
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12. Enter the Number of Slices into the text box.

You can enter only an odd number of slices, for example 
1, 3, 5, or 9.

It is recommended you not enter more than three slices. 
This ensures scan times are kept short for breath holding 
techniques.

13. Enter the remaining imaging parameters.

Choose a FOV to cover desired anatomy. The 
recommended FOV is 44.

Enter the slice thickness and spacing.

Enter matrix and NEX values. Typically use a 256 
Frequency value, 128 Phase value, and 2 NEX.

14. Click [Save Series]. 
This closes the view/edit mode and changes series 
status to RXD.

15. Select the localizer in the Rx Manager, right-click, and 
select Copy from the pull-down menu.

Copy/paste the first series twice, so you can View/Edit 
the localizer and change the Center FOV in the S/I 
direction to the desired offset.

16. With the cursor still in the Rx Manager, select Paste, then 
Paste again.

Selecting Paste twice deposits two localizer 
prescriptions in the Rx Manager.

Select Paste for as many stations as you will prescribe 
for the scan Multi-station prescription. 

17. Select the second localizer in the Rx Manager and click 
[View Edit]. 

18. Change the description of the series.

You may choose to enter any description. The suggested 
description is “Mid Loc”. 

This allows you to distinguish the localized meta-series 
at a glance within the Rx Manager area.

19. Change coil type, if necessary.

You must change your coil type if you are using the PV 
coil.

Quick Steps: Scan the 
Localizer Series cont.
17. Select the second 

localizer in the Rx 
Manager and click [View 
Edit].

18. Change the description of 
the series.

19. Change coil type, if 
necessary.

20. Change Center FOV 
off-set to I420.

21. Click [Save Series].
22. Repeat steps 16 to 20 for 

third and any additional 
stations. Make series 
description and off-set 
changes, as necessary.

23. Select the first station in 
Rx Manager labeled “Top 
Loc”.

24. Click [Prepare to Scan].
25. Click [Auto Prescan].
26. Give patient breathing 

instructions.

27. Click [Scan].
28. Repeat steps 23 to 26 for 

each localizer scan.
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20. Change Center FOV off-set to I420.

Establishes second station center FOV.

Only use the suggested inferior off-set if your patient is in 
the PV coil.

If you choose not to use the suggested off-set, when 
scanning with the body coil, enter desired off-set now.

21. Click [Save Series]. 
Closes the view/edit mode and changes series status to 
RXD.

22. Repeat steps 16 to 20 for third and any additional stations. 
Make series description and off-set changes, as necessary.

You may choose to enter any description. The suggested 
third station series description is “Bot Loc”.

Suggested off-set for third station is I840.

23. Select the first station in Rx Manager labeled “Top Loc”.

Highlights the first series.

24. Click [Prepare to Scan]. 

25. Click [Auto Prescan].
This prescans the localizer series.

26. Give patient breathing instructions.

Instruct the patient to suspend breathing until the table 
starts to move to second station.

If your patient has difficulty suspending their breath, 
follow your facility’s guidelines on breath-holding 
techniques.

27. Click [Scan].
Initiates the first series acquisition. 

NOTE: Only the highlighted series is scanned. 

28. Repeat steps 23 to 26 for each localizer scan. 

Advance the table as needed.

NOTE: When acquiring a SmartStep scan, Auto Scan is 
automatically turned off after the 3-Plane Localizer is 
acquired. You must manually start the next acquisition.
2333956-100 Rev. 0 (06/02)  16-15
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
Scan with SmartStep Set up the Scan Parameters
Use this procedure following Patient Preparation and Scan the 
Localizer Series portions of the examination. The steps 
provided give you instructions on how to set up the scan 
parameters of a SmartStep series with Fluoro Trigger.

1. Click [New Series].
Opens up a new blank scan prescription.

2. Enter the Patient Position information.

Recommended you use the PV coil, if available.

Patient entry must match entry of localizer series.

3. Change the coil type, if necessary.

Recommended you use the PV coil, if available.

4. Enter 3D Top in Series Description text box.

Located in the Patient Position area.

5. Select Plane > Oblique.

Located in the Imaging Parameters area.

6. Select Mode > 3D.

Located in the Imaging Parameters area.

7. Select Fast TOF SPGR in the Pulse Sequence window.

Refer to the Fast Time of Flight Pulse Sequences 
chapter in Volume 2 for pulse sequence specifications.

8. Click [Accept]. 
This registers the pulse sequence for your acquisition.

9. Select Grad Mode > Whole, if applicable.

The Grad Mode text box is only available on 
TwinSpeed™ Resonance Module (TRM) systems.

10. Select Multi Station, ZIPx2, ZIP 512, and Fluoro Trigger in 
the Imaging Options window.

All imaging options listed above can be used, but are not 
required, with the exception of Multi Station. Multi Station 
must be selected in order to perform a Bolus Chasing 
procedure.

Selecting ZIP 1024 may require too much system 
memory and is not recommended.

Quick Steps: Set up the 
Scan Parameters
1. Click [New Series].
2. Enter the Patient 

Position information.

3. Change coil type, if 
necessary.

4. Enter 3D Top in the 
Series Description text 
box.

5. Select Plane > Oblique.

6. Select Mode > 3D.

7. Select Fast TOF SPGR in 
the Pulse Sequence 
window.

8. Click [Accept].
9. Select Grad Mode > 

Whole, if applicable.

10. Select Multi Station, 
ZIPx2, ZIP 512, and 
Fluoro Trigger in the 
Imaging Options window.

11. Click [Accept].
12. Enter all remaining 

imaging parameters.

13. Select Contrast.
14. Enter in the correct 

amount of contrast being 
administered.

15. Click the Vascular 
Screen icon.

16. Select On for collapsed 
image.

17. Enter 0 for the number of 
projections.
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NOTE: SmartPrep can be selected in place of the Fluoro Trigger 
Imaging Option. These options cannot be used at the 
same time. You can only select one.

Refer to the Bolus Triggering chapter in this guide for 
steps on using SmartPrep.

11. Click [Accept].
This registers the imaging options into your current 
acquisition.

12. Enter all remaining imaging parameters.

Suggested parameters are: Minimum TE, 45° Flip Angle, 
46-48 FOV, 3 slice thickness, 32 to 40 locations, 
256x128 matrix, 0.8 Phase FOV, 1 NEX, and turn 
AutoShim on.

13. Select Contrast. 
Amnt and the Agent text box become active.

14. Enter in the correct amount of contrast being administered.

The correct amount of contrast is needed to establish an 
accurate threshold for the patient.

15. Click the Vascular Screen icon.

Located in the Additional Parameters area.

16. Select On for collapsed image.

This allows your system to reconstruct a collapsed image 
of the scanned areas.

17. Enter 0 for the number of projections.

This saves reconstruction time. Images can be post 
processed later for projection images.

NOTE: Refer to Interactive Vascular Imaging chapter in Volume 
5 for information on creating projection images.

18. Click [Accept].
This registers the Vascular selections into the current 
acquisition.

19. Click the User CVs Screen icon. 

Located in the Additional Parameters area.

20. Enter the Number of Stations you want in the text box.

Up to four stations can be entered.

Quick Steps: Set up the 
Scan Parameters cont.
18. Click [Accept].
19. Click the User CVs 

Screen icon.

20. Enter the Number of 
Stations you want in the 
text box.

21. Enter the Max. monitor 
period in the text box, if 
necessary.

22. Enter the Image acq. 
delay in the text box.

23. Turn on a k-space filling 
option.

24. Turn on Mask and/or 
Venous acquisition 
options (optional).

25. Turn on or off any other 
desired options, on the 
User CVs Screen.

26. Click [Accept].
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21. Enter the Max. monitor period in the text box, if necessary.

This option is only available if the SmartPrep Imaging 
Option was selected.

It is recommended you use a 50 second delay. This 
allows sufficient time for the system to detect the bolus.

22. Enter the Image acq. delay in the text box.

This text box value should reflect adequate time to give 
patient breathing instructions.

A 5 to 8 second delay is recommended.

23. Turn on a k-space filling option.

You can only turn on one k-space filling option.

– Top station = Centric filling

– Middle Station = Centric filling

– Bottom and any remaining stations = Elliptical Centric 
filling

Refer to the k-space section of this chapter for additional 
information on the k-space filling options.

24. Turn on Mask and/or Venous acquisition options (optional).

Refer to the Acquisition Type section of this chapter for 
additional information on Mask and Venous acquisitions.

NOTE: SmartPrep or Fluoro Trigger Imaging Options are only 
present in the first station of the Arterial Acquisition 
meta-series.

It is recommended a Mask Acquisition is acquired 
whenever performing this type of scan. This ensures 
correct volume placement and helps to improve image 
quality when subtraction post processing techniques are 
used. 

25. Turn on or off any other desired options, on the User CVs 
Screen.

FAT SAT must be selected prior to choosing SPECIAL on 
the screen.

NOTE: SPECIAL can not be used with elliptic centric or reverse 
elliptic k-space filling.

26. Click [Accept].
This registers the User CVs into the current acquisition.
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Set up the Graphic Parameters
Use this procedure following Patient Preparation, Scan the 
Localizer Series, and Set Up of Scan Parameters portions of 
the examination. The steps provided give you instructions on 
how to set up the graphic parameters of a SmartStep series.

1. Click the Graphic Rx icon.

Located in the Additional Parameters area.

2. Click [Select Series].

3. Select the Top Loc series.

This is your first station of the localizer meta-series.

4. Click [OK].

5. Place the cursor over the desired localizer image and press 
the Shift key and click to deposit your 3D imaging volume.

Adjust angle and the left-right, anterior-posterior, and 
center locations to insure proper coverage of anatomy.

NOTE: Be careful to keep the center FOV “tick” mark at I/S 0 mm, 
which is represented by the horizontal reference line.

6. Click [Accept].
This registers the graphic options into your current 
acquisition.

7. Click [Save Series].
Deposits meta-series in the Rx Manager.

8. Double-click the next station in the meta-series.

Opens second series into view/edit mode.

9. Enter 3D Mid in Series Description text box.

You may choose to enter any description. The suggested 
description is “3D Mid”. 

This allows you to distinguish the localized meta-series 
at a glance within the Rx Manager.

10. Change coil type, if necessary.

You must change coil type if you are using the PV coil.

Quick Steps: Set Up the 
Graphic Parameters
1. Click the Graphic Rx 

icon.

2. Click [Select Series].
3. Select the Top Loc 

series.

4. Click [OK].
5. Place the cursor over the 

desired localizer image 
and press the Shift key 
and click to deposit your 
3D imaging volume.

6. Click [Accept].
7. Click [Save Series].
8. Double-click the next 

station in the meta-series.

9. Enter 3D Mid in Series 
Description text box.

10. Change coil type, if 
necessary.

11. Click the User CVs 
Screen icon to change 
your k-space filling option.

12. Click [Accept].
13. Click the Graphic Rx 

icon.

14. Click [Select Series].
15. Select the Mid Loc 

series.

16. Click [OK].
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11. Click the User CVs Screen icon to change your k-space 
filling option.

It is recommended you change your filling option for each 
station. By doing so you improve your probability of 
catching the bolus at each station.

– Top station = Centric filling

– Middle Station = Centric filling

– Bottom and any remaining stations = Elliptical Centric 
filling

12. Click [Accept].
This registers your User CV selections.

13. Click the Graphic Rx icon. 

Located in the Additional Parameters area.

14. Click [Select Series].

15. Select the Mid Loc series.

This is the second station of the localizer meta-series.

16. Click [OK].
This registers your series selection.

17. Place the cursor over the desired localizer image and press 
the Shift key and click to deposit your 3D imaging volume.

Adjust angle and the left-right, anterior-posterior, and 
center locations to insure proper coverage of anatomy.

18. Click [Accept].
This registers the graphic options into your current 
acquisition.

19. Click [Save Series].
This registers the graphic options into your current 
acquisition.

20. Repeat steps 8 to 19 for all remaining stations.

Change third station series description to 3D Bot.

On the User CV window, first deselect Centric by 
changing it to 0.00, then turn Elliptical Centric on by 
changing it to 1.00.

Quick Steps: Set up the 
Graphic Parameters
17. Place the cursor over the 

desired localizer image 
and press the Shift key 
and click to deposit your 
3D imaging volume.

18. Click [Accept].
19. Click [Save Series].
20. Repeat steps 8 to 19 for 

all remaining stations.
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Scan the SmartStep Series
Use this procedure following Patient Preparation, Scan the 
Localizer Series, Set Up of Scan Parameters and Set Up of 
Graphic Parameters portions of the examination. The steps 
provided give you instructions on how to scan the SmartStep 
series using the Fluoro Trigger Imaging Option.

NOTE: Refer to the Bolus Triggering chapter in this guide for 
using the SmartPrep Imaging Option.

1. Select the 3D Bot series.

Located in the Rx Manager area.

2. Click [Prepare to Scan].

3. Click [Prescan All].
This prescans all stations in the meta-series from bottom 
to top.

All series prescanned displays PSCD in the status area 
of the Rx Manager.

4. Skip to step 7 if NOT performing a Mask series. Select the 
first station of Mask meta-series.

If you prescribed a Mask meta-series, the cursor should 
highlight PSCD M/1.

NOTE: You can highlight any series you want to start scanning 
from. For example, if the patient is claustrophobic and 
you decide to skip the mask series, place the cursor on 
the first station of the arterial series.

5. Click [Prepare to Scan].
This downloads the acquisition and moves the table to 
it’s starting position.

6. Click [AutoStep].
If you have entered a delay before the acquisition, the 
clock counts down the delay time. This allows you to give 
breathing instructions to your patient.

Initiates the first highlighted meta-series acquisition. 

– All stations within the Mask meta-series are scanned 
from top to bottom.

Quick Steps: Scan the 
SmartStep Series
1. Select the 3D Bot series.

2. Click [Prepare to Scan].
3. Click [Prescan All].
4. Skip to step 7 if NOT 

performing a Mask series. 
Select the first station of 
Mask meta-series.

5. Click [Prepare to Scan].
6. Click [AutoStep].
7. Select the first station of 

the Arterial meta-series.

8. Click [Prepare to Scan].
9. Click [AutoStep].
10. Make adjustments to the 

fluoro triggered image to 
ensure a mid-line slice of 
the vessel.

11. Click [Go3D], once bolus 
fills the vessel and 
provide your patient with 
breathing instructions.
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NOTE: The system stops after all the Mask meta-series are 
acquired. This allows you to prepare for the contrast 
injection.

7. Select the first station of the Arterial meta-series.

This highlights this series and prepares it for 
downloading.

If no mask meta-series was prescribed, the cursor 
should highlight PSCD A/1.

8. Click [Prepare to Scan].
This downloads the acquisition and moves the table to 
it’s starting position.

9. Click [AutoStep].
Initiates the first highlighted meta-series acquisition. 

The system switches to the Fluoro Trigger mode.

10. Make adjustments to the fluoro triggered image to ensure a 
mid-line slice of the vessel.

Refer to the Real Time Imaging chapter in this guide for 
additional information on options seen on the FT MRA 
mode screen.

11. Click [Go3D], once the bolus fills the vessel and provide 
your patient with breathing instructions.

This triggers the scan mode of the Arterial acquisition. All 
series in the meta-series are scanned from top to bottom.

The Venous meta-series is acquired from bottom to top.

NOTE: Refer to the Bolus Triggering chapter for additional 
information on Fluoro Trigger.

3D Top Series 3D Mid Series 3D Bot Series
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Copy and Paste a SmartStep Series
The Copy and Paste function allows you to repeat a scan 
prescription that was already listed in the Rx Manager. Use this 
procedure to copy and paste a SmartStep series.

1. Select the first station of the arterial series.

The series highlights in the Rx Manager.

2. Right-click and drag to select Copy.

This copies the arterial series.

3. Select the first station of the venous series.

The series highlights in the Rx Manager.

The copied series is placed immediately below the 
selected (highlighted) series.

4. Right-click and drag to select Paste.

This places the arterial series at the bottom of the list in 
the Rx Manager.

5. Prescan the pasted series.

This places the mask and venous series appropriately in 
the Rx Manager.

6. Proceed with scanning as usual.

Quick Steps: Copy and 
Paste a SmartStep Series
1. Select the first station of 

the arterial series.

2. Right-click and drag to 
select Copy.

3. Select the first station of 
the venous series.

4. Right-click and drag to 
select Paste.

5. Prescan the pasted 
series.

6. Proceed with scanning as 
usual.
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Scan using the GE Saved SmartStep 
Protocol
Use this procedure to perform a SmartStep scan with the Fluoro 
Trigger option using the GE saved protocol. The GE saved 
protocol allows you to select one of two localizers and acquires 
a three-station meta-series.

1. Select the Abdomen/Lumbar A.7 - 3 Station SmartStep 
FTr PV array protocol from the GE Protocol list.

There are three other SmartStep protocols in the 
Abdomen/Lumbar library: 

– A.6- 3-Station SmartStep SPrep PV Array

– A.8- 3-Station SmartStep Sprep-Body Coil

– A.9- 3-Station SmartStep FTr-Body Coil

2. Scan the desired localizer acquisitions.

Select either the 3-Plane Localizer or the TOF localizer.

3. Set up the top series for scanning.

a) Double-click the top station in the meta-series.

b) Click the Graphic Rx icon.

c) Click [Select Series].
d) Select the Top Loc series.

e) Click [OK]. 
f) Place the cursor over the desired localizer image and 

press the Shift key and click to deposit your 3D imaging 
volume.

g) Adjust the angle and position of the 3D volume.

h) Click [Accept].
i) Click [Save Series].

Quick Steps: Scan using 
the GE Saved SmartStep 
Protocol
1. Select the 

Abdomen/Lumbar A.7 - 
3 Station SmartStep FTr 
PV array protocol from 
the GE Protocol list.

2. Scan the desired localizer 
acquisitions.

3. Set up the top series for 
scanning.

4. Set up the middle series 
for scanning.

5. Set up the bottom series 
for scanning.

6. Select the 3D Bot series.

7. Click [Prepare to Scan].
8. Click [Prescan All].
9. Select the M Top series.

10. Click [Prepare to Scan].
11. Click [AutoStep] to scan 

the Mask meta-series.

12. Select the A Top series in 
the Rx Manager.

13. Click [Prepare to Scan].
14. Click [AutoStep] to 

initiate the meta-series.

15. Click [Go 3D] once the 
bolus fills the vessel and 
provide your patient with 
breathing instructions.
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4. Set up the middle series for scanning.

a) Double-click the middle station in the meta-series.

b) Click the Graphic Rx icon.

c) Click [Select Series].
d) Select the Mid Loc series.

e) Click [OK]. 
f) Place the cursor over the desired localizer image and 

press the Shift key and click to deposit your 3D imaging 
volume.

g) Adjust the angle and position of the 3D volume.

h) Click [Accept].
i) Click [Save Series].

5. Set up the bottom series for scanning.

a) Double-click the bottom station in the meta-series.

b) Click the Graphic Rx icon.

c) Click [Select Series].
d) Select the Mid Loc series.

e) Click [OK]. 
f) Place the cursor over the desired localizer image and 

press the Shift key and click to deposit your 3D imaging 
volume.

g) Adjust the angle and position of the 3D volume.

h) Click [Accept].
i) Click [Save Series].

6. Select the 3D Bot series.

7. Click [Prepare to Scan].

8. Click [Prescan All].
The system prescans the meta-series from bottom to 
top.

9. Select the M Top series.

10. Click [Prepare to Scan].

11. Click [AutoStep] to scan the Mask meta-series.

The Mask meta-series scans from top to bottom.
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12. Select the A Top series in the Rx Manager.

13. Click [Prepare to Scan].

14. Click [AutoStep] to initiate the meta-series.

The system switches to Fluoro Trigger mode.

The Arterial meta-series scans from top to bottom.

The Venous meta-series scans from bottom to top.

15. Click [Go 3D] once the bolus fills the vessel and provide 
your patient with breathing instructions.
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Chapter 17

Bolus Triggering

Introduction 
Bolus Triggering is a technique used in imaging vasculature, where a bolus of a 
contrast medium activates the scan and is sequentially imaged as it moves 
through the vessels. It can be performed using either of the purchasable options, 
SmartPrep or Fluoro Triggered Magnetic Resonance Angiography (FT MRA). 

This chapter explains the Bolus Triggering process. The focus is on bolus 
detection and acquisition triggering for contrast-enhanced Magnetic Resonance 
Angiography (CEMRA). It contains key concepts as well as step-by-step 
instructions to help you learn how to:
• Set up a FT MRA Series
• Prescribe the Imaging Volume
• Scan the FT MRA Series

In addition, this chapter answers the following questions:

1. What is FT MRA?

2. Which pulse sequences are compatible with FT MRA?

3. Which features are compatible with FT MRA?

4. When would I use the Fluoro Trigger option?

NOTE: This chapter includes new features or enhancements of Bolus Triggering. 
Refer to the Signa® Infinity with Signa Select™ (ASP2) Learning and 
Reference Guide (direction #2292263-100) for the SmartPrep bolus 
triggering technique. 
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What Do I Need to Know 
About...
This section presents the concepts necessary to successfully complete the 
Bolus Triggering process. Specifically, you need to understand:
• Fluoro Triggered MRA Basics

– Supported Features
• Applications

Fluoro Triggered MRA Basics
Fluoro Triggered Magnetic Resonance Angiography (FT MRA) is a 
technique that uses a thick slab, two-dimensional (2D) real time acquisition 
and reconstruction to monitor a region of interest. FT MRA is used to detect 
the arrival of a contrast bolus. This feature allows you to trigger an 
elliptic-centric view ordered acquisition of a three-dimensional (3D) volume 
of interest once a patient’s vessels have sufficiently enhanced. The 3D 
acquisition is perfectly synchronized to the peak concentration of contrast in 
the vessels. FT MRA images are annotated “FTr” in the lower left hand 
corner.

Elliptic-centric k-space filling may be used with a FT MRA sequence. This 
option is located on the User CVs screen, accessed in the Additional 
Parameters area. Refer to the Elliptic-centric section of this chapter for 
additional information regarding this type of k-space filling.

Unlike SmartPrep, FT MRA relies on you to trigger the acquisition, once the 
bolus is detected. It incorporates Real Time Imaging so the contrast is 
visually seen within the vessel before the acquisition is started. Once the 
acquisition is downloaded and the [Scan] button is clicked, you are in the 
FT MRA mode (Figure 17-1). This window looks and operates much like the 
Real Time Imaging Acquire tab. 
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Figure 17-1 FT MRA Mode

There are five main differences between the FT MRA imaging mode and 
the Real Time imaging mode Acquire tabs.
• The [Pause When Full] button is no longer available.
• The [Save Image] button is no longer available.
• The Review tab is no longer selectable.
• A Delay text box appears, allowing you to enter a system delay value in 

seconds. The value defaults to the delay set by the prescribed 
acquisition. This value can be changed and a new value can be typed 
in. The delay period is the time after the [Go 3D] button is clicked and 
the scan actually starts.

• The [Go3D] button appears, allowing you to initiate the prescribed 
acquisition. This button remains active when real time scanning is in 
progress. If the [Pause Scanning] button is selected, the [Go3D] 
button becomes inactive.
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NOTE: Refer to the Real Time Imaging chapter in this guide for explanation 
of other options present on the Acquire tab.

Supported Features
The Fluoro Trigger Imaging Option is compatible with the 3D imaging mode 
and the following pulse sequences:
• Fast Time of Flight (TOF) Gradient Echo (GRE) and SPoiled Gradient 

Echo (SPGR)
• Fast GRE and SPGR

In addition, FT MRA is compatible with the features listed in Table 17-1.

Table 17-1 Fluoro Trigger Compatibility 

Compatible Not Compatible
ZIP 1024 Flow Compensation

ZIP 512 POMP

ZIP x2 Square Pixels

ZIP x4 Respiratory Compensation

Multi Station Magnetization Transfer

Variable Bandwidth Cardiac Gating/Triggering

No Phase Wrap Tailored RF

Extended Dynamic Range DE Prepared

Multi Phase Full Echo Train

Spatial Saturation SmartPrep

Fat/Water Suppression T2 Prep

Phase Sensitive

Surface Coil Intensity Correction

Sequential

Classic

Respiratory Gating/Triggering

IR Prepared

Cardiac Compensation

Blood Suppression

Real Time

Spectral Spatial RF
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NEX and Fat Saturation

During the real time imaging portion of the FT MRA acquisition, the NEX is 
defaulted to one and Fat SAT is turned off to improve frame rate. Once the 
3D acquisition starts, Fat SAT is turned back on and the NEX you 
prescribed is used.

Saturation Bands

To improve the contrast visualization during a FT MRA acquisition, you can 
prescribe explicit SAT bands during real time imaging along the S/I direction 
by setting User Control Variable (CV) 19 to 0. This selection places the SAT 
bands at the edge of the scan FOV during the real time scan. The default 
SAT band is 8 cm in the S/I direction; 7 cm is outside the FOV and 1 cm is 
inside the FOV.

For axial planes, the concatenated SAT is a better choice, as it is closer to 
the imaging slice. You can select a concatenated SAT by setting User CV 
19 to 1. This selection places the SAT bands parallel to the slice during the 
real time scan and allows them to move with the slice. This is useful for 
monitoring contrast in the axial plane during carotid and liver imaging. For 
body MRA, coronal or sagittal planes are often used where a fixed S/I SAT 
is appropriate. 

The User CV selection only determines the location of the SAT bands. You 
also need to click the [SAT] button on the Real Time Imaging Acquire tab to 
turn SATs on for imaging.

Applications
Use FT MRA when SmartPrep is not optimal,e.g., when a patient has slow 
cardiac output or if delayed imaging enhancement is desired. FT MRA is 
also recommended for performing carotids and T1 post contrast liver 
examinations.
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How Do I...
This section provides the step-by-step instructions for bolus triggering. 
Specifically, it describes how to:
• Set up a FT MRA Series
• Prescribe the Imaging Volume
• Scan the FT MRA Series
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 Anchor Set up a FT MRA Series
Use this procedure to setup a FT MRA series. By using FT 
MRA, the system allows you to scan the prescribed acquisition 
once contrast has been detected by you. This make bolus 
detection easier, if use of SmartPrep is not available or optimal.

You should already know how to set up a protocol for your 
system; only a brief review is explained. The rest of the 
procedure guides you through the FT MRA setup process. 

1. Select the appropriate coil.

Refer to the Gradient, Shim and Imaging Coil chapter in 
Volume 1 for suggested coil positioning.

2. Position the patient comfortably and immobilize the area of 
interest with sponges.

3. As directed by physician, set up the patient IV catheter and 
prepare the power injector (optional). 

Follow your physician’s or facility’s guidelines.

4. Landmark the patient.

5. Press Move to Scan.

This moves the patient to the landmarked location inside 
the scanner bore.

6. Acquire an appropriate localizer series.

Sometimes more than one localizer is needed to make 
sure proper volume coverage is included.

7. Click [New Series]. 

8. Click the Pt. Position icon.

Located on the Scan Desktop.

9. Select Plane > Oblique.

Located in the Patient Position area.

10. Select Mode > 3D. 

Located in the Patient Position area.

NOTE: You can prescribe a coronal orthogonal plane. Make sure 
the volume includes the necessary imaging anatomy.

11. Select Fast TOF GRE or Fast TOF SPGR in the Pulse 
Sequences window. 

Quick Steps: Set up a FT 
MRA Series
1. Select the appropriate 

coil.

2. Position the patient 
comfortably and 
immobilize the area of 
interest with sponges.

3. As directed by physician, 
set up the patient IV 
catheter and prepare the 
power injector (optional).

4. Landmark the patient.

5. Press Move to Scan. 

6. Acquire an appropriate 
localizer series.

7. Click [New Series]. 
8. Click the Pt. Position 

icon. 

9. Select Plane > Oblique.

10. Click Mode > 3D.

11. Select Fast TOF GRE or 
Fast TOF SPGR in the 
Pulse Sequences 
window.

12. Select Grad Mode > 
Whole, if applicable.

13. Select Fluoro Trigger in 
the Imaging Options 
window.

14. Complete the scan 
prescription.

15. Click the User CVs 
Screen icon.

16. Complete the User CVs 
Screen parameters.
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12. Select Grad Mode > Whole, if applicable.

The Grad Mode text box is only available on 
TwinSpeed™ Resonance Module (TRM) systems.

13. Select Fluoro Trigger in the Imaging Options window.

NOTE: Select Multiphase to capture both the arterial and 
venous phase. Refer to the Imaging Options chapter in 
Volume 4 for additional information. 

14. Complete the scan prescription.

a) Select the scan timing parameters to minimize TR and 
TE.

b) Select FOV, matrix, and slice thickness to balance spatial 
resolution and SNR.

c) Minimize scan time to allow for breath-held acquisitions.

NOTE: Remember to enter the correct contrast dosage. Refer to 
Threshold section for detailed information.

15. Click the User CVs Screen icon.

Located in the Additional Parameters area.

16. Complete the User CVs Screen parameters.

a) Expand the delay time.

b) Set your SAT band choices.

– Enter 0 for User CV 19 to prescribe explicit SAT 
bands.

– Enter 1 for User CV 19 to prescribe a concatenated 
SAT band.

c) Set the desired type of k-space filling.
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Enter contrast dosage.Prescribe the Imaging Volume
Use this procedure to prescribe the FT MRA imaging volume. 
The set up of the FT MRA series must be done prior to placing 
the imaging volume.

1. Click the Graphic Rx icon. 

2. Select an appropriate series and image.

3. Press the Shift key and click on the image to place your 3D 
imaging volume.

Example of an imaging volume placed on a midline slice.
A midline slice is best for setting up your imaging 
volume, unless your patient is off center inside the 
magnet.

4. Adjust the angle of the volume to ensure proper coverage of 
anatomy.

The angle can only be adjusted in the oblique plane.

5. Click [Fallback], if necessary. 

This allows your imaging volume center to be set at R0.

Do not fallback if you are using a projection image of a 
2DTOF for the localizer.

6. Click [Accept].
Closes the Graphic Rx screen.

7. Click [Save Series].
Closes the scan prescription screen.

Accepts the scan prescription.

Saves it in the Rx Manager as RXD.

Quick Steps: Prescribe the 
Imaging Volume
1. Click the Graphic Rx 

icon. 

2. Select an appropriate 
series and image.

3. Press the Shift key and 
click on the image to 
place your 3D imaging 
volume.

4. Adjust the angle of the 
volume to ensure proper 
coverage of anatomy.

5. Click [Fallback], if 
necessary. 

6. Click [Accept].
7. Click [Save Series].
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[Accept], then [Save Series] when done. Scan the FT MRA Series
Use this procedure to scan the FT MRA series. The set up of 
the FT MRA series and the prescription of the imaging volume 
must be done prior to scanning the series.

1. Click [Prepare to Scan]. 

2. Click [Auto Prescan].

3. Click [Scan].
Initiates the acquisition in the FT MRA mode.

4. Adjust the real time image.

Use the real time controls.

Visualize the best possible midline slice of the vessel.

5. Enter a delay value in the Delay text box, if necessary.

The delay time should be sufficient enough to allow the 
patient time to hold his or her breath.

Recommended delay times are 5 seconds or less.

6. Begin administering contrast to the patient.

The amount of contrast should be determined by your 
physician or facility personnel.

Contrast can be administered by either a power injector 
or hand bolus.

7. Watch for the bolus on the FT MRA viewer. 

8. Click [Go3D], once bolus fills vessel. 

This enters the quiet delay period. The count-down can 
be observed from the PC monitor or from the magnet 
cover.

Once the delay timer reaches 1 second, the system 
automatically switches into scanning mode. 

The FT MRA screen disappears and the Scan Desktop is 
again displayed.

Once the system switches into scanning mode, an 
audible switch of the gradients can be heard.

Quick Steps: Scan the FT 
MRA Series
1. Click [Prepare to Scan].
2. Click [Auto Prescan].
3. Click [Scan].
4. Adjust the real time 

image.

5. Enter Delay value, if 
necessary.

6. Begin administering 
contrast to the patient.

7. Watch for the bolus on 
the FT MRA viewer. 

8. Click [Go3D], once bolus 
fills vessel.
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Chapter 18

Imaging Real Time

Introduction
iDrive™ Pro Plus is an optional software package that provides a flexible 
environment for imaging Real Time Cardiac Acquisitions (RTCAs). iDrive Pro 
Plus can be used to interactively manipulate the scan plane and image contrast. 
Images you acquire with iDrive Pro Plus can be used to prescribe scan planes 
and locations for other series in the exam once the correct plane and locations 
have been determined. 

This chapter explains how to image real time with iDrive Pro Plus. It provides key 
concepts regarding the acquisition, tools, image review options, and application 
tips on where to use interactive imaging. This chapter also contains the 
step-by-step instructions to help you learn how to:
• Prescribe a real time sequence
• Use the Movement tools

– Drive through an image volume
– Step through an image volume

• Manage Home Images
– Define a scan plane 
– Define new Home Images

• Manage Bookmarks
– Create a Bookmark
– Recall a Bookmark
– Enlarge a thumbnail and apply for scanning
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• Use the Graphic tools
– Change the FOV center
– Draw a line in the Main Viewer
– Draw a line in the Scout Viewer
– Draw a line in the Multi-slice Mode
– Apply the 2 Point tool
– Apply the 3 Point tool

• Review real time images
– Playback images
– Save images

In addition, this chapter answers the following questions:

1. What pulse sequences can I use with iDrive Pro Plus?

2. What factors affect frame rate?

3. What tools are available on the iDrive Pro Plus Acquire tab?

4. What are Home Images?

5. What are Bookmarks?

6. What tools are available on the iDrive Pro Plus Review tab?

7. What are the applications for imaging with iDrive Pro Plus?
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What Do I Need to Know 
About...
This section presents the concepts necessary to successfully complete 
imaging real time process with iDrive Pro Plus. Specifically, you need to 
understand:
• Real Time Imaging Overview
• Real Time Imaging Basics

– Frame Rate
– Image Acquisition

• Acquire Tab 
– Home Images 
– Bookmarks
– Image Buffer
– Multi-slice Mode

• Acquire Tab Tools
– Movement Tools
– Orientation Tools
– Contrast Tools
– Graphic Tools 
– Parameter Tools
– Graphic Prescription Tools

• Review Tab 
– Review Images
– Image Slider

• Applications
• Troubleshooting Tips
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Real Time Imaging Overview
Real time imaging allows you to navigate through your patient’s anatomy for 
rapid visualization and monitoring of temporal physiological events. This 
includes, but is not limited to, patient breathing, kinematic studies, and 
bolus activity. Real time images can also be used for directly prescribing 
scan planes of other series in the exam. The Real Time Imaging Option 
allows for Real Time Cardiac Acquisitions (RTCAs) with the iDrive Pro Plus 
optional software package.

Real Time Imaging Basics
iDrive Pro Plus is an optional software package that allows you to image 
RTCAs with greater flexibility. You can use iDrive Pro Plus to interactively 
manipulate the scan plane and image contrast. Images you acquire with 
iDrive Pro Plus can be used to prescribe scan planes and locations for other 
series in the exam once the correct plane and locations have been 
determined. 

RTCAs can be acquired with the following pulse sequences:
• Fast Gradient Echo (FGRE)
• Fast Spoiled Gradient Echo (FSPGR)
• Fast Gradient Echo-Echo Train (FGRET)
• Spiral GRE
• Spiral SPGR 

Frame Rate
The Advisory panel of the Scan Rx desktop displays the number of images 
acquired in one second based on the current series parameters. This is 
shown in the frames per second (FPS) status area. The gradient platform 
and array processor configuration affect the maximum number of images or 
frames per second that can be generated. Another factor affecting the 
frame rate is the number of receive coils. The use of a phased array coil 
may decrease the frame rate as compared to a single receive coil.

When imaging with iDrive Pro Plus, the phase and frequency matrix 
selections are the predominant factors affecting the FPS in non-Spiral 
acquisitions. In Spiral scans, the number of arms and number of points are 
the predominant factors affecting the FPS. 
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Image Acquisition
To use the features of the Real Time Imaging Option, you must first 
prescribe a single-slice series at the Scan Rx desktop. This series must 
have Real Time selected at the Imaging Options window. The real time 
series can be saved as a stand-alone protocol or as part of a larger protocol 
with an existing batch series. It can be cut, copied or pasted using the Rx 
Manager tools and can be used in a protocol that is being automatically 
scanned. 

When you start the scan, there is a slight pause (less than six seconds) 
before the system is ready to display the images. The tools and functions 
available on the Acquire tab help you manipulate the scan plane and 
contrast of the images. These actions are a combination of button 
selections and cursor manipulations on the image screen itself.

When the real time application is launched, Archive, Network, and Filming 
operations are automatically paused by the system. However, there is no 
notification of the pause status. These processes automatically resume 
when the real time application is closed.

Images acquired real time are not automatically saved to the system disk. 
The [Save Image] button on the Acquire tab saves a single image to the 
disk when that image is displayed in the Acquire tab Main Viewer. 

Data acquisition can be paused by clicking the [Pause Scanning] button on 
the Acquire tab or by pressing the Pause Scan hard key on the keyboard. If 
the keyboard is used to pause scanning, the Acquire tab [Pause Scanning] 
button appears depressed. Scanning can be initiated again with the Start 
Scan hard key or by selecting the [Pause Scanning] button on the Acquire 
tab. When scanning is paused, most of the Acquire tab controls become 
unavailable. 

Acquire Tab
The RTCA Acquire tab (Figure 18-1) displays when the [Scan] button is 
selected from the Scan Rx desktop in a real time prescription with iDrive 
Pro Plus. Data acquisition begins and three Home Images are acquired, 
one image in each orthogonal plane.
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Figure 18-1 RTCA Acquire Tab 

Table 18-1 provides a description and acceptable values for each selection 
on the Acquire tab for RTCAs imaging with iDrive Pro Plus. 

Table 18-1 RTCA Acquire Tab Selections and Descriptions

Selection Description
[Delete 
Bookmarks]

Deletes all bookmark thumbnails currently displayed. 
Individual bookmarks cannot be deleted.

[Add 
Bookmarks]

Saves the plane, location, and image contrast of the 
current image as a bookmark thumbnail for later recall. 
Up to 12 images can be bookmarked. 

[Define Scout]
Copies the image in the Main Viewer to the Scout 
Viewer (the viewer directly under the [Define Scout] 
button). 
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Scout Viewer
Contains a static 256x256 image that can be used with 
the Draw Line tool to prescribe orthogonal real time 
image planes. This viewer is empty when real time 
scanning begins. 

[Pause When 
Full]

Pauses the real time data acquisition automatically 
when the real time image buffer is full. The progress 
bar provides a graphic display of the image buffer 
capacity. 

Main Viewer
Displays the real time images as real time data 
acquisition is taking place. This image is also used with 
the Movement and Graphic Tools for defining new scan 
planes.

[GO]

Becomes visible on the real time image when the Draw 
Line tool is selected. It is used to initiate the scan plane 
change when a line is drawn on the real time image. 
Alternatively, right-click anywhere on the image to 
initiate data acquisition.

[Define New 
Home]

Acquires new home images. The new home images 
are acquired in three orthogonal planes based on the 
real time image currently displayed in the Main Viewer. 

[Save Image]
Saves the current real time image to the system disk 
and lists the image in the Browser. Saved images can 
be used in Graphic Rx in subsequent series.

[Rx Start/End]
Displays the IGRx location tools. The IGRx tools are 
used to save or retrieve locations for defining additional 
real time and/or non-real time sequences. 

[Rx Center]
Displays the IGRx center tools. The IGRx tools are 
used to save or retrieve locations for defining additional 
real time and/or non-real time sequences. 

[Undo]

Returns the real time image to the state prior to the 
most recent change, undoing the most recent scan 
plane or image contrast change. It can also be used if 
iDrive Pro Plus has been exited. Selecting the [Undo] 
button upon re-entering iDrive Pro Plus, the last 
location scanned in the prior real time session will be 
acquired provided the ID, Landmark and Patient 
Position have not changed. In Drive mode, it undoes all 
Drive functions returning the image to its original state 
before any Drive tools were applied. In the Step mode, 
it undoes all Step functions returning the image to its 
original state before any Step tools were applied.

[Redo] Cancels the most recent Undo operation. The real time 
image returns to its previous state.

Selection Description (Continued)
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[Timer]

Turns the on-image time display on or off. The 
on-image timer shows the scan time for a single image. 
When Timer is on, the scan timer on the PC is set to 
zero. The timer readout updates with each new image 
acquired and displayed. It displays the time the image 
was acquired since the [Timer] button was clicked.

Movement Contains tools used to define the on-image scan plane 
manipulation features. 

Orientation

The scan plane can be quickly returned to any 
orthogonal orientation, at the current FOV center, by 
selecting the [Axial], [Sagittal], or [Coronal] buttons. 
The [Normal] button adjusts the image to a normal 
anatomic presentation. The image is presented such 
that RAS coordinates are in their "normal" positions in 
the viewer. 

Contrast
Contains tools used to adjust image contrast 
parameters. The contrast tools available are based on 
the pulse sequence. 

Tools
Provides access to the Graphic tools that provide 
alternate methods used for manipulating the scan 
plane. 

Stack Enables the Multi-slice mode. The stack values are 
shown in millimeters in the range of 10 to 100. 

FOV Allows changes in the prescribed FOV by moving the 
slider or by entering a value in the text box. 

Slice 
Thickness

Allows changes in the prescribed slice thickness by 
moving the slider or by entering a value in the text box. 

Flip Angle Allows changes in the prescribed flip angle by moving 
the slider or by entering a value in the text box. 

Average

Specifies the number of images to be averaged to 
create the real time image. This improves the 
signal-to-noise ratio (SNR), as well as motion 
averaging. Averaging occurs as long as the real time 
image location and contrast setting are not changed. A 
value of 1 effectively means no averaging. The 
maximum allowable value is 8. 

[Swap 
Phase/Freq]

Toggles on to swap the phase and frequency matrix 
directions based on the original series prescription. 
This is not available for Real Time Spiral Imaging. 

[Pause 
Scanning]

Stops real time data acquisition. The Acquire tab 
remains open. Selecting the [Pause Scanning] button 
again resumes data acquisition.

Selection Description (Continued)
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Home Images
The three orthogonal images acquired upon initialization of a real time 
series are displayed in the three vertical viewers along the right side of the 
Acquire tab Main Viewer (Figure 18-2). These images are called Home 
Images. The Home Images created are axial, sagittal, and coronal, based 
on the locations prescribed at the Scan Rx desktop during the real time 
series prescription. The Home Images are automatically saved to the 
system disk.

Figure 18-2 Home Images

[Review]
Pauses scanning and moves the display to the iDrive 
Pro Plus Review tab. The Review tab is used to view 
and save recently acquired real time images. 

Message Area

Displays all error and warning messages that have 
been posted throughout the current real time session. 
Messages displayed are cleared when any action is 
performed within the user interface. Selecting the 
double arrows displays a dialog box with a scrollable 
list of messages that have been displayed for the 
current real time session.

[Close]
Exits the Acquire tab, stops the current real time 
session, and returns to the Scan Rx desktop. Once you 
close iDrive, you cannot access images that have not 
been saved. 

Selection Description (Continued)
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During the real time session, cut-lines display on the Home Images 
indicating where the current real time image intersects the Home Images. 
As the scan plane is manipulated, the cut-lines update to indicate the new 
scan plane.

Defining a Scan Plane Based on Home Images

The Home Images are essentially a three-plane localizer. They can be used 
to define an orthogonal scan plane and new Home Images can be defined. 
You can also use your Home Images to reset your current scan plane. 
Clicking on any one of the Home Images obtains a real time image in that 
scan plane. 

Defining New Home Images

You also have the ability to replace your home images with new images. 
When you decide that new Home Images are desired at the location of the 
current real time image, select the [Define New Home] button. The first 
time you define new home images during an acquisition, a message 
displays informing you that your current home image locations will be 
replaced by new home images. If this is your intent, click the [OK] button. 
The system then acquires and displays three orthogonal images based on 
the location of the real time image. This includes the right, anterior, and 
superior (RAS) offsets of current real time image. 

Bookmarks
An image can be bookmarked to recall at a later time. A recall can be 
performed to obtain the scan plane and image contrast from that image. 
When an image is bookmarked, it is displayed as a thumbnail image in the 
Bookmark Viewers (Figure 18-3). 

Figure 18-3 RTCA Bookmark Viewers
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RTCAs can store up to 12 Bookmarks. A single thumbnail image can be 
enlarged from a 64x64 to a 128x128 pixel display by leaving the cursor on 
the image for longer than one second. When you move your cursor off of 
the enlarged thumbnail image, it immediately returns to its original size. An 
enlarged thumbnail can be selected for scan by clicking it. This updates the 
image in the Main Viewer to the contrast and slice view of the Bookmark.

Bookmarks are not automatically saved to the image disk. If a RTCA is 
exited and re-entered, the Bookmark thumbnails from the prior real time 
session are saved only if the Patient ID, Landmark, and Patient Position 
have not changed.

If all thumbnail viewers are filled and the [Add Bookmarks] button is 
clicked, a message posts telling you to right-click on an occupied viewer to 
replace that thumbnail with the current image. All thumbnail images in 
RTCAs can be deleted by clicking the [Delete Bookmarks] button.

Image Buffer
The Image Buffer holds all of the images acquired with real time. If the 
buffer is filled and scanning continues, the first images placed into the buffer 
are deleted to make room for the current real time images using the First In, 
First Out (FIFO) method. FIFO buffer images are not automatically saved. 
You can review images in the image buffer and save individual images or an 
entire range of images. You can also select an image from the buffer and 
resume scanning at that location. The system automatically pauses 
scanning once the image buffer fills. Think of the image buffer as 
fluoroscopy. Nothing is saved unless you “spot film.”

RTCAs imaged with iDrive Pro Plus can hold up to 960 real time images. 
The actual number of images in the buffer depends on the image size of the 
reconstructed image. For example, an FGRE sequence may allow only 250 
images, while Spiral may allow up to 960. These images are held in the real 
time Image Buffer and the buffer capacity is indicated by the progress bar 
(Figure 18-4).

Figure 18-4 RTCA Image Buffer Progress Bar
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The [Pause When Full] button can be toggled on to halt real time data 
acquisition when the buffer becomes full. This indicates that no images 
acquired from this point forward are to be discarded. When the number of 
images acquired equals the capacity of the image buffer, scanning is 
paused. The progress bar (Figure 18-4) provides a graphic display of the 
Image Buffer capacity. To clear the buffer, click the [Pause When Full] 
button. The progress bar indicator clears, indicating that the buffer has been 
reset. When the [Pause When Full] button is toggled off, the progress bar 
is inactive. 

When the real time Image Buffer becomes 85% full or greater, the [Define 
New Home] button becomes non-functional when the [Pause When Full] 
button is enabled. If you request new home images to be defined while the 
buffer is nearing 85% full, the system may not collect the new home images 
as you requested. In this case, you must empty the Image Buffer before you 
are able to define new home images. 

The arrow button below the Image Buffer progress bar can be used to 
purge the buffer at any time. Alternatively, the images can be reviewed, 
saved, and purged from the Review tab.

Note that if the RTCA is closed, the images in the Image Buffer are held in 
the buffer until a change has been made to the Patient ID, Patient Position, 
or Landmark. Therefore, if the RTCA is re-entered for the current patient, 
the real time images from the prior session remain in the Image Buffer. 

Multi-Slice Mode
Multi-slice mode can be used with iDrive Pro Plus to visualize a 
multiple-slice, or "stack" acquisition during RTCAs. This may be useful to 
visualize the start and end locations before applying the locations to a 
series in the Rx Manager. The Stack check box and the mm text box 
(Figure 18-5) are used in conjunction with the Draw Line tool to use 
Multi-slice mode. 

Figure 18-5 RTCA Multi-slice Mode Enable Area

The stack is NOT used to acquire a volume (stack) in iDrive Pro Plus; it only 
designates the stack thickness to use for the Draw Line tool. The range of 
thickness is 0 to 480 mm. When you change the stack thickness value, the 
locations are updated on the real time image in the Main Viewport to reflect 
the new stack thickness entry. 
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Acquire Tab Tools
The Acquire tab contains tools for you to change the sequence parameters, 
move the acquisition, change the graphic location, enhance real time image 
contrast, as well as set up and enable a graphic prescription. 

Figure 18-6 displays the orientation of the real time scan plane of the RTCA 
relative to you and the conventional axis used to describe the real time 
control tools.

Figure 18-6 Conventional Axis Used to Describe Tools

Movement Tools
The scan plane can be manipulated using the Movement tools accessed in 
both the Drive and Step modes for RTCAs. Each Movement tool is activated 
by an on-screen (on-image) icon on the real time Main Viewer. These 
Movement tools enable you to navigate the location of the real time image. 

The tool icons are used to access the Movement tools in RTCAs imaged 
with iDrive Pro Plus. When the cursor is moved into one of the four corners 
of the Main Viewer, the cursor displays the icon associated with that tool 
accessed in that corner. Table 18-2 illustrates the Movement tools for 
RTCAs imaged with iDrive Pro Plus and provides a description of each. 

Table 18-2 RTCA Movement Tools Selections and Descriptions

Movement Tool Description

Pan
The Pan cursor is activated by clicking in the 
upper-left corner. Panning is used to scroll the image 
in the X and Y directions in the viewer; left and right 
(X), up and down (Y). The FOV center is changed 
with no changes to the scan plane obliquity or 
orientation. When in Step mode, movement occurs in 
increments based on the value set in the Movement 
tools text box. This value is displayed in millimeters.
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The same Movement tools are available for both the Drive and Step modes. 
The mode simply determines the manner in which the scan plane changes 
are applied.

Drive Mode

The scan plane is navigated in Drive mode by clicking and dragging the 
mouse in the Main Viewer. The cursor indicates the direction of movement 
as the cursor is moved. As you drag the mouse, the extent of movement is 
annotated in the lower right corner of the real time image. The scan plane 
updates when you release the mouse button.

In Drive mode, the direction of mouse movement affects the direction of the 
cursor movement. The cursor icon changes to indicating the direction of 
movement.

NOTE: The Movement tool text boxes indicating the millimeter and degree 
of movement are not available in Drive mode. They can only be 
changed in Step mode.

Rotate
The Rotate cursor is activated by clicking in the 
upper-right corner. Rotate turns the image in a 
clockwise or counter-clockwise motion. The FOV 
center in the X and Y directions does not change. 
When in Step Mode, movement occurs in increments 
based on the value set in the Movement tools text 
box. This value is displayed in degrees. 

Tilt The Tilt cursor is activated by clicking in the 
lower-left corner. Tilt rolls (obliques) the image in the 
direction of the arrow on the cursor. Movement 
occurs along the X-axis, the Y-axis or both. When in 
Step Mode, movement occurs based on the value 
set in the deg text box. 

Translate
The Translate cursor is activated by clicking in the 
lower-right corner. The image is rolled (obliqued) 
along the Z-axis, tilting toward or away from you with 
no change in the angle of the image. No movement 
occurs in the X or Y directions. When in Step Mode, 
movement occurs based on the value set in the mm 
text box. As movement begins, the arrow changes to 
display the direction of the translation.

Movement Tool Description
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Step Mode

The scan plane is navigated by clicking the left mouse button. As the mouse 
button is released, the scan plane changes as determined by the 
increments set in the Movement tools millimeter and degree text boxes. The 
location of the cursor on the image determines the direction of movement 
when that tool is used at that point on the image.

When the Step mode is active, you can click and hold and an on-image 
counter displays. The display indicates the millimeter or degree of the scan 
plane change that takes place as long as the mouse button is held down. 
The counter display increases until the mouse button is released. When the 
mouse button is released, the value on the counter is the change applied to 
the real time image. The scan plane change depends on the active 
Movement tool when the mouse button was depressed. 

In Step mode, the cursor indicates the direction of movement, but 
movement direction changes depending on the location of the cursor in the 
Main Viewer. 

The Pan and Tilt tools divide the Main Viewer into 12 zones (Figure 18-7), 
numbered clockwise from 1 to 12. Each area corresponds to a different 
movement direction, depending on which tool is selected. Placing the 
cursor in the viewer and clicking shows location of the cursor at the time the 
mouse button was clicked. It also determines the movement for that zone 
and the cursor reflects the direction of that movement.
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Figure 18-7 Control Zones and Location of Scan Controls

The Rotate tool divides the Main Viewer vertically into two zones. The 
cursor indicates the direction of movement. Clicking the cursor in the right 
half of the viewer results in clockwise movement. Clicking in the left half of 
the viewer results in counter-clockwise movement. 

Translate divides the Main viewer horizontally into two zones. The cursor 
indicates the direction of movement. Clicking the cursor in the upper half of 
the viewer results in movement away from you. Clicking in the lower half of 
the viewer results in movement toward you. 

NOTE: When in Step mode, using the right mouse button to initiate the 
on-image tools results in the opposite effect of using the left mouse 
button.

Orientation Tools
The orientation tools (Figure 18-8) quickly move the real time image to the 
specified orthogonal orientation.

Figure 18-8 Orientation Tools
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For example, when the [Axial] button is clicked, the real time imaging plane 
moves to the axial plane at the current image center point. The [Normal] 
button moves the real time image to a normal viewing orientation at the 
current image center point. The image is presented such that RAS 
coordinates are in their "normal" positions in the viewer. 

Contrast Tools
The Contrast tools (Figure 18-9) allow you to interactively make tissue 
contrast changes to the real time image. These tools apply tissue-specific 
techniques and are selected by either a push button or a toggle button. The 
Contrast tools available are based on the pulse sequence. 

Figure 18-9 Contrast Tools

Table 18-3 lists the Contrast tools and provides a description of each. 

Table 18-3 Contrast Tools

Contrast Tool Description

[IR]
Available with FGRE. The IR single-shot inversion 
recovery pulse is applied once with the push button and 
an image is acquired with the IR pulse. The image then 
returns to its pre-IR pulse contrast. 

[SAT]

Available with FGRE. Applies spatial saturation (SAT) 
slabs in the slice-select direction. The slabs are 
automatically concatenated and track the real time 
image plane. SAT is a toggle button and remains on until 
it is turned off.

[FatSAT]
Available with FGRE. Fat suppression can be used to 
null the signal from fat. FatSAT is a toggle button and 
remains on until it is turned off.

[SPGR]
Available with FGRE and Spiral sequences. A Gradient 
Echo sequence can be changed to a Spoiled Gradient 
Echo (RF spoiling) sequence. SPGR is a toggle button 
and remains on until it is turned off.

[FC]
Available with FGRE. Flow Compensation (FC) is used 
for gradient moment nulling to decrease flow artifacts. 
FC is a toggle button that remains on until it is turned off.

[SS] Spectral Spatial (SS) is not currently available for any 
pulse sequence. 
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There are several factors you should consider when using the Contrast 
tools:
• In FGRE sequences with Real Time, FC and SAT selections (Fat 

Suppression and Spatial SAT) can be made from the SAT screen during 
series prescription. The corresponding button is depressed when the 
Acquire tab opens. These options can be turned on and off at the 
Acquire tab during real time data acquisition.

• SAT is applied in the slice select direction, and when SAT is turned on at 
the SAT screen, only SAT pulses in the slice-select direction are 
allowed. 

• The Contrast tools are NOT available for FGRET Real Time 
(FGRET-RT) sequences. However, FC and Fat SAT can be selected 
during series prescription. They cannot be turned off at the Acquire tab. 

• Only SPGR is available for Real Time Spiral sequences. Spectral 
Spatial RF (SSRF) or Fat SAT can be used with Real Time Spiral, but 
they must be selected during series prescription and they cannot be 
turned off or on at the Acquire tab. 

Graphic Tools
The Graphic tools provide a means by which you can define a new real time 
image location by graphically prescribing cut planes through the imaging 
volume. The Graphic tools available are: Center, Draw Line, 2 Point Tool, 
and 3 Point Tool (Figure 18-10).

Figure 18-10 Graphic Tools

Center

Center changes the FOV center of the real time image to the location of a 
cursor placed on the real time image. This can be accomplished by 
selecting the [Center] button, placing the cursor on the new FOV center, 
and clicking the left mouse button to deposit the cursor. The real time image 
updates to reflect a FOV center at the point of the cursor. Once the new 
FOV center is defined, the Center tool turns off automatically. 

Draw Line 

Draw Line is used to define a new acquisition plane by drawing a line on the 
current real time image in the Main Viewer or on the scout image. Draw Line 
can also be used to define a stack in Multi-slice mode.
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If no scout image has been defined, clicking the [Draw Line] button 
automatically deposits a line on the real time image in the Main Viewer. If a 
scout image has been defined, the cursor must be placed on either the 
scout or real time image, followed by a left click on the mouse. The line is 
deposited at the center of the image. Figure 18-11 illustrates a line defining 
the scan plane that runs along the optic nerve. The image plane becomes 
the plane defined by the line. 

Figure 18-11 Draw Line Defining a Scan Plane

There are three applications for the Draw Line tool.
• Draw Line for the real time image Main Viewer
• Draw Line for the Scout Viewer
• Draw Line for Multi-slice Mode

Draw Line for the real time image Main Viewer draws a line onto the real 
time image to implement a change to the real time scan plane and acquires 
an image at the plane of that line. The line (Figure 18-12) deposited on the 
image is not an indicator of the selected FOV.

Figure 18-12 Real Time Image Main Viewer Line Tool

The line has three handles that are used to adjust the location and obliquity 
of the line.
• The middle handle (the crosshair) is used to drag the line in horizontal 

and vertical directions.
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• Two circles, one towards each end of the line, are used to rotate the 
line.

Once the line has been adjusted, the [GO] button is selected in the Main 
Viewer to initiate the scan plane change. Alternately, right-click anywhere 
on the real time image in the Main or Scout Viewer to initiate the scan plane 
change. 

Draw Line for the Scout Viewer is used to prescribe a real time scan plane 
orthogonal to the current scout image. With Draw Line selected, clicking the 
Scout Viewer displays a line. The real time scan plane moves to that 
location. The line (Figure 18-12) displays and operates the same as the line 
tool for the real time image Main Viewer. 

The line handles are used to position the line segment at the desired 
location on the Scout Viewer. The real time Main Viewer tracks the position 
of the line and updates the real time image as the line is adjusted. Draw 
Line remains active until it has been toggled off, another graphic tool is 
clicked, or a click is performed on the real time image in the Main Viewer.

When the Stack box is checked, the Multi-slice mode is enabled. Multi-slice 
mode is used to visualize the extent of a multiple slice (stack) acquisition. 

In the Multi-slice mode, Draw Line can be used on the Main Viewer real 
time image or in the Scout Viewer. When a line is dropped on an image, two 
additional line segments are displayed (smaller than the main line). The 
small line segment with the two notches at either end designates the first 
slice in the stack. The second small line segment indicates the last location 
in the stack. The mm text box to the right of the Stack check box 
determines the distance between the two small line segments in 
millimeters.

2 Point Tool

The 2 Point tool allows you to define an acquisition plane by depositing two 
points on the current real time image or on two different real time images. 
The on-image Movement tools are used to navigate the real time image to 
deposit a point on a second image. The plane resulting from the two points 
is positioned midway between the points, and perpendicular to the line 
defined by the points. Figure 18-13 illustrates the 2 Point tool defining the 
scan plane perpendicular to the optic nerve. The optic nerve will be viewed 
on end in the resulting image of this example. 
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Figure 18-13 2 Point Tool Defining a Scan Plane

3 Point Tool

The 3 Point tool allows you to define an acquisition scan plane by 
depositing three points at selected locations on one, two, or three images. 
The on-image Movement tools are used to navigate the real time image to 
deposit a point on a second or third image. The plane resulting from these 
three points contains all three points. The 3 Point tool is typically used with 
complex anatomy that requires you to work with multiple images in a 
prescription. Figure 18-14 illustrates the 3 Point tool defining a scan plane 
along the thoracic aorta. 

Figure 18-14 3 Point Tool Defining a Scan Plane

Parameter Tools
The FOV, slice thickness, flip angle, and number of averages can be 
changed interactively from the Acquire tab in iDrive Pro Plus for RTCAs. 
The RTCA Parameter tools (Figure 18-15) available depend on the selected 
pulse sequence. 

Upon entering the Acquire tab, these parameters are set to the values 
prescribed at the Scan Rx desktop. The sliders can be used to make the 
change or a value can be entered in the text boxes. 
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Figure 18-15 RTCA Parameter Tools

Each parameter can be changed within the limits described in Table 18-4. If 
you enter a value that exceeds either the minimum or maximum allowed 
value, a default entry is made automatically. The default entry is either the 
minimum or maximum value, whichever is closer to the value you entered. 

Table 18-4 RTCA Parameter Tool Limits

Parameter 
Tool Limits

FOV

The FOV can be changed to a minimum of 50% and a 
maximum of 150% of the prescribed value. The change 
cannot exceed the minimum and maximum values 
based on the pulse sequence, series prescription, and 
system limitations. The slider and text box are based on 
millimeter changes (not centimeter) and when the slider 
is moved, changes occur in 10 mm increments. The 
FOV slider is not available for FGRET-RT.

Slice 
Thickness

The slice thickness can be changed to a minimum of 
50% and a maximum of 150% of the prescribed value. 
The change cannot exceed the minimum and maximum 
values based on the pulse sequence, series prescription 
and system limitations.The slider changes the slice 
thickness in increments of 0.1 mm.

Flip Angle

The flip angle can be altered to 50% above and below 
the prescribed value. The flip angle cannot exceed the 
minimum and maximum values as determined by the 
pulse sequence. The slider changes the flip angle in 
increments of 1°.
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Graphic Prescription Tools
iDrive Graphic Prescription (IGRx) tools can be used to:
• Save start and end locations that can then be acquired at a later time in 

the real time session.
• Apply start and end locations that have been scanned and saved to the 

IGRx tools area during a real time session. 
– These locations can be applied to a series in the Rx Manager. 

• Retrieve the start and end locations from a series (2D, 3D or Real Time) 
in the Rx Manager that can then be acquired at a later time in the real 
time session.

• Apply the center of a stack to a series in the Rx Manager. 
– The stack center is used by the series to determine the start and end 

locations based on the coordinates of the stack center and the slice 
thickness and spacing of the series.   

• Retrieve the center location of a 3D series to be used in the current real 
time session.

NOTE: The series you wish to prescribe must be downloaded in the Rx 
Manager and highlighted prior to starting the RTCA.

Two methods of defining imaging locations can be performed, prescribing 
the start and end locations and prescribing the center location. It is not 
possible to retrieve slice locations from an Rx Manager series in which the 
slice locations have been graphically prescribed. Attempting to enter the 
Graphic Rx screen of a series in which a RTCA was used to apply locations 
results in the locations erasing.

Average

The average value defines the number of reconstructed 
images that are averaged to create one real time image 
for each new scan plane. As averages increase, SNR 
increases and the frame rate may decrease due to a 
decrease in reconstruction time. Note that this is not the 
same as Number of Excitations (NEX). The allowable 
range for image averaging is one to eight. One means 
that image averaging will not be performed. The value 
steps in increments of one. Image averaging occurs as 
long as the interactive scan plane and contrast settings 
are not changed.

Parameter 
Tool Limits (Continued)
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Prescribing Start and End Locations

When the [Rx Start/End] button is clicked, the IGRx tools (Figure 18-16) 
allow image locations to be defined from a start and end perspective. The 
start and end locations displayed are the RAS coordinates of the center 
point of the image.

Figure 18-16 RTCA IGRx Tools

Table 18-5 lists the tools available in IGRx for RTCAs and a description of 
each. 

Table 18-5 RTCA IGRx Tools and Descriptions

 IGRx Tool Description
[Rx Start/End] Accesses the IGRx tools in the Rx Start/End mode. 

[Rx Center] Changes the IGRx tools area to the Rx Center 
mode.

[Set Start]
Saves the current position of the real time image as 
the first location of another series or to be used to 
acquire a real time image at that location. The saved 
start coordinates are displayed.

[Set End]
Saves the current position of the real time image as 
the last location of another series or to be used to 
acquire a real time image at that location. The saved 
end coordinates are displayed.
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When defining locations using the IGRx tools, consider the following:
• The start and end locations can be redefined by clicking the [Set Start] 

and [Set End] buttons. If the start and end locations have been defined 
and one of the buttons is clicked to redefine a location, the other 
location responds in one of the following fashions.
– If the plane of the new location and the old location remain parallel, 

the old location remains as defined.
– If the plane of the new location and the plane of the old location are 

consistent, the old location is deleted. A message posts to notify you 
of this action.

• Start and end locations can be the same location. This may be done 
when the locations are to be applied to a real time series in the Rx 
Manager.

• When using the [Apply Locations] button, the applied start and end 
locations may be rejected if the plane of the start and end locations do 
not match the plane of the series to which they are being applied. For 
example, locations can be applied oblique to oblique, axial to axial, etc. 
An error message posts if an incompatibility exists. 

• If the number of slice locations being applied (when using Apply 
Locations) exceeds the maximum number of acquisitions for the 

[Acquire at Start]
Prompts iDrive to scan an image at the locations 
defined by the [Set Start] button. This button is 
unavailable if a start location has not been defined.

[Acquire at End]
Prompts iDrive to scan an image at the locations 
defined by the [Set End] button. This button is 
unavailable if an end location has not been defined.

[Apply 
Locations]

Sends the current Start/End locations to the 
currently highlighted series in the Rx Manager. 
These locations become the prescribed slice 
locations for that series. Slice locations already 
prescribed are overwritten. 

[Retrieve 
Locations]

Pulls the start and end slice locations from a series 
in the Rx Manager. The RAS coordinates of the 
start/end locations are displayed below the [Set 
Start] and [Set End] buttons in the IGRx tools area. 
These locations can then be used to obtain real time 
images at those locations. If the currently selected 
series has no prescribed start and end locations, the 
locations become (or remain) undefined.

[Save Series] Saves the prescribed series in the Rx Manager. The 
series is then labeled as RXD in the Rx Manager.

 IGRx Tool Description (Continued)
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selected series in the RX Manager, an error message results stating, 
“Scn: Incompatible Scan Range. Apply Ignored.”

• When using the [Retrieve Locations] button, if the Rx Manager series 
does not contain prescribed slices, the start and end coordinates remain 
clear.

Prescribing Center Locations

When the [Rx Center] button is selected during a RTCA, the IGRx tools 
allow image locations to be defined from a center of the stack perspective.

Figure 18-17 RTCA Center IGRx Tools

Table 18-6 lists the tools available in Center IGRx and a description of each. 

Table 18-6 RTCA Center Tools and Descriptions

Center IGRx 
Tool Description

[Rx Start/End] Changes the IGRx tools area to the Rx Start/End 
mode. 

[Rx Center] Accesses the Rx Center IGRx tools.

[Set Center]

Saves the current position of the real time image for 
use as the center location for a series in the Rx 
Manager, or to be used to acquire a real time image 
at that location. The coordinates are displayed and 
the current stack value is entered as the Stack 
Thickness on the IGRx tools area.
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When defining locations using the Center IGRx tools in RTCAs, consider 
the following:
• By convention, when the center slice and stack thickness are used to 

define locations, the start location in that stack is the location nearest 
you in the real time viewer. The end location in the stack is the furthest 
away form you. 

• It is possible for a stack to be applied to a series in the Rx Manager and 
a double acquisition results for that series. For example, the series slice 
thickness is 5 mm, spacing is 1 mm, and the maximum number of 
locations per acquisitions is 11. If the applied stack is 80 mm thick, a 
double acquisition is required to scan the entire stack. The series can 
only acquire 66 mm in a single acquisition. 

Review Tab
The Review tab is used to view and save real time images residing in the 
Image Buffer. Viewing images can be done in a cine-style, movie mode, or a 
single image at a time. The defined image range determines the images 
available to be viewed.

[Set Thickness]

Allows you to change the stack thickness after the 
[Set Center] button has been clicked. Enter a new 
value in the Stack text box and click the [Set 
Thickness] button. The stack value currently in the 
Stack text box is entered as the Stack Thickness in 
the IGRx tools area.

[Acquire 
Center]

Obtains a real time image at the location displayed in 
the Rx Center tools area.

[Apply 
Locations]

Sends the stack locations to the currently highlighted 
series in the Rx Manager. These locations become 
the prescribed slice locations for that series. Slice 
locations already prescribed are overwritten.

[Retrieve 
Locations]

Pulls the slice locations from a series in the Rx 
Manager. The center slice of the series is used as the 
center of the stack and the thickness is based on the 
start/end locations of the series. The center location 
and thickness are displayed in the IGRx tools area 
and can be used to obtain real time images at those 
locations.

[Save Series] Saves the prescribed series in the Rx Manager. The 
series is labeled “RXD” in the Rx Manager. 

Center IGRx 
Tool Description (Continued)
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Clicking the Review tab on the lower left corner of the Acquire tab accesses 
the Review tab. The Review tab takes longer to open as the Image Buffer 
becomes more full. If the Review tab is clicked while data acquisition is 
taking place, scanning pauses. When the Review tab (Figure 18-18) opens, 
the image displayed is the last image displayed in the Main Viewer on the 
Acquire tab. 

Figure 18-18 RTCA Review Tab

Table 18-7 provides a description and acceptable values for each selection 
on the Review tab in iDrive Pro Plus for RTCAs.

Table 18-7 RTCA Review Tab Selections and Descriptions

Selection Description

[Delete 
Bookmarks]

Deletes all bookmark thumbnails currently 
displayed. Note that bookmarks created on the 
Acquire tab are shown on the Review tab. Individual 
bookmarks cannot be deleted.
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[Add Bookmarks]

The plane, location, and image contrast of the 
image currently in the Review tab viewer is saved 
as a bookmark thumbnail for later recall. 
Bookmarks can be created and deleted in both the 
Acquire and Review tabs.

[Define Scout]
Copies the image in the Main Viewer to the Scout 
Viewer (the viewer directly under the [Define 
Scout] button). The new scout is also applied to the 
Scout Viewer on the Acquire tab. 

[Define New 
Home] Inactive on the Review tab.

[Pause When 
Full]

Automatically pauses the real time data acquisition 
when the real time image buffer is full. The progress 
bar provides a graphic display of the image buffer 
capacity. 

[Save Image]
Saves the image in the Review tab Main Viewer to 
the system disk. When a saved image is displayed, 
the word “Saved” is seen below this button.

Image Slider Allows you to move through the images to change 
the image currently displayed in the viewer. 

Play Back Button: 
Play Forward

Starts a movie in a forward play motion. The images 
are displayed in movie playback in ascending 
image number order, starting at the first image in 
the defined range. The Image Slider updates to 
reflect the image that is currently being viewed.

Play Back Button:
Stop Play Stops the movie playback. You can also stop 

playback by pressing the selected toggle that 
started play.

Play Back Button: 
Play Backward

Starts a movie in a backward play motion. The 
images are displayed in movie playback in 
descending image number order, starting at the last 
image number defined in the image range. Play 
continues according to the temporal or spatial play 
mode selected. 

[Temporal]

Plays the movie images in a continuous loop from 
first to last. When the end of the range is reached, 
play wraps to the first image again. For example, an 
image set consisting of four images appears in the 
following order: 1, 2, 3, 4, 1, 2, 3, 4, etc.

Selection Description (Continued)
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[Spatial]

Plays the movie images forward, then backward in 
a repeating loop. Image play effectively "bounces" 
off the end of the range in a forward and backward 
direction. For example, an image consisting of four 
images appears in the following order:1, 2, 3, 4, 3, 
2, 1, etc.

FPS
Frames per Second (FPS) defines the rate of movie 
playback. The valid range is 1 to 60 FPS. If you 
enter a value higher than the system allows, the 
maximum allowed value of 60 is displayed.

[Set Range First]
Defines the first image to be included in a range for 
saving, or set of images for displaying in movie 
mode. 

[Set Range Last]
Defines the last image to be included in a range for 
saving, or set of images for displaying in movie 
mode. 

[Full Annotation] Displays all image annotation in the main viewer. 
Otherwise, only partial annotation is displayed.

[Measure 
Distance]

Displays a line on the main image. The length and 
angle of the line can be adjusted by dragging either 
end. You can change the line location by clicking 
and dragging anywhere, other than the ends of the 
line. The line length and angle from vertical is 
displayed on the image.

[Save Range]

Saves the range of images defined on the Review 
tab to the system disk. As the images are being 
saved, a status box displays, counting down the 
number of images yet to be saved. You can cancel 
the save during the save operation. When a saved 
image is displayed in the Main Viewer, the word 
"Saved" is seen below the [Save Image] button.

[Acquire at 
Current]

Returns the display to the iDrive Acquire tab and 
begins data acquisition at the image location 
currently displayed in the Review tab Main Viewer. 

[Acquire] Returns the display to the iDrive Acquire tab. 

Message Area Displays messages at the bottom of the Review tab. 
Click the button to display a list of messages for the 
current real time session.

[Close] Exits the Review tab, stops the current real time 
session, and returns to the Scan Rx desktop. 

Selection Description (Continued)
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Review Images
Real time images are not automatically saved to the system disk. The 
[Save Image] button is used to save a single 128x128 image to the disk 
when that image is displayed in the Acquire tab Main Viewer, or via the 
[Save Image] or [Save Range] buttons on the Review tab. When a saved 
image is displayed in the Review tab, the word "Saved" is seen below the 
[Save Image] button. This is not true when displaying images in the Acquire 
tab.

Bookmarks in the Review tab cannot be used to initiate data acquisition as 
can be done in the Acquire tab.

Annotation on the real time image indicates the parameters with which that 
image was acquired, including those parameters changed at the Acquire 
tab. Partial annotation (Table 18-8) is displayed, unless you click the [Full 
Annotation] button. 

Table 18-8 Partial Annotation Selections

Image Slider
Images currently in the real time Image Buffer can be displayed using the 
Image Slider (Figure 18-19). The Image Slider is set to the number of the 
last real time image acquired before pausing. The image displayed on the 
viewer is the same image. The Image Slider can define or redefine the 
image range that is used for saving or playing real time images. 

Figure 18-19 Image Slider

There are four ways to move through the images in the Review tab and 
select an image number for display.

Partial Annotation Selections
System

Hospital

Time

Magnification, Filtering, and Rotation Factors

PSD

Sequence Parameters

Slice Thickness and Spacing 
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• Dragging the slider. 
– As the slider moves, the image in the viewer updates to the image on 

the slider.
• Clicking the arrows at either end of the slider.
• Clicking the slider background.

– This displays the image associated with that point on the slider.
• Pressing the Page Up and Page Down hard keys on the keyboard.

Within Review, the operations of playing and saving images are applied to a 
single defined range of images within the image buffer. The number of the 
image currently shown in the viewer is labeled above the slider, as well as, 
on the image. At both ends of the slider the range of images is also 
displayed. Upon entering the Review tab, the range of images indicates all 
the images in the buffer. The image numbers shown indicate how many 
images have been acquired during the real time session; therefore, they 
may be numbered in the hundreds or thousands. 

The background of the slider is shaded to indicate the range of images 
defined by the Set Range buttons. Initially, the background is completely 
shaded. If the range of images is changed, only the area of the slider 
associated with the image range is shaded. If an attempt is made to set the 
first image in the range to a value greater than the currently defined last 
image in the range, the first and last images are swapped.

Applications 
The RTCA application consists of a continuous high-temporal-resolution 
acquisition, reconstruction, and display of low spatial resolution images. 
This allows you to instantaneously view anatomy and interactively make 
contrast adjustments and prescribe scan planes. Real time imaging works 
well to monitor temporal physiological events.

Use real time imaging to:
• Navigate through patient anatomy for orientation to “scope out the lay of 

the land.”
• Rapidly localize anatomical landmarks of interest.
• Define the boundaries of an imaging volume.
• Localize complex anatomy or anatomical anomalies that lie in double 

oblique planes. 
• Monitor temporal events such as the passage of a contrast timing bolus.
• Image dynamic joint studies. 
• Know what the scan looks like before investing the scan time.
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Troubleshooting Tips
The following section gives you tips for troubleshooting errors when 
scanning RTCAs with iDrive Pro Plus. 

If you click the [Scan] button too quickly following pressing the Stop Scan 
hard key and closing the RTCA interface, iDrive is not prepared to begin 
data acquisition. An error message posts, “Prep action failed, please try 
again.”

For example, the following scenario may result in the failure to start a real 
time data acquisition.

1. A real time acquisition is paused by selecting the [Pause Scan] button 
at the Acquire tab.

2. The Stop Scan hard key on the keyboard is pressed.

3. The [Close] button is selected at the Acquire tab and the real time 
interface closes. 

4. The [Scan] button is clicked at the Scan Rx desktop quickly after the 
real time interface closes. 

At this time, the real time data acquisition should be initiated. Instead, the 
error message posts because iDrive is not ready to begin the data 
acquisition.

Error messages posted in the message log also include:
• Proc: scn Error: XXXXXXXXXX
• Unexpected allocDone packet received from IFCC for sequence 

number XX. Proc: NSP Error: XXXXXXXXXX
• An unexpected CERD Network packet was received by ASC Data 

Acquisition during acquisition. 
• Internal software error, please retry the acquisition!

Should it be necessary for you to stop a scan and close iDrive as stated in 
the steps above, it is recommended the real time series be copied and 
pasted and the data acquisition be started from the new series. 
Alternatively, wait a period of time before selecting the [Scan] button and 
re-starting the real time acquisition. The exact amount of time needed for 
iDrive to be ready is not known. It is recommended that you wait at least five 
seconds before restarting the acquisition. 
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How Do I...
This section provides the step-by-step instructions for imaging real time with 
iDrive Pro Plus. Specifically, it describes how to:
• Prescribe a real time sequence 
• Use the Movement tools

– Drive through an image volume
– Step through an image volume

• Manage Home Images
– Define a scan plane 
– Define new Home Images

• Manage Bookmarks
– Create a Bookmark
– Recall a Bookmark
– Enlarge a thumbnail to apply for scanning

• Use the Graphic tools
– Change the FOV center
– Draw a line in the Main Viewer
– Draw a line in the Scout Viewer
– Draw a line in the Multi-slice Mode
– Apply the 2 Point tool
– Apply the 3 Point tool

• Review real time images
– Playback images
– Save images
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Prescribe a Real Time Sequence 
The Real Time Imaging Option can be used for RTCAs to 
navigate through your patient’s anatomy for rapid visualization 
and monitoring of temporal physiological events. Real time 
images can also be used for directly prescribing scan planes of 
other series in the exam.

Use this procedure to prescribe a real time sequence. The PSD 
you select determines which values in each area need entered. 
You need to enter a value in all active fields.

1. Click [New Series].
Located in the Rx Manager.

2. Enter the Patient Position parameters. 

Patient Position

Patient Entry

Coil

– Real Time is compatible with all coils. The use of a 
phased array coil may decrease the frame rate as 
compared to a single receive coil.

Series Description

3. Enter the Imaging Parameters.

Plane 

– Real Time can be initiated in any orthogonal plane. 
Oblique planes may be prescribed using an explicit 
coordinate entry or from localizer images using 
Graphic Rx tools.

Mode 

– 2D is the only valid mode with Real Time. 

Gradient Mode 

– Real Time is compatible with any gradient mode.

Pulse Sequence

– PSDs available with iDrive Pro Plus: Fast GRE, Fast 
SPGR, Fast GRE ET, Spiral GRE, and Spiral SPGR

Quick Steps: Prescribe a 
Real Time Sequence
1. Click [New Series].
2. Enter the Patient Position 

parameters.

3. Enter the Imaging 
Parameters.

4. Enter the Scan Timing 
parameters. 

5. Enter the Scanning 
Range parameters. 

6. Enter the Acquisition 
Timing parameters. 

7. Click [Save Series].
8. Click [Prepare to Scan].
9. Click [Scan].
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Imaging Options

– Real Time must be selected to enter the feature. 

– Other compatible options are Flow Compensation and 
No Phase Wrap.

4. Enter the Scan Timing parameters.

TE 

TR 

Flip Angle

Echo Train Length 

Bandwidth 

5. Enter the Scanning Range parameters. 

FOV

Slice Thickness

– This value can be changed during iDrive Pro Plus 
data acquisitions. 

Start and End Locations

– Only one slice location is allowed for real time 
sequences. 

6. Enter the Acquisition Timing parameters. 

Frequency Matrix or Points

Phase Matrix or Arms

Phase FOV

Freq DIR 

Auto Center Frequency

7. Click [Save Series]. 
Closes the scan prescription screen, accepts the 
prescription, and saves it in the Rx Manager as RXD.

8. Click [Prepare to Scan]. 
Downloads the series. 

9. Click [Scan]. 
Initiates Auto Prescan and the Acquire tab opens. 

Home Images are acquired. 
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Use the Movement Tools
Drive Through an Image Volume
The scan plane of your RTCA can be manipulated and you can 
navigate through an image volume using the Movement tools. 
Each Movement tool is activated by an on-image icon on the 
real time Main Viewer. RTCAs begin in the Drive mode with the 
Translate tool active. 

1. Move the mouse over the real time image in the Main 
Viewer until the cursor changes shape.

2. Click in Tool Selection area of desired tool. 

Cursor icon indicates the function of the tool.

3. Click and drag on the real time image in the Main Viewer.

Your cursor indicates the direction of movement by 
displaying the icon associated with that tool accessed in 
that corner and the image moves in the direction of the 
cursor.

The extent of movement is annotated in the lower-right 
corner of the real time image.

a) Move the cursor to the upper-left corner.

– Activates the Pan tool to scroll the image in the X and 
Y directions.

b) Move the cursor to the upper-right corner.

– Activates the Rotate tool to turn the image in a 
clockwise or counter-clockwise motion.

c) Move the cursor in the lower-left corner.

– Activates the Tilt tool to roll the image in the direction 
of the arrow on the cursor.

d) Move the cursor in the lower-right corner.

– Activates the Translate tool to oblique the image 
along the Z axis, tilting the image away from you.

4. Release the mouse button.

The scan plane of the real time image updates.

NOTE: Click [Undo] to cancel the location changes all the way 
back to the start of motion, at the last mouse click.

Quick Steps: Drive 
Through an Image Volume
1. Move the mouse over the 

real time image in the 
Main Viewer until the 
cursor changes shape.

2. Click in Tool Selection 
area of desired tool.

3. Click and drag on the real 
time image in the Main 
Viewer.

4. Release the mouse 
button.
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Use the Movement Tools
Step Through an Image Volume
The scan plane can also be manipulated using the Movement 
tools accessed in the Step mode for RTCAs. In the Step mode, 
the cursor indicates the direction of movement, but movement 
direction changes depending on the location of the cursor in the 
Main Viewer. 

1. Click [Step].
Your cursor location determines the direction of 
movement.

Movement direction changes when a specific tool is used 
at that point on the image.

2. Click in Tool Selection area of desired tool.

Cursor indicates direction of motion that will be induced.

Control Zones and Location of Scan Controls

3. Click and hold on the real time image in the Main Viewer.

An on-image counter displays, indicating the millimeters 
or degrees of the scan plane change that takes place as 
long as the mouse button is held down.

a) Click one of the twelve zones on the image in the Main 
Viewer.

– Activates the Pan and Tilt tools to move the image in 
the X and Y directions based on the value in the mm 
or the degrees text box, respectively.

Quick Steps: Step 
Through an Image Volume
1. Click [Step].
2. Click in Tool Selection 

area of desired tool.

3. Click and hold on the real 
time image in the Main 
Viewer.

4. Release the mouse 
button.
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b) Click in the right-half of the Main Viewer to move 
clockwise or in the left-half to move counter-clockwise.

– Activates the Rotate tool to turn the image based on 
the value set in the degrees text box. 

c) Click in the upper-half of the Main Viewer to move the 
image away from you or in the lower-half to move the 
image towards you.

– Activates the Translate tool to oblique the image 
along the Z axis, moving the image away or towards 
you based on the value set in the mm text box. 

4. Release the mouse button.

Applies the value on the counter to move the scan plane 
of the real time image that amount.

The scan plane of the real time image updates.

NOTE: Click [Undo] to cancel the location changes all the way 
back to last mouse click.
2333956-100 Rev. 0 (06/02)  18-39
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
Manage HomHome Manage Home Images
Define a Scan Plane 
Home Images are the three orthogonal images acquired upon 
initialization of a real time series that are displayed in the 
vertical viewers along the right side of the Acquire tab Main 
Viewer. The Home Images are created axially, sagittally, and 
coronally, based on the locations prescribed at the Scan Rx 
desktop during the real time series prescription. These images 
can be used to define an orthogonal scan plane and reset your 
current scan plane. 

Use this procedure to define a scan plane based on the Home 
Images. 

1. Prescribe a real time sequence. 

2. Click [Scan].
Acquire tab opens.

Home Images are acquired.

3. Click one of the Home Images.

The system obtains a real time image in the scan plane 
of the selected Home Image.

Quick Steps: Define a 
Scan Plane
1. Prescribe a real time 

sequence. 

2. Click [Scan].
3. Click one of the Home 

Images.
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Manage Home ImagesManage Home Images
Define New Home Images
Home Images are the three orthogonal images acquired upon 
initialization of a real time series that are displayed in the 
vertical viewers along the right side of the Acquire tab Main 
Viewer. The Home Images are created axially, sagittally, and 
coronally, based on the locations prescribed at the Scan Rx 
desktop during the real time series prescription. You have the 
ability to define new Home Images.

Use this procedure to replace your Home Images with new 
images at the desired at the location of the current real time 
image.

1. Display the desired real time image in the Main Viewer.

Use the Movement tools, if necessary. 

2. Click [Define New Home].
Located at the top-right corner of the Acquire tab. 

The system informs you that if you define new Home 
Images, your current home locations will be replaced.

3. Click [OK].
The system acquires and displays three new Home 
Images.

– The images are perpendicular to the location of the 
real time image in the Main Viewer. 

– The images include the RAS offsets of the real time 
image in the Main Viewer. 

Quick Steps: Define New 
Home Images
1. Display the desired real 

time image in the Main 
Viewer.

2. Click [Define New 
Home].

3. Click [OK].
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Manage Bookmarks
Create a Bookmark
Real time images can be bookmarked to recall at a later time. A 
bookmarked thumbnail obtains the scan plane and image 
contrast from that image and stores it in the Bookmark Viewers. 

Use this procedure to create a Bookmark. 

1. Display the desired real time image in the Main Viewer.

Use the Movement Tools, if necessary.

2. Click [Add Bookmark].
Creates a bookmark thumbnail of the current image in 
the Main Viewer. 

NOTE: If all Thumbnail Viewers are filled, a message posts, 
telling you to right-click an occupied Bookmark to replace 
the thumbnail image with the current image in the Main 
Viewer. 

Quick Steps: Create a 
Bookmark
1. Display the desired real 

time image in the Main 
Viewer.

2. Click [Add Bookmark].
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Manage BookmarksManage Bookmarks
Recall a Bookmark 
A recall can be performed on a bookmark to obtain the scan 
plane and image contrast from that image. The bookmarks are 
held in the Acquire tab when the current real time session is 
closed and upon re-entry into the RTCA, those bookmark 
thumbnails are displayed as long as the Patient ID, Landmark, 
and Patient Position have not changed. 

Use this procedure to recall a Bookmark. 

1. Click [Scan].
Acquire tab opens.

2. Click the desired bookmark thumbnail image. 

The system scans the new image based on the scan 
plane and image contrast of the thumbnail image. 

Quick Steps: Recall a 
Bookmark
1. Click [Scan].
2. Click the desired 

bookmark thumbnail 
image. 
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Manage Bookmarks Manage Bookmarks
Enlarge a Thumbnail to Apply for 
Scan
A single bookmark thumbnail image acquired during a RTCA 
with iDrive Pro Plus can be enlarged from a 64x64 to 128x128 
pixel display. This enlarged thumbnail can be applied for 
scanning in the real time Main Viewer.

Use this procedure, while the Acquire tab is opened, to enlarge 
a bookmark thumbnail to apply for scanning.

1. Place cursor over desired thumbnail image.

Leave cursor over thumbnail for at least one second.

– The image enlarges. 

The thumbnail image returns to its original size when the 
cursor is moved off the Thumbnail Viewer.

2. Click the enlarged image. 

The system begins scanning the image. 

Quick Steps: Enlarge a 
Thumbnail to Apply for 
Scan
1. Place cursor over desired 

thumbnail image.

2. Click the enlarged image.
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Use the Graphic Tools
Change the FOV Center
The Graphic tools provide a means by which you can define a 
new real time image location. The Center tool in iDrive Pro Plus 
changes the FOV center of the real time image of a RTCA to a 
new location. This Graphic tool is located in the Tool area of the 
Acquire tab. 

Use this procedure to change the FOV center of the real time 
image to the location of a cursor placed on the real time image.

1. Display the desired real time image in the Main Viewer.

Use the Movement tools, if necessary.

2. Click [Center].

3. Place the cursor at the desired FOV center. 

This point will be the center of your new image location.

4. Click the real time image. 

Updates real time image to reflect the new FOV center at 
the point of the cursor. 

NOTE: The Center tool turns off automatically. 

Quick Steps: Change the 
FOV Center
1. Display the desired real 

time image in the Main 
Viewer.

2. Click [Center].
3. Place the cursor at the 

desired FOV center.

4. Click the real time image. 
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Use the Graphic Tools Use the Graphic Tools
Draw a Line in the Main Viewer
The Draw Line tool allows you to draw a line on the current real 
time image in the Main Viewer to acquire an image at the plane 
of the line. This Graphic tool is located in the Tool area of the 
Acquire tab.

Use this procedure to draw a line on the real time image in the 
Main Viewer to define a new scan plane.

1. Display the desired real time image in the Main Viewer.

Use the Movement tools, if necessary. 

2. Click [Draw Line].
A line appears on the image in the Main Viewer.

– If a line does not appear, click on the real time image.

Draw Line Tool

3. Move the line to the desired position.

Click and drag the middle handle of the line.

– Moves the line in the horizontal and vertical directions.

4. Rotate the line to the desired position.

Click and drag one of the circle handles of the line.

– Rotates the line clockwise or counter-clockwise. 

5. Click [GO].
Alternatively, you may right-click anywhere on the real 
time image. 

An image is acquired at the plane defined by the line. 

NOTE: Draw Line remains active until you toggle it off, click 
another Graphic tool, or a click on the Scout image. 

Quick Steps: Draw a Line 
in the Main Viewer
1. Display the desired real 

time image in the Main 
Viewer.

2. Click [Draw Line].
3. Move the line to the 

desired position.

4. Rotate the line to the 
desired position.

5. Click [GO].
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Use the Graphic Tools
Draw a Line in the Scout Viewer
The Draw Line tool for the Scout Viewer in iDrive Pro Plus 
allows you to prescribe a new acquisition plane orthogonal to 
the current Scout image. This Graphic tool is located in the Tool 
area of the Acquire tab.

Use this procedure to draw a line on the real time image in the 
Scout Viewer.

1. Display the desired real time image in the Main Viewer.

Use the Movement tools, if necessary. 

2. Click [Define Scout].
Copies the image in the Main Viewer to the Scout 
Viewer.

3. Click [Draw Line].

4. Click the image in the Scout Viewer.

A line appears on the image in the Scout Viewer.

The real time image scan plane moves to that location. 

5. Move the line to the desired position.

Click and drag the middle handle of the line.

– Moves the line in the horizontal and vertical directions.

– Updates the real time image to reflect changes.

6. Rotate the line to the desired position.

Click and drag one of the circle handles of the line.

– Rotates the line clockwise or counter-clockwise. 

– Updates the real time image to reflect changes.

NOTE: Draw Line remains active until you toggle it off, click 
another Graphic tool, or a click on the real time image in 
the Main Viewer. 

Quick Steps: Draw a Line 
in the Scout Viewer
1. Display the desired real 

time image in the Main 
Viewer.

2. Click [Define Scout].
3. Click [Draw Line].
4. Click the image in the 

Scout Viewer.

5. Move the line to the 
desired position.

6. Rotate the line to the 
desired position.
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Use the Graphic Tools Use the Graphic Tools
Draw a Line in the Multi-slice Mode
Multi-slice mode is used to visualize the extent of a multiple 
slice (stack) RTCA in iDrive Pro Plus. Drawing a line in the 
Multi-slice mode can be performed in the Main Viewer or in the 
Scout Viewer. This Graphic tool is located in the Tool area of the 
Acquire tab and the Stack option is located below the tools. 

Use this procedure to draw a line in the Multi-slice mode to 
visualize the distance of a multi-slice acquisition. 

1. Display the desired real time image in the Main Viewer.

Use the Movement tools, if necessary. 

2. Select Stack.

Enables Multi-slice mode.

3. Click [Draw Line].

4. Click the image in the Main or Scout Viewer.

A line appears on the real time image.

Two smaller line segments display (smaller than the 
main line).

– The small line segment with two notches at either end 
indicates the first slice in the stack.

– The second small line segment indicates the last 
location of the stack.

5. Enter a value in the mm text box. 

Acceptable values are 10 to 100.

This value determines the distance between the two 
small line segments. 

Quick Steps: Draw a Line 
in the Multi-Slice Mode
1. Display the desired real 

time image in the Main 
Viewer.

2. Select Stack.

3. Click [Draw Line].
4. Click the image in the 

Main or Scout Viewer.

5. Enter a value in the mm 
text box.
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Use the Graphic Tools
Apply the 2 Point Tool
The 2 Point Tool allows you to define an acquisition plane by 
depositing two points on the current real time image or on two 
different real time images. The plane resulting from the two 
points is positioned midway between the points and orthogonal 
to the line defined by the points. This Graphic tool is located in 
the Tool area of the Acquire tab. 

Use this procedure to define an acquisition plane perpendicular 
to a line deposited by two points. 

1. Display the desired real time image in the Main Viewer.

Use the Movement tools, if necessary.

2. Click [2 Point Tool].
Two toggle buttons appear.

– Point 1 (toggled on)

– Point 2

3. Place the cursor at the point you wish to deposit Point 1 on 
the real time image.

4. Click the real time image.

Deposits Point 1. 

Toggles the [Point 1] button off. 

– Clicking [Point 1] again allows the point to be 
repositioned. 

5. Navigate to the desired image plane for Point 2.

Use the Movement tools, if necessary.

6. Click [Point 2].

7. Place the cursor at the point you wish to deposit Point 2 on 
the real time image.

8. Click the real time image.

Deposits Point 2.

Acquires an image perpendicular to the line connecting 
the two points and displays the new image.

NOTE: The 2 Point Tool turns off automatically. 

Quick Steps: Apply the 2 
Point Tool
1. Display the desired real 

time image in the Main 
Viewer.

2. Click [2 Point Tool].
3. Place the cursor at the 

point you wish to deposit 
Point 1 on the real time 
image.

4. Click the real time image.

5. Navigate to the desired 
image plane for Point 2.

6. Click [Point 2].
7. Place the cursor at the 

point you wish to deposit 
Point 2 on the real time 
image.

8. Click the real time image.
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Use the Graphic Tools
Apply the 3 Point Tool
The 3 Point Tool allows you to define an acquisition scan plane 
by depositing three points at selected locations on one, two, or 
three images. The image plane resulting from these three 
points contains all three points. This Graphic tool is located in 
the Tool area of the Acquire tab.

Use this procedure to define a cut plane when you need to use 
more than one image location and you want an image plane 
along the plane defined by the points.

1. Display the desired real time image in the Main Viewer.

Use the Movement tools, if necessary.

2. Click [3 Point Tool].
Three toggle buttons appear.

– Point 1 (toggled on)

– Point 2

– Point 3

3. Place the cursor at the point you wish to deposit Point 1 on 
the real time image.

4. Click the real time image.

Deposits Point 1. 

Toggles the [Point 1] button off. 

– Clicking [Point 1] again allows the point to be 
repositioned. 

5. Navigate to the desired image plane for Point 2.

Use the Movement tools, if necessary.

6. Click [Point 2].

7. Place the cursor at the point you wish to deposit Point 2 on 
the real time image.

8. Click the real time image.

Deposits Point 2.

Toggles the [Point 2] button off. 

– Clicking [Point 2] again allows the point to be 
repositioned. 

Quick Steps: Apply the 3 
Point Tool
1. Display the desired real 

time image in the Main 
Viewer.

2. Click [3 Point Tool].
3. Place the cursor at the 

point you wish to deposit 
Point 1 on the real time 
image.

4. Click the real time image.

5. Navigate to the desired 
image plane for Point 2.

6. Click [Point 2].
7. Place the cursor at the 

point you wish to deposit 
Point 2 on the real time 
image.

8. Click the real time image.

9. Navigate to the desired 
image plane for Point 3.

10. Click [Point 3].
11. Place the cursor at the 

point you wish to deposit 
Point 3 on the real time 
image.

12. Click the real time image.
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9. Navigate to the desired image plane for Point 3.

Use the Movement tools, if necessary.

10. Click [Point 3].

11. Place the cursor at the point you wish to deposit Point 3 on 
the real time image.

12. Click the real time image.

Deposits Point 3.

Acquires and displays the new image.

NOTE: The 3 Point Tool turns off automatically. 
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Review Real Time Images
Playback Images
Real time images residing in the Image Buffer can be viewed in 
the Review tab. Images can be viewed cine-style, in a movie 
mode, or by a single image at a time. The Review tab is 
accessed on the lower left corner of the Acquire tab and can be 
opened while scanning is taking place.

Use this procedure to playback images in the Image Buffer. 

1. Click [Review].
Pauses scanning. 

Opens the Review tab. 

2. Define the range of images for movie playback.

All images in the buffer can be viewed. If this is desired, 
continue with step 3. 

a) Click and drag the Image Slider to the first image.

b) Click [Set Range First].
c) Click and drag the Image Slider to the last image.

d) Click [Set Range Last].

3. Select the movie mode.

Click [Temporal].
– Plays images in a continuous loop.

Click [Spatial].
– Plays images forward, then backward.

4. Enter a value in the FPS text box. 

Defines the rate of movie playback.

Valid entries are 1 to 60.

5. Click the Play Forward or the Play Backward icon.

Starts movie playback in ascending or descending order, 
respectively.

6. Click the Stop icon.

Stops movie playback.

At this point, another range of images can be defined. 

Quick Steps: Playback 
Images
1. Click [Review].
2. Define the range of 

images for movie 
playback.

3. Select the movie mode.

4. Enter a value in the FPS 
text box.

5. Click the Play Forward or 
the Play Backward icon.

6. Click the Stop icon.
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Review Real Time Images
Save Images
Real time images are not automatically saved to the system 
disk. Real time images residing in the Image Buffer can be 
saved in the Review tab. An image group or a single image can 
be saved at one time. The Review tab is accessed on the lower 
left corner of the Acquire tab and can be opened while scanning 
is taking place.

Use this procedure to save images in the Image Buffer. 

1. Click [Review].
Pauses scanning. 

Opens the Review tab. 

2. Define the range of images for saving.

All images in the buffer can be saved. If this is desired, 
continue with step 3. 

a) Click and drag the Image Slider to the first image.

b) Click [Set Range First].
c) Click and drag the Image Slider to the last image.

d) Click [Set Range Last].

3. Click [Save Range].
A confirmation message appears showing the number of 
images to be saved. 

Saves images to the Browser list.

Alternatively, images can be saved one at a time.

– Display images in the viewer.

– Click [Save Image].

Quick Steps: Save Images
1. Click [Review].
2. Define the range of 

images for saving.

3. Click [Save Range].
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Chapter 19

Spectroscopy FuncTool 2

Introduction
FuncTool 2 is a post processing tool used to display advanced level Magnetic 
Resonance Imaging (MRI) and Magnetic Resonance Spectroscopy (MRS) 
images. Specially designed algorithms programmed into FuncTool 2 protocols 
can be used to portray various pixel intensity settings.

This chapter describes example Spectroscopy post processing techniques. You 
must first acquire a Spectroscopy sequence in order to perform any of these post 
processing procedures. This chapter contains the step-by-step instructions to 
help you learn how to:
• Display Images and Spectrums
• Display Regions of Interest

In addition, this chapter answers the following questions:

1. What are the prostate algorithms?

2. What are the brain algorithms?

3. What type of image sets can be processed with FuncTool 2?
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What Do I Need to Know 
About...
This section presents the concepts necessary to successfully complete the 
FuncTool 2 post processing techniques with Spectroscopy image data. 
Specifically, you need to understand:
• FuncTool 2 Basics
• Valid Image Sets
• Predefined Algorithms

FuncTool 2 Basics
FuncTool 2 is an optional image analysis software package, that processes 
dynamic image data to generate information with regard to changes in 
image intensity over time in the form of graphs and parametric images.

Valid Image Sets
An MRS data set is an ordered acquisition with sequential changes in 
frequency. The horizontal scale of a graph for such a data set represent 
parts per million (ppm) values. PROstate Spectroscopy and imaging 
Examination (PROSE) and Single-voxel Proton Brain Examination 
(PROBE) sequences qualify as valid image data sets.

Predefined Algorithms
FuncTool 2 has predefined algorithms for your use to calculate the 
metabolite or metabolite ratio maps. Table 19-1 lists the protocols for the 
brain and prostate. 

Table 19-1 Predefined Brain and Prostate Algorithms

Brain Prostate
N-Acetyl Choline
Choline Creatine
Composite Creatine + Choline
Startup Choline/Creatine
Creatine Lipid and Lactate
Lactate Lipid Citrate
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A brief description of the predefined protocols are listed in Table 19-2.

Table 19-2 Protocols And Descriptions

Choline/Creatine Choline + Creatine/Citrate
Choline/N-Acetyl Composite Image

Signal Over Noise Ratio

Protocols Descriptions

Choline
Displays the averaged, absolute pixel 
values from CSI images 64 to 74 as a 
metabolite map.

Creatine
Displays the averaged, absolute pixel 
values from CSI images 78 to 88, as a 
metabolite map.

Creatine + Choline
Displays the sum of pixel values from 
PROSE images 66 to 85, as a metabolite 
map.

Choline/Creatine Displays a map of the ratio of the choline, 64 
to 74 region, to the creatine, 78 to 88 region.

Lipid and Lactate Displays the sum of pixel values from 
images 183 to 222, as a metabolite map.

Citrate
Displays the averaged, absolute pixel 
values from PROSE images 95 to 114, as a 
metabolite map.

Choline + Creatine/Citrate
Displays a map of the ratio of the choline + 
creatine, images 66-85 compared to citrate, 
images 95-114.

N-Acetly
Displays the averaged, absolute pixel 
values from CSI images 143 to 154 as a 
metabolite map.

Choline/N-Acetyl
Displays a map of the ratio of the N-acetyl, 
143 to 154 region, to the choline, 64 to 74 
region.

Startup
Displays the averaged, absolute pixel 
values over the region of 50 to 200. This is a 
good picture of the excited ROI.

Composite image Signal from all spectrum.

Signal Over Noise Ratio
The amplitude of the N-acetyl peak divided 
by the variation of the noise region (range 
0.4 to 0.9 ppm).

Brain Prostate
2333956-100 Rev. 0 (06/02)  19-3
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
How Do I...
This section provides the step-by-step instructions for using FuncTool 2 to 
display a PROSE or PROBE sequence. Specifically, it describes how to:
• Display Images and Spectrums
• Display Regions of Interest
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Display Images and Spectrums
Use this procedure to display the 3D PROSE or PROBE 
images that you obtained during scanning. The prerequisite for 
display is a valid image set of 3D spectroscopy images.

1. Click the Display Desktop icon.

2. Select your 3D series.

Located in the series section of your Browser.

This prepares the series for download into the FuncTool 
2 display software.

3. Click [FuncTool 2]. 
This launches your selected series into the FuncTool 2 
software.

4. Select an appropriate localizer series.

5. Click [OK].
This opens the Display Tool Command window.

The default format of the display window is the top two 
viewports displaying spectrums and the bottom two 
viewports displaying metabolite maps.

NOTE: Refer to the FuncTool 2 Performance User Guide for 
additional information on viewports and FuncTool display 
commands.

6. Click the appropriate icon to launch the metabolite map and 
spectrum display for the acquisition.

For PROSE, click [Prostate].
For PROBE, click [Brain].
This displays the metabolite maps and spectrum 
displays. The number of metabolite maps is defaulted to 
five: one single image (a composite map) and four other 
metabolite maps.

7. In the upper right viewport, change number of pixels to one.

This setting avoids cursor size smoothing.

Quick Steps: Display 
Images and Spectrums
1. Click the Display Desktop 

icon.

2. Select your 3D series.

3. Click [FuncTool 2]. 
4. Select an appropriate 

localizer series.

5. Click [OK].
6. Click the appropriate icon 

to launch the metabolite 
map and spectrum display 
for the acquisition.

7. In the upper right viewport, 
change number of pixels to 
one.

8. Right-click and select Set 
X unit > ppm to change 
the horizontal spectrum 
annotation in the upper 
right viewport from rank to 
ppm.

9. To toggle between a 1:1 
and 1:4 image display, 
place the cursor over the 
viewport you want to 
change and press the / 
(forward slash) key.

10. To make a single spectrum 
display in the upper left 
viewport, click an ROI on 
one of the images.

11. To make a single spectrum 
in the upper right viewport, 
click the single spectrum 
on the left.
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8. Right-click and select Set X unit > ppm to change the 
horizontal spectrum annotation in the upper right viewport 
from rank to ppm.

This displays the ppm scale below the spectrum, which 
designates the chemical address of each metabolite.

9. To toggle between a 1:1 and 1:4 image display, place the 
cursor over the viewport you want to change and press the / 
(forward slash) key.

10. To make a single spectrum display in the upper left 
viewport, click an ROI on one of the images.

11. To make a single spectrum in the upper right viewport, click 
the single spectrum on the left.

The advantage of viewing the spectrum in the upper right 
viewport is that it has the ppm horizontal scale. 

As you move the cursor over the spectrum in the upper 
right viewport, the ppm that correlates with the vertical 
cursor position displays on the horizontal axis.

12. To select a different metabolite map, place the cursor over 
the red metabolite annotation, right-click and select a 
metabolite from the pull-down menu.

13. To adjust the window width and level of the localizer image, 
hold and press the Ctrl key while adjusting the width and 
level with the middle mouse button.

If the metabolite map width and level turn red or get 
significantly changed, to return to the default values, 
press the W key.

14. To page through the 3D images, place the cursor on the red 
slice location annotation, and click or right-click to navigate 
through the series.

15. Reset threshold if there is little to no color on the ratio map.

a) Select Prostate > Advanced Settings > Ratio > 
Custom.

b) Enter a value representing the baseline.

c) Select Save > Done > Compute > Close.

16. Right-click and select Save View to save an 
image/spectrum (if desired).

This saves the image/spectrum in black and white for 
later viewing in the Viewer or Mini Viewer.

Quick Steps: Display 
Images and Spectrums
12. To select a different 

metabolite map, place the 
cursor over the red 
metabolite annotation, 
right-click and select a 
metabolite from the 
pull-down menu.

13. To adjust the window 
width and level of the 
localizer image, hold and 
press the Ctrl key while 
adjusting the width and 
level with the middle 
mouse button.

14. To page through the 3D 
images, place the cursor 
on the red slice location 
annotation, and click or 
right-click to navigate 
through the series.

15. Reset threshold if there is 
little to no color on the 
ratio map.

16. Right-click and select 
Save View to save an 
image/spectrum (if 
desired).
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Display Regions of Interest
The ROIs displayed when you first enter a protocol represent 
the voxels from the acquired VOI. The size of the individual ROI 
is determined by the acquisition matrix.

Use this procedure to display regions of interest in 
spectroscopy images.

1. Place the cursor on an ROI and click to display a spectrum 
from an individual ROI.

2. Click and drag an individual ROI to move it to a new 
location.

3. Erase the ROI, if necessary.

To erase a single ROI, click to make it active and press 
the Ctrl+X keys.

To erase all the ROIs on the images, place the cursor 
outside the ROIs, press and hold the Ctrl key and click 
and drag a box around the ROIs. Press the Ctrl+X keys.

– The box around the ROIs connects or groups the 
ROIs.

4. Click an ROI from the Display Tool Command window to 
deposit an ROI on all image viewports.

Choose a box or a circular ROI.

Choose the pencil for a free-hand ROI.

Choose spline to draw your own ROI 
shape.

ROIs are displayed on all images within the data set. 

5. Click and drag any of the square handles on the ROI to 
re-size ROI coverage.

6. Click and drag the center ROI to reposition the ROI.

7. Toggle between splitting and merging ROIs.

a) Connect the ROIs together by clicking and dragging a 
box around the ROIs.

b) Click [Split ROI]. 
– This splits ROIs into multiple ROIs.

Quick Steps: Display 
Regions of Interest
1. Place the cursor on an 

ROI and click to display a 
spectrum from an 
individual ROI.

2. Click and drag an 
individual ROI to move it 
to a new location.

3. Erase the ROI, if 
necessary.

4. Click an ROI from the 
Display Tool Command 
window to deposit an ROI 
on all image viewports.

5. Click and drag any of the 
square handles on the 
ROI to re-size ROI 
coverage.

6. Click and drag the center 
ROI to reposition the ROI.

7. Toggle between splitting 
and merging ROIs.

8. Undo a split ROI.
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8. Undo a split ROI.

a) Connect the ROIs together by clicking and dragging a 
box around the ROIs.

b) Click [Merge ROI].
It is much easier to Merge ROIs and then delete them by 
pressing the Ctrl+X keys, rather than deleting each 
individual ROI.
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Chapter 20

Imaging with ASSET

Introduction
Array Spatial Sensitivity Encoding Technique (ASSET) is an optional imaging 
feature that allows faster scanning when using the Torso Phased Array (PA) coil. 
It is designed to achieve the following benefits:
• reduced breath-hold time
• increased spatial resolution for a given scan time
• increased number of slices for a given scan time
• reduced blurring for compatible FSE family sequences

This chapter explains the characteristics of ASSET. It also explains the 
step-by-step instructions to help you learn how to:
• Acquire an ASSET Calibration Sequence
• Acquire an ASSET Imaging Sequence

In addition, this chapter answers the following questions:

1. What is ASSET?

2. When would I use ASSET?

3. What pulse sequences can I use with ASSET?

4. Which features are compatible with ASSET?

5. What is ASSET Calibration?
v. 0 (06/02)  20-1
 Electric Company. All rights reserved.



Signa® LX Release 9.1
What Do I Need to Know 
About...
This section presents the concepts necessary to successfully understand 
imaging with ASSET. Specifically, you need to understand:
• ASSET Basics

– Supported Features
• Scan Parameters

– ASSET Calibration
– ASSET Imaging

• Imaging Characteristics
• Applications

ASSET Basics
ASSET is a technique for reducing scan time when the Torso Phased Array 
(PA) coil is used. The reduction in scan time is due to every other line in 
K-space being skipped, while keeping the total area covered in K-space the 
same. A half phase field of view (0.5 PFOV) is an example of a technique 
that uses a similar principle. ASSET requires a calibration scan prior to the 
image acquisition. This calibration scan is required for the system to 
account for the phase wrapped or aliased anatomy that occurs within each 
coil in the phased array set. The calibration scan measures each receive 
coil’s sensitivity (spatial image intensity weighting). These sensitivity maps 
are needed to unwrap the aliasing in the ASSET scan (Figure 20-1). The 
calibration acquisition takes approximately six seconds.

The aliasing occurs in an ASSET scan and not in a non-ASSET scan 
because the ASSET acquisition is, in effect, acquiring half the data in the 
phase FOV direction. Anytime there is anatomy outside the FOV in the 
phase direction, aliasing or wrap around occurs. 

NOTE: At this time, ASSET Imaging is only compatible with the Torso PA coil.
20-2  2333956-100 Rev. 0 (06/02)
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Figure 20-1 ASSET Diagram

The receive coil sensitivities must be measured in a separate acquisition, 
called ASSET Calibration before any ASSET image acquisitions are 
performed. The information obtained during ASSET calibration is stored 
and used throughout the patient’s exam. You only need to perform the 
ASSET Calibration once for your entire exam. However, you may acquire 
more, if the scanning ranges change considerably throughout your exam. If 
more than one calibration is done, the data is used from the most recent 
calibration scan. Once you have ended the exam, the ASSET calibration 
information is discarded. ASSET Calibration images are saved as a 
separate series and can be recalled from the Browser.

NOTE: If another exam is performed on the same patient, another ASSET 
Calibration must be performed. 

In Figure 20-2, Fast Gradient Echo (GRE) images are shown with and 
without the use of ASSET. Both images were acquired with the same scan 
parameters, but note the scan acquired with ASSET was imaged in half the 
time.

ASSET 
Processing

Coil 1 K-space

Coil 2 K-space

Calibration 
Coil 1 
Image

Unaliased
Image

Coil 1 Low Res
Calibration Image

Coil 2 Low Res
Calibration Image

Aliased Image

Aliased Image
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Figure 20-2 Conventional Fast GRE vs. Fast GRE with ASSET

NOTE: The scan parameters used in Figure 20-2: 2.3 Time to Echo (TE), 62 
bandwidth (RBw), 15 slices, 8 mm thick, 2 mm space, 34 FOV, 26 
phase FOV, 256x128 matrix with 1 number of excitations (NEX).

Supported Features
The ASSET option is available only when using the Torso PA coil and can 
be used with the following pulse sequences:
• 2D Fast Gradient Echo (Fast GRE)
• 2D Fast SPoiled Gradient Echo (Fast SPGR)
• 3D Gradient Echo (GRE)
• 3D SPoiled Gradient Echo (SPGR)
• 3D Fast Time of Flight Gradient Echo (Fast TOF GRE)
• 3D Fast Time of Flight Spoiled Gradient Echo (Fast TOF SPGR)
• Single Shot Fast Spin Echo (SSFSE)
• Fast Spin Echo-Accelerated (FSE-XL)
• 2D or 3D Fast Recover Fast Spin Echo-Accelerated (FRFSE-XL)

NOTE: For the FSE-XL and FRFSE-XL pulse sequences, time reduction 
depends on the choice of ETL, phase FOV, NEX, and matrix.

Only 2D Fast GRE and 2D Fast SPGR pulse sequences are compatible 
with ASSET calibration. After the calibration scan is acquired, any of the 
ASSET pulse sequences can use the calibration data to perform the 
ASSET image acquisitions. ASSET calibration images are annotated “CAL” 
in the lower left corner of display screen. These images are not clinically 
diagnostic and are not recommended for filming. Images acquired during 

With ASSETWithout ASSET
Scan Time = 16 Sec. Scan Time = 8 Sec.
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ASSET imaging are annotated “AST” in the lower left corner of display 
screen. In addition, ASSET is compatible with the features listed in Table 
20-1.

Table 20-1 ASSET Compatibility. The X denotes the PSD is compatible with 
the Imaging Option and ASSET.

Imaging Option SSFSE FRFSE-XL FSE-XL
FGRE/
FSPGR

FTOF
GRE/SPGR

Flow Compensation X X X X
POMP
Square Pixel
Resp Comp
Mag Transfer
Cardiac Gating/Trig X X X X X
Tailored RF X X
De Prepared X
Full Echo Train X X
ZIP 1024
ZIP x 2 X (3D) X (3D) X
Smart Prep X
Multi Station X
T2 Prep
Phase Sensitive
ASSET Calibration
Variable Bandwidth X X X X X
No Phase Wrap
EDR X X X X X
SCIC X X X X X
Classic X
Sequential X X X X (2D)
Resp Gate/Trig X X X X
IR Prepared X X
Multi Phase X X
CCOMP
ZIP 512 X X X X X
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NOTE: *Fractional echo and fractional NEX are not compatible; only one of 
the two can be used within a series prescription.

Scan Parameters
Scan parameters most often changed with ASSET are divided into three 
sections: Scan Timing, Acquisition Timing, and Scanning Range 
parameters. Selection of these parameters can vary for each acquisition 
and between ASSET calibration and ASSET imaging acquisitions.

ASSET Calibration
You must select the ASSET Calibration Imaging Option, located on the 
Imaging Options window, in order to perform this acquisition. During ASSET 
calibration, several scanning parameters are not selectable. The only 
selectable scan parameters are plane, PSD, slice thickness, and slice 
locations. The calibration data must cover the scanning range of the ASSET 
image acquisition. Therefore, prescribe the ASSET Calibration scanning 
range from posterior to anterior, the right to left, or the inferior to superior 
borders of the anatomy. ASSET Calibration FOV is set at 48 cm, and can 
not be changed.

ZIP x 4 X (3D) X (3D) X
Blood Suppression X
Real Time
Spectral Spat. RF
Navigator
Fluoro Trigger
Fat/Water SAT X X X X X
SPECIAL X (3D) X
Fractional NEX* X X X X X
Fractional Echo* X X
PFOV in steps of 
0.1 X X

Oblique X X X X X
Spatial SAT X X X X X

Imaging Option SSFSE FRFSE-XL FSE-XL
FGRE/
FSPGR

FTOF
GRE/SPGR
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ASSET Imaging
Selection of scanning and acquisition parameters should be chosen to best 
display your desired imaging anatomy. You must select ASSET on the 
Imaging Options window in order to perform any acquisition using ASSET.

NOTE: Refer to the Signa® Infinity with Signa Select (ASP2)™ guide for 
additional information about the compatible pulse sequences.

The scanning range of the ASSET image acquisition must be within the 
borders of the scanning range used for the ASSET Calibration acquisition. 
Scan regions that fall outside of the calibration volume are blank in the final 
images. Figure 20-3 provides an example of an acceptable scanning range.

Figure 20-3 ASSET Calibration and ASSET Imaging Scanning Range

ASSET is compatible with oblique imaging, although as the oblique angle 
increases, the potential for aliasing increases.

Imaging Characteristics
ASSET does not change the characteristics of the compatible PSDs. The 
primary applications for using the ASSET option include:
• Decreased scan time

– For example, scan time decreases with the use of a smaller phase 
FOV.

– Scan time for the FSE PSDs may not decrease for all combinations 
of scan parameters that typically affect scan time. For example, with 
some combinations of ETL and PFOV selections, changing the 
phase matrix value does not change scan time.

– An even ETL should be prescribed for all FSE PSDs when using 
ASSET.

ASSET Calibration Scanning Range ASSET Imaging Scanning Range
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• Increased resolution
– For example, you can increase the spatial resolution by selecting a 

larger phase matrix, with the same scan time when compared to 
images acquired without using ASSET.

• Increased number of slices
– For example, if your scan time of 15 seconds allows 6 slices, 

selecting ASSET decreases the scan time. Therefore, increasing the 
number of slices and moving into a dual acquisition allows more 
slices within the same 15 second breath-hold.

• Reduced blurring in the FSE family of ASSET compatible PSDs
– ASSET allows a lower ETL selection for FSE-XL and FRFSE-XL 

while keeping the scan time the same as a non-ASSET scan.
– SSFSE scans with ASSET exhibit reduced blurring versus 

non-ASSET SSFSE images.

Everything in Magnetic Resonance Imaging (MRI) has a trade-off. ASSET’s 
trade-off is the notable decrease in signal to noise ratio (SNR). When 
comparing two images acquired with and without the ASSET option, the 
ASSET images have an SNR loss comparable to halving the NEX (slightly 
more than a 40% loss). In examinations with high signal, such as a Contrast 
Enhanced Magnetic Resonance Angiography (CEMRA) exam, the SNR 
effects are rarely noticed. Keep in mind the image quality trade-offs listed in 
Table 20-2, if you need to regain SNR that is reduced when ASSET is 
turned on.

Table 20-2 Imaging Effects

NOTE: *There is not always a direct correlation. 

**There is no effect on Scan Time unless the TR is increased.

Parameters
Image Effect

Echo Spacing SNR Resolution Scan Time
Gradient Slew 
Rate ⇑ ⇓ N/A * *

Receive 
Bandwidth ⇑ ⇓ ⇓ * *

Frequency 
Matrix ⇑ ⇑ ⇓ ⇑ **

Phase Matrix ⇑ N/A ⇓ ⇑ ⇑

FOV ⇑ ⇓ ⇑ ⇓ **
Phase FOV ⇑ N/A ⇑ N/A ⇑

NEX ⇑ N/A ⇑ N/A ⇑
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Applications
ASSET is currently used for body applications. These body applications 
include abdomen and chest imaging, as well as breath-held angiography 
studies. 

An example of a 13 second Renal CEMRA acquisition using ASSET is 
shown in Figure 20-4.

Figure 20-4 ASSET CEMRA

ASSET is not appropriate for all imaging applications, only those that 
require more speed, have SNR to spare, and cannot employ other 
techniques.
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How Do I...
This section provides the step-by-step instructions for performing an 
ASSET acquisition. Specifically, it describes how to:
• Acquire an ASSET Calibration Sequence
• Acquire an ASSET Imaging Sequence
20-10  2333956-100 Rev. 0 (06/02)
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Acquire an ASSET Calibration 
Sequence
ASSET calibration sequences must be performed prior to any 
sequences using the ASSET feature. This sequence acquires 
the data necessary for effectively performing ASSET imaging.

Use this procedure to set up and scan an ASSET calibration 
sequence. These images are not to be used for clinical 
diagnostic purposes and are not recommended for filming.

1. Acquire a 3-Plane Localizer series.

Make sure the localizer covers the desired anatomy.

2. Click [New Series].

3. Select Coil > Torso PA.

ASSET is only compatible with the Torso PA coil, at this 
time.

4. Select Plane > Axial.
ASSET calibration is compatible with any imaging plane.

5. Select Mode > 2D.

ASSET calibration is only compatible with 2D mode.

6. Select a Fast GRE or Fast SPGR pulse sequence.

ASSET calibration is only compatible with FGRE and 
FSPGR.

Applicable series in the GE Protocols are Abd/Lumbar 
and ASSET Abdomen.

7. Select Grad Mode > Whole, if applicable.

ASSET Calibration is compatible with the Whole Body 
gradient mode.

The Grad Mode text box is only available on 
TwinSpeed™ Resonance Module (TRM) systems.

8. Select the ASSET Calibration Imaging Option.

This imaging option must be selected in order to perform 
this sequence.

This is the only imaging option compatible with ASSET 
Calibration.

Quick Steps: Acquire an 
ASSET Calibration 
Sequence
1. Acquire a 3-Plane 

Localizer series.

2. Click [New Series].
3. Select Coil > Torso PA.

4. Select Plane > Axial.
5. Select Mode > 2D.

6. Select a Fast GRE or Fast 
SPGR pulse sequence.

7. Select Grad Mode > 
Whole, if applicable.

8. Select the ASSET 
Calibration Imaging 
Option.

9. Enter the Scanning Range 
parameters.

10. Graphically prescribe your 
desired scan locations.

11. Click [Save Series] to 
close the prescription.

12. Click [Prepare to Scan] to 
download the ASSET 
Calibration sequence.

13. Click [Auto Prescan] to 
ready the system for data 
acquisition.

14. Give your patient breath 
holding instructions.

15. Click [Scan] to initiate the 
ASSET Calibration 
acquisition.
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9. Enter the Scanning Range parameters.

Choose your locations to optimize your desired anatomy 
coverage.

– Typically an 8 mm slice thickness provides enough 
slices within a single acquisition to cover the scanning 
range form one border of the anatomy to the opposite 
border of anatomy (left to right, anterior to posterior, or 
inferior to superior). If not, increase the slice thickness 
until the prescription is a single acquisition.

10. Graphically prescribe your desired scan locations.

a) Click the Graphic Rx Icon in the Additional Parameters 
area.

b) Select the desired localizer image to prescribe your 
imaging slices.

c) Press the Shift key and click to deposit the starting slice.

d) Click and drag the add handle to increase the number of 
slices.

– Prescribe enough slices to cover from one border of 
the anatomy to the opposite border of anatomy. 
Extend beyond the anatomical borders to ensure 
complete coverage. This ensures you can place your 
ASSET image prescription anywhere on the localizer 
and there will be a CAL file available.

– Maximum number of slices is 128.

e) Adjust the prescription as necessary.

f) Click [Accept] to register the slice locations for the 
current acquisition.

– Location values are displayed in the Scanning Range 
area.

11. Click [Save Series] to close the prescription.

12. Click [Prepare to Scan] to download the ASSET 
Calibration sequence.

13. Click [Auto Prescan] to ready the system for data 
acquisition.

14. Give your patient breath-holding instructions.

Use the same breath-hold instructions that will be used in 
the ASSET image acquisition.

15. Click [Scan] to initiate the ASSET Calibration acquisition.
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Acquire an ASSET Imaging Sequence
ASSET is an imaging technique used for rapid breath-held 
scanning. Specific applications are rapid liver imaging and 
contrast enhanced renal MRA studies.

Use this procedure to set up and scan an ASSET imaging 
sequence. ASSET imaging sequences are only to be performed 
proceeding an ASSET calibration acquisition.

1. Click [New Series].

2. Select Coil > Torso PA.

ASSET is only compatible with the Torso PA coil.

3. Select Plane > Axial.
ASSET imaging is compatible with any imaging plane.

4. Select Mode > 2D or 3D.

ASSET imaging is only compatible with 2D and 3D 
modes.

5. Select any ASSET compatible pulse sequence.

6. Select Grad Mode > Whole, if applicable.

ASSET is compatible with both gradient modes.

The Grad Mode text box is only available on 
TwinSpeed™ Resonance Module (TRM) systems.

7. Select the ASSET Imaging Option.

You must select this imaging option in order to perform 
an ASSET acquisition.

8. Enter the Imaging Parameters.

The parameters should reflect the specific protocol 
tailored to the current imaging examination.

For specific exam protocols refer to either your site 
tailored protocols or GE pre-loaded protocols.

Quick Steps: Acquire an 
ASSET Imaging Sequence
1. Click [New Series].
2. Select Coil > Torso PA.

3. Select Plane > Axial.
4. Select Mode > 2D or 3D.

5. Select any ASSET 
compatible pulse 
sequence.

6. Select Grad Mode > 
Whole, if applicable.

7. Select the ASSET 
Imaging Option.

8. Enter the Imaging 
Parameters.

9. Graphically prescribe 
your desired scan 
locations.

10. Click [Save Series] to 
close the prescription.

11. Click [Prepare to Scan] 
to download the ASSET 
imaging acquisition.

12. Click [Auto Prescan] to 
ready the system for data 
acquisition.

13. Give your patient breath 
holding instructions.

14. Click [Scan] to initiate the 
ASSET imaging 
acquisition.
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9. Graphically prescribe your desired scan locations.

a) Click the Graphic Rx Icon in the Additional Parameters 
area.

b) Select the desired localizer image to prescribe your 
imaging slices.

c) Press the Shift key and click to deposit the starting slice.

d) Click and drag the add handle to increase the number of 
slices.

– Slice locations should be within the imaging range of 
the ASSET Calibration series.

– Maximum number of slices is 128.

e) Adjust the prescription as necessary.

f) Click [Accept] to register the slice locations for the 
current acquisition.

– Location values are displayed in the Scanning Range 
area.

10. Click [Save Series] to close the prescription.

11. Click [Prepare to Scan] to download the ASSET imaging 
acquisition.

12. Click [Auto Prescan] to ready the system for data 
acquisition.

13. Give your patient breath-holding instructions.

Use the same breath-hold instructions that you used in 
the ASSET Calibration acquisition.

14. Click [Scan] to initiate the ASSET imaging acquisition.
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Chapter 21

High Order Shim

Introduction
The High Order Shim feature allows you to shim over a region-of-interest (ROI) 
taking advantage of the High Order Shim coils. This feature is likely to improve 
the local field homogeneity for use in applications such as fat suppression, 
spectroscopy, spiral scanning, and functional imaging.

This chapter explains the characteristics of High Order Shim. It also explains the 
step-by-step instructions to help you learn how to:
• Scan a High Order Shim Series
• Calculate the Shim

In addition, this chapter answers the following questions:

1. What is the High Order Shim feature?

2. When would I use High Order Shim?

3. What are the available shim series?

4. How can I identify if the shim has improved?

5. What are some applications for High Order Shim?
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What Do I Need to Know 
About...
This section presents the concepts necessary to successfully understand 
the High Order Shim feature. Specifically, you need to understand:
• High Order Shim

– Available Shim Series
– Autoshim Button

• Shimming Process
– Selecting a Region of Interest
– Shim Improvement Identification
– Shim Calculation Failures
– Advanced Window
– Library Window

• High Order Shim Notes
• Recommendations

High Order Shim
The High Order Shim process is run as another series in the exam prior to 
the main clinical series. It allows you to shim over a region-of-interest (ROI) 
to take advantage of the High Order Shim coils. High Order Shim is likely to 
improve the local field homogeneity. The following sections describe the 
basic routine for in-vivo high order shimming with a patient, and additional 
parts with a brief explanation of the options available in each window. 
Currently, there is a specific order of steps that need to be followed to use 
the shim process in regards to the shim series capturing any S/I FOV offset 
that may occur between the localizer series and subsequent clinical series. 
This process is explained in the How Do I ... section of this chapter.

Available Shim Series
There are four shim series available defined by the field of view (FOV) and 
gradient mode. The 48 cm FOV series is primarily used in the body coil, but 
can also be used for receive only surface coils and for small volume T/R 
coils that are off-center, such as the wrist or knee coils. For use with the 
volume T/R coils, you may want to update the coil used after selecting the 
head shim series to benefit from the increased SNR.
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The 24 cm FOV series is used primarily for the head coil and can also be 
used for the knee T/R volume coil if the knee is positioned at isocenter. 
Anything outside the 24 cm region at isocenter must be shimmed with the 
48 cm series.

To use the 24 cm FOV shim series for a coil other than the head coil, select 
the series matching the gradient mode you will use in the next clinical series 
and then change the patient orientation and coil name to match.

Choose the gradient mode in the Grad Mode text box to match with that 
defined in the clinical series just saved. In the event of a mis-match, a 
message to this effect is given upon saving the High Order Shim series. 

Autoshim Button
Anytime you enable the [Autoshim] button after running a High Order Shim 
series, the following message appears: 

"You have set ON the autoshim button after having run the high order 
shim calibration. If this remains ON, scanning with this series resets ALL 
the shim coils."

This is telling you all the shims channels will be reset to zero as if you had 
never run the shim series. Reselecting the [Autoshim] button should be 
done anytime you change locations in the anatomy that are outside the 
previously shimmed volume or that will cause the table to move due to a 
new S/I offset. A new shim series should also be performed for any new 
slices prescribed that will fall outside the previously selected shim ROI even 
if an S/I table movement is not required. This is due to the fact that ONLY 
the region inside the ROI used in the last shim series is shimmed.

Shimming Process
After the shim scan and reconstruction finishes, the Shim User Interface 
appears (Figure 21-1). 
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Figure 21-1 Shim User Interface (ROI Selection Window)

NOTE: The processing and displaying times of this interface are a function 
of the High Order Shim series used, and may take many seconds to 
appear. The 24 cm FOV series processing only takes 5 to 10 seconds, 
whereas the 48 cm FOV series takes 30 to 45 seconds before the 
shim interface appears.

The Shim User Interface is where the action of defining a specific region to 
shim takes place. Only the region inside the ROI used in the shim series is 
shimmed, given the patient has not been moved. Anatomy outside the 
region selected for shimming may be adversely affected by the shim 
process and may cause image distortions and artifacts. The High Order 
Shim process is for improving localized areas of anatomy to correct for 
affects of the patient in the magnetic field. This process improves further 
upon the capabilities of the current Autoshim process but only in the area 
selected by the ROI in the shim user interface. The shim of the regions 
surrounding the ROI is sacrificed in order to allow the area inside the ROI to 
be further improved. It is important to insure the ROI selected covers the 
slices desired in the following series.

Selecting a Region of Interest
For selecting the ROI, you can select any slice from the corresponding 
scrollbar in each direction. The slice may also be selected by using the two 
green intersection lines on each of the three images (axial, sagittal, and 
coronal). The selected ROI may be either rectangular or elliptical.

You may drag and resize the ROI on any image. The ROI displayed on the 
other two images updates accordingly.
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Figure 21-2 ROI Selection Window

In the ROI Selection window (Figure 21-2), you may select any of the 
features listed in Table 21-1 by clicking on the appropriate button.

Table 21-1 ROI Selection Window Features

Feature Description

Green lines Allows you to off-center the intersection between 
all three displayed images.

[Calculate Shim] Runs the shim values calculation with the current 
ROI selection.

[Done] Downloads the calculated values to the Shim 
supply and exits.

[ROI Shape] Allows you to select between a rectangular and an 
oval shape ROI.

[Quit] Exits without downloading.

[Help]

Includes instructions for manipulating the ROI and 
the green lines, as follows:

• You may change the ROI shape by clicking the 
[ROI Shape] button, then selecting either 
rectangle or oval.

• You may move the ROI by placing the cursor 
inside the ROI and dragging.

• You may resize the ROI by placing the cursor 
outside the ROI and dragging.

• You may move the intersecting planes one by 
one by placing the cursor on one of the green 
lines outside the ROI and dragging.

[Advanced] Opens the Advanced window for additional 
choices.
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Shim Improvement Identification
To identify the improvement in the shim of the ROI selected, look at the 
RMS deviation current and predicted areas in the ROI Selection window 
after positioning the ROI and selecting the [Calculate Shim] button. The 
current area tells you what the shim is now and the predicted gives you a 
sense of how much it might improve after Done/Download is run. Any 
shifting by the patient makes the results shift. Generally, if the predicted 
value is close to the current value (within 1 to 2 Hz,) then there is very little 
benefit in running another iteration. Generally, only one or two iterations 
should be necessary. 

If there seems to be little to no improvement for the very first pass, clicking 
the [Advanced] button opens the Advanced window and allows you to 
make sure all shim coils are enabled for use on the right hand side. This is 
evident by seeing that the buttons next to each coil is indented (selected), if 
not, then select them all and calculate the shim again. The buttons stay 
enabled until someone manually disables them. Refer to Figure 21-3 for the 
Advanced window and coil buttons.

Shim Calculation Failures
If the shim calculation fails, an error message appears stating, "SVD error: 
not enough points". This is telling you that the software could not identify 
enough data points within the ROI that are above a certain pixel intensity 
threshold to be used in the calculation of the new shim settings.

Possible causes:
• The image is very dark, i.e., not enough signal. 

– It may be possible to fix this by exiting the shim interface, running 
autoprescan again, entering manual prescan and increasing the R1 
receive gain by 1 or more counts while looking at the Scan TR entry 
point. You may also use the R2 gain if R1 is at maximum. If this does 
not help, then the anatomy currently being imaged is not able to be 
shimmed.

[Phase/Magnitude 
Maps]

Allows you to toggle between displaying phase or 
magnitude images. The Phase Maps can help 
identify the location of off-center anatomy such as 
knees, wrists or shoulders. Small regions show up 
as small objects and are difficult to see in the large 
FOV shim series. The phase maps can help in 
locating a suitable ROI around the anatomy.

Feature Description (Continued)
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• The ROI contains too much of the background inside the ROI 
boundaries. 
– Check the ROI size and position, shifting and repositioning as 

necessary. Clicking [Calculate Shim] repeatedly during this process 
lets you know when the problem is corrected sufficiently to provide 
shim information.

• The patient is causing a severe shim distortion. 
– This may occur for many reasons such as imaging near metal 

implants that cause RF reflection. Clicking [Phase Maps] from the 
shim interface can help identify this issue. You will see white and 
black stripes side by side inside the ROI if there are severe shim 
distortions. The shim option is not able to correct for shim distortions 
that are this severe.

Advanced Window
Clicking the [Advanced] button in the ROI Selection window (Figure 21-2) 
allows you to review details of the shim calculation results, save a shim-set 
of data, recall a previously saved set, manually enter values, or remove one 
or more of the shim channels.

Figure 21-3 Advanced Window

In the Advanced window (Figure 21-3), you may select any of the features 
in Table 21-2 by clicking the appropriate button.

On/Off
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Table 21-2 Advanced Window Options

Field range of values (Table 21-3) are suggested ranges for each channel 
based on expected changes in field homogeneity, and are not necessarily 
typical values.

The numbers in each channel are add-on values to whatever is already in 
that channel. Hence any positive or negative value within the ranges 
defined is valid. Typical values are below +/- 0.100A, with less than +/- 
0.010A considered negligible.

Table 21-3 Field Range of Values

Option Description 

Log Window

Allows you to review a log of the shim calculation and 
download details. An estimate as to the quality of the 
improvement after the channels are updated can be 
seen by looking at the change in RMS deviation 
between the Current and Predicted Map statistics.

[library] Opens the Library window, to either save a shim-set or 
recall a previously saved one.

[Set Defaults]
Allows you to select a set of predefined shim values, 
corresponding to resetting the linear shims to the 
original system LVShim values, and with high order 
shim channels set to zero.

[Download] Loads the current set of shim values to the Shim supply.

[Exit] Returns to the basic window.

On/Off

Allows you to remove a linear and/or high order shim 
channel from the current shim set, i.e., not use it for 
updating the calculation or downloading to the shim 
supply. More than one can be removed for this purpose. 
The default for each channel is ON.

Field text 
boxes

Allows you to manually enter the difference value to be 
added to each channel or the system automatically 
enters values after calculating the shim.

Channel Units Negative Limit Positive Limit
Zo Frequency in Hertz -500 +500

X Linear shim in grad units -20 +20

Y Linear shim in grad units -20 +20

Z Linear shim in grad units -20 +20

ZY High order shim in A -.500 +.500
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Library Window
Clicking the [library] button, in the Advanced window (Figure 21-3), allows 
you to save a shim-set of data, recall a previously saved set, or manually 
adjust a previously saved set. 

Figure 21-4 Library Window (File Selection Window)

In the Library window (Figure 21-4), you may select any of the features 
listed in Table 21-4 by clicking on the appropriate button.

Table 21-4 Library Window Options

X2_Y2 High order shim in A -.500 +.500

ZX High order shim in A -.500 +.500

XY High order shim in A -.500 +.500

Z2 High order shim in A -.250 +.250

Option Description 

Desc:
Allows you to give the new file a description, which 
appears in the list in place of the current description line. 
The first line is reserved for the default linear shim values.

[Read]
Allows you to read the current set of shim values from the 
shim supply and linear shims, and present the difference 
between these and the highlighted set in the Library in the 
Advanced window.

[Save] Saves the currently displayed set of shim values to the 
selected description file.

Channel Units Negative Limit Positive Limit
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High Order Shim Notes
• The shim series takes up an Exam series number but does not place 

any images in the database. When looking at the Browser listing, it will 
be evident as a missing series. A series may also be missing from an 
Exam if the series was purposely deleted. 

• Use as large an ROI as practical for the anatomy to be shimmed. The 
larger the area, the better the chance of improving the overall shim. 
Effectiveness becomes reduced for smaller ROIs due to limited data 
points for the software to distinguish between shim coils for corrections.

• If you choose to run a shim series as the first series in an exam the 
confirmation message in Figure 21-5 appears:

Figure 21-5 

This message may also appear for the very first shim series after the 
System software has been started even if the shim series is not the first 
series. This is a known issue and is currently being investigated.

• There is a 6 second delay in the start of Autoprescan for any series that 
has changed the gradient mode or has AutoShim selected due to the 
shim feature making sure the High Order Shim coils are reset to zero 
current.

• If you change the coil selection used for any High Order Shim series, 
make sure the Frequency Direction in the Acquisition Timing area is set 
to A/P prior to saving the shim series. If the selection is changed from 

[Open]
Opens an editor with a previously saved set of shim 
values, which are afterwards read in as the difference 
between these values and the currently downloaded set.

[Exit] Returns you to the Advanced window.

Option Description  (Continued)
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the default Head or Body coil, the frequency direction may automatically 
change, causing the images displayed in the High Order Shim user 
interface to rotate by 90 degrees with respect to the annotation. This 
only affects the image orientation in the shim display and not the 
following clinical images.

• Do not change any parameter in the shim series other than coil name 
discussed elsewhere.

• Do not use the GRx box to change slice locations in the shim series.
• Do not use the download button in the Advanced UIF screen more than 

once per scan. The [Calculate Shim] button can be used as many 
times as necessary while changing ROI positioning/shape, but only 
download once.

• Do not Copy/paste any shim series. Always pull in a new copy from the 
GE/other saved protocol HighOrderAutoshim. 

Recommendations
The recommended occasions when High Order Shim calibration should be 
rerun are:
• Change in gradient mode
• Change in table position
• Change in region to be high order shimmed
• When results are not as expected, such as the RMS current value being 

higher than the last shim iteration during the same shim series.
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How Do I...
This section provides the step-by-step instructions for High Order 
Shimming. Specifically, it describes how to:
• Scan a High Order Shim Series
• Calculate the Shim
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Scan a High Order Shim Series
The High Order Shim feature allows you to shim over a ROI 
taking advantage of the High Order Shim coils. This process is 
run as another series in the examination, prior to the main 
clinical series.

Use this procedure to run high order shimming with a patient.

1. Prescribe and run a localizer series.

Perform this series as normally done.

2. Prescribe and run any other series that you wish to run prior 
to specific localized shimming. 

You may also just go right to the shim series.

3. Prescribe and save the clinical series you wish to run 
following the shim series before pulling in the shim series.

Remember to turn off the Autoshim option in this series 
since the High Order Shim takes precedence. Make sure 
there is a series description for each series used.

The High Order Shim series uses the series description 
as shown in step 6. (Further notes regarding the protocol 
Autoshim button are found below in the section 
"Autoshim Button")

4. Choose one out of the four series from the 
GE/other/HighOrderAutoshim protocol.

The choice depends on the expected maximum FOV 
(<24 cm or <48 cm) and the gradient coil (WB for 
WHOLE-BODY or ZM for ZOOM) to be used during 
clinical scanning. 

5. Change the patient position parameters and RF coil to 
match those of the clinical series to be run next.

This High Order Shim scan should be run just prior to the 
actual clinical series, but after having saved the clinical 
series.

A change in the gradient coil used and/or cradle location 
for other series with the same patient requires a rerun of 
the High Order Shim scan.

Quick Steps: Scan a High 
Order Shim Series
1. Prescribe and run a 

localizer series.

2. Prescribe and run any 
other series that you wish 
to run prior to specific 
localized shimming.

3. Prescribe and save the 
clinical series you wish to 
run following the shim 
series before pulling in the 
shim series.

4. Choose one out of the four 
series from the 
GE/other/HighOrderAutos
him protocol.

5. Change the patient 
position parameters and 
RF coil to match those of 
the clinical series to be run 
next.

6. Save the series without 
changing any of the scan 
parameters other than 
those mentioned in the 
previous step.

7. If this information matches, 
then click [Accept] and 
[Prep Scan].

8. Press Advance to Scan to 
move the table to the new 
position.

9. Run the shim series and 
complete the High Order 
Shim calibration.

10. Prep and run the 
previously saved clinical 
series.
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6. Save the series without changing any of the scan 
parameters other than those mentioned in the previous 
step.

At this point the shim series gives you the following 
message with the choices of accept or reject: "Running 
High Order Shim calibration for clinical protocol: Saved 
series description here."

Other messages also appear in the same message 
pop-up window if there is any conflict identified between 
the clinical series and the shim series, such as the 
gradient mode and RF coil used do not match the 
subsequent series to be scanned.

7. If this information matches, then click [Accept] and [Prep 
Scan].

If not, then click [Reject] and pull in a new shim series 
and make the appropriate modifications. 

8. Press Advance to Scan to move the table to the new 
position.

9. Run the shim series and complete the High Order Shim 
calibration.

10. Prep and run the previously saved clinical series. 

No cradle movement should occur at this time. 

If you did not deselect Autoshim previously, use the 
view/edit feature to deselect autoshim, then save the 
series and proceed with the scan. 
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Calculate the Shim
Calculate the shim to run the shim values calculation with a 
specific ROI selected. This helps you to identify the 
improvement in the shim if the selected ROI.

Use this procedure to calculate the shim.

1. Place an ROI on the image.

The selected ROI may be rectangular or elliptical.

2. Manipulate the ROI on the images so that it occupies the 
desired region.

3. Click [Calculate Shim]. 
The optimum values to improve the magnet homogeneity 
within the specified ROI volume are calculated. 

The results are shown as the current and predicted RMS.

When the calculation is complete, the [Done] button 
highlights.

4. Make any ROI size/position changes and recalculate the 
shim, if necessary. 

Any changes and subsequent "Calculate Shim" requests 
must be done prior to clicking the [Done] button.

5. Click [Done]. 
At this point, the new values for the central frequency 
and linear shims are transferred to the system, and the 
five high order shim currents are downloaded to the shim 
supply channel by channel.

Once the download is complete, the High Order Shim 
interface closes.

6. If required, click [Scan] to check the shim corrections by 
running the shim scan again.

Ensure prior to any scanning that the High Order Shim 
windows have been closed (the High Order Shim 
windows remain open after download when this action is 
run from the Advanced window).

7. When the User Interface comes up again, click [Calculate 
Shim] and verify that the current RMS value has improved. 

Refer to the section "Shim Improvement Identification" 
for details.

Quick Steps: Calculate the 
Shim
1. Place an ROI on the 

image.

2. Manipulate the ROI on 
the images so that it 
occupies the desired 
region.

3. Click [Calculate Shim].
4. Make any ROI 

size/position changes and 
recalculate the shim, if 
necessary.

5. Click [Done].
6. If required, click [Scan] to 

check the shim 
corrections by running the 
shim scan again.

7. When the User Interface 
comes up again, click 
[Calculate Shim] and 
verify that the current 
RMS value has improved.
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Appendix A

MR Compatibility Test
Guidelines for the Signa

System

Scope and Summary

Introduction
The document describes a set of procedures and standards which can be used to 
evaluate the “MR Compatibility” of hand-held, non-electronic equipment used in 
conjunction with the Signa system.

Included are a definition of MR Compatibility, a scheme for classification of 
equipment, and a set of tests and standards for assessing MR Compatibility.

A Working Definition of MR Compatibility
For the purposes of this document, “MR Compatibility” shall be defined as 
follows:
• A device shall be considered MR Compatible if and only if:

– It’s presence in the Signa magnet room does not pose an increased safety 
risk to the patient or other personnel [MR Safety]

– It performs its intended function when used in conjunction with the Signa 
system in a safe and effective manner [Device Safety and Effectiveness]

– Its use in conjunction with the Signa scanner does not adversely impact 
the function of the scanner [Scanner Compatibility]
v. 0 (06/02)  APX-1
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A device may be MR Compatible for certain types of use but not for others. 
The idea of “usage classification is discussed. Note that MR Compatibility 
does not imply general safety. Other normal operating room safety issues 
(sterility, electrical isolation, etc.) must be addressed independently of MR 
Compatibility.
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The components of the definition of MR Compatibility are discussed below.

MR Safety

The “MR Safety” part of the definition is related to whether the presence of 
the device in question in or near the Signa system poses an additional 
safety risk. The primary areas of concern are:
• Magnet forces: The device must not be attracted to the magnet with 

sufficient force as to be a projectile. The device must not experience 
sufficient torque as to be a possible source of injury.

• Heating: The device or immediately surrounding tissue must not have 
the potential to become hot enough to cause injury during scanning.

Device Safety and Effectiveness

“Device Safety and Effectiveness” refers to whether the introduction of the 
device into the Signa environment alters the way in which the device 
functions. In order to be MR compatible, the device must perform its 
intended function effectively and in a way that does not pose a safety risk 
while in the Signa SP scanner environment.

NOTE: GE shall not be responsible for assessing the proper function of any 
device. The manufacturer of the device must make arrangements to 
test their device in the MRI environment. Written certification that the 
device functions as intended in the MRI environment shall be 
provided before the device shall be considered MR compatible.

The following are aspects of the MRI environment which may impact device 
function:
• Large static magnetic field
• Rapidly changing magnetic field
• Radio frequency energy

Scanner Compatibility

Scanner compatibility refers to whether the use of the device in conjunction 
with the scanner adversely effects scanner performance (signal to noise 
ratio, artifacts, image distortion, etc.). The areas of concern are:
• Static Magnetic Field Homogeneity: The device must not cause 

significant changes in the main magnetic field homogeneity.
• Radio Frequency Interference: The device must not distort the transmit 

pattern of the RF energy used for imaging. The device must not 
generate significant radio frequency (RF) energy in the sensitive range 
of the scanner.
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Classification
This document applies to hand-held, non-electronic devices. The degree of 
MR Compatibility required for a device is broken into four “zones” according 
to where the device will be used during scanning. Knowledge of the correct 
MR Compatibility Zone allows the appropriate MR Compatibility tests and 
standards for the device in question to be determined.

Testing Approach
The tests used to assess MR compatibility fall into the following areas:
• Magnet Forces and Torques
• Heating
• Magnet Field Distortion (Static)

Each area has tests and acceptance criteria appropriate to the MR 
Compatibility Zones.

When a new device is considered for MR Compatibility, it is first classified. 
Then the appropriate tests and acceptance criteria are chosen. Once the 
device passes the tests, and the device manufacturer has provided in 
writing the results of their functionality tests indicating that the device 
functions as intended in the MR environment, the device may be 
designated “MR Compatible” for the Zone tested. The tests are designed 
such that MR Safety is independent of the Zone tested. For example, a 
Zone 4 hand-held device may be safely positioned at iso-center and 
scanned but may cause severe image distortions and/or artifacts.

Results of MR Compatibility testing should be maintained on file at the site 
along with design drawings and any other documentation necessary to 
describe the device. Since design changes may make the device 
incompatible, any changes must be reviewed with and approved by the site 
testing personnel in order to maintain the “MR Compatibility” of the device. 
Some changes may necessitate retesting.

Applicable Documents

MR Compatibility Test Specifications
• Magnet Forces and Torques Test Specification
• Heating Test Specification
• Magnet Field Distortion (Static) Test Specification
APX-4  2333956-100 Rev. 0 (06/02)
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Classifications
In order to manage the tremendous variety of devices and applications, the 
following classifications are used throughout this document.

Device Classifications
The tests specified assume the device has the following properties:
• Electrically Passive: The device contains no electric or electronic 

circuitry.
• Hand-Held: The device can be comfortably lifted and manipulated with 

one hand by a typical person. Such devices typically will weigh less than 
2kg.

Usage Classifications
The degree of MR compatibility required depends on the intended use of 
the device. The degree of MR compatibility shall be designated Zone 1, 2, 
3, or 4:
• A device which is Zone 1 MR Compatible is suitable for use in the 

imaging volume, potentially in contact with the patient, during scanning.
• A device which is Zone 2 MR Compatible is suitable for use in the 

imaging volume, potentially in contact with the patient, during scanning, 
provided that the device is at least 5cm away from any anatomical 
feature for which spatially accurate images are required.

• A device which is Zone 3 MR Compatible is suitable for use in the 
imaging volume, potentially in contact with the patient, when not 
scanning. The device should be moved outside of 1.0 m from iso-center 
during scanning.

• A device which is Zone 4 MR Compatible is suitable for use in the scan 
room during scanning when kept more than 1.0m from iso-center.

The highest Zone of MR Compatibility is Zone 1. A Zone 1 MR compatible 
device may be used in the imaging volume in the region of interest without 
degradation of image quality or spatial accuracy. Biopsy needles and 
endoscopes would typically be Zone 1 devices. A Zone 2 device may be 
used in the imaging volume but can cause spatial distortions and artifacts 
nearby (within 5cm). Typical Zone 2 devices would include positioners and 
microscopes. A Zone 3 device should be removed from the scan volume 
prior to scanning to avoid spatial distortion and artifacts. The majority of MR 
Compatible hand-held surgical instruments would be Zone 3 devices. A 
Zone 4 MR compatible device should not cause problems only if it is no 
closer than 1.0m from iso-center. Typical Zone 4 devices include furniture 
and carts. Note that the same type of device can be made MR Compatible 
to any Zone depending on the material used in fabrication. For example, a 
2333956-100 Rev. 0 (06/02)  APX-5
© 2002 General Electric Company. All rights reserved.



Signa® LX Release 9.1
scalpel can be either Zone 1, 2, or 3. A scalpel made of a non-ferrous metal 
might be Zone 3 MR Compatible, while one made of ceramic could be Zone 
1 MR Compatible.

Test Descriptions
This section describes in general terms the tests used to assess MR 
Compatibility. Please see the referenced test procedures for detailed test 
descriptions. The tests used to assess MR compatibility fall into the 
following areas:
• Magnet Forces and Torques
• Heating
• Magnet Field Distortion (Static)

Magnet Forces and Torques
The following are general descriptions of the tests used for magnet forces 
and torques. Please see document “MR Compatibility Tests: Magnet Forces 
and Torques Test Specification” for a complete description.

MFT Test 1: Screening

Part A

This test is to be performed outside of the screen room. A hand magnet is 
suspended on a string and the device is slowly brought into contact with the 
magnet. If the hand magnet is strongly attracted to the device, the test fails. 
See “MR Compatibility Guidelines: Magnet Forces and Torques Test 
Specification” for details.

Results: Pass/Fail

Part B

This test is to be performed using the Signa magnet. Only devices which 
have passed the screening test should be tested. The following apparatus 
is required: clear plastic box with locking lid, paper, marking pen.

The device is placed in a clear box on top of a sheet of paper, its outline is 
traced on the paper and the lid closed and locked. The device is then 
moved into the magnet bore and then removed from the bore. If the device 
moves or pivots as it moves into or out of the bore, it fails. The test is 
repeated with the device oriented 90 degrees from its original position.

Results: Pass/Fail
APX-6  2333956-100 Rev. 0 (06/02)
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MFT Test 2: Small Object Test

This test is to be performed using the Signa magnet ramped. Only devices 
which have passed the screening test should be tested. The following 
apparatus is required: deflection meter.

The device is suspended from a string and slowly carried toward the Signa 
magnet until it is positioned in a known magnetic force area. The angle of 
deflection of the string (and thus the force on the device) is monitored.

Results: Pass/Fail

Heating
The following is a general description of the Heating test. Please see 
document “MR Compatibility Guidelines: Heating Test Specification" for a 
complete description. The tests are applicable only for devices which can 
physically be located inside of a 1.0m diameter sphere centered at 
iso-center during scanning. Other devices may be exempted.

Heating 1: Heating Test 1

This test is used for devices which may be in surface contact with the 
patient or operator during scanning and for devices which may be inserted 
into the patient during scanning. This test is to be performed using the 
Signa magnet ramped.

Use one of the conductive gel samples specifically designed for the heating 
test. Paint the exposed surfaces of the device with the temperature 
sensitive paint. The paint is water-based and undergoes a permanent 
change if its temperature exceeds a specific value. Position the device next 
to or in the gel as it would be positioned in the skin. Run the Heating Test 
PSD listed under the GE Protocols on the system. Remove the device from 
the scanner after the scan is complete and examine the device to determine 
if any surfaces exceeded the prescribed temperature. If any surfaces 
exceeded the appropriate temperature threshold the device fails.

Results: Pass/Fail

Magnet Field Distortion
The following are general descriptions of the Magnetic Field Distortion tests. 
Please see document “MR Compatibility Guidelines: Magnetic Field 
Distortion Test Specification” for a complete description.

MFD Test 1: Local Field Disturbance

This test is to be performed using the Signa magnet ramped. Only devices 
which have passed the magnet forces test should be tested. Zone 3 and 
Zone 4 devices do not need to be tested.
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This test is designed to evaluate local field disturbances from devices that 
would be in the imaging volume during scanning. A copper sulfate phantom 
is scanned, then the device is submerged in the solution and the phantom is 
re-scanned. The change in field due to the device is measured and the 
potential impacts on signal intensity and spatial accuracy are reported.

Results: Zone 1: Pass/Fail
Zone 2: Pass/Fail

Test Procedure
The following procedure shall be used to assess whether a device is “MR 
Compatible”.

1. Make sure that all the appropriate documentation has been provided: 
the documentation shall include a detailed mechanical drawing 
indicating the types of materials used in fabrication.

2. Determine the appropriate device and usage classifications. 

3. Perform the magnetic force screening test. If the device passes, go on 
to step 4. If not, the device shall not be designated “MR Compatible”.

4. Confirm that the manufacturer performed a test of the device 
functionality in the Signa system and/or provides satisfactory 
documentation indicating that the safe function of the device is not 
compromised by its introduction into the MR environment.

5. Determine the appropriate tests for the device.

6. Perform the indicated tests and record the results. If all the test results 
are within the acceptance criteria, the device may be considered “MR 
Compatible” to the lowest Zone passed.

The results of the MR Compatibility test shall be recorded on the MR 
Compatibility data sheet.

Please reference the indicated sections for test descriptions.

Table APX-1 Compatibility Test Selection

Magnetic 
Force Heating Field 

Distortion
Zone 4 4.1.2 4.2.1 n/a

Zone 3 4.1.2 4.2.1 n/a

Zone 2 4.1.2 4.2.1 4.3.1

Zone 1 4.1.2 4.2.1 4.3.1
APX-8  2333956-100 Rev. 0 (06/02)
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Table APX-2 Compatibility Test Acceptance Criteria

Magnetic 
Force Heating Field 

Distortion
Zone 4 <30° deflection <5°C n/a

Zone 3 <30° deflection <5°C n/a

Zone 2 <30° deflection <5°C
<100 counts 
above zero 
distortion (at 
5cm)

Zone 1 <30° deflection <5° C
<100 counts 
above zero 
distortion
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MR Compatibility Data Sheet
Device Information

Device Name: _________________________ Model #: _________________________
Manufacturer: _________________________ Serial #: _________________________
Description: ________________________________________________________________

________________________________________________________________
________________________________________________________________

Documentation Checklist:
❑ A set of detailed mechanical drawings indicating the type of material used (attach copy)

❑ Results of Manufacturer test indicating the device functions as intended in the MRI 
environment (attach copy)

Device Classification:
Circle One: Handheld portable stationary
Circle One: electrically active electrically passive
MR Compatibility Zone Required (circle one)

1 2 3 4
Results of Magnetic Forces Screening Test: Pass Fail

Comments (if failed): _________________________________________________________

_________________________________________________________

List the required tests from Table 1 along with test results:

Test Results Status (circle lowest Zone 
passed)

__________________
___

__________________
___ 4 3 2 1 none

__________________
___

__________________
___ 4 3 2 1 none

__________________
___

__________________
___ 4 3 2 1 none

__________________
___

__________________
___ 4 3 2 1 none

__________________
___

__________________
___ 4 3 2 1 none

__________________
___

__________________
___ 4 3 2 1 none

___
_

___
_

___
_

___
_ _____

Overall Status
(circle highest of above) 4 3 2 1 none
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Magnetic Forces and Torques 
Test Specification

Scope and Summary

Introduction
This document describes the Magnetic Forces and Torques (MFT) Test 
Specification called out in the “MR Compatibility Test Guidelines for the 
Signa System.” Three tests are described:
• MFT 1: Screening
• MFT 2: Small Object Test
• MFT 3: Small Object Test

The MFT Screening Test Part A (MFT 1A) is designed to exclude devices 
which may be strongly attracted to the Signa magnet. The results of the 
MFT Screening Test Part A shall be either “Pass” or “Fail”. The MFT 
Screening Test Part A shall be performed prior to the introduction of any 
device under consideration for the MR Compatibility into the magnet room. 
The MFT Screening Test Part B (MFT 1A) is designed to pass devices 
which experience no force or torque while in the Signa SP magnet. The 
MFT Screening Test Part B involves moving the device into and out of the 
magnet and detecting any translation or rotation of the device. The results 
of the MFT Screening Test Part A shall be either “pass” or “fail”.

The MFT Small Object Test 2 (MFT 2) shall be used for devices which have 
passed the screening test (MFT 1). The test involves moving the device 
toward the magnet in a controlled fashion while the force on the device is 
monitored.

Applicable Documents
MR Compatibility Test Guidelines for the Signa System

Test Equipment
The MFT Screening Test Part A requires the use of a hand-held permanent 
magnet. The magnet used shall be an Edmund Scientific 25 lb. pull SN 
#40847 or equivalent.
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The MFT Screening Test Part B and the MFT Small Object Test 2 require 
the use of the Signa magnet. The following apparatus is required:
• MFT Screening Test — Part B

– Clear Plastic box with locking lid
– Plastic box-sized sheets of paper
– Marking pen

• MFT Small Object — Test 2
– Deflection meter (level - equipped protractor with a string attached)
– Mesh bag

Test Procedures

Small Object Test 1: Screening Test

Part A

Magnet

Box Top View

Test Object

Table

Outline

Magnet

Apparatus of MFT Screening Test Part B

Apparatus of MFT
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The MFT Screening Test Part A shall be performed outside the screen 
room. Suspend a hand magnet (Edmund Scientific 25 lb. pull SN#40847 or 
equivalent) with a string (as opposed to a metallic wire). Slowly bring the 
device into contact with the magnet. If the magnet moves and the string 
deflects from vertical before the device touches the magnet, or if the device 
sticks to the magnet and pulls the magnet so that the string deflects from 
vertical, the device fails.

Results: Pass/Fail.

Part B

The MFT Screening Test Part B is designed to detect any magnetic force or 
torque on a device. Only devices which have passed the Magnetic Forces 
and Torques Screening Test Part A should be tested.

The MFT Screening Test Part B uses the setup shown in Figure 2. While 
outside the procedure room, place the device to be tested into the 
plexiglass box on top of a piece of paper which has been taped into the 
bottom of the box. Draw an outline of the device on the paper to indicate its 
initial position. Close and secure the lid. Place the box on the outer end of 
the patient table and secure it to the table. Make sure that the device has 
not shifted. Move the table such that the box with the device is moved to 
magnet iso-center, then return it to the starting position. If the position of the 
device relative to its outline has not changed (including rotation), the device 
passes. Repeat the test with the device oriented 90 degrees from its original 
position.

Results: Pass/Fail

Small Object Test 2
The Magnetic Forces and Torques Small Object Test 2 is designed to 
determine the magnetic force and torque on a device. Only devices which 
have passed the Magnetic Forces and Torques Screening Test (MFT 1) 
should be tested.

The Magnetic Forces and Torques Small Object Test 2 uses the setup 
shown in Figure 1. While outside the procedure room, place the device to 
be tested into a mesh bag. Adjust the position of the device in the bag such 
that its long axis is parallel to the floor. Run the string attached to the mesh 
bag through the center hole of the deflection meter.
2333956-100 Rev. 0 (06/02)  APX-13
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Hold the deflection meter level, out in front of you and pointing at the 
magnet as you enter the procedure room. Walk slowly toward the magnet 
while observing the angle of deflection. Make sure to keep the device 
between yourself and the magnet. If the angel of deflection exceeds 30°, 
stop the test and remove the device from the procedure room. Otherwise, 
continue moving toward the patient end of the magnet until the top center of 
the deflection meter touches the top of the magnet opening at the patient 
end. Align the deflection meter with the Z axis of the magnet. Record the 
maximum deflection on the data sheet. If the deflection angle exceeds 30° 
the device fails.

Results: Pass/Fail
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Heating Test Specification

Scope and Summary

Introduction
This document describes the Heating Test Specification called out in the 
“MR Compatibility Test Guidelines for the Signa System.”

The Heating Test is designed to detect if the device interacts with the Signa 
system so as to create hazardous temperatures when positioned in the 
patient or when in contact with the patient’s or operator’s skin. The 
maximum safe internal temperature is 41°C, which represents a 4°C rise 
from normal internal temperature of 37°C. The maximum skin exposure 
temperature allowed is also 41°C. Skin temperature can reach 37°C during 
MR scanning, so a temperature increase of 5°C would exceed the allowed 
temperature. Thus, the temperature level to be detected by the heating test 
is 28°C, which represents a 5°C rise above normal room temperature of 
23°C.

Applicable Documents
MR Compatibility Test Guidelines for the Signa System

Test Equipment
The Signa Heating Test requires the use of a temperature sensitive marking 
material such as Omega OMEGASTIK Temperature Indicating Crayons or 
OMEGALAQ Temperature Indicating Lacquer. These materials melt at a 
specific temperature and maintain an altered appearance when cooled. The 
specific model used should melt at a temperature of 28°C, assuming a 
room temperature of 23°C.

The Signa Heating Test also requires the use of a tissue-simulating 
material. A gel phantom designed to simulate the electrical conductivity 
properties of tissue has been developed. The gel consists of 9.70% TX-150 
(Oil Center Research, Lafayette LA), 9.06% aluminum powder (JT Baker 
Chemical Co., Phillipsburg, NJ), 80.97% water and 0.27% NaCl.
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Test Procedure
Part 1 of the test can be performed outside the procedure room. Part 2 of 
the test is to be performed in the Signa magnet. Only devices which have 
passed the required magnet forces and torques test should be tested.

Part 1: Pre-Test Inspection

Before testing the device, inspect it for the following:
• Construction material

– If the device is constructed entirely of a non-conductive material such 
as ceramic or plastic (as indicated in information supplied by 
manufacturer and confirmed by inspection) it may be exempted from 
further Heating testing.

Part 2: Scanner Testing

Apply the temperature indicating material to the surfaces of the device to be 
tested. Lay the body-flex coil flat on the table at iso-center. Position the 
device in the tissue simulating gel in a manner that duplicates the relative 
position between the device and tissue. Place the gel/device on top of one 
of the sides of the body-flex coil with the long axis of the device aligned 
perpendicular to the magnet’s Z axis. Refer to Figure 1 for recommended 
coil/device configurations. Scan the device with the Heating Test protocol 
listed under the GE protocols. The Heating Test protocol exposes the 
device to the maximum RF power possible on the system for a period of 15 
minutes. Observe the device via the over-patient camera during the scan. If 
you can visually verify that the temperature sensitive material is undergoing 
a color change you can stop the scan before it’s completion to prevent 
damage to the device. If no change is detectable during the scan, wait for 
the scan to finish, then remove the device and inspect for temperatures 
exceeding the melting point of the indicating material. If the indicating 
material melted at any point on the device, the test fails.

Repeat with the long axis of the device aligned parallel to the magnet’s Z 
axis. If the indicating material melted at any point on the device, the test 
fails.
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MR Compatibility Test Guidelines for the Signa System
If the device has some loop area, repeat the test with the loop area 
perpendicular to the magnet’s Z axis. Refer to Figure for recommended 
coil/device configurations. If the indicating material melted at any point on 
the device, the test fails.

A needle is shown in the figures for demonstration purposes. The needle 
axis represents the long axis on the device being tested.

cradle

coil

coil

coil

cradle

cradle

cradle

gel

gel

gel

gel

needle

needle

needle

needle

TOP VIEW

SIDE VIEW

SIDE VIEW

Long axis of device parallel
to magnet axis

TOP VIEW

Long axis of device perpendicular
to magnet axis

Loop area of device
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Signa® LX Release 9.1
Table APX-3 Data Log

Distance 
From 

Instrument

Instrument Description (MFG, SN#, ETC) Date ______________

Plane Max Min
Max 

Deviation 
from Zero

Max Min
Max 

Deviation 
from Zero

Pass/Fail
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Verb Generation 8-7, 8-9, 8-10

Patient Preparation 8-9
Voluntary Hand Movement 8-7, 8-8

Left 8-8
Patient Preparation 8-8
Right 8-8

Paradigm Design 10-29
Duplicate an Event or Group 10-31

Paradigm Preview 10-32
Paradigm Setup 10-29

Paradigm Development 2-14, 10-1
Description 10-2
Event Behaviors 10-7

Background Setup 10-12
Debug Options 10-17
Display Properties 10-14
Feedback Setup 10-10
Input/Output Setup 10-7
Other Properties 10-16

Exam 10-19
Configure Feedback and Background

Events 10-23
Background Event 10-25
Edit or Delete an Event 10-27
Feedback Event 10-23

Configure Input and Output Devices
10-21

Input Device 10-21
Output Device 10-22

Delete a Paradigm Sequence 10-34
Design a Paradigm 10-29

Event or Group Duplication 10-31
Paradigm Preview 10-32
ParadigmSetup 10-29

Display Properties Setup 10-28
Save a Paradigm 10-33
Stimulus PC Startup 10-20

Input Devices 10-7, 10-21
Output Devices 10-9, 10-22
Prerequisites 10-3
Save a Paradigm 10-17, 10-33
Window Layout 10-4

Event Area 10-5
Group Area 10-5
Sequence Area 10-4

Parameter Selection Effects
FGRET-MP 13-7
FGRET-RT 13-12
Real Time Spiral 14-12
Spiral 14-6

Parameter Tools
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RTCA 18-21
Average 18-23
Flip Angle 18-22
FOV 18-22
Slice Thickness 18-22

Partial Radial Spacing 3-16
Patient Position

2D FIESTA 11-8
3D FGRE Cardiac Navigator 15-13
3D FIESTA 5-7
3D FRFSE-XL 4-19
FGRET-MP 13-16
FGRET-RT 13-29
Hi-Res Spiral 14-16
IR Prep Gated FGRE Sequence 12-19
Multi Phase FGR-ET Sequence 12-11
PROSE 6-27
Real Time Spiral 14-23
Wall Motion Sequence 12-3

Peripheral Nerve Stimulation 14-7
Phased Array 13-7, 14-11, 14-12
Points 14-4, 14-5, 14-12
Preferences Tab

Lightbox View 9-23
Volume Rendering View 9-7

Prescribing Images 2-11, 3-1
3-Plane GRx 3-1

2D
Multi-Group Prescriptions 3-12
Radial Prescriptions 3-14
Slice Prescritpions 3-8

3D
Multi-Slab Prescriptions 3-21
Tracker Prescriptions 3-22
Volume Prescriptions 3-18

Graphic Functions 3-29
SAT Prescriptions 3-24

Prescriptions
2D

Multi-Group Locations 3-12, 3-33
Radial Locations 3-14, 3-37
Single Locations 3-8, 3-33

2D FIESTA Sequence 11-8

3D
Multi-Slab Locations 3-21, 3-40
Single Location 3-18, 3-40
Tracker Location 3-22, 3-43

3D FIESTA Sequence 5-7
Cardiac Navigator Sequence 15-13
Cardiac Navigator Tracker 15-23
DTI Sequence 7-13
Dynamic R1 4-18
FGRET-MP Sequence 13-16
FGRET-RT Sequence 13-29
Hi-Res Spiral Sequence 14-16
IR Prep Gated FGRE Sequence 12-19
Multi Phase FGR-ET Sequence 12-11
PROSE 6-27
Real Time Sequence 18-35
Real Time Spiral Sequence 14-23
SAT Locations 3-24, 3-45
Wall Motion Sequence 12-3

Preset Materials 9-13
Print

Color Images
fMRI 8-53

PROSE 2-13, 2-16
Associated Imaging Options 6-11
Auto Prescan 6-17
Coil Placement and Selection 6-4
CSI Storage 6-19
Description 6-4
Examine the Spectrum 6-34
Manually Adjust the Homogeneity 6-36
PACC 6-8, 6-25
Prescan 6-18
Prescription 6-27
Prostate Imaging 6-6
Prostate Spectrum 6-9
Protocol Example 6-27, 6-38
Scan Parameters 6-10

CSI Voxel Size 6-12
Imaging Options 6-11
Phase Encoding Matrix Selections 6-11
Scan Timing 6-13, 6-29
User CVs 6-13, 6-15, 6-31
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VOI Prescription 6-14
Signal Suppression 6-10
Suppression Techniques 6-19

Prostate Analytical Coil Correction (PACC) 6-8
Prostate Imaging 6-6
Prostate Spectroscopy Imaging Exam 2-13
Prostate Spectrum 6-9
Protocol Example

2D FIESTA Cardiac Short or Long Axis
11-15

3D FGRE Cardiac Navigator 15-13
3D FIESTA 5-7

Body 5-15
IACs 5-14
MRCP 5-16
Sagittal Spine 5-13

3D FRFSE-XL Breath-Hold 4-19
3D FRFSE-XL with Respiratory Gat-

ing/Triggering 4-25
FGRET-MP 13-16
FGRET-RT 13-29
Hi-Res Spiral 14-16
IR Prep Gated FGRE Sequence 12-19
IR Prep Gated FRGE Sequence 12-28
Multi Phase FGR-ET Sequence 12-11, 12-27
PROSE 6-27, 6-38
Real Time Spiral 14-23
Wall Motion Sequence 12-3, 12-26

PSD Trigger
SS-GRE EPI 8-5

Pulse Sequences
2D FIESTA 2-14, 11-1
3D FIESTA 2-12, 5-1
Additional Cardiac 12-1
Cardiac 2-15
Clinical Spectroscopy 2-13, 2-16
DTI 7-1
Fast Gradient Echo (FGRE) 15-2
FGRET 2-15, 13-1
PROSE 2-16
Spiral 2-15, 2-16, 14-1

R
Radial Prescription 3-4, 3-14

Cat Whiskers 3-17, 3-38
Graphic Objects 3-16
Intersections 3-15, 3-38
Multi-Group Oblique 3-18
Number of Locs Before Pause 3-18
Number of Slices 3-15, 3-16
Partial Radial 3-16
Pulse Sequences 3-14
Radial Direction 3-15, 3-16, 3-37
Radial Parameters 3-17
Spacing 3-15
Wagon Wheel 3-17, 3-38

Ramp Sampling 13-5
DTI 7-6
SS-GRE EPI 8-5

Ray Casting 9-12
Real Time 13-14, 14-14
Real Time Cardiac Acquisition (RTCA) 18-4

Acquire Tab Tools 18-13
Contrast Tools 18-17
Graphic Prescription Tools 18-23
Graphic Tools 18-18
Movement Tools 18-13
Orientation Tools 18-16
Parameter Tools 18-21

Drive Mode 18-14
FGRET 13-11
Review Tab 18-27
Spiral 14-12
Step Mode 18-15

Real Time Image Processing (RTIP)
Database

fMRI 8-27
Real Time Imaging 2-18

Acquire Tab 18-5, 18-6
Tools 18-13

Applications 18-32
Basics 18-4
Bookmarks 18-10
Frame Rate 18-4
Home Images 18-9
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Defining a Scan Plane 18-10
Defining New Home Images 18-10

iDrive Pro Plus 2-18, 13-11, 14-12
Image Acquisition 18-5
Image Buffer 18-11
Multi-Slice Mode 18-12
Overview 18-4
Troubleshooting Tips 18-33

Real Time Spiral
Applications 14-14
Associated Imaging Options 14-14
Imaging Characteristics 14-13
Parameter Selection Effects 14-12

Real-Time SAT
SmartStep 16-9

Receive Bandwidth 14-4, 14-11, 14-12
Reference Image 2-18

Compatibility 2-18
Filming 2-19

Reference Lines
3-Plane GRx 3-10, 3-18, 3-20, 3-30

Overlap Locations 3-22
Report Cursor

3-Plane GRx 3-7, 3-9, 3-29
Reset Center

3-Plane GRx 3-9, 3-31
Resolution

FGRET-MP 13-8
FGRET-RT 13-12

Respiratory Gating/Triggering
3D FRFSE-XL 4-16

Response Time Problems
3-Plane GRx 3-7

Reverse Loop Order 5-3
Review Tab 18-27

Image Slider 18-31
Review Images 18-31

Playback Images 18-52
Save Images 18-53

RTCA 18-27
ROI Selection Window

High Order Shim 21-5
R-R Intervals

FGRET-MP 13-7
Rx Manager

2D FIESTA 11-14
3D FIESTA 5-12
FGRET-MP 13-23
FGRET-RT 13-29, 13-34
Hi-Res Spiral 14-22
IR Prep Gated FGRE Sequence 12-25
Multi Phase FGR-ET Sequence 12-18
PROSE 6-32
Real Time Spiral 14-23, 14-27
Wall Motion Sequence 12-10

S
Safety 2-1

Clinical Hazards 2-7
Equipment Hazards 2-7
Symbols 2-2
System Maintenance 2-3

Cleaning Tips 2-4
Services 2-4

Safety Notices 1-5
Caution 1-5
Danger 1-5
Note 1-5
Warning 1-5

Sagittal Spine 5-7, 5-13
SAT 3-4, 3-24

3-Plane 3-24
Concatenated 3-26
Fat 3-26
Graphic Objects 3-27
Location 3-25, 3-26, 3-27
Screen 3-25
Tag Spacing 3-26
Tag Type 3-26
Thickness 3-25, 3-26, 3-27
Water 3-26

Complimentary Band 3-27
Icon 3-24, 3-28

3-Plane GRx 3-10
Fat 3-28
Spatial 3-28
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Water 3-28
Spatial 3-27

Save
Paradigms 10-17, 10-33

Scalar Bar 9-21
Scan Duration

SS-GRE EPI 8-5
Scan Operations

2D FIESTA 11-14
3D FGRE Cardiac Navigator 15-21
3D FIESTA 5-12
3D FRFSE-XL 4-24
FGRET-MP 13-24
FGRET-RT 13-34
Hi-Res Spiral 14-22
IR Prep Gated FGRE Sequence 12-25
Multi Phase FGR-ET Sequence 12-18
PROSE 6-33
Real Time Spiral 14-27
Wall Motion Sequence 12-10

Scan Parameters
3D FRFSE-XL 4-14
ASSET 20-6
DTI 7-5
FSE 4-4
PROSE 6-10
SSFSE-XL 4-9

Scan Rx Desktop
2D FIESTA 11-8
3D FGRE Cardiac Navigator 15-13
3D FIESTA 5-7
3D FRFSE-XL 4-19
FGRET-MP 13-16
Hi-Res Spiral 14-16
IR Prep Gated FGRE Sequence 12-19
Multi Phase FGR-ET Sequence 12-11
PROSE 6-27
Wall Motion Sequence 12-3

Scan Timing
2D FIESTA 11-10
3D FGRE Cardiac Navigator 15-15
3D FIESTA 5-9
3D FRFSE-XL 4-21

FGRET-MP 13-18
FGRET-RT 13-31
Hi-Res Spiral 14-18
IR Prep Gated FGRE Sequence 12-21
Multi Phase FGR-ET Sequence 12-13
PROSE 6-13, 6-29
Real Time Spiral 14-25
Wall Motion Sequence 12-5

Scanner Control 8-17, 8-18
BrainWave 8-14, 8-15

Scanning Range 3-5
2D FIESTA 11-11
3D FGRE Cardiac Navigator 15-16
3D FIESTA 5-10
3D FRFSE-XL 4-22
3-Plane GRx

Editable Parameters 3-5
Limitations 3-5

FGRET-MP 13-19
FGRET-RT 13-32
Hi-Res Spiral 14-19
IR Prep Gated FGRE Sequence 12-22
Multi Phase FGR-ET Sequence 12-14
PROSE 6-30
Real Time Spiral 14-26
Wall Motion Sequence 12-6

Segmentation Process
BrainWave 8-14, 8-15, 8-17

Select Image
3-Plane GRx 3-7, 3-10
Button 3-7, 3-8

Select Series
3-Plane GRx 3-10
Button 3-7, 3-8

Sensory Equipment
fMRI 8-5

Audio 8-6, 8-7
Hand Controls 8-6, 8-7, 8-34
Microphone 8-6

Adjust 8-34
Controls 8-34

Visual 8-6
Equipment Setup 8-30
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Sequential 14-11
Multi-Group Prescriptions 3-13
Radial Prescriptions 3-17

Series Control
2D FIESTA 11-14
3D FGRE Cardiac Navigator 15-21
3D FIESTA 5-12
3D FRFSE-XL 4-24
FGRET-MP 13-23
FGRET-RT 13-34
Hi-Res Spiral 14-22
IR Prep Gated FGRE Sequence 12-25
Multi Phase FGR-ET Sequence 12-18
PROSE 6-32
Real Time Spiral 14-27
Wall Motion Sequence 12-10

Shim Calculation Failures
High Order Shim 21-6

Shim Improvement Identification
High Order Shim 21-6

Shim Series
High Order Shim 21-2

Shimming Process 21-3
Advanced Window 21-7
Library Window 21-9
ROI Selection Window 21-5
Selecting a Region of Interest 21-4
Shim Calculation Failures 21-6
Shim Improvement Identification 21-6

Signal Calibration 10-9
Single Shot Fast Spin Echo (SSFSE)

Radial Prescriptions 3-14
Single Shot Fast Spin Echo (SSFSE). See SS-
FSE.
Single Shot Fast Spin Echo-Excel (SSFSE-XL).
See SSFSE-XL.
Single Shot Fast Spin Echo-Inversion Recovery
(SSFSE-IR)

Radial Prescriptions 3-14
Single Shot-Gradient Echo Echo Planar Imag-
ing (SS-GRE EPI)

fMRI 8-3
BOLD 8-4

User CVs 8-4
Slice Thickness

3-Plane GRx 3-11
SmartPrep

Tracker 3-19
User CVs

Meta-Series 16-5
SmartStep 2-18, 16-2, 16-8

Basics 16-2
Contrast Mechanism 16-2
Scanning 16-11

Graphic Parameters 16-19
Localizer Series 16-13
Patient Preparation 16-11
Scan Parameters 16-16
SmartStep Series 16-21

User CVs 16-3
Acquisition Type 16-8
Image Acquisition Delay 16-7
K-Space Filling 16-8
Real-Time SAT 16-9
SPECIAL 16-8
Turbo Mode 16-7

Spacing
3-Plane GRx 3-11
Radial Prescriptions 3-15

Spatial Saturation 14-11, 14-13
SPECIAL

SmartStep 16-8
Specific Absorption Rate 14-7
Spectral Spatial RF 2-16, 14-10, 14-12, 14-14
Spectroscopy

Auto Prescan 6-17
Prescan

PROSE 6-18
Spiral 2-15, 2-16

Basics 14-3
Frame Rate 18-4
Gated Non-Sequential Hi-Res 14-8
Gated Sequential Hi-Res 14-8
Gradient Echo 14-7

RTCA 18-4
High Resolution 14-7
Signa® LX Release 9.1 2333956-100 Rev. 0 (06/02)  Index-16
© 2002 General Electric Company. All rights reserved.



Parameter Selection Effects 14-6
Peripheral Nerve Stimulation 14-7
Pulse Sequences 14-1
Real Time 14-12
Spoiled Gradient Echo 14-7

RTCA 18-4
Spiral Trajectory 14-3
SSFSE 2-12
SSFSE. See Single Shot Fast Spin Echo (SS-
FSE).
SSFSE-IR. See Single Shot Fast Spin Echo-In-
version Recovery (SSFSE-IR).
SSFSE-XL 4-8

Applications 4-13
Associated Imaging Options 4-12
Scan Parameters 4-9

Flexible TE Range 4-9
Fractional Phase FOV Ranges 4-11
Receiver Bandwidth 4-11
Selectable TR Values 4-10
User CVs 4-11

SS-GRE EPI
fMRI 8-3

BOLD 8-4
User CVs 8-4

Stimulation Duration
SS-GRE EPI 8-5

Stimulus Delivery
BrainWave 8-14, 8-16, 8-18

Motion Detection 8-20
Open Console to Stimulus System 8-19
Patient Responses 8-20
Test 8-19

Stimulus PC 10-1, 10-3, 10-8
Signal Calibration 10-9
Startup 10-20

Stimulus Personal Computer (PC) 8-27
Database 8-27
Logfile Deletion 8-26
Management 8-27

Structural Magnetic Resonance Imaging (sMRI)
8-23
Subvolume

Volume Rendering View Cropping 9-18
Super Sampling 9-12
System Maintenance 2-3

Cleaning 2-4
Services 2-4

T
T1 FLAIR 2-12, 4-7
T2 FLAIR 2-12
T2 Images

DTI 7-8
T2 Prep 2-16, 14-6, 14-10
Tagging 12-3
Temporal Resolution

FGRET-MP 13-9
Text Report

BrainWave 8-23
Three-Dimensional (3D)

Graphic Objects
3-Plane GRx 3-20

Prescriptions 3-18
Locations per Slab 3-19
Multi-Slab 3-21
Number of Scan Locations 3-19
Overlap Locations 3-19, 3-22
Slice Direction 3-21
Slice Ordering 3-21
Tracker 3-19, 3-22

Torso Phased Array (PA)
ASSET 20-4

Tracker 3-4, 3-19, 3-22
3D Prescriptions 3-19
Cardiac Navigator 15-5
Graphic Objects 3-24
Length 3-23, 3-24
Thickness 3-23, 3-24

Transfer Function Editor 9-16
Transfer Functions 9-15
Transfer Tab

Volume Rendering View 9-14
Troubleshooting Tips

Real Time Imaging 18-33
Turbo Acquisition Mode 13-6
Signa® LX Release 9.1 2333956-100 Rev. 0 (06/02)  Index-17
© 2002 General Electric Company. All rights reserved.



Turbo Mode
SmartStep 16-7

TwinSpeed
Indications for Use 2-8
Resonance Module 2-8

Two-Dimensional (2D)
Graphic Objects

3-Plane GRx 3-11, 3-12
Prescriptions 3-8

Multi-Group 3-12
Radial 3-14

U
User Control Variables (CVs)

3D FGRE Cardiac Navigator 15-20
3D FIESTA

Reverse Loop Order 5-3
BOLD fMRI 8-4
DTI 7-5

DT1+ 7-6
Ramp Sampling 7-6

FGRET 13-4
Echo Tuning and Alignment 13-4
Ramp Sampling 13-5
Turbo Acquisition Mode 13-6
User CVs Screen 13-4

Multi-Group Prescriptions 3-13
PROSE 6-31

ROI Edge Sat Mask 6-15
Scan Mode 6-13

Ramp Sampling 13-5
SmartStep 16-3
SSFSE-XL 4-11

Fractional NEX Optimization 4-12
Maximum Number of Echoes 4-12

SS-GRE EPI
Baseline Duration 8-5
Delay After Slice Package 8-5
Initial State 8-5
PSD Trigger 8-5
Ramp Sampling 8-5
Scan Duration 8-5
Stimulation Duration 8-5

Turbo Acquisition Mode 13-6
User Preferences 2-19

Partial Annotation 2-19
Tick Marks 2-19

V
Valid Localizers

2D Prescriptions 3-5
3D Prescriptions 3-5
SAT Prescriptions 3-5

Variable Bandwidth (VBw)
3D FRFSE-XL 4-16

Venous Acquisition 16-8, 16-18
Viewports

3-Plane GRx 3-10
Visualize fMRI Data 2-14, 9-1

BrainWave Visualizer Basics 9-2
Transfer Functions 9-3

Exam 9-27
Adjust the Lightbox View 9-39

Hide and Window Properties 9-39
Image Features Properties 9-42
View Properties 9-40

Adjust the Volume Rendering View 9-28
Hide and Window Properties 9-28
View Properties 9-29
Volume Appearance Properties 9-31
Volume Features Properties 9-35
Volume Manipulation 9-37

Interface 9-3
Control Panel 9-5
Image Display Views 9-5
Lightbox View 9-5
Main Menu Bar 9-4
Message Area 9-5
Progress Area 9-5
Volume Rendering View 9-5

Lightbox View Interactions 9-22
Image Features Properties 9-24
View Properties 9-23
Window Properties 9-22

Volume Rendering View Interactions 9-6
View Properties 9-8
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Volume Appearance Properties 9-10
Volume Features Properties 9-17
Window Properties 9-6

Volume Appearance Properties
Interactive Speed 9-12

Volume Information 9-11
Volume Rendering View 9-5, 9-6

Image Features Properties
Image Color 9-26
Probe Information 9-26

View Properties 9-8
Annotate 9-9
General 9-8

Volume Appearance Properties 9-10
General 9-10
Material 9-12
Transfer 9-14

Volume Features Properties 9-17
Annotation 9-20
Cut Tab 9-17

Window Properties 9-6
Layout 9-6
Preferences 9-7

Volume Rendering View Procedures 9-28
Hide and Window 9-28
View Properties 9-29

Change the Background Color 9-29
Image Annotation 9-30
Standard View 9-29

Volume Appearance Properties 9-31
Adjust Image Shading 9-31
Color and Opacity Transfer Functions

9-33
Gradient Transfer Functions 9-34
Transfer Functions 9-32

Volume Features Properties 9-35
Annotate 9-36
Cut and Reformat 9-35

Volume Manipulation 9-37
Distance Measure 9-38
Pan 9-37
Quick Keyboard Functions 9-38
Rotate 9-37

Zoom 9-37

W
Wall Motion Sequence 12-26

Tagging 12-3
Water Suppression 14-11
Window and Level (W/L)

3-Plane GRx 3-7, 3-30
Auto Update 3-30
Keep W/L 3-10

Z
Zerofill Interpolation (ZIP) Options

ZIP 1024 4-16
ZIP 512 4-16

Zoom
3-Plane GRx 3-7, 3-10, 3-29

Auto Update 3-29
Slider 3-29
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